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Preface 
 
 
 

Formerly, the analysis and design of structures has been a very extensive work that 
can take you hours, days, or months of calculations the most experienced designer. Such a 
feat has now been reduced in time, by the help of computer programs specializing in the 
design and structural analysis. 

 
There are software packages that allow you to perform such work, such as STAAD.Pro, 
SAP 2000, ETABS, Tricalc, RISA, among others. Being the STAAD.Pro program, one of 
the most widely used by structural engineers worldwide. 

 
This series of manuals for STAAD.Pro V8i program is aimed at students, professors, 
professionals such as civil engineers, architects, etc., who are interested in learning how to 
manipulate this great tool. Even if they have any history or already familiar with the 
program, this manual will enable them to delve into detail procedures or commands not as 
well known. It also serves as a complement to the structures related subjects taught in Civil 
Engineering. 

 
The content of this document is based on and translated from the number four series of 
the English version of the "Getting Started and Technical Reference of STAAD.Pro" because 
it had no such detailed Spanish version of the manual. Along with this, excellent information 
obtained in a course taken by students in the 2010-2014 generation of Civil Engineering of 
the Technological Institute of Nuevo Laredo, where whose contribution was more attached 
to the labor application of this software approach was also collected; ie the most common 
problems that can occur in structural design as a profession and possible solutions thereof. 

 
In the treatment of different instructions that appear throughout the text, we find Anglo 
technical terminology that immediately after; in some terms, its meaning, others said it is 
understood. As the software is of English origin, thus allowing a quick understanding of 
the procedures and / or commands used in the tutorials. 

 
The book was written as a student work Advanced Structural Analysis subject belonging to 
the seventh semester of the race. It is deeply grateful to the Engineer Hector Adame Eliud 
Martínez, for their unconditional to pass on their knowledge, allowing us to look beyond 
our horizons contribution. 
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Introduction 
 

STAAD.Pro is a general purpose program for analysis and design of a wide variety of structures. The 
three basic activities that can be undertaken to achieve that goal - a) generation of the model b) 
calculations for verification of analytical results c) result - they are all provided by GUI tools contained 
in the program. This manual contains some tutorials showing a guide through the steps to create, analyze, 
process, and generate reports for each example. 

 
The first of these tutorials shows these processes using a simple two-dimensional steel frame website. 
It is a good starting point for learning the program. If you are not familiar with STAAD.Pro, will 
greatly benefit through this first tutorial. 

 

For the second tutorial, we have chosen a reinforced concrete structure. We can generate the model, the 
analysis and design of concrete beams and columns. It contains extensive information on the various 
facilities available for viewing and verification of results. 

 

 
The modeling and analysis of a slab is shown in the third tutorial. Slabs and other surface entities such 
as walls are modeled with plate elements. Large surface entities will be defined using several elements 
and this sometimes requires a tool called mesh generator. This tutorial demonstrates the simple 
techniques as well as mesh generation method to generate the finite element model of the slab. It also 
explains the methods by which one can check the results for the elements of the plate. 

 
Contains practical exercises as a warehouse consists of several frames repeated in an address, a seven-
story building, a dome, in the which are summarized in a few steps all seen on the section of tutorials, 
plus using other commands to create other types of common load presented in a building being used 
in structural analysis and design as applicable, such as wind loads and loads due to earthquake. In 
seismic loads, the google earth program is used to obtain geographic coordinates and thus to perform 
the analysis of seismic spectrum given location and how to apply or generate a building. 
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About STAAD.Pro 
 
 
 

STAAD.Pro is a general purpose program for structural analysis and design with applications primarily 
in the building industry - commercial buildings, bridges and structures, industrial structures, structures 
for chemical plants, dams, retaining walls, foundations of turbines, sewers and other embedded structures, 
etc. Therefore, the program consists of the following means for this task. 

 
1. Utilities for generating graphical model and based text editor commands to create the mathematical 

model. Members of the beam and column are represented by lines. Panel type entities, slabs and 
walls are represented by triangular and rectangular finite elements. Blocks are represented using 
solid brick elements. These utilities allow you to create the geometry, assign properties, target cross 
sections as you wish, assign materials like steel, concrete, wood, aluminum, specify supports, apply 
loads explicitly and have the program generate loads, design parameters etc. .. 

 

2. Analysis engine to perform linear elastic analysis of PDELTA, finite element analysis, extraction 
and dynamic response frequency (spectrum, time history, steady state, etc.). 

 
3. Engine design for code verification and optimization of the members of steel, aluminum and wood. 

Calculations of reinforcement for concrete beams, columns, slabs and shear walls. Design of shear 
and moment connections for steel members. 

 
4. Result visualization tools generation and verification result report to examine patterns of displacement, 

bending moment and shear force diagrams, beam, plate and solid efforts contours, 
 

 
5. Peripheral tools for activities such as import and export data to and from other widely accepted 

formats, links to other popular programs for niche areas such as the design of slabs of reinforced 
and prestressed concrete, foundation design, steel connection design, etc. .. 

 
6. A library of functions exposed OpenSTAAD call that allows you to access internal functions and 

routines STAAD.Pro and their graphics to access the database and link STAAD input and output 
third command software written using languages such as C, C ++, VB, VBA, FORTRAN, Java, 
Delphi, etc. .. So, can OpenSTAAD used to link internal or third-party applications with 
STAAD.Pro. 
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Document Conventions 
 

Throughout this manual, the following typographic conventions are used and math. It is 
recommended to spend some time to familiarize yourself with these as to facilitate 
understanding of the content. 

 

Notes, Tips and Warnings 
 

Items to note are indicated as follows: 
 

Note: This is an element of general importance. 
 
 

Tip: This information is optional timesaving. 
 
 

Caveat: This is information about the actions that should not be done under 
normal operating conditions. 

 

File Path / File Name.extension 
 

A fixed-width font is used to indicate file names, file paths and file extensions (for 
example, C:. / SPROV8I / STAAD / STAADPRO (EXE) 

 
Interface Control 

 
A bold font is used to indicate the user controls. Menu items and submenus are indicated 
with a number of> characters to distinguish levels of menu. (For example, File> Save 
As ...) 

Data Entry by User 
  A fixed-width font is used to indicate the information to be entered manually. (For 

example, type DEAD LOAD as the title for load case 1). 

Page Control STAAD 
 

A character "|" is used to represent control levels page between pages and subpages. (Eg, 
select the page Design | Steel). 

 
 

Terminology 
 
 

    Click - this refers to the action of pressing a mouse button to "click" a button on screen 
interface. When not specified, click means to press the left mouse button. 

 
    Select - indicates that the command should be run on a menu or dialog (Click synonymous). 

Used when referring to an action in another control, drop-down list or list box 
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menu where multiple options are available to you. 

    l popup menu - a popup menu typically appears with a right mouse click on an element of 
the interface. 

    Window - describes the display element that can be manipulated independently. 
Multiple windows can be open simultaneously and interacted with. 

 

    dialogue - is an element on the screen (typically) in what should be interacted before 
returning to the main window. 

    Cursor - various selection tools are called "sliders" in STAAD.Pro. Select 
one of these tools will change the mouse icon to reflect the current selection mode. 

 

Conventions Mathematics 
 

 
Similar to orthographic conventions, as this program is of American origin, the American 
mathematical notation used throughout the documentation. 

 

    Numbers greater than 999 are written using a comma (,) to separate every three digits. 
For example, US value of Young's modulus is taken as 29, 000,000 psi. 

 
Caveat: Do not use commas or spaces to separate digits in a number in a STAAD input file. 

 

 

    Numbers with decimal fractions are written with a period to separate integer and 
fraction parts. For example, a beam with a length of 21.75 feet. 

 

 

    Multiplication is represented by a high point, or medium, (·). For example, P = m · A. 
 

 

    Separators are used operations in the following order: 
 

1. Parenthesis () 

2. Brackets [] 

3. Braces {} 
 
 
For example, 
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Section 1 

Getting Started ... 
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1. Introduction 
 

 
STAAD.Pro is a software package for analysis and design of structural engineering. This manual 
is designed to guide users who are new to this software, as well as experienced users seeking 
specific information on the basics of using the program. 

 
Section 1 describes the following: 

    system requirements 

    installation and licenses 
 

    Running STAAD.Pro 
 

    Running Section Wizard 

    Running Mesher 

Section 2 contains tutorials on using STAAD.Pro. The tutorials guide the user through the 
process of: 

 

    Creating a structural model. This consists of generating the structural geometry, specify 
a member property, material constants, loads, analysis and design specifications, etc. 

 

    Visualization and verification of the model geometry. 
 

    Running STAAD analysis engine for analysis and design.     

Verification results - graphically and numerically. 

    Printing and reporting. 
 

 
Section 3 contains some additional information about how to perform some common tasks in 
STAAD.Pro. 

 
Section 4 contains some practical exercises on specific commands that are not addressed in 
Section 3 and / or a summary of the most commonly used commands. 

 

2. System Requirements 
 
 

The following minimum hardware requirements are suggested. Higher capacity systems provide 
improved performance. 
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    PC with Intel-Pentium or equivalent. 
 

    graphics card and monitor with 1280 x 1024 resolution, 256-color display (16-bit color high 
recommended). 

 

    System Memory: 512 MB minimum, 1 GB recommended better and 2GB. 
 

    Windows NT 4.0 or higher operating system. (Windows 95, Windows 98 and Windows 
Me are not supported). The program works best on Windows 2000, XP, Vista or Windows 
7 operating systems. 

 

    enough free space on your hard disk to save the program files and data. The disk space 
requirement varies depending on the modules you are installing. The typical minimum is 
500MB free space. 

 

    A clever speaker and sound card multimedia system is required to run the tutorial movies 
and slideshows. 

 

An additional RAM, disk space and video memory will improve the performance of STAAD.Pro. 
From STAAD.Pro 2001 version, the size of structures that can handle the program has increased 
significantly. As a result, the minimum amount of physical memory 
Virtual + required by the program has also increased to more than 600 MB. You may need to 
ensure that an adequate amount of virtual memory available, and Windows NT and 2000 systems, 
parameters such as the size of the paging file should be large enough to span multiple units or 
other free space is exhausted in one of the disks . 

 
Another aspect to consider is the location of the "TEMP" parameter as in the environment variable 
"TEMP SET" on Windows NT and 2000 systems While performing calculations, depending on 
the size of the structure, the program can create gigantic scratch files that are placed on the 
location of the associated "TEMP" folder parameter. Users may wish to point the variable "TEMP 
SET" to a folder on a disk that has disk space large enough to accommodate the requirements for 
large structures. 

 

You should have a basic knowledge of Microsoft Windows systems to use the software. 
 
 
 
 

3. Installation and Licensing 
 

Please see the document Quick Start and Troubleshooting (Quickstart.pdf), which is included in 
the installation package. 

 

 
Once installation is complete, select Quick Start and Troubleshooting (Quick Start & Troubleshooting 
Guide) on the Start menu in Windows All Programs> Bentley Engineering> STAAD.Pro 
V8i. 
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Figure 1‐1: Quickstart 
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4. Starting STAAD.Pro 
 

Select the STAAD.Pro icon from the STAAD.Pro V8i program group in the Windows Start 
menu. The home interface or STAAD.Pro window opens on the home screen. 

 

Figure 1‐2: 
 

 
 

 

5. Running Section Wizard 
 

Section Wizard is a set of utilities for generating custom sections for use in STAAD.Pr0. 
 

    Select one of the program icons located in the folder assistant section (Section Wizard) in 
the program group STAAD.Pro V8i located in the Windows Start menu. It consists of a set 
of utilities for generating custom sections for use in STAAD.Pro. 

 
Note: For help on using this program, see the help section of the wizard (Section Wizard) accessed from the 
same location or from within individual programs. 

 

 

6. Running Mesher 
 

  Select situated in STAAD.Pro V8i program group in the Windows Start menu Mesher 
icon. 

 
Information on the use of this program is available from the Help menu of the program. 
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Section 2 

Tutorials 
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Tutorial 1 - Portals Steel 
 

This chapter provides a step by step tutorial for creating a framework of 2D portal STAAD.Pro. 
 

 
 

1.1 Model creation methods 
 

There are two methods to create data structure: 

1. Using the graphical model generation mode, or graphical user interface (GUI) 
that typically refers 

 
2. Using the file command (Command File) 

 

The File command is a text file that contains the data of the modeled structure. This file 
consists of simple English like commands. This script can be created directly using the editor 
built into the program, or at least, any editor that saves the data in text form (eg, Notepad, 
TextPad, Notepad ++, etc. ..). 

This script is automatically created behind the scenes when the structure is generated using 
the GUI. 

 
The graphical model generation mode and the script are integrated. So, at any time, you can 
temporarily exit the graph generation model and access the script. You will find that reflects 
all data entered through the mode graph generation model. In addition, to make changes to 
the command file and save it, the GUI immediately reflects the changes made to the structure 
through the script. 

 

Both methods of creating our model are explained in this tutorial. Sections 1.3 to 
1.6 explains the procedure to create the file using the GUI. Section 1.7 describes the creation 
of the script file using the text editor STAAD.Pro. 



STAAD.Pro V8i MANUAL 

 

 

 

1.2 Problem description tutorial 
 

The structure of this project is a steel frame with a clear and a floor that will be analyzed and 
designed with profiles according to American standards. You can style it with some other type 
of profile or other standard (IMCA). 

 
The program has provided an input file called Tut-01-portal.std (C: \ SPro2007 \ STAAD \ 
examp \ US \ Tut_01_portal) containing the input data for the structure to be held in this 
tutorial. 

 

Basic information about the 
structure 

 

Attributes Data 
Properties for 
Members 

Members 1 and 3: 
W12X35 Member 2: 
W14X34

Material 
Constants 

Modulus of Elasticity: 29000 ksi 
Poisson ratio: 0.30 

Offset 
Members 

6.0 inches along global X for member 2 at both ends 

Supports Node 1: Built-Node 
4: Articulated 

Loads Load case 1: Dead + Live 
 

Beam 2: 2.5 kips / ft along down load and overall 
 

Case 2: Wind left 10 kips point force at node 2 load case 3: 75 percent 

of (DL + LL + WL) Load Combination - L1 + L2 X 0.75 X 

0.75 

Type of analysis Elastic-Linear (PERFORM) 
 

 
Design of Steel 

Considered load cases 1 and 3 only. 
Parameters: 40 ksi 

Length flexural compression flange without stand: 10 feet for 2 
and 3 members, 15 members 1 feet. 

Creep of Steel: 40 ksi 
The selection of members for the members 2 and 3 

 

1.3 Starting the program 
 

1. Select the STAAD.Pro icon from the STAAD.Pro program group in the Windows Start 
menu. 

 
 
 

STAAD.Pro window opens on the home screen. 
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Note on the unit system: 

Figure 2‐1: 

 
 

There are two systems of base units in the program control unit (length, force, temperature, etc.) 
in which the values; specifically the results and other information presented in tables and reports 
are shown. The base system units also dictates what kind of default, the program will use when 
attributes such as modulus of elasticity, density, etc., based on types of materials are assigned: steel, 
concrete, aluminum - selected library program . These two systems are English units (foot, pound, 
etc.) and metric or International (KN, metro, etc.). 

 

If you remember, one of the choices made when installing STAAD.Pro is this basic system 
configuration units. That choice will serve as the default until you change it specifically we value. 

We can change this setting either by going to the menu File> Configure or by selecting Settings 
under project tasks. In the dialog box that appears, choose the unit system to your liking. For this 
tutorial, we will choose English units (Kip, feet, etc.). 

 

Figure 2‐2: 
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Figure 2‐3: 
 

 

 
 

 
Click OK to close the dialog box. 

 

1.4 Creating a new structure 
 
 

In the New dialog box, offer some initial critical data needed to build the model. 
 

1. Select File> New or select new project on project tasks. 
 

Figure 2‐4: 
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The New dialog opens. 
 

Figure 2‐5: 
 

 
 
 
 
 

The structure type is defined as Space (Space), Plane (Plane),Floor (Ground), Or 
Truss (Armor): 

Space 
 

The structure, charge, or both, cause the structure to deform in all three global axes 
(X, Y and Z). 

 

 

Plane 
 

The geometry of the load and the deformation is limited only to the overall plane 
XY. 

 

Floor 
 

 
 
A structure whose geometry is limited to the plane XZ. 

 

Truss 
 

The structure carries pure axial load action. The members of the truss are 
considered incapable of carrying loads cutting, bending and twisting. 

 
2. Select Plane. 

3. Select Foot (Feet) as unit length and Kilo Pound (Pound Kilo) as a unit of force. 
 

Tip: The units can be changed later if necessary, at any stage of the creation model. 
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4. Specify the file name as PORTAL and specify a location where the STAAD input file 
will be located on your computer or network. 

 
 

Directly you can type a file path or click [...] to open the search dialog by folder, which is 
used to select a location using a Windows file tree. After specifying the previous entry, click 
Next. The next wizard page, Where do you want to go? (Where do you want it to go?) 
Opens. 

Figure 2‐6: 

 
 

In the dialog, we choose the tools that will be used to initially build the model. 
 

Add Beam (Beam Add), Add Plate (Add plate) or Add Solid (Add Solid) 
Respectively, the choices you make tools are used in the construction of beams, 
plates or solids when the GUI (Graphical User Interface) is opened. 

Open Structure Wizard (Wizard Open structure) 
 

Provides access to a library of structural templates that comes equipped with the 
program. Those template models can be extracted and modified parametrically to 
reach the model geometry or some of its parts. 

 

Open STAAD Editor 
 

Used to create a model using STAAD command language in the STAAD editor. All 
these options are also available from the menus and dialog interface, even after this 
rule box 
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dialog. 
 

Note: To use the Editor to create the model, choose Open STAAD Editor, click Finish and proceed 
to section 1.7. 

 

5. Select the Add Beam option and click finish. The dialog box will be dismissed and 
professional STAAD.Pro graphical environment is displayed. 

 
 

1.5 Creating the model using the graphical user interface (GUI) 
 

It is useful to take some time to familiarize yourself with the components of the STAAD.Pro 
window. A sample of the STAAD.Pro window shown in the figure below. The window has five 
major elements as described below: 

Figure 2‐7: 

 
 

A) Menu Bar 
 

Located at the top of the screen, the menu bar provides access to all commands STAAD.Pro. 
 

B) Toolbar 
 

The dockable toolbar provides access to the most frequently used commands can also 
create your own customized toolbar. 

C) Main Window 
 

This is the largest area in the center of the screen, where the drawings and model 
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results are shown in pictorial form 

D) Control Page 
 

Control page is a set of tabs on the left side of the screen. Each tab in the Control page 
allows you to perform specific tasks. The pages are arranged from top to bottom, 
represents the logical sequence of operations, such as defining beams, specification of 
member properties, loading and so on. 
Each tab has a name and an icon for easy identification. The name on the cards may or 
may not appear depending on your screen resolution and window size of STAAD.Pro. 
However, the icons always appear in the tabs Control page. The pages in the area of 
control of the page depends on the operating mode. The operating mode can be set from 
the mode menu bar 

E) Data Area 
 

The right side of the screen is called the Data AreaWhere different dialogues, tables, list boxes, etc. 
appear depending on the type of operation being performed. For example, when you select the Geometry | 

Page BeamThe data area 

contains the node-coordinate member-incidence and ironing board. When you're in Load 
PageThe content of the changes in the data area shows the load cases assigned 
currently and icons for different types of loads. 

 
The icons in the toolbar and in the area of Page Control ToolTip offer help. As we move 
the mouse over a button, the button name appears - called a ToolTip - above or below the 
button. This helps identify the floating Tooltip icon. A brief description of the icon also 
appears in the status bar. 

We are now ready to start building the model geometry. The steps and, when possible, 
the corresponding STAAD.Pro commands (instructions that are written in the STAAD 
input file) are described in the following sections. 

 
 

1.5.1 Generating the model geometry 
 

 
The geometry of the structure consists of numbers of junctions or nodes, coordinates, member 
number, the member's connectivity information, numbers of element-plate, etc. From the point 
of view of the STAAD command file, the commands generated by the structure shown in 
section 1.2 are: 

 
JOINT COORDINATES 

 

1  0.  0 .; 2 0.  15 .; 3 20 15 .; 4  MEMBER 

INCIDENCE 20 0 

1 1 2; 2 2 3; 3 3 4 
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Procedure: 
 

1. Select the Add Beam (Beam Add) option possible to facilitate the addition of beams to create 
the structure. This initiates a grid in the main drawing area as shown below. The directions 
of the global axes (X, Y, Z) are represented in the icon in the lower left corner of the drawing 
area. 

Figure 2‐8: 
 

 
 
 
 
 

2. Dialogue Snap Node / Beam appears in the data area on the right side of the screen. 
Click Create. 
A dialog box allows you to set a grid opens. Within this dialog box, there is a drop-down 
list from which you can select the linear, Radial or Irregular shape of the grid lines. 

Figure 2‐9: 
 
 

 
 
 

The linear profile is intended for the placement of construction lines perpendicular to each 
other along a pattern of "left to right - top to bottom", as in the lines of a chessboard. 

 
The Radial tab allows construction lines appear on a web style that 
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makes it easy to create circular type models where members are modeled as piece-wise 
linear line segments into. 

 
The Irregular tab can be used to create the grid lines with unequal spacing found in the 
world on a flat or incline. 

 

Select line (linear), which is the default network. 
 

In our structure, the segment formed by the members of 1-3 and 1-4 nodes, occurs in the 
XY plane. So in this dialog box, keep as the XY plane of the net. The size of the model 
that can be removed at any time is controlled by the number of construction lines left and 
right of the origin and spacing between lines of adjacent construction. 

 

By setting 20 as the number of lines to the right of the origin along X, 15 on the origin Y 
and a 1 foot between lines along both X and Y (see figure below) we can draw a frame 20 ft 
X 15 m, suitable for our structure. 

 

After entering the specifications, provide a name and click accept. 

Figure 2‐10: 
 

 
3. Note that these values are only starting grid setting, to enable us to draw the structure, and 

do not restrict our overall model these limits. 
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Figure 2‐11: 

 

 
 

 
In this way, we can create any number of grids. By providing a name, each new grid can 
be identified for future reference. To change the settings for this grid, click Edit. 

 

4. Let's start creating the nodes. From the button Snap Node / Beam is active by 
default, with the mouse, click the origin (0, 0) to create the first node. 
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Figure 2‐12: 

 

 
 

 
Figure 2‐13: 

 

 
 
 

5. Similarly, click the following to create nodes and automatically successive nodes are 
joined by members of the beam 

 

 
(0, 15), (20, 15) AND (20, 0) 

 
The exact location of the mouse can be monitored in the status bar at the bottom of the 
window that continuously update the coordinates X, Y and Z of the current cursor 
position. 

 
Figure 2‐14: Status bar 

 

 
 

When you have completed steps 1-4, the structure is displayed in the drawing area as 
shown below. 
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Figure 2‐15: 
 

 
 

6. At this point, remove the grid structure. To do this, click on the close box Snap dialog 
Node / Beam 

Figure 2‐16: 
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Now the grid and the structure of the main window should look like the figure shown 
below will be deleted. 

Figure 2‐17: 

 

 
 
 

 
It is very important that you save your work often to prevent data loss and protect 
our investment of time and effort against power outages, system problems or other 
unforeseen events. 

 

Tip: Remember to save your work or by selecting File> Save, save the tool or press CTRL + S. 
 
 

1.5.2 Switching node labels and beam 
 

The node and beam labels are a way to identify entities that have drawn on the screen. 
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1. Right-click anywhere in the drawing area, select the labels in the pop-up menu or select 
View> diagrams of structures. The dialog box diagrams opens in the Labels tab. 

 

2. In the dialog box that appears diagrams, numbers selected node (Node Numbers) and 
number of beam (Beam Numbers) and click on OK. 

Figure 2‐18: 
 

 
 
 

The following figure shows the node and beam numbers shown in the structure. The 
structure of the main window should look like the figure shown below. 

Figure 2‐19: 
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1.5.3 Specific properties of the Member 
 
 

Our next task is to assign cross-section properties of beams and columns (see figure in section 
1.2). For those who want to know the equivalent commands in the STAAD editor are: 

 
MEMBER AMERICAN PROPERTY 

 

1 3  TABLE ST W12X35 
 

2 TABLE ST W12X34 

 
Procedure: 

1. To define the properties of members, select the tool properties page located on the top 
toolbar. 

 

Figure 2‐20: 
 

 
 

Alternatively, one can go to General | Property the tabs on the left side of the screen 
as shown below. 

 

Figure 2‐21: 
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2. In any case, the Properties dialog box opens (see figure). The type of property you want 
to create is the way W of the AISC table. This is available on the button of the database 
sections (Section Database) In the dialog box 

Properties as shown below. So click Section Database. 
Figure 2‐22: 

 

 
 

3. In the table dialog profile-section (Section Profile Tables) that appears, select the tab 
W Shape under the American option. 
The checkbox material (Material  check box) is selected. Leave it as it is used to 
subsequently assign the material constants E, density, Poisson, etc, along with the cross-
section, assigning default values. 

Choose W12X35 (IR310x52 according to MIAC) as the size of the beam and ST as such 
section. Then, click Add as shown in the following figure. 

 

Figure 2‐23: 
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4. To create the second member property (ST W14X34), select the shape of W14X34 

(IR360X51) And click add. 
 

After you have created the member properties, click Close. 
 

5. The next step is to associate the properties we just created with selected members in 
our model. Follow these steps. 

a. Select the first reference to the property in the Properties dialog box (W12X35). 
 

b. Choose "Use Cursor to Assign"Allocation method in the box. 

c. Click on Assign. 

The mouse cursor will change to  

d. Click on the members 1 and 3. 
 

e. To stop the allocation process, or select assign or press the ESC key. 

 

 
Figure 2‐24: 
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6. Similarly, assign the second property reference (W14X34) the Member 2. 
After both properties have been assigned to the respective members, our model should 
resemble the following figure. 

Figure 2‐25: 
 

 

 
 
 

Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S 
 
 

 

1.5.4 Specifying material constants 
 

 
In Section 1.5.3, we kept the check box of "on" Material to assign the properties of the member. 
Consequently, the material constants are assigned to members together with the properties, and 
obtained the following commands in the command file: 

 
CONSTANTS 

 

29000 E MEMB 1 TO 3 
 

0.3 POISSON MEMB 1 TO 3 
 

DENSITY 0.000283 MEMB 1 TO 3 
 

6.5e‐006 ALPHA MEMB 1 TO 3 
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Therefore, there is no need to separately allocate constant. However, if these had not been previously 
assigned, selecting from the submenu items C o m m a n d s> Material Constants, used to 
make these assignments. 

 

Figure 2‐26: 
 

 
 

1.5.5 Changing input length units 
 
 

To enter compensation values, as a matter of convenience, it is easier if our length units are inches 
instead of feet. The commands generated are: 

 

 
UNIT KIP INCHES 

 
Steps: 

 
1. Select the tool or input units 

Figure 2‐27: 
 

 
 

 
OTools> Set Current Input Unit. 

 

The Units Setup dialog box opens current input. 
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2. Set the units long in Inch inches and click OK. 

Figure 2‐28: 
 

 
 
 

1.5.6 Specifying offsets member or element 
 

 
 
 

Since the beam 2 actually covers only the clear distance between the faces of the column and not 
the distance from center to center, we can take advantage of this aspect specifying offsets. The 
member 2 is offset to the initial set by 6 inches in the global X direction, 0.0 and 0.0 in directions 
Y and Z. The same member is offset by the negative 6.0 inches in the final joint. The corresponding 
STAAD commands are: 

 
MEMBER OFFSET 

 

2  START 6.0  0.0 0.0 
 

2  END  ‐6.0  0.0 0.0 

 
Procedure: 

 
1. Since we know that 2 is the member to be assigned to the offset, first select this member 

before the offset itself. Select Member 2 by clicking on it with the tool Beam Cursor
. Member is highlighted 
selected. (See 'Tasks performed frequently' of this manual to learn more about selecting 
members section). 

 

2. To set the compensation of members, select the tool specification page (Specification Page)  
located on the top toolbar. 

 
Figure 2‐29: 
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Alternatively, one can go to General | Spec from the left side of the screen. 

Figure 2‐30: 
 

 
 

3. In any case, the specifications dialog shown below appears. The press members and 
offsets are defined through the button beam (Beam) in this dialog box as shown 
below. 

 

Figure 2‐31 
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4. In the dialog box beam specifications that opens, select the tab for Offset. We define the 
offset in the starting node in the direction X. Therefore, make sure the option is selected Start Location 
option below. 
Specify a value of 6.0 for X. Since we have already selected the member, we click Assign. 

Figure 2‐32: 
 

 
 

5. To apply the displacement at the end node, repeat steps 3 and 4, except for selecting the 
final option, providing a value of ‐6.0 for X. 

 
After you have been assigned both the start and end offsets, the model will be as 
shown below. 

Figure 2‐33: 
 

 
 

 
Click anywhere in the drawing area to desrealzar member. 
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Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 

 

1.5.7 Printing member information in an output file 
 
 

We would like to get a report that contains information on all members including initial and 
final numbers of connections (incidence), length of membership, angle beta (Beta Angle) and 
the final statement in the STAAD output file member. The corresponding STAAD command 
is: 

 
PRINT ALL INFORMATION MEMBER 

 
Procedure: 

1. Select all members going to the menu Select> By All> All Beams 

2. Select Co  m  ma  nd  s>  Print  Preview  Analysis>  Member  Information.  
 

The box of member information Print dialog (Print Member Information) 

Figure 2‐34: 
 

 
 
 

3. Make sure that the method of allocation is To Selection. 

4. Press the button OK in this dialogue. 
 
 
 

Click anywhere in the drawing area to desrealzar member. 
 

Tip: Remember to save your work or selecting File> SaveThe tool to save or press 
CTRL + S. 
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1.5.8 Specifying Support 
 
 

The specifications of this problem (see section 1.2) require restrict all degrees of freedom at node 1 
(embedded support "fixed") and an articulated support (Pinned) in node 4 (restricted against all 
translations, free to all rotations). The commands to be generated are: 

 

 
SUPPORTS 

 

1 FIXED; 4  PINNED 
 

Procedure: 

1. To create a support tool selected Support Page located in the top toolbar as 
shown below. 

 

Figure 2‐35: 
 

 
 

Or select the tab General> Support Page from the left of the screen. 

Figure 2‐36: 
 

 
 
 

2. In any case, the dialog box Supports opens as shown in the following figure. Since we 
know that node 1 is to be asso ciated with a fitted stand, using the Nodes Cursor

, Select node 1 is 
He highlighted. (See 'Tasks performed frequently' of this manual to learn more about 
selecting members section). 
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3. Click Create in the dialog Supports as shown below. 

Figure 2‐37: 
 

 
 

 

4. In the dialog box Create Support that opens, select the tab Fixed (Which also happens 
to be the default) and click Assign as shown below. This creates a kind of support FIXED 
on node 1 where all subjects are 
6 degrees of freedom. 

Figure 2‐38: 
 

 
 

5. To create a PINNED support (articulated) in node 4, repeat steps 2-4, except 
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to select the node 4 and select the tab Pinned in the dialog box. After the supports 

have been assigned, the structure will look as shown 
below. 

Figure 2‐39: 
 

 
 

 
 
 
 
Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
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1.5.9 Visualizing the 3D model 
 

Let's see how we can show our 3D model. 
 

1. Right-click and select Structure Diagrams (structure diagrams) from the popup menu 
or select View> Structure Diagrams. 

The dialogue of the diagrams (Diagrams) Is opened in the flange Structure. 

Figure 2‐40: 
 

 
 
 

Sections 3D options control how members are displayed. 

None (None) 
 

Shows the structure without showing the properties of the members and 
cross members. 

 

Full Sections (Complete Sections) 
 

3D shows the cross sections of members, depending on the member properties. 
 

Sections Outline (Outline of Sections) 
 

Displays only the outline of the sections of the members 

2. Select Full Sections and click OK. 
 

Tip: You can also change the color of the sections by clicking the button color contour section (Section 
Outline) In color. 
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The resulting diagram is shown in the following figure. 
 

Figure 2‐41: 
 

 
 

Fast 3D Rendering Option 
 

One.  Right-click and select 3D Rendering from the popup menu or select View> 3D 

Rendering. 
 

A new view opens with the 3D model rendering, perspective 

 

1.5.10 Specifying loads 
 

Three load cases should be created for this structure. Earlier in this tutorial details of individual 
cases are explained. Then the corresponding commands generated are listed. 

 
UNIT KIP FEET 

 

LOADING  1  DEAD  +

  MEMBER LIVE LOAD 

2 UNI GY ‐2.5 
 

LOADING  2  WIND  FROM  LEFT 

JOINT LOAD 

2 FX 10. 
 

March 75 PERCENT LOAD COMBINATION OF (DL + 

LL + WL) 1 0.75 2 0.75 

 
Procedure: 

 

The creation and allocation of load cases involves the following two steps 
 

I. First, we will create all the three load cases 
 

II. Then assign to the respective members / nodes 
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Creating load cases 1 and 2 
 

1. To create loads, first select the tool Load Page (Page load) on the top toolbar. 

Figure 2‐42: 
 

 
 

Alternatively, one can go to General | Load from the left side of the screen. 

Figure 2‐43: 
 

 
 

2. Before creating the first load case, we need to change our units of length in feet. This, as 

above, use the tool input Units    "Input units" (see Section 1.5.5) Note that a 
window appears titled "Load" to 
right of the screen. To create the first load case, highlight details of case load (Load 
Cases Details) And then click add (Add) In the dialog box. 

Figure 2‐44: 
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3. Dialogue Add New Load Cases (r I added new load cases) it opens. 

The drop-down list for type of charge is available if you want to link the case load that 
we are creating with any of the definitions of ACI, AISC or IBC of dead, live, ice loads, 
etc. This type of association must be made if we use the installation program to 
automatically generate load combinations according to the codes. Note that there is a 
checkbox called reducible by UBC / IBC. This feature becomes active only when the load 
case is assigned a type called Live load at the time of creation of that case. 

 

As we do not intend to use the option of automatic generation of load combination (Auto 
Load Combination), We will leave the type of load as None  (Loading Type- None). Enter 
DEAD + LIVE as the title for the load case 1 and click Add. 

Figure 2‐45: 
 

 
 
 

The newly created load case appears under the option Load Cases Details (Details of 
charging load cases). 

 
To create the load member, first select input 1: DEAD + LIVE. You will notice that the dialog 
Add New Load Items  (Add new items to load) 
now shows more options. 

Figure 2‐46: 
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4. In the dialog box Add New Load ItemsSelect the tab Uniform Force under the loading 
point of the member. Specify GY as the address, type ‐2.5 as strength and click Add. 

Figure 2‐47: 
 

 

 
 

 
 

The next step is to create the second load case containing a common load 

5. Perform step 3 again to create a second type of load. Enhancement Load Case Details, click 
Add, let the type of load as None. Specify the title of the second load case as WIND FROM LEFT 
(Wind from left) and click Add. 

Figure 2‐48: 
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6. Then, to create the joint load, select 2: Wind From Left. 

Figure 2‐49: 
 

 
 

7. In the dialog box Add New Load ItemsSelect the tab Node Nodal point for the load. Specify 
10 for Fx and click Add. 

 
Figure 2‐50: 

 

 
 
 

Creating the third load case 
 
 

The Load Cases 1 and 2 were cases of main charge. Charging Case 3 was defined as a combination 
of load. Then the next step is to define the load case 3 and 0.75 x (1 load 
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Load + 2), which is a combination of load. 
1. This, again, select Load Case Details (details of the case load) in the 

Loads dialog & Definition. In the dialog box Add New Load CasesPress 
the tab Define Combinations the left side. Specify the title as the 75 Percent of [DL + 
LL + WL]. 

Figure 2‐51: 
 

 
 
 
 

Table define combinations, the combination type is set to predetermined load Normal 

(default), Which means an algebraic combination. The other types are called combination 
available SRSS ("Square root of sum of squares" - root 
square of the sum of squares) and ABS (absolute). The SRSS type offers the flexibility of 
SRSS and algebraic part. That is, certain load cases are combined using the square root of 
the sum of the squares approach, and the result is combined with algebraic other cases, as 
in 

A + SQRT (B * B + C * C) 
 

Where A, B and C are primary individual cases. 
 

We intend to use the type of algebraic combination default (Normal). 
 
 
 
 

2. Table defined combinationsSelect both load cases in the list box on the left side (by holding down 
CTRL) And click [>]. The load cases appear in the list box on the right. Then, enter 0.75 in the edit box 
Factor. (These data indicate that the two cases are adding a 
multiplication factor loading of 0.75 and that the results of the load combination would 
be obtained by the algebraic sum of the results for individual load cases). Click Add. 
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Figure 2‐52: 

 
 

 
 

Now that we have completed the task of creating all load cases 3, click shut down. 
 

 
 
 
 

Associating a load case with a member 
 

Our next step is to associate the load case 1 with 2 member following steps. 

1. Select the first reference load in the load dialog (UNI GY-2.5 kip / ft). 
 

2. Select the option Use Cursor to Assign in the allocation method box. 

3. Click on Assign. 
 

 

The cursor will change to this form  
 
 

4. Click the Member 2. 

5. To stop the allocation process, click Assign or press Esc. 
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Figure 2‐53 
 
 

 
 

 
 
 

After charging member is assigned, the pattern will be as shown below. 
 
 

Figure 2‐54: 
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Similarly, the second assigning load case (FX 10 kip, ft) to node 2. 

Figure 2‐55: 
 

 
 
 
 

Tip: Remember to save your work or by selecting File> Save, save the tool or press CTRL + S. 
 
 

1.5.11 Specifying type of analysis 
 
 

We are required to do the kind of analysis as a linear static type. We also need to get a 
report of static equilibrium. This requires the command: 

 

 
PERFORM ANALYSIS PRINT CHECK statics 

 
Procedure: 

1. To specify the analysis command, go to Analysis / Print | Analysis from the left side of the 
screen. The Analysis / Print Commands dialog opens: 

 

Figure 2‐56: 

 
 

 
2. In the dialog box Analysis / Print Commands that appears, make sure the tab is selected Perform 

Analysis (Analyzes). Then, check the Static check printing (Check Statics print option). Click Add 
and then Close. 
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Figure 2‐57: 

 

 
 

 
Tip: Remember to save your work or by selecting File> Save, save the tool or press CTRL + S. 

 
 
 
 

1.5.12 Specifying print commands further analysis 
 
 

We would like to get the final member forces and support reactions are written to the 
output file. This requires specification of the following commands: 

 

 
PRINT ALL FORCES MEMBER 

 

PRINT SUPPORT REACTION LIST April 1 

 
Procedure: 

1. The dialog box to specify the above opens when Analysis / Print | Post‐Print is 
selected. 
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Figure 2‐58: 
 

 
 
2. Then select all members. 

 
3. Click Define Commands on the right side of the screen. 

Figure 2‐59: 
 

 
 
 

63 



STAAD.Pro V8i MANUAL

64 

 

 

 

4. In the dialog box Analysis / Print Commands that appears, select the tab Member 

Forces and click Assign followed by the button shut down 

Figure 2‐60: 
 

 
 
 
 
 
 
 
 
 

5. Repeat steps 2-4 except selecting both supports and support 
reactions tab in the dialog box analysis and printing 
commands. (Recall that 

brackets can be selected by turning the Nodes 
Cursor, Hold the key 'Ctrl ' and click 
brackets). Click assign and then shut down. In this 
point, the Print dialog Post analysis should resemble the 
figure shown below. 

Figure 2‐61: 
 
 
 
 
 
 

Tip: Remember to save your work or selecting Archive 
> SaveThe tool save or press CTRL + S. 
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1.5.13 Pre-selection of load cases to be used in steel design 
 

The design of steel shall be carried out for load cases 1 and 3 only for the specification at the 
beginning of this tutorial. To tell the program to use these cases and ignore the rest, we have to 
use the LOAD LIST command. The command appears in the STAAD file as: 

 
 

LOAD LIST March 1 
 

Procedure: 

1. In the menus at the top of the screen, go to the option Commands> Loading> Load 

List as shown below. The List cargo box opens. 
 

Figure 2‐62: 
 

 
 

2. From the list box load cases on the left, double-click 1: DEAD + LIVE and3: 75 
Percent of [DL + LL + WL] to send to the list box on the right load, as 
shown below. Click on OK. 

 

1.5.14 Specifying design parameters steel 
 

 
The specifications listed in Section 1.2 of this tutorial require us to provide values for some of 
the terms used in the design of steel because the default values of these terms are not adequate. 
The corresponding commands are generated: 

 
PARAMETER 

CODE AISC 

5760 ALL Fyld 

MEMB UNT 2 3 10.0 
 

UNB 10.0 MEMB 23 
 

TRACK 2 MEMB March 2 
 

SELECT MEMB March 2 
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Procedure: 
 

1. To specify the design parameters of steel, go to Design | Steel  from the left side of the screen. 
Ensure that selections Current code in the upper right side is AISC ASD (American Institute 
of Steel Construction- Allowables Stress Design) 

Figure 2‐63: 

 

 
 

2. Click on Define Parameters in dialogue Steel Design. 

Figure 2‐64: 
 

 

 
3. In the dialog box that appears design parameters, select the parameter 
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Fyld. Then, provided the Yield strength of steel (Yield strength steel) and 5760 Kip / ft2 and 
click add. 

 

Figure 2‐65: 
 

 
 
 

4. To define the remaining parameters, repeat step 3 except to select the parameters and provide 
the values listed below. 

Parameter Value 
UNT 1 

UNB 1 

TRACK 2 
 

5. When you have added all the parameters, click the close button in the dialog box design 
parameters. 

 
6. The next step is to assign those parameters for specific members of the model. Looking the 

requirements listed in the beginning of this tutorial, we know that the parameter Fyld should 
be assigned to all members, while the remaining parameters must be allocated to the 
members 2 and 3. 

 
As before, using the method Use Cursor to Assign to assign these parameters. 
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Figure 2‐66: 

 

 
 

After all the design parameters have been assigned, the dialog 
Steel Design will be as shown below. 

Figure 2‐67: 
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7. To specify the SELECT command, click Commands in the dialog box Design-steel as 
shown below. The SELECT command is an instruction to the program to get and set 
the cross section of less weight that meets all code requirements (AISC ASD) for the 
member. 

Figure 2‐68: 

 
 

8. In the box Dialog command  design that appears, click on the tab 
select. Then click on add, Followed by the button shut down. 
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Figure 2‐69: 
 

 
 
 
 

9. Again, this command must be associated with members of both 2 and 3 can be use Cursor 
method to assign or first select members 2 and 3 and then use the option Assign to 
Selected Beams. 

 
After the parameters are assigned, click anywhere in the drawing area to desrealzar members. 

 
Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 

 

 

1.5.15 Re-specifying the command Analysis 
 

 
When the analysis and design engine executes the member selection operation we specified in 
the previous step, a new set of properties will end up being allocated to the members. This has 
the effect of changing the distribution of stiffness of the structure 
whole. Since the structure is statically  indeterminateWe must go back if we analyze the nodal 
displacements, member forces, etc. to reflect the new distribution of stiffness. Therefore, it is the command to generate: 

 

 
PERFORM ANALYSIS 
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Procedure: 
 

 

1. To specify the analysis command, repeat step 1 of section 1.5.11 of this tutorial. In the dialog 
analysis and printing command that appears, select the tab Perform Analysis. Since we are 
not interested in a review report static 
once again setting option No print. Finally, click add, Followed by the button shut down. 

 
Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 

 

 
 

1.5.16 Re-specifying parameter TRACK 
 

 
 

The final calculation we have to do is make sure that the current set of member properties meet the 
requirements of codes by means of the forces in the members updated. This will require us to do a code 
check the operation again. To restrict the output produced at a reasonable level, the track parameter 
(TRACK) again is specified as: 

 
TRACK 1 ALL 

 
Procedure: 

 

1. To define and assign 1.0 to the track parameter, repeat steps 1-4 of section 
1.5.14 of this tutorial. 

 

2. Then select all the members by clicking and dragging a window around them using the 
mouse. (See 'Tasks performed frequently' of this manual to learn more about selecting 
members section). Then assign this parameter to all members. 

 

1.5.17 Specifying the CHECK CODE command 
 

 
The scan operation carried out in response to the command in Section 1.5.15 will create a new set of 
forces members. It is likely that these forces are very different from those used in the operation of 
selecting members (see commands section 1.5.14). Consequently, we have to verify that the structure 
is able - from the point of view of the requirements of the design code - to bring these new forces. A 
trial run code that uses the updated sections of the members and the last forces of members, we will 
provide a report on this topic. Therefore, it is the command to generate: 

 
CHECK CODE ALL 

 
 

Procedure: 
1. Select Commands> Design> Steel Design. 
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2. Click Commands in dialogue Steel Design dialog as shown below. 

Figure 2‐70: 

 

 
 

 
3. In the dialog box layout commands that appears, click the CHECK CODE (Check 

Code) tab. Then click on add, Followed by the button shut down. 
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Figure 2‐71: 
 

 
 

 

4. Since the verify command code must be assigned to all members, the easiest way to do 
is to click on map to view - Assign to View‐. 

 
Figure 2‐72: 

 

 
 

We have now completed the tasks for the assignment of the input for this model. 
 

Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 

 

1.6 Viewing the input command 
 

Procedure: 

Now take a look at the data that has been written to the file you just saved before. The 
contents of the file can be viewed by clicking on the tool STAAD Editor or, going to the 
Edit menu and selecting Edit command file input as shown 
below. 
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Figure 2‐73: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2‐74: 
 
 
A new window with the data listed will open as shown 
here: 

 
 

 
Figure 2‐75: 
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This window and the commands they contain are known as STAAD Editor. 

We may make changes to the data of our structure in this Editor if we want to. To exit the Editor 
selects File> Exit option Menu Editor window of the output (not the file> exit the menu from 
the main window behind the editor window). 

 
As we saw in Section 1.1, we could have created the same model also writing relevant STAAD 
commands in a text file using the STAAD editor, or any external editor of your choice. To 
understand this method, proceed to the next section. If you want to skip that part, proceed to 
Section 1.8 where we perform the analysis and design of this model. 

 

 

1.7 Creating the model using the command-file 
 

 
 

We now use the method of command-file to create the model for the above structure. The 
STAAD.Pro command file can be created using the built-in editor, the procedure explained below 
in this section. Any text editor such as Notepad or WordPad can also be used to create the 
command file. However, the Editor STAAD.Pro command file syntax has the advantage when 
writing the commands. The keywords, numeric data, etc. are shown in different colors in the 
STAAD.Pro Editor. Below is a typical screen editor is shown to illustrate the general appearance. 

Figure 2‐76: 
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To access the built-in editor, first start the program using the procedure explained in section 1.3. 
Then follow step 1 of section 1.4. 

 

Figure 2‐77: 
 

 
 

Then you will find the dialog box shown below. In this dialog box, set the check box Open 

STAAD Editor (Open STAAD Editor). 
 

Figure 2‐78: 
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At this point, the editor screen like the one shown below is displayed. 

Figure 2‐79: 
 

 
 
 

Deletes all lines of command in the editor window and the lines shown in bold below (do not 
have to delete the lines if you know what to keep and where to fill in the rest of the commands). 
The commands can be written in lowercase or upper letters. Usually all that is needed are the 
first three letters of a keyword, the remaining letters of the word are not necessary. The letters 
are underlined necessary. ("PLANE" = "PLA" = "plane" = "pla") 

 

 
STAAD PLANE PORTAL FRAME 

 

 
Each STAAD.Pro input file must start with the word STAAD. Word PLANE means that the structure 
is a flat frame (in the XY plane). The rest of the words is the title of the problem, which is optional. 

 

 
If you write a line with an asterisk in the first column means that the line is a comment line and 
should not be executed. For example, one could have put the optional title above a separate line 
as follows. 

 
*  PORTAL  FRAME 

UNIT FEET KIP 

 
 

Specify the units of force and length commands to follow. 

 
JOINT COORDINATES 

 

1  0 0; 2  0 15; 3  20  15; 4  20  0. 
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Numbers boards and their corresponding global coordinate X and Y are provided above. For 
example, March 20, 15 indicates that node 3 has a 20 ft X coordinate and a Y coordinate of 15 
feet. Note that the reason for not providing the Z coordinate is because the structure is a plane 
frame. If this were a spatial structure, the Z coordinate would also be necessary The semicolon 
(;) are used as line separators. In other words, they can put data normally put in multiple lines 
in a single line by separating them with a semicolon. 

 
MEMBER INCIdence 

 

1  1  2; 2  2  3; 3  3  4 
 

 
 

The members are defined by the joints to which they are connected. 

 
MEMBER PROAME PERTYRICAN 

 

1 3  TABLE  ST  W12X35 
 

2 TABLE ST  W14X34 
 
 
 

The members 1 and 3 are assigned one table section W12X35 built American steel. The Member 
2 has been assigned a W14X34. Word ST is defined as the standard single section. Sections 5.20.1 
to 5.20.5 of the STAAD.Pro V8i Technical Manual 
explain the Convention for naming the member properties. 

 
UNIT 

INWITH 

CHESStant

s 

E29000.0 ALL 

POISSON 0.3 

ALL 

 
The unit of length is changed from feet to inches to facilitate the entry of modulus of elasticity 
(E). CONSTANTS keyword is needed before material properties that provide such as E, density, 
coefficient of Poisson's ratio, thermal expansion (ALPHA) etc. See Section 5.26 of the Technical 
Manual for details. 

 
MEMBER OFFSET 

 

2 START 6.0 0 0. 
 

2 END ‐6.0 0 0. 
 
 

The beam member is physically connected to the two columns on the face of the column and 
not on the center line of the column. This creates a rigid zone, about half of the depth of the 
columns, in the two ends of the beam 2 This rigid zone is exploited by 
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compensation to a member (it's your choice if you want to use these). Thus, the above commands 
define the member 2 is connected eccentrically or offset its initial meeting by 6 inches in the 
global X direction, 0.0 and 0.0 in Y and Z. The same member is offset by the negative 6.0 inches 
its final meeting. See section 5.25 of STAAD.Pro V8i Technical Manual for details. 

 
PRINT MEMBER INFOrmation ALL 

 
 
 

The above command is self-explanatory. The printed information includes first and last numbers 
together (incidence), length of membership, member releases beta angle and end. 

 
SUPPORTS 

 

1 FIXED; 4  PINNED 
 
 
 

A flush mount is in the ring 1 and an articulated support (fixed for translations released for 
rotations) on the board 4 More information on the specification of support is available in Section 
5.27 of the STAAD Technical Manual. 

 
UNIT FT 

 
 
 

The unit of length is changed to the feet to facilitate the entry of charges. 

 
LOADING  1  DEAD  +  LIVE 

MEMBER LOAD 

2 UNI GY ‐2.5 
 
 
 

The previous commands identify a load condition. DEAD + LIVE is an optional title to identify 
this load case. A uniformly distributed load in the Member 2.5 kips / ft is acting in the member 
2 in the overall direction Y. The specification of negative charge members explained in section 
5.31 of the STAAD Technical Manual. 

 
LOADING WIND FROM LEFT 

JOI 2NT LOAD 

2  FX  In October. 
 

 
The previous commands identified a second case load. This load is a load on the joint. A force 
of 10 kip is acting on node 2 in the overall direction X. 

 
LOAD COMBination March 75 PERCENT OF (DL + 

LL + WL) 1  0.75 2  0.75 
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This command identifies a load combination with an optional title. The second line gives the 
components of the load combination box - primary load cases and factors which must be 
multiplied individually. 

 

 
PERFORM ANALStatics Ysis CHECK PRINT 

 
 
 

This command instructs the program to continue the analysis and report verification of static 
equilibrium. Section 5.34 of the STAAD Technical Manual provides information on the various 
options available analysis. 

 
PRINT MEMBER FORCES ALL 

 

PRISUP NTPORT REACTION LIST April 1 
 
 
 

The above print commands are self-explanatory. The forces in the members are in the local axes 
while the reactions of the supports in the global axes. 

 
March 1 PAR 

LOAD 

LISTAMETERS 

CODE AISC 

UNT 10.0 MEMB March 2 
 

UNB 10.0 MEMB 

March 2 Fyld 5760 

ALL TRACK 2.0 MEMB 

March 2 

SELECT MEMBER March 2 
 
 

The script is used to start the design process of steel. Command parameters are followed by the 
different design parameters of steel. The parameters are normally specified when their values 
differ from the defects of the software supplied. AISC ASD code specifications must be followed. 
A list of parameters for the AISC code is available in Table 2.1 on page 80 of the Technical 
Manual STAAD.Pro V8i. 

 
 

All members have 10 feet of unsupported length of the upper and lower flange (UNT and UNB). 
UNB UNT and used to calculate the allowable compressive stress in bending. The yield strength of 
steel is specified as 5.760 MPa (40 ksi), and which is different from the default value of 36 ksi. The 
TRACK parameter controls the level of description of the output, 2.0 is the most detailed. The SELECT 
command lists MEMBER load cases (1 and 3) to be used in the design. The member selection 
command calls the program to get the cheapest part for members 2 and 3 in the context of the above 
analysis 

 
PERFORM ANALYSIS 
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When the analysis and design engine executes the operation selection of members was 
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specified in the previous step, a new set of properties will be allocated to the members. This has 
the effect of changing the distribution of stiffness of the entire structure. Since the structure is 
statically indeterminate, we must go back if we analyze the nodal displacements, member forces, 
etc. to reflect the new distribution of stiffness. The above command instructs the program to do 
another cycle of analysis. 

 
1 ALL TRACK 

PARAMETER 

 
 

The TRACK parameter is re-specified. Controls the level of information produced in the output 
of steel design. We have dropped from 2.0 to 1.0 we specified before, since we are not interested 
in the maximum level of detail at this time. 

 
CHECK CODE ALL 

 

 
 

The analysis performed above operation will create a new set of forces in the members. These 
forces are likely to be very different from those used in the operation of selecting members. 
Consequently, we have to verify that the structure is safe - from the point of view of the 
requirements of the design code - able to bring these new forces. A trial run code that uses the 
updated sections of the members and the last forces of members, we will provide a report on 
this topic. 

 
FINISH 

 

The STAAD executor is terminated using the FINISH command. Save the file and return to 
the main screen. 

 
This concludes the session in the generation of our model as a script using the built-in editor. 
To perform the analysis and design, you can proceed to the next section of this manual. The 
facilities at the screen post-processing are explained in Section 1.10. 

 
 

Caveat: Remember that without completing the analysis and design of post-processing facilities are not accessible. 
 
 

1.8 Performing the Analysis / Design 
 

 
 

STAAD.Pro performs analysis and design 
simultaneously. 

 
Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
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In order to perform analysis and design, select Analyse>  Run 
Analysis .... 

As the analysis progresses, several messages appear on the screen as shown in the following figure. 
 
 

Figure 2‐80: 
 

 
 
 
 

Note that we can choose from the three options available in the dialog box above: 

Figure 2‐81: 
 

 
 

These options are indicative of what will happen after you click Done. 

Option View Output File (see output file) allows us to see the output file created by STAAD. The 
output file contains the numerical results produced in response to different input commands you 
specified during the generation process model. It also tells us if errors were found and if so, whether 
the analysis and design was completed successfully or not. Section 1.9 provides additional details on 
viewing and understanding the contents of the output file. 

Option Go to Post Processing Mode (go to the post-processing mode) allows us to go to the graphics 
part of the program known as the post-processor. This is where one can exhaustively verify the results, 
see the results graphically, draw diagrams of results, produce reports, etc. Section 1.10 explains the post-
processing mode in more detail. 

Option Stay in Modelling Mode (Staying in modeling mode) allows us to remain at the generation 
mode of the program model (in which it is currently) in case we want to make more changes in our 
model. 
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1.9 Viewing the output file 
 

 
 

During the analysis process, STAAD.Pro creates an output file. This file contains important 
information about whether the analysis was successful. For example, if STAAD.Pro is a problem of 
instability during the analysis process will be reported in the output file. 

We can access the output file using the method explained at the end of the previous section. Alternatively, 
you can select the option File> View> Output File> STAAD Output the top menu. The 
STAAD.Pro output file for the problem that we have 
I found is shown in the following pages. 

 

 
Figure 2‐82: 

 

 
 

 
The output file is displayed through a file viewer called SproView. This display lets you set the text 
font for the whole file and print the output file to a printer. Use the appropriate menu option Archive from the 
menu bar. 

Figure 2‐83: 
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By default, the output file also contains a list of all the input. You can choose not to print the echo 
of the commands into the output file. Please select Commands>  Miscellaneous> 

September Echo from the menu bar and 

select the button Echo Off. 
 

It is very important that we sail across the output file and ensure that the results seem reasonable, 
no error messages or warnings reported, etc. Errors found during the analysis & design can 
disable access to post-processing mode - graphical displays which can display results graphically. 
The information presented in the output file is a crucial indicator of whether or not the structure 
meets the requirements of engineering safety and ease of maintenance. 

 

 
 
 

1.10 Post-Processing 
 

STAAD.Pro provides ample facilities for verification and visualization of results. These commands 
are accessible from the Post-processing mode. The post-processing mode is used to check the results 
of analysis and design and generate reports. 

For this tutorial, we must perform the following tasks: 
 

 
 

1.10.1 Go to the post-processing mode 
 

At the end of section 1.8, we saw how one could go directly from the scan window to screen 
post-processing. However, you can access the post-processing mode using the following 
procedure at any time. 

 

Procedure: 
 

1. Select the tool Post Processing orMode> Post Processing. Opens the Output 
Settings dialog. 

 

 
 

Figure 1.95 
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Figure 2‐84: 
 

 
 

2. Select the load cases for which to display the results. For this tutorial, click [>>] To 
select all load cases and click accept. 

 

Note that in the post-processing mode, change control bar tabbed page and the menu 
bar to offer the post processing functions: 

Figure 2‐85: 
 

 

 
 
 

Page Control mode modeling  

 
Control mode Page Post-Processing 
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M 

 
 
 

 
 
 

Menu Bar mode modeling 
 

 
 
 
 

 
 

 
 
 

Bar menu mode post-processing 
 
 

1.10.2 Noting the displacement 
 

Procedure: 
 

The screen will now look like the figure shown below. 

Figure 2‐86: 

 
 
 

The chart is currently on display nodal deflection diagram or "elastic curve" for the case of load 
1 (DEAD + LIVE). The title in the bottom of the diagram is indicative of that aspect. If you, say, 
he walked away to any other result diagram and wanted to return to the diagram 

deviation, just select the tab Node> Displacement along the area 
Page control on the left side. 
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Figure 2‐87: 
 

 
 

Annotation (Annotation) is the process of viewing the offset values on the screen. Select 
Results> View Value ... 

 
The annotation dialog box opens 

 

Figure 2‐88: 
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From the Record RangesSelect All all nodes. If you want to annotate deflection for few nodes, 
node numbers specified in the node list. 

From the Record NodeSet the checkbox Resultant. This represents the square root of the sum of the squares 
of the values of X, Y and Z displacements. Click the record button and note that the values appear in the structure and 
then click 
shut 

down. 
Figure 2‐89: 

 

 
 

The following figure shows the annotated deflection diagram for load case 1. 

Figure 2‐90: 
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1.10.3 Viewing diagrams of forces / moment 
 

Procedure: 
 

The easiest way to access the facilities to display diagrams of force / moment is from the tab Beam 
| Forces along the page control area on the left side of the screen. The bending moment MZ will 
be checked by default, makes evident 
which may be in the form of icon Mz shown in the diagram below which it becomes active. 

 

Figure 1 106 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2‐91: 

 

 
 

The option to select the scheme forces / time from another facility is available too - menu option 
Results> Bending Moment. 
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Figure 2‐92: 
 

 
 

 
1.10.4 Scoring diagram force / moment 

 
Procedure: 

Annotation is the process of displaying the values of force / moment on the screen. Select Results> 
View Value .... The Annotation dialog. 

 

Select the tab Ranges and then All all members. If you want to annotate the strength to few 
members, specify the numbers of the beam in the list of the beam. 

 

Figure 2‐93: 
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On the record Beam Results (Results of beam), set the checkboxes Ends andMid‐point 

section Bending. Click the record button and note that the values appear in the structure and click OK. 
 

Figure 2‐94: 
 

 
 
 

The following diagram shows the MZ scored for the case of load 2. 
 

Figure 2‐95: 
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1.10.5 Changing the degree of freedom for the forces diagram 
trace 

 
 

They can draw diagrams and moment of 6 degrees of freedom - Axial cut, shear-Y,-Z shear, 
torque, moment-Y,-Z time. 

 

Select View> Structure Diagrams> Loads and Results. 

 
Figure 2‐96: 
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Select Load Case 3 (75 PERCENT OF [DL + LL + WL] and set the checkbox Shear yy. 
 

The resulting figure is shown below. 

Figure 2‐97: 
 

 
 

The degrees of freedom currently drawn are noted with a check mark in the dialog box diagrams. 
 

The icons in the bar results can also be used to enable / disable certain degrees of freedom 
 

Figure 2‐98: 
 

 
 

For the sake of easy identification, each degree of freedom (degree of freedom -dof-) has been 
assigned a different color (see diagrams above dialog). One can change the color of the "shallow" 
by clicking on the color button next to the "shallow" and make a new selection of the color 
palette. 

Figure 2‐99: 
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The appearance of the diagram can also be set to one of 3 - Grilles, fill and stroke by selecting 
the appropriate option in the dialog box shown above. 

 

Figure 2‐100: 
 

 
 

 
 

1.10.6 Showing the dimensions of the members 
 

 
 

To display the dimension members, select the dimension tool. Alternatively, one can go to the 
command Dimension on the Tools menu. In the dialog box that option dimension to open 
the view is active. Click Display followed by the button CloseAnd the dimensions of the members 
appear next to members. 

Figure 2‐101: 
 

 
Figure 2‐102: 
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The diagram will be as shown below. 
 

 
Figure 2‐103: 

 

 
 

 
 

We can choose to save the screenshot by clicking on the tool Take Picture (Photo-taking shown 
below). This table can be included in custom reports. 

Figure 2‐104: 
 

 
 

To get a quick impression of the plot on the screen, select the tool Print Current View (print 
the current view) as shown below. 

 

Figure 2‐105: 
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Tutorial 2 - Setting reinforced concrete 
 

 
This tutorial provides step by step instructions to create the model of a reinforced concrete 
framed structure with STAAD.Pro. 

 

 
 
 

 
 

2.1 Model creation methods 
 

As explained in section 1.1 of the tutorial 1, there are two methods for creating the data structure: 
 

1. Using the graphical model generation mode, or graphical user interface (GUI) that 
typically refers. 

 
2. Using the file command. 

 

Both methods are explained in this tutorial too. The graphical method is explained first, in 
section 2.2 hereinafter. Section 2.8 describes the process of creating the model using the method 
of command file and text editor STAAD.Pro 

 
 
 

2.2 Problem description tutorial 
 

The structure of this project is a reinforced concrete structure with 2 bays and one level located 
in two Cartesian planes (XY, YZ), as shown in Fig. Our goal is to create the model, assign 
everything that requires input and perform the design and analysis of concrete. 
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Basic information about the structure 
 

Attributes Data 
Member 

Properties 
Beams 2 & 5: Rectangular, 275 mm Width 350 mm Depth Columns 1 & 4: 

Rectangular, 275 mm wide by 300 mm 

depth 
 

Column 3: Round, diameter 350 mm 

Member 
Orientation 

ALL members (except column 4): Default 
 

Column 4: rotated 90 degrees relative to the default 
Material 

Constants 
Modulus of elasticity: 22 KN / 

sq.mm Density: 25 kn / cu.m 

Poisson ratio: 0.17
Supports Base of all columns: Built

Loads Load case 1: Dead load with weight of the beams 2 & 5 

structure: 400 kg / m in the global Y down 

load case 2: live load 
 

Beams 2 & 5: 600 kg / m in the global Y down 

load case 3: wind load 

Beam 1: 300 kg / m along X positive overall 
 

Beam 4: 500 kg / m along positive overall charge of X 

Case 4: DEAD + LIVE 

L1 + L2 X 1.2 X 1.5 (Use REPEAT LOAD not Load 

Combination) Load Case 5: DEAD WIND L1 + 

L2 + X 1.1 X 1.3 (Use REPEAT LOAD not Load 
Combination) 

Type of Analysis PDELTA
Concrete 
Design 

Consider load cases 4 and 5 only. Parameters: 

Yield Strength: 415 n / sq.mm Concrete 

Strength: 25 n / sq.mm clear cover up: 25 

mm clear cover to the bottom: 30 mm 

Cover the light side: 25 mm 
 

design of beams 2 and 5 
 

Design of columns 1, 3 and 4 
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2.3 Starting the program 
 

 

1. Select the STAAD.Pro icon from the program group STAAD.Pro V8i in the 
Windows Start menu. 

 
The STAAD.Pro window opens to the home screen. 

Figure 2‐106: 
 
 

 
 

 
Note: See "1.3 Starting the Program" on page 22 for notes about changing the system default drive. 

 
 

 

2.4 Creating a new structure 
 

In the dialog box NewOffer some initial critical data needed to build the model. 
 

1. Select File> New or select New Project under Project Tasks. 
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The New dialog 
opens: 

figure 2‐107: 

 
Figure 2‐108: 

 

 
 

 
The structure type is defined as Space, Plane,Floor, Or Truss: 

Space (Space Structure) 
 

The structure, charge, or both, cause the structure to deform in the three global axes 
(X, Y and Z). 

 

 

Plane (Flat Structure) 
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The geometry of the load and the deformation is limited only to the overall plane 
XY 



STAAD.Pro V8i MANUAL

101

 

 

 

 

Floor 
(Floor) 

 
A structure whose geometry is limited to the plane XZ. 

Truss (Armor) 
 

The structure carries pure axial load action. The members of the truss are 
considered incapable of carrying shear, bending and torsion. 

2. Select Space. 

3. Select Meter as the unit length and Kilo Newton co m u l a f orce nity of. 
 

Tip: The units can be changed later if necessary, at any stage of the creation model. 
 

4. Specify the file name as RCFrame and specify a location where the STAAD input file 
will be located on your computer or network. 

 
Directly you can type a file path or click [...] to open the search dialog by folder, which is 
used to select a location using a Windows file tree. 

After specifying the previous entry, click Next. The next wizard page, Where do you want to go 
open. 

 
Figure 2‐109: 
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In the dialog, we choose the tools that will be used to initially build the model. 
 

Add Beam, Plate Add, or Add Solid 
 

Respectively, the selected tools are used in the construction of beams, plates or 
solids when the GUI is opened. 

 

Open Structure Wizard 
 

Provides access to a library of structural templates that comes equipped with the 
program. Those template models can be extracted and modified parametrically to 
reach the model geometry or some of its parts. 

Open STAAD Editor 
 

Usually created a model using STAAD command language in the STAAD editor. 
 

All these options are also available from the menus and dialog interface, even after we 
discard this dialog. 

 
Note: To use the Editor to create the model, choose Open STAAD Editor, click end and proceed to section 
2.8. 

 
 
 

5. Select the option to add the beam and click finish. The dialog box will be dismissed 
and STAAD. Professional GUI displays. 

 

 

2.5 Elements of the STAAD.Pro screen 
 

STAAD.Pro The main window is the screen where the model generation process is performed. It is 
important to become familiar with the components of the window before embarking on the creation of 
the structure of reinforced concrete frame. In section 1.5 the tutorial problem 1 of this manual explains 
the components of that window in detail. 

2.6 Building the STAAD.Pro model 
 

We are now ready to start building the model geometry. The steps and, when possible, the 
corresponding commands (instructions that are written in the STAAD input file) are described in 
the following sections. 

 

2.6.1 Generating the model geometry 
 
 

The geometry of the structure is composed of node numbers, coordinates, member numbers, 
connectivity information of the member, plate element numbers, etc. From the point of view of 
the STAAD command file, the commands are generated by the structure shown in section 2.2: 
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JOINT COORDINATES 
 

1 0.0 0.0 0.0; 2 0.0 3.5 0.0 
 

3 6.0 3.5 0.0; 4 6.0 0.0 0.0 

 
5 6.0 0.0 6.0; 6 6.0 3.5 6.0 

 

MEMBER INCIDENCE 
 

1 1 2; 2 2 3; 3 3 4; 4 5 6; 5 3 6 
 

 
 

Procedure 

1. Select the option Add Beam before to allow us to add beams and columns to create the 
structure. This initiates a grid in the main drawing area as shown below. The directions of 
the global axes (X, Y and Z) are represented in the icon in the lower left corner of the 
drawing area. 

Figure 2‐110: 
 
 

 
 

 
2. Dialogue appears in the data area on the right side of the screen Snap Node / Beam. 
Click create. A dialog box allows you to set a grid opens. 
Within this dialog box, there is a drop-down list from which you can select Linear, Radial or 
Irregular shaped grid lines. 
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Figure 2‐111: 
 

 
 

 
Select linear, Which is the default network. 

In our structure, the segment consists of members from 1-3 and 1-4 nodes happens in the 
plane X‐Y. So in this dialog box, keep X‐Y as the plane of the net. The size of the model that can 
be removed at any time is controlled by the number of construction lines left and right of the 
origin of 

  axes and the spacing between lines of adjacent construction. 12 by setting the number of lines 
to the right of the origin along X,7on the origin Andand space 0.5 m between lines along 
both XandAnd(See figure below) we can draw a marquee 6m X3.5 m, suitable for our 
segment. 

After entering the specifications, provide a name and click OK. 

 
Figure 2‐112: 
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In this way, we can create any number of grids. By providing a name, each new grid can be 
identified for future reference. 

 

Please note that these values are only starting grid setting, to enable us to draw the 
structure, and do not restrict our overall model these limits. 

 

3. Let's start creating the nodes. From the Snap Node / Beam button is enabled by default, 
with the mouse, click the origin (0, 0) to create the first node. 

 

 
Figure 2‐113: 

 

 
 
 
 

Figure 2‐114: 
 

 



STAAD.Pro V8i MANUAL

106 

 

 

 
 

4. Similarly, click the following to create nodes and nodes by successive members of the 
beam is automatically attached. 

 
(0, 3.5), (6, 3.5) and (6, 0) 

 

The exact location of the mouse can be monitored in the status bar at the bottom of the 
window that continuously update the coordinates X, Y and Z of the current cursor 
position. 

 

 

 
 
 

When you have completed steps 1-4, the frame will be displayed in the drawing area as 
shown below. 

 

 
Figure 2‐115: 

 

 
 
 

5. At this point, we remove the display of the grid structure. To do this, click Close in the 
dialog box Snap Node / Beam 

 

 
Figure 2‐116: 
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Now the grid and the structure of the main window should look like the figure shown 
below will be deleted. 

 

Figure 2‐117: 
 
 
 

 
 

 
6. It is very important to save our work often to prevent data loss and protect our 

investment of time and effort against power outages, system problems or other 
unforeseen events. 

 

Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 

 
 
 

Switching node labels and beam 
 

The node and beam labels are a way to identify entities that have drawn on the screen. In 
order to show the node numbers and beam. 

 

1. Right-click anywhere in the drawing area and select Labels from the popup menu or select 
View> Structure Diagrams 

 

The Diagrams dialog opens in the Labels tab. 
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Figure 2‐118: 
 

 
 

2. In the dialog box that appears diagrams, set the boxes node and beam numbers and 
click OK. 

 
 

The following figure shows the node and beam numbers shown in the structure. The 
structure of the main window should look like the figure shown below. 



STAAD.Pro V8i MANUAL

109

 

 

 
 

figure 2‐119: 
 

 
 
 
 

If you're feeling adventurous, here's a little exercise for you. Change the font of the labels / 
node beam selecting View> Options and then select the corresponding tab (node labels / 
tags beam) dialog box 

Options. 
 

3. Examining the structure shown in section 2.2 of this tutorial, you can see that the members 
of 4 and 5 can be easily generated if we could create a copy of first members 1 and 2 and 
then turn those units copied on a vertical line passing the point (6, 0, 0, that is, node 4) by 
90 degrees. Fortunately, there are those 

facilities that can be executed in one step. It is called Circular Repeat (Repeat 
Loop) and is available from the menu Geometry. 

First, select the members 1 and 2 using the tool Beams Cursor   

4. Select the tool Circular repeat from the bar proper tools 
 

Figure 2 21 
 
 
 
 
 
 
 
 

Or select Geometry> Circular Repeat. 3D Circular Table dialog box opens. 
 
 

5. Specify the axis of rotation Y, Total angle 90 degrees and step numbers as 1 and the 
vertical line as step 4 of the node. O can be specified in place of X and Z coordinates as 
6 and 0 respectively. 
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Clear the Link Steps (link steps) and click ok. 

 

Figure 2‐120: 
 

 
 

After completing the process loop repetition, the pattern will be as shown below. 
 

 
Before 
Figure 2‐121: 

 

 
 

Then 
Figure 2‐122: 
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Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 
 

2.6.2 Changing input length units 
 

As a matter of convenience, to specify properties of members of our structure, it is easier if our 
length units are millimeters instead of meter. This will require changing the current length units 
input. The commands generated are: 

 

 
UNIT KN MMS 

 
Procedure: 

 
1. Select tool or input units 

 

Figure 2‐123: 
 

 
 

OTools> Set Current Input Unit. 
 

The Units Setup dialog box opens current input. 

Figure 2‐124: 
 

 
 

2. Sets the units of length mm and click OK. 
 
 

2.6.3 Specifying the properties of members 
 

Our next task is to assign cross-sectional properties of beams and columns (see section 2.2). For 
those of us know the equivalent commands in the STAAD command file are: 
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MEMB PROP 
 

1 4 PRIS YD 300 ZD 275 
 

2 5 PRIS YD 350 ZD 275 
 

3 PRIS YD 350 
 

Procedure: 

1. Select Tool property page located on the toolbar of the structure. 
 

Figure 2‐125: 
 

 
 

Or select General | Property page from the left side of the screen shown below. 

Figure 2‐126: 
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The Properties dialog - Whole Structure opens. 

 
Figure 2‐127: 

 

 
 

2. Click on Define ...   

 
Open the Properties dialog box. 

3. Select the tab Rectangle 
 

 
 
 

Note: The checkbox is set Material. By keeping the shape, the particular material properties (E, Poisson, 
density, alpha, etc.) along with the name of cross section is assigned. The material property values thus 
assigned shall be the default program. We do not want the default, however we will assign our own values 
later. Therefore, clear the check box Material. Then enter the following values: 

 

 

Property Value 

YD 300 
mm 

ZD 275 
mm 
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Figure 2‐129: 

Finally, click the button Add as shown below. 

Figure 2‐128: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Material box in unchecked mode 
 
 
 
 
 
 
 
 
 

 
 

4. Repeat step 3 to create the second member property (PRIS YD 350 ZD 275) provide 350 
YD and 275 to ZD (Instead of 300 and 275) and click add. 

5. To create the third member property in the dialog PropertiesSelect the option Circle. Specify 
diameter (YD) as 350 mm. So, clear the check box Material and click add. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Material box in unchecked mode 
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6. Click on Close. 
 

The next step is to assign the properties of these members as follows:     

0.30x0.28 Rect - members 1 and 4 

    0.35x0.28 Rect - members 2 and 5 

    Cir 0.35 - Member 3 
 

To assign the member properties, follow these steps: 
 

1. Select the first property reference in the dialog 
Properties (Rect 0.30x28). 

2. Select the Use Cursor to Assign in the allocation method box. 

3. Click on Assign. 
 

 
 

 
4. Click members 1 and 4. 

 

The mouse cursor changes to 

5. To stop the allocation process select Assign or press Esc. 
 

Figure 2‐130: 
 

 
 
 

Similarly, assigning the remaining properties. 
 

After all member properties have been assigned, the model will be as 
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below. 
 

Figure 2‐131: 

 
 
 
 

Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 
 

 

2.6.4 Specifying geometric constants 
 

 
 

In the absence of any explicit instruction, STAAD guide the beams and columns of the structure 
of a default. Orientation refers to the direction that the width and depth of the cross section is 
aligned with respect to the global axis system. The rules that dictate this default orientation are 
explained in section 1 of the STAAD.Pro Technical Reference Manual. 

 

We wish guiding member 4 so that their longer edges (local Y axis parallel to sides) are parallel to 
the global Z axis. This requires applying a beta angle of 90 degrees. The command has to be 
generated is: 

 
 
 

BETA 90 MEMB 4 
 
 
 

Steps: 

1. Select the tab Beta Angle in the dialog box Properties. 

2. Click on Create Beta Angle. 
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3. In the dialogue box Angle Beta, specify the angle in degrees 90. 

 
Figure 2‐132: 

 

 
 
 

4. Highlight the expression Beta 90 in the dialog box Properties. 

5. Then select member 4 using the tool Beams Cursor . 

Note that we select the member, the allocation method to automatically set assigned to 
the selected beams. 

 

6. Click on Assign. Click anywhere in the drawing area to an enhanced member. 

 
(An alternative method for allocating beta angles is as follows. First select the member for which you 
want to assign the beta angle. Then select Commands> Geometric Constants> Beta Angle. 
Specifies the angle in degrees 90, ensure that the allocation method is "A selection"And click OK.) 

 

Figure 2 36 
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Check the orientation of the local axes of selecting members View> Structure diagrams> 

Labels and select the option for orientation of the beam. 
 

 
figure 2‐133: 

 

 
 

Figure 2‐134: 
 

 
 

 
 

2.6.5 Specifying the material constants 
 

 
When assigning member properties, we deliberately choose not to assign the same material 
constants as we wanted to specify values that are different from the default built. The desired 
values are listed at the beginning of this tutorial. The appropriate commands we want to generate 
in the STAAD input file are: 

 
CONSTANTS 

E  22  ALL 

UNIT METER 



STAAD.Pro V8i MANUAL

119

 

 

 
 

DENSITY 25.0 ALL 
 

POISSON 0.17 ALL 
 
 
 
 

Procedure: 

1. Select Commands> Material Constants> Elasticity .... 

2. In the dialog Material Constant that appears, enter 22 in Table Enter Value. 
Since the value has to be assigned to all members of the structure, the current configuration 
of the allocation method, ie, To ViewAllows us to accomplish this easily. Then click on OK. 

Figure 2‐135: 
 

 
 

3. To specify the constant density, it will be convenient if we change our units of length in meters. To 

change the units of length, as before, select the tool input Units     the structure toolbar, or 
select the menu option Tools> Set Current Input Unit unit of the menu bar 
top. In the current set input units dialog that appears, specify the units of length and 
meter. 

Figure 2‐136: 
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4. We follow steps 1 and 2 above, we choose Commands> Material Constants> Density, 
specify the value as 25 kN / m 3 and assign to the view. 

5. To define the Poisson's ratio, Using a similar procedure as described above, providing the value 0.17 
all members of sight. 

 
 
 
 
 
 
 

2.6.6 Specifying Mounting 
 

The basis of all columns nodes are restrained against translation and rotation of the 3 global 
axes (see section 2.2). In other words, fixed supports (wardrobes) must be specified in those 
nodes. The commands generated are: 

 
SUPPORTS 

 

1  4  5  FIXED 
 

Procedure: 
 

1. Select the tool Support Page located on the toolbar of the structure as shown 
below. 

Figure 2‐137: 
 

 
 

Or select the tab General | Support from the left side of the screen 

Figure 2‐138: 
 

 

 
 

 
The media dialog opens. 
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figure 2‐139: 
 

 
 

2. Since we know that the nodes 1, 4 and 5 must be associated with the fixed support, 

using the Nodes Cursor . Select these nodes. 

3. Click create. Open dialog box build support. 
 

 
Figure 2‐140: 
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4. Select the tab Fixed and click Assign. 

After the supports have been assigned, the structure will look as shown below. 
 

Figure 2‐141: 
 

 
 

5. Click anywhere in the drawing area to deselect all selected nodes s and avoid accidentally 
assigning unwanted data to nodes. The pulse anywhere in the drawing area to deselect all 
selected nodes and avoid accidental data allowance unwanted nodes. 

 

 
 

Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 

 

2.6.7 Specifying Loads 
 

The five load cases need to be created for this structure. Earlier in this tutorial details of 
individual cases are explained. 

 
Then the corresponding commands generated are listed. Note that cases 4 and 5 are to be built not 
like the type of standard combination, but using a combination of load type called REPEAT LOAD 
(Repetitive) load. The instructions at the beginning 
This tutorial require us to analyze this structure using a type of analysis called PDELTA. Analysis 
PDELTA It is a type of nonlinear analysis. In STAAD, states also account for the effects of the 
simultaneous PDELTA action horizontal and vertical loads 
predefined; previous cases should be included as components of the combo box using the exchange 
REPEAT LOAD. 
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KG METER UNIT 

DEAD LOAD 1 LOAD 

SELFWEIGHT ‐1 MEMBER 

AND LOAD 

May  2  UNI  GY  ‐

400  MEMBER  LOAD 

LOAD LOAD 2 Live 

May  2  UNI  GY  ‐

600 3 WIND LOAD 

LOAD LOAD MEMBER 

1 UNI GX 300 
 

4 UNI GX 500 
 

LOAD  4  DEAD  +  LIVE 

REPEAT LOAD 

1 1.2 2 1.5 
 

LOAD  5  DEAD  +

  REPEAT LOAD WIND 

1 1.1 3 1.3 
 

 
 

LOAD CASE 1 
 

STAAD has a limitation in that you can not change the unit load cases while editing. An error 
message appears if you try. 

 

Before creating load cases, we have to change the unit of kilogram. See "2.6.2 Changing the units of 
the input length" on page 107 for related information on the required steps. 

(At the beginning of this tutorial load values appear in units kg and subway. Instead of converting 
these values in the current input units, conform to those units. The current input units, while finally establish specify 
the density, are KN and METER). 

 

1. To create loads, select the tool or Load Page located on the toolbar Structure Tools. 
 

figure 2‐142: 
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Or select the General | Load General | Page Load from the left side of the screen. 

Figure 2‐143: 
 

 
 

Definition dialog box & load on the right side of the program window opens. 
 

2. To start the first load case, select the section Load Case Details in the list and click add. 

Figure 2‐144: 
 

 
 

The Open dialog box Add New Load Cases (Add new load cases). 
 

3. Select loading type if you want to associate the load case with any of the definitions of 
ACI, AISC or IBC dead load, live, ice, etc. This type of partnership should be done if you 
intend to use the facility for automatic program generation load combinations in accordance 
with the codes. 
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Note that there is a checkbox labeled Reducible per UBC / IBC (Reducible by UBC 
/ IBC). This feature becomes active only when the load case is assigned a load type 
called Live at the time of creation of that case. 

 
As we do not intend to use the option of automatic generation of load combination, we will 
leave the loading type how come None. Write DEAD LOAD as the title for If load 1 
and click add. 

Figure 2‐145: 
 

 
 

The newly created load case appears under the option Load Cases Details (Load case data). 

Figure 2‐146: 
 

 
 

4. To generate and assign the type of selfweight load (own weight), first select 1: DEAD LOAD. 
You will notice that the dialog Add new items loading now shows more options. 

Figure 2‐147: 
 

 
 

5. Specify the address as Y, and Factor as ‐1.0. A negative number means that the load acts against 
the positive direction of the overall axis (Y in this case) over which it is applied. Click the button Add. The 
load selfweight applies to all 
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members of the structure and can not be applied to a selected list of members. 
 

Figure 2‐148: 
 

 
 

6. Load 1 contains a component of additional load, loads on the members of 2 and 
5 To create the load member, first select 1: Dead Load button followed AddThen .... click Article 
Member Load in the dialog box Add new items loading. 

Figure 2‐149: 
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7. Select the option Uniform Load and specify GY as Street address and‐400 as force. 
For these members, because the local Y axis coincides with the axis Y global, you can choose the direction of the 
load as "Y" or "GY" both have the same effect. 

(You can see the orientation of the local axes members to go to View> Structure 

Diagrams> Labels> Beam Orientation.) A negative value means that the load acts 
in the negative direction of GY. Click add and then shut down. 

 
 

8. The burden of the member who just created should be assigned to the members of 2 and 
5. 

Select the input UNI GY‐400 kg / m in the dialog box Load & Definitions. 
Figure 2‐150: 

 

 
 
 

9. Then select members 2 and 5 with the tool Beams Cursor . 
See 'frequently performed tasks' section at the end of this manual for 
learn more about the selection of members). 

 

 
Then, select Assign to Selected Beams and then Assign. 

 
Figure 2‐151: 

 

 
 
 

As you click on the button AssignThe following dialog box appears. This message box appears only 
wish to confirm that indeed the case load associated with the selected beams. Click Yes I do. 

 

 
Figure 2‐152: 
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After the load has been assigned, the structure will look as shown below: 
 
 

Figure 2‐153: 
 

 
 

 
LOAD CASE 2 

 
1. The next step is to start charging the second case containing a load over the element. Select 

details of the case load and click add. Again, the dialog box opens Add new load cases. 

Figure 2‐154: 
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In this dialog box, once again, we are not we associating the load case, we are about to create 
with any load code base and so leave that box as None. Specify the title of the second load case as 
Live Load (Live load) and click add. 

Figure 2‐155: 
 

 
 

2. To create the load member, point 2: Live Load. 

Figure 2‐156: 
 

 
 

3. Follow steps 6-9 of the previous task to create and assign a uniformly distributed force ‐
600 Kg / m 2 and 5. 

 

After loading the second case has been assigned, the structure will look as shown below: 
 

Figure 2‐157: 
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Click anywhere in the drawing area to an enhanced members. 
 

 

CASE LOAD 3 
 

1. The third load case, which has loads members again, the creation involves the same procedure as 
in the case of load 2 As before, first select Load Case Details in the Load dialog box to 
start charging the third case. Type Wind Load (Wind load) as the title for the case of load 3. 

 
2. To apply the load to the member 1, follow similar procedure as in steps 6 to 9 The only 

differences are, member 1 is the recipient of this burden, Street address is GX and the force 
is +300 Kg / m. 

3. Also, for the member 4 and the third load case, specify the force 500 Kg / m and direction 
as GX. 

After charging the third case has been assigned, the structure will look as shown below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
CASE LOAD 4 

 

Figure 2‐158: 

 
 

1. Now we come to the point where we have to create the load case 4 and (1.2 x Load 1) 
(1.5 x Load 2). We saw earlier in this section should be creating a type of "Repeat Load" of the 
combination and not the kind of "Load Combination". To start the load case 4, select Load 
Case Details in the dialog box and load 
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specify the title as DEAD + LIVE. 

2. Then click on 4: DEAD + LIVE in the dialog box definitions & loads as shown below. 

 
Figure 2‐159: 

 

 
 

3. In the dialog box Add new items loadingSelect the option Repeat Load. Then select load case 
1 (dead load), click [>] and enter the Factor how come 1.2. (This indicates that the data values of one case 
cargo load 
are multiplied by a factor of 1.2, and the resulting values are used in load case 4) 

 
4. Similarly, select box load 2 (live load), click the [>] button and enter the factor as 1.5. You will 

now see the dialog Add new items loading as shown below. Click the button Add. 

Figure 2‐160: 
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No additional operation is needed for load case 4 recipients (members) loads in load case 
4 are automatically chosen to be the same that were assigned components REPEAT LOAD 
cases (repetition of load-loads 1 and 2). 

 

The structure will now similar to the one shown below. 
 

 
 

Figure 2‐161: 
 

 
 

 
 
 
 

CASE LOAD 5 
 

1. Since cases 4 and 5 are nearly identical in nature, the same procedure used in building load 
hypothesis 4 is also applicable for the case 5 Let us select Load Case Details  in the 
dialog box to start the load 

fifth load case. Enter Dead + Wind as the title for the load case 5. 
 

2. Follow steps 16-19 except for associate a factor of 1.1 for the first case and load factor 1.3 with 
the third load case. Follow steps 16-19 except associates a factor 1.1 if the first load and a factor 
1.3 with the third load case. 

 

 
You will now see the dialog Add new items loading as shown below. Click the button Add 
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Figure 2‐162: 
 

 
 

We've finished creating all load cases, we can now click shut down. 

The structure will now similar to the one shown below. 
 

Figure 2‐163: 
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Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 

 
 

2.6.8 Specifying the type of analysis 
 

The analysis of this type of structure is called PDELTA. Since this problem involves concrete 
beam and column design by the ACI code, the second-order analysis is required and must be 
made in the factored loads acting simultaneously. The factored loads previously created as cases 
4 and 5 Now it's time to specify the type of analysis. 

 

 
The command for a PDELTA analysis appear in the STAAD file as: 

 
ANALYSIS PDELTA 

 
Procedure 

1. Select Analysis / Print | Analysis on the left side of the screen. 

 
Figure 2‐164: 
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Dialog box opens Analysis / Print Commands. 

Figure 2‐165: 
 

 
 

2. Select the tab PDELTA Analysis. 

 
3. Click on Add and then Close. 

 
Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 

 
 
 

2.6.9 Preselection of load cases to be used in the design of concrete 
 

The design of concrete shall be carried out for load cases 4 and 5 only because those are only 
the cases factored. To tell the program to use these cases and ignore the rest, we have to use the 
LOAD LIST command. 

 
 

The command appears in the STAAD file as: 

 
LOAD LIST May 4 
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Procedure: 

1. Select Commands> Loading> Load List. The List Open dialog load. 
Figure 2‐166: 

 

 
 
 

2. Press the key CTRL to select cases of load 4 (DEAD + LIVE) and 5 (DEAD + WIND). 
 

3. Click [>]. Load cases 4 and 5 will be selected and placed in the cargo box selection list. 
 

4. Click on OK. 
 
 
 

2.6.10 Specifying particular design parameters 
 

Among the various terms in the equations for the design of concrete beams and columns, some 
of these can be directly specified; such as the degree of concrete or the maximum size of the 
rebar that may wish to use. Such terms are called specific design parameters. For the ACI code, 
a list of these parameters is available in Section 3 of the Technical Manual STAAD.Pro. The 
parameters that we want to use and the associated command should appear in the STAAD input 
file are: 

 
 

NEWTON MMS ACI 

CODE UNIT 

CLT 25 ALL 
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CLB 30 ALL 
 

CLS 25 ALL 
 

FC 25 ALL 
 

FYMAIN 415 ALL 
 

TRACK 1 ALL 
 

 
 

Procedure 
 

1. Define the units of force as Newton and the units of length and mm. See "2.6.2 Changing 
the units of the input length" on page 107 for details. 

 
2. Select the tab Design | Concrete from the left side of the screen and select ACI as the 

current code in the dialog Concrete design. 
 

 
 

Figure 2‐167: 
 

 
 
 

 
3. Click define parameters in the dialog concrete design. 

It opens dialogue Design Parameters. 
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Figure 2‐168: 
 

 
 
 

4. Select the parameter CLT (Clear Cover for Top- topcoat reinforcement). 
Then, provide the value as 25mm and click add. 

 

5. Repeat step 4 to set the remaining parameters to the following values: 
 
 
 
 

Parameter Value 
Clb 30
Cls 2
Fc 2
Fymain 415
Track 1.0

 
 
 

When all the above parameters have been assigned, click Close in the dialog box design 
parameters. 

 

After that all design parameters have been assigned, the dialog Concrete design will be as shown 
below. 
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Figure 2‐169: 
 

 
 
 
 

The next step is to assign these parameters to all members of our model. The easiest way is to 
use the method of assigning to the view: 

 
1. Stresses the parameter in the Concrete Design | Whole Structure to be assigned to 

model elements. 

2. Select the option Assign to View. 
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3. Click on Assign. 

 
Figure 2‐170: 

 

 
 

 
Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 

 
 
 
 

2.6.11 Specifying design commands 
 

 
Commands design are the actual instructions for the design of beams and columns. We intend to 
design beams 2 and 5 and columns 1, 3 and 4 commands generated are: Design commands are 
the actual instructions for the design of beams and columns. We intend to design beams columns 
1, 3 and 4 and 5 and 2 commands generated are: 

 
DESIGN BEAM May 2 

 

COLUMN DESIGN 1 March 4 
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Procedure: 
 

1. The design commands are generated through the dialog boxes available under the button 
Commands in the dialog box Concrete Design. So, we click Commands as shown 
below. 

Figure 2‐171: 
 

 
 

2. In the dialog box Design Commands that appears, select the option Beam Design 

and click add. 
 

 
Figure 2‐172: 
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3. We need to add a command for column layout. Then, select the Column Design and 
click to add. 

4. Click on Close. 

The next step is to associate the layout command beam members 2 and 5 and the design command 
column members 1, 3 and 4. 

1. Select the design and then the beam members 2 and 5 with the tool Beams Cursor . 
2. Click on Assign to Selected Beams and then in Assign. 

Figure 2‐173: 
 

 
 

As we click assign, The following dialog box appears. This message box appears only to 
confirm that indeed we associate the design of the beams of the selected command. Click 
Yes. 

Figure 2‐174: 
 

 
 

3. Repeat steps 1 and 2 to assign the command column design members 1, 3 and 4 
 

Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 

 
 

2.7 Visualizing the archive command input 
 

 
 

Now take a look at the data that has been written to the file you saved above. 

1. To view the contents of the file, select the tool STAAD Editor 
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Figure 2 82 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Or select Edit> Edit Input Command File. STAAD Editor window opens. 

Figure 2‐175: 
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Changes to the data can be made in this window and saved. 

2. Select File> Exit to close the Editor window. 
 

As we saw in Section 2.1, we could also have created the same model relevant STAAD typing 
commands into a text file using the STAAD editor, or any external editor of your choice. To 
understand this method, proceed to the next section. If you want to skip that part, proceed to 
Section 2.9 where we perform the analysis and design of this model. 

 

 

2.8 Creating the model using the file command 
 

Now we use the method of file command to create the model for the above structure. The 
commands used in the script are described later in this section. 

 
The STAAD.Pro command file can be created using the built-in editor, the procedure explained 
below in this section. Any text editor such as Notepad or WordPad can also be used to create 
the command file. However, the Editor STAAD.Pro command file syntax has the advantage as 
we write commands. The keywords, numeric data, etc. are shown in different colors in the 
STAAD.Pro Editor. Below is a typical screen editor is shown to illustrate the general appearance. 

Figure 2‐176: 
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To access the built-in editor, start the program using the procedure explained in Section 2.2. Then 
follow step 1 of section 2.4. 

Figure 2‐177: 
 

 
 

Then you will find the dialog box shown below. In this dialog box, choose Open STAAD 
Editor. 

 

Figure 2‐178: 
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Editor screen opens as shown below. 

 
Figure 2‐179: 

 

 
 

Deletes all lines of command in the editor window and the lines shown in bold below (do 
not have to delete the lines if you know what and where to keep the rest of the commands). 
The commands can be written in lowercase or uppercase. Usually all that is needed are the 
first three letters of a keyword, the rest of the Letters of the word are not necessary. The 
letters are underlined necessary. ("SPACE" = "SPA" = "space" = "spa") 

 

 
Current entry points is shown in bold, followed by the explanation. 

 
STAAD SPACE RC FRAMED STRUCTURE 

 
 

Each entry must begin with the word STAAD. SPACE word means that the structure is a 
structure of space (three-dimensional) and the geometry defined by X, Y and Z coordinates. 

 
UNIT METKN ER 

 
 
 

Specifies the unit to use. 

 
JOINT COORDINATES 

 

1 0 0 0; 2 0 3.5 0; March 6 3.5 0 
 

4 6 0 0; 5 6 0 6; June 6 3.5 6 
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Node number followed by the X, Y and Z are shown. Signs semicolon (;) are used as line 
separators. It allows us to offer multiple data sets in a single line. 

 
MEMBER INCIDENCES 

 

1 1 2; 2 2 3; 3 3 4 
 

4 5 6; 5 6 3 
 

 
 

Defines members are connected to the joints. 

 
UNIT MMSKN 

 

MEMBER PROAME PERTYRICAN 
 

1 4 PRIS YD 300 ZD 275 
 

2 5 PRIS YD 350 ZD 275 
 

3 PRIS YD 350 
 
 
 

The member properties defined above by the prismatic attribute to YD (D) and ZD (w) values 
are provided in MM unit. When have YD and ZD, STAAD considers the rectangular section. 
When one specified YD, the section is considered to be circular. Details are available in Section 
5 of the Technical Manual STAAD.Pro V8i. 

 
WITHStants 

 

E22 MEMB 1 TO 5 
 
 
 

The material constant E (modulus of elasticity) is specified as 22KN / sq.mm command 
followed CONSTANTS. 

 
UNIT  METER  KN 

WITHStants 

DEN25.0 SITY ALL 

POISSON 0.17 ALL 

 
 

The unit of length is changed to METER MMS to facilitate entry of the density. Next, the 
Poisson ratio is specified. 

 
BETA 90 MEMB 4 

 
 

In the absence of any explicit instruction, STAAD guide the beams and columns of the 
structure in a predefined manner (see section 1 of the Technical Manual for more 
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information.) To guide the member 4 so that its longer edges (parallel to local Y axis sides) 
are parallel to the global Z axis, we have to apply a 90 degree angle beta. 

SUPPORT 
 

1 4  5  FIXED 
 
 
 

Nodes 1, 4 and 5 are defined as recessed support. 

 
UNIT  METER  Kg 

LOADEAD LOAD D1 

 
Force units are changed to KG KN to facilitate entry of loads. The load case 1 begins with an 
accompanying title. 

 

 
SELFWEIGHT Y ‐1 

 
 
 

One component of the load case 1 is the weight of the structure acting on the overall direction 
by a factor of -1.0. Since Y is overall vertically upward, the factor of -1.0 indicates that the load 
will act downward. 

 
MEMBER LOAD 

 

2 5 UNIGY ‐400 
 
 
 

Load 1 contains member loads too. GY indicates that the burden is on the overall direction Y. 
The word means uni UNI loadformly distributed. Loads are applied in the Member 2 and 5. 

 
LOAD2 LIVE LOAD 

 
 
 

The load case 2 starts along with a companion title. 

 
MEMBER LOAD 

 

May 2 UNIGY ‐600 
 
 
 

Charge 2 also contains loads of members. GY indicates that the burden is on the overall direction. 
The word UNI stands for uniformly distributed load. Loads are applied in the Member 2 and 5. 

 
LOAD3 WIND LOAD 

 
 

The load case 3 starts along with a companion title. 
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MEMBER 

LOAD1 UNIGX 

300 

4 UNIGX 500 
 

Charge 3 members also contains fillers. GX indicates load in the X direction is global. The word 
UNI is meant to evenly distributed load. Loads are applied to members 1 and 4. 

 
LOAD 4  DEAD + LIVE 

 
 
 

The load case 4 starts along with a companion title. 
 
 
 

REPEAT LOAD 

1 1.2 2 1.5 

 
When loading 4 illustrates the technique used to Staad instruct to create a case consisting of 
charging data to be assembled from other load cases specified above. We are instructing the 
program to examine the structure loads of cases 1 and 2 acting simultaneously. The data values 
of load load case 1 multiplied by 

factor 1.2, And the resulting values are used in the case of load 4 also values 
Data load load case 2 are multiplied by a factor of 1.5, And the values 
resulting are also used in case of load 4. 

 
LOAD 5 DEAD + WIND 

 
 
 

The load case 5 starts with an accompanying title. 
 
 
 

REPEAT LOAD 

1 1.1 3 1.3 

 

 

We are instructing the program to examine the structure loads of cases 1 and 3 acting 
simultaneously. 

 

 
PDELTA ANALYSIS 

 
 
 

The command is an instruction PDELTA analysis program to execute a second-order 
analysis and account for P-delta effects. 

 
LOAD LIST May 4 

 

The previous LOAD LIST command is a way of affirming that all calculations should be based 
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results of load cases 4 and 5 only. The intention is to restrict concrete design calculations for 
load cases 4 and 5 only. 

 

 
 

START  WITHCRETE  DESIGN 

CODE ACI 

 

UNIT  MMSNEWTON 

CLT 25 ALL 

CLB 30 ALL 
 

CLS 25 ALL 
 

FC 25 ALL 
 

FYMAIN 415 ALL 
 

TRACK 1 ALL 
 
 
 
 

The first thing is to align the command that starts the operation of concrete design. The values 
for the design parameters of the concrete defined in the above commands. The design is made 
according to the ACI code. Length units are switched from the meter to MMS to facilitate entry 
of the design parameters. Similarly, the units of force to change KG NEWTON. The TRACK 
value determines the scope of the information related to the project to be produced by the 
program at the start. The parameters specified include CLT (Clear cover for top surface - superior 
surface coverage), CLB (Clear cover for bottom surface - bottom cover), CLS (Clear cover for 
sides - side cover), FC (Strength of concrete - Effort to Concrete Compressive Strength at 28 
days), and FYMAIN (Ultimate strength of steel - ultimate strength of reinforcing steel). These 
parameters are described in Section 3 of the Technical Manual. 

 
DESIGN BEAM May 2 

 

DESIGN AUUMN 1 April 3 
 
 
 

The above commands indicate a program to design the beams 2 and 5 for bending, shear and 
torsion, and design the columns 1, 3 and 4 for axial and biaxial flexure. 

 
ENDCONCRETE DESIGN 

 
 
 

This command terminates the operation of concrete design. 

 
EndISH 

 
 

This command terminates the STAAD run. Let's save the file and exit the editor. 
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2.9 Performing analysis and design 
 

 
STAAD.Pro performs analysis and design simultaneously. In order to perform analysis and design, 
select Run Analysis (Perform analysis) on the menu Analyze. 

 

Figure 2‐180: 
 

 
 

Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 

As the analysis progresses, several messages appear on the screen as shown in the following 
figure. 

 

Figure 2‐181: 
 

 
 

Note that we can choose from the three options available in the dialog box above: 

Figure 2‐182: 
 

 
 

These options are indicative of what will happen after we click the button Done. 
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Option View Output File allows us to see the output file created by STAAD. The output file 
contains the numerical results produced in response to different input commands that were 
specified during model generation. It also tells us if errors are found, if the analysis and design 
was completed successfully or not. Section 2.10 provides additional details on viewing and 
understanding the contents of the output file. 

Option Go to Post Processing Mode lets go to the graphic part of the program known as the 
postprocessor. This is where one can exhaustively verify the results, see the results graphically, draw 
diagrams of results, produce reports, etc. Section 2.11 explains how post-processing in detail. 

Stay in Modelling Mode allows us to continue in the mode of generation of the program model 
(in which they are present) in case we want to make more changes in our model. 

 
 

2.10 Viewing the output file 
 

 
 

During the analysis process, STAAD.Pro creates an output file. This file contains important 
information about whether the analysis was successful. For example, if STAAD.Pro encounters an 
instability problem during the analysis process will be reported in the output file. 

 
We can access the output file using the method explained at the end of the previous section. 
Alternatively, you can select the option File> View> Output File> STAAD Output the top 

menu or go directly to the command STAAD Output    placing in the 
toolbar. The output file for the problem we have encountered is shown in the following pages. 

Figure 2‐183: 
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The output file is displayed through a file viewer called SproView. This display lets you set the text 
font for the whole file and print the output file to a printer. Use the appropriate menu option Archive from the 
menu bar. 

 
Figure 2‐184: 

 

 
 
 
 

By default, the output file contains a list of all the input too. You can choose not to print the echo 
of the commands into the output file. Select Commands> Miscellaneous> September 

Echo from the menu bar and select the 

button Echo 

Off. 
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It is very important that we sail across the output file and ensure that the results seem 
reasonable, no error messages or warnings reported, etc. Errors found during the analysis & 
design can disable access to post-processing mode - graphical displays which can graphically 
display the results. The information presented in the output file is a crucial indicator of whether 
or not the structure meets the requirements of engineering safety and ease of maintenance. 
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2.11 Post-Processing 
 

 
 

STAAD.Pro provides ample facilities for verification and visualization of results. These facilities are 
accessible from the post-processing mode. The post-processing mode is used to check the results of 
analysis and design and generate reports. 

 

For this tutorial, we must perform the following tasks: 
 
 

2.11.1 Go to the post-processing mode 
 

At the end of section 2.9, we saw how one could go directly from the analysis window to 
the screen postprocessing. However, you can access the post-processing mode using the 
following procedure at any time. 

 

Procedure: 
 

1. Select Tool Post‐Processing orMode> Post Processing. Table Settings dialog opens results. 
 

Figure 1.95 

 
 

Figure 2‐185: 
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2. Select the load cases for which to display the results. For this tutorial, click [>] to select 
all load cases and click OK. 

 

 

2.11.2 Viewing the chart deflections 
 

The screen will now look like the figure shown below. 

Figure 2‐186: 
 

 
 

The chart is currently on display diagram displaced nodes and elements for load case (DEAD 
LOAD) 1. 

 

To return to this particular scheme, select the page Node | Displacement along the page 
control area on the left side. 

Figure 2‐187: 
 

 
 

orResults> Deflection. 
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2.11.3 Switching between load cases for diagram deflection 
 

 
Steps: 

1. To change the load to that seen in the deviation diagram, select the desired loading wishlist 

active load 

Figure 2‐188: 
 

 
 
 
 

O 

Select the tool Symbols and Labels 
 

Figure 2 100 

 
 
 

O 

Select View> Structure Diagrams 
 

For the latter two options, the dialog box opens diagrams. 

 
2. Select the tab Loads and Results and choose the desired load case list box load case. 



STAAD.Pro V8i MANUAL

165

 

 

 
 

Figure 2‐189: 
 

 
 
 

3. Click on OK. 
 

The following figure shows the deflected shape of the structure in the case of load 3. 
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Figure 2‐190: 
 

 
 

4. To show deflection say, load case 5 (DEAD + WIND), repeat steps 1-3 and select load 
case 5. 

 

The deflection of the load case 5 will now be displayed in the model as shown in 
the following figure. 

 

Figure 2‐191: 
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2.11.4 Resize deflection diagram 
 

Steps: 

If the chart appears very imperceptible, it may be because you can draw a very small scale. To 
change the scale of the plot of the deviation, you can 

 
 
 

1. Select the tool Scale 
 

Or choose Scale from menu Results 

Figure 2‐192: 

 

 
 

Figure 2‐193: 
 

 
 

Or select View> Structure Diagrams> Scales. The dialog box opens diagrams 
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the tab stops. 
 

 
Figure 2‐194: 

 

 
 
 
 

 
 

2. In the field of Displacement (Displacement), specify a smaller number of what is currently 
on the list and click OK. 

 

The deflection diagram should now be larger. 

In the tab Scales in the dialog box DiagramsIf you set checkbox Apply ImmediatelyPressing 
the up or down buttons associated parameter will produce immediate results in terms of a larger retail or diagram 
(Preview). 
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Figure 2‐195: 
 

 
 
 
 
 
 

2.11.5 Annotation displacements 
 

L to Annotation is the process of viewing the offset values on the screen. 
 

 
Procedure: 

1. Select Results> View Value .... 

2. The following dialog box opens. From the Record RangesSelect all nodes (all nodes) 
 

Tip: If you want to annotate deflection few nodes, node numbers specified in the node list. 
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Figure 2‐196: 
 

 
 

1. Select the tab Node and set the option Resultant. 

Figure 2‐197: 
 

 
 
 

The result represents the square root of the sum of the squares of the 
values of X, Y and Z displacements. 
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2. Click on Annotate and then click Close. 

The deflection pattern structure is recorded for the load case 2 as in the figure below. 
 

Figure 2‐198: 
 

 
 
 
 
 
 

2.11.6 Changing the units in which the offset values are entered 
 

The units in which the values of displacement are shown in post-processing mode called 
display units. 

 

Procedure: 
 

1. Modifies the display units by selecting the tool Graphical Display Change Unit 
 

Figure 2‐199: 
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Or select Tools> Set Current Display Unit or selecting View> Options. The Options 
dialog box opens. 

 

 
Figure 2‐200: 

 

 
 
 

2. Select the tab Structure Units  and changing the dimensions of the displacement of 
mm toinches. 

3. Click on OK. The chart is updated to reflect the new units. 
 

Figure 2 116 
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2.11.7 Sliding Table node 
 

As we enter the post-processing mode, then the first screen that we are shown. 
 

Figure 2‐201: 
 

 
 

 
 

For page Node> Displacement on the left side, note that there are two tables appears along 
the right side. The upper table Displacements called Node table (table node displacement) lists 
offset values from each node for each selected load case. The load cases can be selected or de-
selected in 

purpose of this table from the menu Results> Select Load Case. (See 2/11/16 for 
details) The table below is called Beam relative displacement table (table of relative displacement 
of the beam). 

If you happen to any of these tables is closed, you can restore from the menu View> Tables. 
 

Figure 2 118 
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The window table nodal displacements has two tabs: All andSummary (See figure below). 

Figure 2‐202: 
 
 
 
 
 
 
 
 

All 
 

This tab displays all the nodal displacements in tabular form for all load cases and 
degrees of freedom. 

 
Figure 2‐203: 

 

 
 

Summary 
 

This tab, shown in the figure below presents the maximum and minimum nodal 
displacement (translation and rotation) for each degree of freedom. All nodes and load 
cases specified during configuration of results are considered. The maximum values 
are presented for all degrees of freedom with the corresponding node of occurrence 
and number of load case (L / C). 

Figure 2‐204: 
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Table for relative displacement of the beam, the details are as follows: 

All 
 

The tab All presents the displacements of the members at the points of the intermediate 
section. All specified members and all cases include the specified load. The table shows 
the displacements along the local axes of the members and their resultant. 

Max Displacements 
 

The tab Max Displacements presents the summary sectional maximum displacement 
(see figure). This table includes the values of maximum displacement and location of their 
occurrence along the member, for all specified members and all specified load cases. The 
table also provides the ratio of the span length of the maximum resultant displacement 
member to member section. 

Figure 2‐205: 
 

 
 

Subpages in the page Node described below in brief. 
 

 

Page Sub-Page Purpose 
Node Displacement Displays the nodal displacements with tabular results for 

nodal displacements and displacement sectional beams. 

Reactions Shows the reactions of the supports in the drawing 
and in a tabular form.

Modes Modes shows the number of ways to form selected mode. 
The eigenvectors appear simultaneously in tabular form. This 
page appears only in case of dynamic analysis, response 
spectrum, time history, and modal calculations if requested. 

Time History Shows the time history graphs for analysis over time. This 
sub-page also appear only if the consolidation analysis were 
performed. 
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2.11.8 Viewing diagrams force / time 
 

Procedure: 
 

1. The easiest way to access the amenities to display diagrams of force / moment is from 
page Beam | Forces along the page control area on the left side of the screen. The 
bending moment will be marked by MZ 
fault, evidence of which can be in the form of icon Mz shown in the diagram below 
which it becomes active. 

 

Figure 2 123 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 2‐206: 
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2. The option to select the diagram of force / time from another facility is available too - the 
menu Results> Bending Moment - As shown below. 

 

Figure 2‐207: 
 

 
 
 

2.11.9 Switching between load cases for a diagram of force / 
moment 

 

 
Procedure: 

1. To change the load case for a diagram of force / time, you can click the list box called 
Active Load and choose the one you want. 

 

Figure 2‐208: 
 

 
 
 

Or select the tool Symbols and Labels or select View> Structure Diagrams. Dialog box 
opens diagrams. 
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Figure 2‐209: 

 
 
 

2. Select the tab Loads and Results and choose the second load case (LIVE LOAD) in the 
list box of the case load and check box Shear yy. 

3. Click on OK. 
 

 
The following diagram shows the shear forces for the load case 2. 

Figure 2‐210: 
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4. To show the diagram of bending moment to say, if load 4 (DEAD + LIVE), follow steps 
1-3 and select the load 4. 

 

The following diagram should appear in the drawing area: 

Figure 2‐211: 
 

 
 

 

2.11.10 Resize diagram force / moment 
 

Procedure: 

If the chart appears very imperceptible, it may be because it is drawn to a very small scale. To 
change the scale of the plot of the moment, you can: 

 

1. Select tool Scale or select Results> Scale 
 
 

 
 
 
 
 
 
 
 
 

Or selecting View> Structure Diagrams> Scales 
 

The Diagrams dialog opens on the tab stops. 
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Figure 2‐214: 
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2. In the field of BendingSpecify a smaller number of what is currently on the list and click OK. The 
moment diagram should now be larger. 

 
 
 

3. In the above dialog box, if the box set Apply ImmediatelyPressing the up or down arrows next 
to the number will produce immediate results in terms of a smaller or a larger diagram. 

Figure 2‐215: 
 

 

 
 
 

 
2.11.11 Changing the degree of freedom for the layout of the diagram 
of forces. 

 
 

The force and moment diagrams can be drawn by six degrees of freedom: Axial cutting-Y, 
Shear-Z, torsional moment and moment-Y-Z. 

 

1. Select View> Structure Diagrams> Loads and Results. 
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Figure 2‐216: 
 

 
 

 
Occupies associated with each degree of freedom shown box. The icons in the bar results 
can also be used to enable / disable certain degrees of freedom. 
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Figure 2‐217: 
 

 
 

 
 

For easy identification, each degree of freedom (DOF) has been assigned a different color. You can 
change the color of that d.o.f. clicking the color button with the shallow and make a new selection 
of the color palette. 

Figure 2‐218: 
 

 
 

The appearance of the diagram can also be set to one of three options: grid, fill and stroke by 
selecting the appropriate option in the dialog box shown above. 

Figure 2‐219: 
 

 
 

2.11.12 Scoring diagram force / moment 
 
 

Annotation is the process of displaying the values of force / moment on the screen. Procedure: 

1. Select Results> View Value. The annotation dialog box opens. 

2. Select the tab Ranges and select All. 
 

Tip: To record the forces and moments for a few members, specify the numbers of the beam in the list of 
the beam. 
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Figure 2‐220: 

 
 

 
 

3. Select the tab Beam Results, Tick Maximum bending results. 
Figure 2‐221: 

 

 
 

 
 

4. Click on Annotate and then Close. 
 

The maximum time, MZ, the values of load 5 are shown in the diagram bending structure, 
as shown in the following figure. 
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Figure 2‐222: 
 

 
 
 

2.11.13 Changing the units in which are recorded the 
moments / forces 

 
 

The units in which the values of force and moment in the post-processing mode appear are 
called the display units. 

 
Steps: 

 

1. Units can also be modified by selecting a tool Graphical Display Change Unit 
 

Figure 2‐223: 
 

 
 
 

Or selecting Tools> Set Current Display Unit or selecting View> Options. 
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The Options dialog box opens 
 

2. Select the tab Force Units. For bending moments change the unit of time of your current 
configuration kip‐ft. 

 

Figure 2‐224: 
 

 
 

3. Click on OK. 
 

The chart is updated to reflect the new units. 
 

Figure 2‐225: 
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2.11.14 Table of forces in beam 
 

 
When selecting the page Beam | Forces from the control area of the page on the left side, 
the screen shown below. 

 
Figure 2‐226: 

 

 
 
 
 
 
 

The axial forces and shear forces, bending moments and torsional all selected for all cases of 
load beams appear in a tabular selected along the right half of the screen form. The load cases 
can be selected or discounts 

selected for the purpose of this table from the menu Results> Select Load Case 
(See 11.2.16 for details) 

 

If you happen to any of these tables is closed, you can restore from the menu View> Tables. 
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Figure 2 149 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The table window Beam End Forces has three tabs: All, Summary andEnvelope. 

Figure 2‐227: 

 
 

 
 

All 
 

This card has all the forces and moments corresponding to all six degrees of freedom at 
the beginning and end of each selected member for all selected load cases. 
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Figure 2‐228: 
 

 
 
 

Summary 
 

This tab, shown in the figure below shows the maximum and minimum values (forces and 
moments) for each degree of freedom. All beams and all specified loading cases are 
considered when setting results. The maximum values are presented for all degrees of 
freedom with the corresponding node of occurrence and number of load case (L / C). 

Figure 2‐229: 
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Envelope 
 

This tab displays a table consisting of the maximum and minimum for each degree of 
freedom for each member and responsible for each of these load values. 

 
 

Figure 2‐230: 
 

 
 
 

2.11.15 Viewing diagrams force / moment from page Beam> Graphs 
 

Page graphics  in the post‐processing mode  is used to graphically display moments and forces as 
Axial,zz bending,Shear yy andcombined stresses for individual members. 

 

1. Select Beam | Graph on the left side of the screen as shown below. 

Figure 2‐231: 
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The view window shows the load of the structure. On the right side of the screen 
diagrams force / moment appear (see figure below). 

2. Select a member in the main window and plotted graphs for members in the data area. 
The following figure shows the graphs for members 1 for the case of load 4. 

Figure 2‐232: 
 

 
 

The following figure shows the graphs for the same member 2 charging. 

Figure 2‐233: 
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3. Right Click on any of the diagrams force / time and select 
Diagrams ... the popup menu. 

Figure 2‐234: 
 

 
 
 

Open dialog box diagram. 

4. Set the check box to the degrees of freedom you want to see in the diagram. 
 

Figure 2‐235: 
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5. Click on OK . 
 

The selected degree of freedom is drawn in the window. 

 

2.11.16 Restricting the load cases for which the results are seen 
 

Steps: 
 

1. To restrict the load cases for which the results are viewed, select the tool Setup Results    or, 
go to the menu Results> Select Load Case as shown below. 

Figure 2‐236: 
 

 
 

2. In the dialog box Setup Results that appears first case de-seleccionanamos load and 
selected by clicking the [<<]. 

 

Figure 2‐237: 
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3. Hold down the 'Ctrl' key to select the load cases 1 (DEAD LOAD) and 3 (WIND LOAD). 
Click [>]. After the load cases have been selected, click OK. 

Figure 2‐238: 
 

 
 

 
 

2.11.17 Using the Query command members 
 

Member consultation (Member query) Is a facility where you can see several results for specific members 
simultaneously from a single dialog box. It is also a place where many of the attributes of the members as the definition 
of property specifications (release, armor, cable, etc.) and beta angle can be changed for purposes of entry. 

 

Procedure: 
 

To access this service, first select the member. Then, go to the menu Tools> Query> Member 
or double-click the member. Try to double-click Member 4. 

Figure 2‐239: 
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  As we double-click the member 4, the following dialog box opens. Take a look at the record 

Property. 
Figure 2‐240: 

 

 
 
 

In the figure above shows where the buttons on the box member consultation. If the member 
contains output result sheets (shear / flexion, deflection, steel design, etc.) in the query box, it 
will cause these chips results disappear by changing the attributes of members and released. 
This is due to the fact that the current output does not reflect the new entry. 

 

Note: If you assign or change property by clicking on the button Assign  / Change 
Property in the previous dialog box, make sure to keep the check mark on "Apply to this 
Member only" in the next dialog. Otherwise, changing the attributes of an individual member 
to later change the attributes of all the other members belonging to the same attribute list. For 
example, if the property of the current members are also assigned to other members, changing 
the property of the current member will change the property of all members. 
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We click on the tab Shear / Bending. The following dialog box appears. 
 

 
Figure 2‐241: 

 

 
 

 
The above page contains amenities for displaying the values of shear and moments, selecting 
the load cases for which the results are presented a slide bar (see figure below) to see the values 
at specific points along the limb length and a print option for printing screen elements. 
Experiment with these options to see what kind of results you can get. Take the slider with the 
mouse and move it to get the values in specific locations. 

Figure 2‐242: 
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Then another page (deflection) of the previous dialog box is displayed. 
Figure 2‐243: 

 

 
 

Then the page design concrete above dialog box is displayed. 

Figure 2‐244: 
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To see the results of another member of the use of this mechanism for consultation, simply close 
this dialogue box query and repeat the steps described earlier in this section for the desired 
member. 

 
2.11.18 Producing a report on screen 

 
Sometimes we find the need for results that conform to certain restrictions, such as, for example, 
resulting from node movements for a couple of selected nodes, for a few selected load cases, 
sorted in order of lowest to highest, with values reported in tabular form. The facility allows us 
to obtain these results as they appear on the screen is the menu Report in the top of the screen. 

Here, a report that includes a table with values greater time shaft member (MZ) sorted from 
high to low, for members 1 and 4 for all load cases created. 

 
Steps: 

 

1. Select the members 1 and 4 of the structure using the Beams Cursor 

OSelect> By List> Beams and type 1 and 4 as the numbers of members 

2. Select Report> Beam End Forces. 
 

Open dialog box beam end forces. 

Figure 2‐245: 
 

 
 

3. Select the tab Sorting (Classification). 

4. Select Moment‐Z as final forceEstablishes the Sorting Order toList from High to 

Low and set the checkbox Absolute Values low If done Sorting. 
 

TipIf you want to save this report for future use, select the tab ReportProvides a title for the report and 
sets the checkbox Save ID. 
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5. Select the tab Loading  and ensures that all the five load cases were selected. 

6. Click on OK. 

The leaderboard at the end of the member forces opens with MZ values sorted from 
highest to lowest based on absolute numbers. 

 
 

Figure 2‐246: 
 

 
 

 
 

7. To print this table, right click anywhere in this part of the table and select Print the 
popup menu. 

 

 
 

2.11.19 Taking photographs 
 

Several options are available to take pictures. The simplest of these is in the Edit menu is called 
Copy Picture. Transfer the contents of the active drawing window in the windows clipboard. Then we can go into any 
word processing program 
Image as Microsoft Word or Microsoft Paint and paste the image into the program for further 
processing. 

 

Another versatile option allows any "snapshot" or image of the drawing window in a report. It 
is called Take Picture and is under the menu Edit. Consider this feature. 

 

Steps: 

1. To take a picture, select the tool Take Picture or select Tools> Take Picture. 
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Picture box # dialog opens. 
Figure 2‐247: 

 

Figure 2 172 

 

 
 
 

2. Provides a title for the box so that you can be identified when generating a report. 
Click OK to save the image. 
This image is saved until we are ready to produce a personalized report of results. 

 

 
 

2.11.20 Creating Custom 
 

STAAD.Pro offers spacious facilities reporting. Articles that can be incorporated in the reports 
include information input numerical results steel design results, etc. One can choose from a select 
set of load cases, mode shapes, structural elements, etc ... We can include any "snapshot" or image 
of the 

screenshot taken using the icon toolbar Take Picture. Other parameters 
include configurable font size, title block, headers, footers, etc. 

1. Select the page Reports | Reports or tool Report Setup  . 
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Figure 2‐248: 

 
 

The Report Settings dialog box opens. 

 
Figure 2‐249: 

 

 
 

Different tabs of this dialog box offer different options. The Record Items  lists all 
available data that can be included in the report. Note that the elements in the list 
Selected are those that have been selected by 
default. 
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Items available are classified into seven categories: input,Output,Pictures, Reports, 
STAAD.etc output, Steel Design Output andAdvanced Query Reports. 

 

Figure 2‐250: 
 

 
 

2. In our report, you will include Job Information,Displacement Node Summary,Max Beam 

Moments, And Picture 1. 
 

Job Information is selected by default. 

In the box Available  list, select Output. Since the output elements available, select 
Displacement Node Summary andMax Beam Moments. 

 

Then select list boxes Available and select Picture 1. 
 

When all items have been selected, the dialog box 
Report Settings should appear as shown below. 

 

 
Figure 2‐251: 

 

 
 

The Report detail increases indicates the number of segments in which a member 
Printable divide sectional displacements, forces, etc. 
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3. Select the tab Load Cases  to select the load cases to be included in the report. Used 
options Grouping to group the data in the group node numbers / beam or load case 
number. 

 
In the first case, all the results of the load event appear below a certain node or beam. 
In the second case, results for all nodes or beams for a particular load case appear 
together. 

Figure 2‐252: 
 

 
 

4. Select the tab Picture Album  to visually identify previously taken photos. The following 
figure shows 1 photo stored by the program. 

Figure 2‐253: 
 

 
 

5. The Options tab allows you to include header, footer, page numbers, tables grids, Sources 
for column header anddata tableEtc. .. 
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6. The Record Name and Logo allows you to enter the company name and logo. 
Click the blank area and type the name and address of the company. Click Font in the 
group Text and adjust the font to be Arial Bold 16 Pt. Click the button right in the 
group Alignment align text to the right of the name of the 
compan
y. 

Figure 2‐254: 
 

 
 
 

7. Select OK to end or select Print to print the report. 
 
 

Tip: It is always a good idea first before printing the report. This is done by selection of the tool Print 
Preview (Print preview). 

 

 
Figure 2‐255: 

 

 
 
 

The first and last pages of the report are shown in the following two figures. 
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Figure 2‐256: 
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Figure 2‐257: 

 
 
 

This brings us to the end of this tutorial. Although we have covered a lot of topics, many more 
missing features to explore in STAAD.Pro. 
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Tutorial 3 - Analysis of a Slab 
 

This tutorial provides step-by-step modeling and analysis of a slab supported on two 
embedded edges. 

 

 
 
 

3.1 Model creation methods 
 

As explained in section 1.1 of the tutorial problem 1, there are two methods for creating the 
data structure: 

 
1. Using the graphical model generation mode or graphical user interface (GUI) (user 

GUI) that typically refers. 
 

2. Using the file command. 
 

Both methods to create the model explained in this tutorial. The graphical method is explained 
from section 3.2. The script method is explained in section 3.8. 

 

 

3.2 Problem description tutorial 
 

The structure of this project is a slab fixed along two edges. We are using 6 flat quadrilateral 
elements. The structure and the mathematical model are shown in the following figures. Is 
subjected to own weight loads and pressure loads temperature. Our goal is to create the model, 
assign all the required entries, perform analysis and review the results. 
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Basic Information of the 
structure 

Figure 2‐258: 

 

 
 

Attributes Data 

Item Properties Slab is 300mm thick 

Material Constants E, Density, Poisson, Alfa - specific default values 

Supports The nodes along the two edges are fixed as shown in Figure 3.2 

Primary Loads Charge 1: Dead Weight 
Charge 2: Pressure Load 300kg / m2. act vertically downwards load 
3: uniform expansion 75 degrees, plus 60 degrees upper surface is 

hotter than the bottom 

Combined Loads Case 101: Case 1 + Case 2 
Case 102: Case 1 + Case 3 

Type of Analysis Elastic-Linear 
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3.3 Starting the program 
 

1. Select the STAAD.Pro icon from the program group in the Windows Start menu or 
shortcut icon on the desktop (If you have one). 

 
The STAAD.Pro V8i window opens to the home screen 

Figure 2‐259: 
 

 
 
 

Note: See "1.3 starting the program" on page 19 for notes about changing the system default drive. 

 

3.4 Creating the new structure 
 
 

In the New dialog box, offer some initial critical data needed to build the model. 
 

1. Select File> New 
 

or 

select New Project low Project Tasks. 
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Opens the New dialog box. 

Figure 2‐260: 

 

Figure 2‐261: 
 

 
 

The structure type is defined as Space,Plane,Floor, Or Truss: 

Space 
 

The structure, charge, or both, cause the structure to deform in the three global axes 
(X, Y and Z). 
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Plan
e 

 

The geometry of the load and the deformation is limited only to the overall plane XY 
Floor 

 
A structure whose geometry is limited to the plane XZ. 

Trus
s 

 

The structure carries pure axial load action. Truss members deemed incapable of 
carrying shear, bending and torsion. 

 

2. Select Space. 

3. Select Meter as the unit length and Kilo Newton as the unit of force. 
 

Tip: The units can be changed later if necessary, at any stage of the creation model. 
 

4. Specify the file name as Plates Tutorial and specify a location where the STAAD 
input file will be located on your computer or network. 

 
Directly you can type a file path or click [...] to open the Search Folder dialog, which is 
used to select a location using a Windows file tree. 

After specifying the previous entry, click Next. 
 

The next wizard page, Where do you want to go ?, opens. 

Figure 2‐262: 
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5. Set Checkbox Add Plate. 

Figure 2‐263: 
 

 
 

In the dialog, we choose the tools that will be used to initially build the model. 
 

Add Beam, Plate Add, or Add Solid 
 

Respectively, the tools you selected for use in the construction of beams, plates or 
solids when the GUI is opened. 

 

Open Structure Wizard 
 

Provides access to a library of structural templates that comes equipped with the 
program. Those template models can be extracted and modified parametrically to 
reach the model geometry or some of its parts. 

Open STAAD Editor 
 

It is customary to create a language model using STAAD commands in the STAAD 
editor. 

 
 

All these options are also available from the menus and dialog interface, even after we 
discard this dialog. 

 
Note: To use the Editor to create the model, choose Open STAAD Editor, click Finish and proceed to 
Section 3.8. 

 
 

6. Click end. The dialog box will be dismissed and professional STAAD.Pro graphical environment is displayed. 
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3.5 Elements of the STAAD.Pro screen 
 

The main window STAAD.Pro is the main screen where the generation process model is performed. It 
is important to become familiar with the components of the window before embarking on the creation 
of the structure. Section 1.5 in the tutorial problem 1 of this manual explains the components of that 
window in detail. 

3.6 Building the STAAD.Pro model 
 

We are now ready to start building the model geometry. The steps and, when possible, the 
corresponding commands (instructions that are written in the STAAD input file) are described 
in the following sections. 

 

3.6.1 Generating the model geometry 
 

 
 

The geometry of the structure is composed of numbers together, coordinates, membership 
numbers, the connectivity information of the member element plate numbers, etc. .. From 
the point of view of the STAAD command file, the commands generate are: 

 

 
 
 

In this tutorial, we will explore 4 different methods to create the model in section 3.2: 
 

1. Using a mix of drawing an item and the ease of copy / paste. 
 

2. Using a mixture of drawing and ease element translational repetition. 
 

3. Through the comfort of the Geometry Structure Wizard menu. 
 

4. Using the mesh generation facilities of the main graphical display. 
 

Creating placas- Method 1 
 

Steps: 
 

Grid Settings 

1. Select the option add plate to permit anterior plates add 
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create the structure. This initiates a grid in the main drawing area as shown below. The 
directions of the global axes (X, Y and Z) are represented in the icon in the lower left corner 
of the drawing area. (Note that we could start this 
selecting grid Geometry> Snap / Grid Node> Plate also menu option.) 

Figure 2‐264: 
 

 
 

 
It is worth paying attention to the fact that when we choose the option of Add Plate in section 
3.4, the control page Geometry | Plate is automatically selected. 

 

Figure 2‐265: 
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2. Dialogue appears in the data area on the right side of the screen Snap Node / Beam. 
Click Create. A dialog box allows you to set a grid opens. 
Within this dialog box, there is a drop-down list from which you can select the linear, 
Radial or Irregular shape of the grid lines. 

 

Figure 2‐266: 
 

 
 
 
 

The Record Linear is intended for the placement of construction lines perpendicular to 
each other along a pattern of "left to right - top to bottom", as in the lines of a chessboard. 
The Record Radial allows lines 
construction appear in a web style that makes it easy to create circular type models where 
members are modeled as linear pieces to line segments. The Record Irregular can be 
used to create the grid lines with unequal spacing 
found in the overall design or an inclined plane. We will choose Linear is 

the default network. 
 

 
3. In our structure, the elements are in the X-Z plane. Thus, in this dialogue, let us choose X‐

Z as the plane of the net. The size of the model that can be removed at any time is controlled 
by the number of construction lines to 
left and right of the origin of the axes and the spacing between adjacent lines of 
construction. By setting 6as the number of lines to the right of the origin along the X, 4Z 
along and a distance of 1meters between lines along both X and Z 
(See figure below) we can draw a frame 6 m X 4 m, suitable for our model. 

 

Please note that these values are only an initial grid setting, to enable us to draw the 
structure, and do not restrict our overall model these limits. In fact, do not even need this 
grid of 6 m X 4 m. Here we are using the 
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method requires only a grid of 2 m X 2 m since we are about to take one single 
component. 

Figure 2‐267: 
 

 
 
 

After entering the specifications, provide a name and click OK. 
 

In this way, we can create any number of grids. By providing a name, each new grid can 
be identified for future reference. 

Note that these values are only starting grid setting, to enable us to draw the structure, 
and do not restrict our overall model these limits. 

 

4. In the dialog box Snap Node / PlateCheck the box of red 1 (linear). 
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Figure 2‐268: 
 

 
 

The newly defined network will be displayed. 

Figure 2‐269: 
 

 
 

Creation of element 1 
 

a. The four corners of the first element are the coordinates (0, 0, 0), (2, 0, 0), (2, 0, 2) and 
(0, 0, 2) respectively. Since the button Snap Node / Beam  it is active by default, 
using the mouse, click the origin (0, 0, 0) to create the first node. 

 

Figure 2‐270: 
 

 
 

b. Similarly, click on the remaining three points to create nodes and automatically join 
successive nodes of a plate. 

 

(2, 0, 0), (2, 0, 2) and (0, 0, 2) 
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The exact location of the mouse can be monitored in the status bar at the bottom of the 
window that continuously update the coordinates X, Y and Z of the current cursor 
position. 

 

 
 

When you have completed steps 1 and 2, the item is displayed in the drawing area as 
shown below. 

Figure 2‐271: 
 

 

c. At this point, we remove the display of the grid structure. To do this, click Close in the 
dialog box Snap Node / Plate. 

 

 
Figure 2‐272: 
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Now the grid and the structure of the main window should look like the figure shown 
below will be deleted. 

 

Figure 2‐273: 
 

 
 

d. It is very important that you save your work frequently to avoid losing data and protect 
our investment of time and effort against power outages, system problems or other 
unforeseen events. To save the file, pull 

down menu Archive and select the command Save. 
 

e. To facilitate identification, entities drawn on the display can be labeled. Let us see the numbers 
on the board. (See 'frequently performed tasks' section at the end of this manual to learn 
more about the change node labels / beams / plates). 

The following figure shows the plate number that appears in the structure. The structure 
of the main window should look like the figure shown below. 

 

Figure 2‐274: 
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If you're feeling adventurous, here's a little exercise for you. Change the font of the labels by 
selecting plate View> Options and then selecting the appropriate tab (label plate) of the 
Options dialog box. 

 
 

Creation of element 2 
 

a. Examining the structure shown in section 3.2 of this tutorial, we see that the remaining 
elements can be easily generated if the existing board could copy and then paste the 
copied unit at specific distances. The program has made 

ease of copying and pasting is below the menu Edit. 

First, select Plate 1 using the Plates Cursor  . 

b. Click the right mouse button and choose copy the pop-up menu (or select Edit> Copy). 
Again, click the right mouse button and select Paste Plates (Or select Edit> Paste Plates). 

 
c. From this place allows us to create a single copy at a time, all we can create from element 1 

is 2 component The four nodes are element 2 distance X = 2, Y = 0 and Z = 0 of the element 
1. Thus, in the dialog box that comes up, 

provide 2,0, And 0for X, Y and Z respectively and click OK. 
Figure 2‐275: 

 

 
 

The model will now look like the one shown below. 

Figure 2‐276: 
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Creation of element 3 

 

 
a. The nodes of the element 3 are X = 4m away from the element 1 Thus, we create the third 

element repeating steps 8-10 except X 4 m expected in the dialog Paste with Move. 
 

Alternatively, we could use an element 2 as the basis for item 3, in which case it will be 
the increased X 2m. If you make a mistake and end up hitting the item in a wrong 
location, you can undo the operation by selecting 

of Undo menu edition. 
After creating the third element, the model should it look like the one shown below 

 

Figure 2‐277: 
 

 
 
 

Click anywhere on the screen for the highlighted desrealzar plate. 
 

Creation of the elements 4, 5 and 6 
 

 
a. The elements 4, 5 and 6 are identical to the first three elements except that the nodes are at 

a distance of 2m Z distance elements corresponding nodes 1 through 3 therefore can use the 
technique of copy‐paste and Z specify increasing 

how come 2m 
Select the three existing boards doing a "rubber band" around them using the mouse. 

 
b. Right-click and select Copy the pop-up menu (or select Edit> Copy). Again, click the right 

mouse button and select Paste Plates (Or select Edit> Paste Plates). 

c. Enter 0,0, And 2for X, Y and Z respectively in the box Paste with Move that appears. 
Then click on OK and note that three new elements are created. 
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Since some elements still stand, tap anywhere on the drawing area for a desrealzado 
those elements. 

 

The model, with all six plaques generated will now be as shown below. 
Figure 2‐278: 

 

 
 

To continue with the rest of the data allocation, go to section 3.6.2. But if you want to 
explore the other methods of creating this model, the current structure will have to be 
removed completely. This can be done using the following procedure. 

 
1. Select Select> By All> By Geometry. The complete structure will be highlighted (in 

elements in red) 

2. Press the key DELETE. 
 

A message box appears to confirm deletion of the selected plates. 

Figure 2‐279: 
 

 
 

3. Click on OK 
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A message box opens indicating that you have created the solitary nodes; ie, disjoint, and 
confirm the deletion. 

 

4. Click on Yes. Now the complete structure is eliminated. 
 
 
 

Cr e d a tio n P la cas - M ét or d to 2 
 

Steps 
 

Creation of Element 1 
 

a. In this method, we use the command Translational Repeat STAAD to create our model. To 
use this service, we need at least one existing entity to use as a base for translational repetition. 
Then, follow the steps 1-7 of 'Method 1' to create the first element. Once this is done, our 
model will look like the one shown below. 

 
NoteIf you have problems to get the dialog box network settings, go to the menu geometry and select 
Snap / Grid Node Plate. 

 
Figure 2‐280: 

 

 
 

 
 

Creation of the elements 2 and 3 
 

a. In method 1, it required two separate executions of the copy / paste to create the elements 
2 and 3 That's because this facility does not contain a provision to specify the number of 
copies you would like to create. Translational Repetition is a command where that 
provision is available. 
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Select plate 1 using Plates Cursor  . (See 'frequently performed tasks' section at 
the end of this manual to learn more about selection of plates). 

b. Select the tool Translational Repeat 
 
 
 
 

Figure 3 31 
 

 
 
 
 
 
 
 
 
 
 

Or select Geometry> Translational Repeat. 

Open the dialog repeat 3D. By default (when the option Only Geometry is not selected), all 
loads, properties, design parameters, freed member, etc. on the selected features are 
automatically copied along with the entities. 

Making a new option Only GeometryThe replay will be made using translational 
only the geometry data. In our example, it does not matter because there are other 
attributes that have been assigned yet. 

c. To create the elements 2 and 3 in the X direction, specifies the Global address how come 
X,No of Steps how come 2and Default Step Spacing (Along X) as 2m. Option Link Steps 
applicable when the newly created units physically existing units are extracted, 

and when you want to connect to those using the members. Renumber Bay enables us 
use our own numbering scheme for the entities to be created, rather than using a sequential 
numbering if the program does no instructions provided. Let these boxes unchecked. Then 
click on OK. 

Figure 2‐281: 
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d. Since even the element 1 is highlighted click anywhere in the drawing area to 
desrealzarlo. 

 

 
The model will now look as shown below. 

 

Creation of the elements 4, 5 and 
6 

 

 
Figure 2‐282: 

 

 
 
 

a. Let us follow the same approach translational repetition to create these items. 
Select all three sombreándolas existing plaques using the mouse. Make sure before you do 

this, the cursor type is Course Platesr If not, will not be selected plates. 

b. Repeat steps 3 and 4, but this time, specify the address as Global Z,No of Steps how come 1and 
the default spacing as m step 2 Leave all boxes unchecked. Then do click OK. 

 

Now all 6 elements are created. 
 

Since some of the dishes stand out even click anywhere in the drawing area to desrealzarlos. 
 

Our model will now look like the one shown below. 

Figure 2‐283: 
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To continue with the rest of the data allocation, go to section 3.6.2. 
 

But if you want to explore the other methods of creating this model, the current structure will 
have to be removed completely. This can be done using the following procedure. 

1. Select > By All> By Geometry. The entire structure will be highlighted 

2. Press the key DELETE. 

Opens a message box to confirm the deletion of the selected plates. 

Figure 2‐284: 
 

 
 

3. Click on OK 
 

A message box opens indicating that orphans were created nodes and to confirm 
your deletion. 

4. Click on Yes. Now the entire structure is eliminated. 
 
 

 
Creating plates - Method 3 

 
Procedure 

 

There is a facility in STAAD called Structure Wizard that provides a library of predefined 
prototypes structures such as Pratt Truss Armor, Armor Northlight cylindrical frame, etc. .. A 
surface entity such as a slab or wall, which can be defined using elements with 3 or 4 nodes on 
the plate, is a prototype . We can also create our own library of prototype structure. 

 

 
From this wizard, a structural model can be generated parametrically and then can be incorporated 
into our structure. Structure Wizard can therefore be thought of as a store where you can find 
various components and assemble a structure 

complete. Even with Structure Wizard You can import models created from other packages 
software; eg AUTOCAD. 

 
 

1. Select Geometry> Structure Wizard Run. 
 

Opens the wizard to the structure as shown below. 
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Figure 2‐285: 
 

 
 
 
 

Note: The option Open Structure Wizard In the dialogue Where do you want to go? 

in the initial stage of creating a new dialogue structure - see Figure 3.9 - also brings this 
facility. 

 
2. It must be specified before the length unit of the generation of a model. Select File> Select 

Units  the wizard window structure. In the dialog box to select units that opens, select 
meters and click OK. 

 
 

Figure 3 40 
 

 
 
 

3. The box model type list, select Surface / Plate Models as shown below. 
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Figure 2‐286: 
 

 
 

 
4. Double-click the option Quad Plate or drag the option Quad Plate on the right side of 

the assistant structure as shown below. 
 

Figure 2‐287: 
 

 
 

5. A dialog box appears with the name of Select Meshing Parameters. In this box, specify, inter 
alia, two major pieces of information - a) size limit (or super element as it is commonly known) that the individual 
elements are generated b) the number of individual elements that must be generated. (A) is defined in terms of the 
X, Y, Z of the corners A, B, C and D. 
(B) is defined in terms of the number of divisions along the sides AB, BC, etc. .. 

Let us provide the Corners (Corners) Bias (Bias) and Divisions model as shown in 
the following figure. Then click Apply. 
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Figure 2‐288: 
 

 
 

TipIf you made a mistake and want the previous dialog box appears, right click in the drawing area and select 
Change Property (change of ownership) in the popup menu. 

 

 
Figure 2‐289: 

 

 
 

6. To transfer the model in the main window, select File>  Merge  Model  with 

STAAD.Pro Model or click on the command Transfer Model located on the toolbar 
of the window as shown below. 

  7. When the following message box appears, confirms the transfer by clicking the button 
"Yes". 

Figure 2‐290: 
 

 
 

The dialog box shown in the following figure appears. If we had an existing structure in 
the main window, in this dialog box, we will be able to provide the coordinates of a node 
in the structure in the main window you want to connect the piece being brought from 
the wizard. 

 

If there is no existing structure, this box is a way to specify any distances along the X, Y 
and Z by which we want the unit (to be brought from the wizard) to be displaced. 
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Figure 2‐291: 
 

 
 

8. In our case, since we have an existing structure in the main window, or want to 
change the unit for any amount, we click OK. 

 
The model will now be transferred to the main window. 

 

 
Figure 3 50 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To continue with the rest of the data allocation, go to section 3.6.2. But if you want to explore 
the other methods of creating this model, the current structure will have to be removed 
completely. This can be done using the following procedure. 

 

1. Select the menu option Select> By All> By Geometry. The entire structure is highlighted. 
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2. Press the key DELETE. 
 

Opens a message box to confirm the deletion of the selected plates. 

Figure 2‐292: 
 

 
 

3. Click on OK 

A message box opens indicating that orphans were created nodes and to confirm your 
deletion. 

 

4. Click on Yes. The whole structure is deleted. 
 
 

 
Creating plates - Method 4 

 
Procedure: 

 

The graphical user interface STAAD.Pro contains a mechanism to generate a mesh of elements 
of a limit (or super element) defined by a set of corner nodes. This facility is in addition to what 
we saw in the method 3 The limit must form a closed surface must be a plane, but the plane can 
be inclined to any global levels. 

1. The first step is to define the boundary selection of corner nodes. If there are no nodes must 
be created before they can be selected. Then, select Tool Snap Node / Quad Plates. 

 
Figure 2‐293: 

 

 
 
 

NoteIn STAAD.Pro 2007, the amount of space occupied by a series of icons on the screen has recovered 
from a series of similar icons to collapse in a single icon. You can change the active icon while holding 
down the left mouse button or click the button. The icons that have this property are identified with a 
black triangle in the bottom right corner. 
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Icon Snap Grid Node supports three icons: 

Figure 2‐294: 
 

 
 

They are the tools: Snap Node Beam,Snap Node Quadrilateral Plate, 
And 
Snap Node Triangular Plate. 
Alternatively, select Geometry> Snap / Grid Node> Plate> Quad. 

2. Dialogue appears in the data area on the right side of the screen Snap Node / Plate. (We have 
seen this dialog in methods 1 and 2). As before, click Create. Opens the dialog line. In our structure, the elements are 
in the 

X-Z plane. Thus, in this dialogue, let us choose X‐Z as the plane of the net. Size 
model that can be removed at any time is controlled by the number of construction lines left 
and right of the origin of axes and the spacing between lines of adjacent construction. All 
we want is the 4 nodes of the corners of super- 

element. Then, let 1as the number of lines to the right of the origin to 
along X and Z, and a space of 6m between lines along X and 4m along Z. 

 
 
 

Figure 2‐295: 
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The main drawing area now look like the one shown below. 

Figure 2‐296: 
 

 
 

3. To start creating the nodes, first we activate the button Snap Node / Plate clicking on 
it. Hold down the 'Ctrl' key, click on the four corners of the grid, as shown below. These 
four points represent the four corners of the slab and are (0, 0, 0), (6, 0, 0), (6, 0, 4) and 
(0, 0, 4). Indeed, keeping the 

key Ctrl He pressed and clicking on grid points, is a 
how to create new nodes without connecting nodes with beams or plates. If you do not 
hold the key CTRL, The nodes would be connected. 

Figure 2‐297: 
 

 
 

If nodes are not visible, press SHIFT + K. 
 

It should be noted that the purpose of the above four steps was simply to create the four 
nodes. Consequently, any of the various methods available in the program could be used 
to create such nodes. We could write the data in the editor, or the grid tables Control 
Area page 

geometry of the plate, or even select Geometry> Grid Snap / Node Beam for 
graphically create the points. 
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4. Click on Close dialogue Snap Node / Plate. 

Figure 2‐298: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

We are now ready to use the second method available in the mesh generation program. 

5. Select the tool Generate Surface Meshing 

Figure 2‐299: 
 

 
 

or 

Geometry> Generate Surface Meshing. 
 

6. Select the points that form the boundary of the super-element from which the individual 
elements are created. The four points that we just created are those four points. So we click 
the 4 points in succession as shown below. Finally, closes the cycle by clicking the start 
node (or the first click point) again. 

Figure 2‐300: 
 

 
 

As you click on the start node of the second half, the following dialog box opens. Select the 
option Quadrilateral Meshing and click OK. 
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Figure 2‐301: 
 

 
 

 

7. Dialogue Select Meshing Parameters (As we saw earlier in method 3), appears. Note that 
this time however, the data from the four corners are automatically filled. The program uses 
the coordinates of the four nodes that have chosen to define A, 
B, C and D provide the Bias and division model as shown in the following figure. Click 
Apply. 

 

Figure 2‐302: 
 

 
 
 

As We press applyOur model appears in the drawing area as shown below. Press the key Esc to exit 
mesh generation. 

 

Figure 2‐303: 
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3.6.2 Changing input length units 
 

As a matter of convenience, to specify the properties of the element of our structure, it is easier if 
our units of length are inches instead of subway. This will require changing the current length units input. 
The command to generate is: 

 
UNIT CM KN 

 
Steps: 

 
1. Select the 

herrramienta 
Input Units 

 
Figure 2‐304: 

 
or 

Tools> Set Current Input Unit 
 

Opens the Configure dialog units current input. 

Figure 2‐305: 
 

 
 

2 Define the units of length and the centimeter click accept. 

3.6.3 Specifying the properties of elements 
 

As the properties are assigned to members, properties must also be assigned to elements of the 
plate. The property required for the plates is the plate thickness (or the thickness at each node 
if the slab element has a varying thickness). 

 

 
The corresponding command to be generated in the STAAD command file is: 

 
ELEMENT PROPERTY 

 

THICKNESS 1 TO 6 30 
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Steps 
 

1. Select the tool Property Page located on the toolbar Structure Tools. 

Figure 2‐306: 
 

 
 

Or select General | Property the left side of the screen as shown below. 

Figure 2‐307: 
 

 
 
 
 

The Properties dialog - Whole Structure opens. 

2. Click on Thickness .... 
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Figure 2‐308: 
 

 
 

Dialogue Element Plate / Surface Property opens. 
 

3. The dialog box shown below appears. Provide the bulk of plate as 30 cm. Note that the field 
named Material is currently in the current mode. If we keep this way, the material properties 
are assigned 
concrete (E, Poisson, density, alpha, etc.) together with the plate thickness. The material 
property values thus assigned shall be the default program. (To see the default values, press 
materials in the dialog box shown in Figure 
above). Since we want to assign only the defaults, keep the material in the activated mode. 
Then click on add, Followed by the button close as shown below. 

Figure 2‐309: 
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At this point, the Properties dialog box will be as shown below. 

Figure 2‐310: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Since we want the bulk is applied to all elements of the structure, we select the allocation 
method call Assign to View and then click Assign as shown in the previous figure. 

The following message dialog box opens. Click the button "Yes"To confirm. 

Figure 2‐311: 
 

 
 

The structure will now look as shown below. 

Figure 2‐312: 
 

 
 

5. Click anywhere in the drawing area to desrealzar selected entities. 
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We do this only as a safety measure. When an entity is highlighted, clicking on any option 
to set it can cause an unwanted attribute being assigned to that entity. 

3.6.4 Specifying the material constants 
 

 
In Section 3.6.3, we kept the check box Material "on" to assign the properties of the element. 
Consequently, the material constants (E, density, Poisson's ratio, etc.) of concrete are assigned 
to the plates along with the properties, and obtained the following commands in the command 
file: 

 
UNIT METER KN 

CONSTANTS 

E  MEMB  2.17185E  +  007  1 
TO 6 

 

POISSON 0.17 MEMB 1 TO 6 
 

DENSITY 23.5616 MEMB 1 TO 6 
 

ALPHA 1.0E‐5 MEMB 1 TO 6 
 

Therefore, there is no need to allocate constants separately. However, if we would not have assigned 
as before, we could go to the option menu Commands> Material Constants and explicitly 
assign as shown in the following figure. 

Figure 2‐313: 
 

 
 

3.6.5 Specifying Support 
 

The slab is supported fixedly (recessed) along the entire length of two sides. However, when 
modeled as elements of the plate, the supports can be specified only in the nodes along the edges 
and at any point between the nodes. Therefore, it is clear that if one is interested in better model 
boundary conditions, the slab must be modeled using a larger number of elements. 

 

 
In our case, we have to generate the commands are: 
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SUPPORTS 
 

January 2 4 5 7 10 FIXED 
 
 

Steps: 
 

1. To create media, select the tool Support Page located on the toolbar of the structure 
as shown below. 

Figure 2‐314: 
 

 
 

Alternatively, one can go to General | Support from the left side of the screen. 

Figure 2‐315: 
 

 
 
 

2. In any case, the dialog box opens aid as shown in the following figure. 
 

3. To facilitate the identification of the nodes where we want to place the brackets, alternating 
the display of node numbers. 

4. Since we know that the nodes 1,2,5,7,4and10 They are associated with the fixed support, 

using Nodes Cursor Select these nodes. 
 

5. Click Create in the dialog brackets as shown below. 
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Figure 2‐316: 
 

 
 

6. The dialog box shown below appears. The Record Fixed becomes the default value 
that is appropriate for this case. As shown below, click assign. 

Figure 2‐317: 
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NoteIt is important to understand that the button Assign asset is what we did in step 4 above. 
We had not selected nodes before reaching this point, this option would not have been 
activated. 

 
After the supports have been assigned, the structure will look as shown below. 

Figure 2‐318: 
 

 
 
 

3.6.6 Load cases specifying primary 
 

 
Three cases of primary charge should be created for this structure. Details of these load cases are 
available at the beginning of this tutorial. Ahead corresponding commands generated are listed. 

 
KG  LOAD  METER 

UNIT 1 DEAD LOAD 

AND SELF ‐1.0 

2 EXTERNAL PRESSURE LOAD LOAD 

LOAD ELEMENT 

1 TO 6 PR GY ‐300 
 

3 TEMPERATURE 

LOAD LOAD TEMP 1 

TO 6 40 30 

 
Procedure: 

1. To create loads, select the tool Load Page bar located in 
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tools tools structure. 

Figure 2‐319: 
 

 
 

Alternatively, one can go to General | Load from the left side of the screen. 

 
Figure 2‐320: 

 
 

 
 

 
 
 

2. Note that the enumerated pressure load at the beginning of this tutorial value is in units 
KN andsubway. Instead of converting that value to units 
input current, conform to those units. The current input units, while finally establish specify 
the thickness was centimeter. We have to change the unit to kilogram and units of length 

Meters. To change the units, as before, select the tool Input Units     from the bar above, or 
select the Tools menu Tools> Set Current Input Unit. In the dialog Set Current Input 
Units that appears, specify the units of length and subway and force units like kilogram. 

3. A window titled "Load" appears on the right side of the screen. To start the first load case, 
highlight Load Case Details and click add. 
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Figure 2‐321: 
 

 
 
 

4. Open the dialog Add new load cases. The drop-down list against Loading Type is available if 
you want to link the case load we are creating with any of the definitions of ACI, AISC or 
IBC undead, ice, etc. This type of association must be made if we are to use installation 
program to automatically generate load combinations according to the codes. 

Note that there is a checkbox labeled Reducible per UBC / IBC. This feature becomes active 
only when the load case is assigned a load type called Live at the time of creation of that case. 

As we do not intend to use the option of automatic generation of load combination, we 
will leave the type of load as none. Write Dead Load as the title for load case 1 and 
click add. 

 
 
 

Figure 2‐322: 
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The newly created load case details appear under the load cases in the load dialog. 
 

Figure 2‐323: 
 

 
 

5. To generate and assign the first type of load, select 1: Dead Load. You will notice that the dialog Add new 
items loading now shows more options. 

Figure 2‐324: 
 

 
 

6. In the dialog box, select the Load Selfweight under Article Selfweight. Specify the address AndSuch as 
Factor ‐1.0. A negative number means that the load acts against the positive direction of the overall axis (Y in this case) over 
which it is applied. Click add. The 
selfweight charge is applicable to all members of the structure and can not be applied to a selected 
list of members. 

Figure 2‐325: 
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7. Then, initiate the establishment of the second load case is a pressure load on the elements. 
This highlights Load Case Details in the dialog box Add New Load CasesOnce again, we 
are not we are associating the load based about to create code with any kind of load and so leave that box as none. 
Specify the title of the second load case as Load  External  Pressure  (Loading of external 
pressure) and then 
click add. 

Figure 2‐326: 
 
 

 
 

To generate and assign the second load type, highlight 2: External Pressure Load. 

Figure 2‐327: 
 

 
 
 

8. In the dialog box Add New Load ItemsSelect the option Pressure on Full Plate under 
the theme of Plate Loads enables the load applied over the entire area of the element. (The 
concentrated load is to apply a force concentrated on the 
element. Options Trapezoidalis e hydrostatic they are definable by the pressure with varying 
intensity from one point to another. The Partial Pressure Plate Load -partial pressure 
loading plate- It is useful if the load is to be applied as a "patch" located in a small portion of an element). 
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Provides ‐300 kg / m2for W1 (force) GY as Street address and click Add followed by 
Close. 

Figure 2‐328: 
 

 
 

9. Since the burden of pressure should be applied to all elements of the model, the easiest way 
is to set the method of allocation Assign to View. Then click on assign in the upload dialog 
box as shown below. 

 
Figure 2‐329: 
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After the load has been assigned, the model will be as shown below. 

Figure 2‐330: 
 

 
 
 
 

10. Then let us create the third load case is a temperature load. 
The initiation of a new load case is performed by the procedure explained in Step 7 In the 
dialog box that appears, specify the title of the third load case as Temperature Load and 
click Add. 

Figure 2‐331: 
 

 
 

11. To generate and assign the third type of load, as before, select 3: Temperature Load. Charges 
temperature created from the input screens are available on the option Temperature in the dialog box 
Add New Load Items. 

 

12. In the dialog box, make sure the item is selected temperature under option Temperature 

Loads. Then provides 40  as the temperature change for Axial elongation (Temperature 

Change for Axial Elongation) and30 as the temperature differential from top to bottom 
(Differential Temperature from Top to Bottom) and click Add and click Close. 
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Figure 2‐332: 
 

 
 

13. Since we intend to apply the temperature load on all plates, as before, choose Assign to 
View and click Assign loads in the dialog (see step 
9 for explanation). 

 
 
 

3.6.7 Creating load combinations 
 
 

Specifications at the beginning of this tutorial require us to create two instances of 
combination. The required commands are: 

 

 
101 CASE LOAD COMBINATION CASE 1 + 2 

 

1 1.0 2 1.0 
 

LOAD COMBINATION 102 CASE 3 CASE 1 + 
 

1 1.0 3 1.0 

 
Steps: 

 
1. To initiate and define the load case 4 as a load combination, once again, highlight the option Load 

Case Details. In the dialog box Add new load casesClick the option Define Combinations the 
left side. Enter No Load: How come 101 and title as Case 1 + Case 2. 
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Figure 2‐333: 

 

 
 
 

2. Then, in the box define combinationsSelect load case 1 on the left side of the list and click [>]. Repeat this 
step with the load case 2 also. The Load Cases 1 and 2 appear in the list box on the right as shown in the following figure. 
(These data indicate that the two cases are adding a multiplication factor of 1.0 of the load and the results of the load 
combination would be obtained by the algebraic sum of the results 

for individual load cases). Finally, click Add. 
Figure 2‐334: 

 

 
 

The Case 101 has now been created. 
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3. To initiate and define the load case 5 as a load combination, as before, enter the No Load:102 and 
title as Case 1 + Case 3. 

4. Then repeat step 2, except for selected load cases 1 and 3 instead of 1 and 2 cases. 
 

Figure 2‐335: 
 

 
 

Therefore, load 102 is also created if we change our mind about the composition of any case 
of existing combination, you can select if you want to change and make the necessary 
changes in the instances or their constituent factors. 

Figure 2‐336: 
 

 



STAAD.Pro V8i MANUAL

253

 

 

 
 

5. Let's get this dialog box by clicking the button Close. 
 

Also noteworthy is that as the load cases are created, a facility to quickly switch between the 
different cases is available on the top of the screen as a selection box load cases as shown below. 

Figure 2‐337: 
 

 
 

 
We have now completed the task of creating all load cases. 

 
Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 

 
 

3.6.8 Specifying the type of analysis 
 
 

The type of analysis that is required is a linear static type. We will also obtain a report of static 
equilibrium. This requires the command: 

 

 
PERFORM ANALYSIS PRINT CHECK statics 

 
 
 

Procedure: 

1. Select the tab Analysis / Print | Analysis from the left side of the screen. 

 
Figure 2‐338: 

 

 
 
 

Opens the dialog analysis and printing commands. 
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2. Select the tab Perform Analysis. For static equilibrium report, select Print Statics Check. 
 

Figure 2‐339: 

 
 

NoteIn response to this option, a report is the Summary of the applied load and Summary of the support 
reactions for each load case will occur in the STAAD output file. See Section 3.10 for information on how 
to view this report. 

 
 

3. Finally, click add, Followed by the button shut down. The dialog analysis in the data area with the newly 
added training will be as shown below. 

 

 
Figure 3 103 
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Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 
 

 

3.6.9 Specifying print commands post-analysis 
 

 
 

Two types of results of element may be obtained: a) efforts elements (ELEMENT STRESSES) at the 
centroid, or any point on the surface element b) the forces of elements (FORCE ELEMENT) nodes. 
The first consists of voltage and time width of the unit, as described in Sections 1.6.1 and 5.41 
STAAD Technical Reference Manual. The latter consists of 3 forces and 3 moments on each node 
of the elements in the global axis system (see section 5.41 for details). 

 

 
We'd like to get both these results. Also establish the units in which these results are printed 
and Metro KN element voltages and Kg and metro forces in the element. This requires 
specification of the following commands: 

 
UNIT METER KN 

 

PRINT LIST ELEMENT STRESSES 3 KG 

METER UNIT 

PRINT FORCE ELEMENT LIST June 

 
These results will be written to the output file can be viewed with STAAD and the procedure 
explained in section 3.10. 

 

Steps: 

1. Set the length and strength units subway andKilonewton respectively. 

See "3.6.2 changing the units of the input length" on page 232 for more information on 
this procedure. 

 

2. Select the tab Analysis / Print | Post Print. 

Figure 2‐340: 
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3. Click Define Commands in the data area on the right side of the screen. 
 

Opens the Print command Analysis and dialogue. 

Figure 2‐341: 
 

 
 

 
4. Select the tab Element Forces / Stress. Select the option Print Element Stresses and click 

add followed by Close. 

5. Set the length and strength units subway andkilogram respectively. 

6. Then, repeat steps 2 and 3 In step 3, select Print Element Forces and click add, Followed by the 
button Close. 
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At this point, the dialog Print Post analysis will be as shown below. 

 
Figure 2‐342: 

 

 
 

7. To associate the command PRINT ELEMENT STRESSES element 3, first select the command 

as shown in the figure above. Then, using Cursor Plates Click the selected item No.3 As 
plaque, allocation method automatically becomes Assign to Selected Plates. As shown below, 
click 
assign. 

Figure 2‐343: 
 

 
 

Eight. To associate the command PRINT ELEMENT FORCE to item 6, repeat step 7 except to 
select item No. 6 in place of No. 3 element. 

 

We have now completed the task of mapping the input to this model. 
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Tip: Remember to save your work or selecting File> SaveThe tool to save or press CTRL + S. 
 
 

3.7 Displaying the command file entry 
 

Now take a look at the data that has been written to the file you just saved before. As seen in 
the previous tutorials, while the model is being created graphically, a corresponding set of 
commands that describes that aspect of the model simultaneously written to a script file is a 
simple text file. A command summary was also mentioned under "commands are generated ..." 
at the beginning of each section of this tutorial. 

 

The content of that text file can be viewed in its entirety or by clicking the tool STAAD Editor or by 
going to the menu edition and selecting Edit Input Command File as shown below. 

Figure 2‐344: 
 

 
 

Figure 2‐345: 
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A new window with the data listed will open as shown here: 

 
Figure 2‐346: 

 

 
 

 
 

This window contains the facilities and is known as the STAAD Editor. 

We may make changes to the data of our structure in this Editor  if we want to. Let's get out of 
Editor do without selecting the menu option File> Exit the output editor window (not the File> 
Exit menu of the main window behind the 
Editor window). 

 

Instead of using graphical methods explained in the previous sections, we could have created the 
entire model writing these specific commands in the editor. This was one of the methods 
mentioned in paragraph 3.1 of this tutorial. To understand this method, proceed to the next 
section. If you want to skip that part, proceed to Section 3.9 where we reviewed this model. 

 
 

3.8 Creating the model using the script 
 

Now we use the method of the command file to create the model for the above structure. The 
commands used in the script are described later in this section. 

 
The STAAD.Pro command file can be created using the built-in editor, the procedure explained 
below in this section. Any text editor such as Notepad or WordPad can also be used to create 
the command file. However, the File Editor command syntax has the advantage as we write 
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commands. Keyword, numerical data, comments, etc. are shown in different colors in the 
STAAD.Pro Editor. Below is a typical screen editor is shown to illustrate the general appearance. 

 

Figure 2‐347: 
 

 
 

To access the built-in editor, start the program using the procedure explained in section 3.3. Then 
follow step 1 of Section 3.4 (also see examples below). 

Figure 2‐348: 
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Then you will find the dialog box shown below. In this dialog box, choose 
Open STAAD Editor. 

 
Figure 2‐349: 

 

 
 

At this point, the editor screen will open as shown below. 

Figure 2‐350: 
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Deletes all lines of command appears in the editor window and the lines shown in bold below 
(do not have to delete the lines if you know what to keep and where the rest of the commands). 
The commands can be written in lowercase or upper letters. Usually all that is needed are the 
first three letters of a keyword, the rest of the Letters of the word are not necessary. Necessary 
letters are underlined. ("SPACE" = "SPA" = "space" 

= 
"Spa") 

 

 
The current input is shown in bold, followed by explanation Letters. 

 
STAAD SPA2 EC SLAB SUPPORTED ALONG EDGES 

 
 

Each entry must begin with the word STAAD. The word space means that the structure is a 
structure of space (three-dimensional) and the geometry defined by the X, Y and Z. 

 
UNIT METKN ER 

 
 
 

Specifies the unit to be used for data to follow. 

 
JOINT COORDINATES 

1  0  0  0  ; 2 2 0 0; March 2 0 2 ; 4 0 0 2 

5  4  0  0  ; 6 4 0 2; June 7 0 0 ; 8 6 0 2
9  2  0  4  ; 10 0 0 4; 11 4 0 4 ; June 12 0 

 

 
 

The number of Union followed by X, Y and Z coordinates are indicated. Signs semicolon (;) are 
used as line separators. It allows us to offer multiple data sets in a single line. For example, node 
6 has coordinates (X, Y, Z) of (4, 0, 2). 

 
ELEMENT INCIDENCES SHELL 

 

1 1 2 3 4; 2 2 5 6 3; 3 5 7 8 6; April 4th September 3, 10; 
 

March 5 6 11 9; 6 June 12 August 11 
 

 
 

The incidences of the elements are defined above. For example, the element 3 is defined as a 
connection between nodes 5, 7, 8 and 6. 

 
UNIT  CMKN 

ELEMENT 

PROPERTY 

1 TO 6 THICKNESS 30 
 
 

Unit length is changed from meters to centimeters. Element specifying properties of the 
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UNIKN  ERmet  T 

WITHStants 

E2.17185E + 007  ALL 

POISSON 0.17 ALL 

DENSITY  23.5616  ALL 

ALPIt has 1E‐005 ALL 

 
 

The constants of the materials, which are E (modulus of elasticity), density, and Poisson's ratio 
alpha specified command following constants. Before this, the input units to Metro and KN are 
changed. 

 
SUPPORTS 

 

January 2 4 5 7 10 FIXED 
 

 
Unions of 1, 2, 4, 5, 7 and 10 are defined as embedded support. This will make all 6 degrees of 
freedom in these nodes are restricted. 

 
UNIT KG 

 

LOADEAD LOAD D1 
 
 
 

Units of force change to KG KN to facilitate entry of loads. The Load Case 1 then starts with a 
companion. 

 
SELFWEIGHT Y ‐1 

 
 

The Load Case 1 consists of the weight of the structure acting in the Y direction by a factor of 
overall ‐1.0. And overall is vertically upwards, the factor ‐1.0 indicates that the load will act downward. 

 
LOAD 2 LOAD EXTERNAL PRESSURE 

 
 
 

The Load Case 2 starts along with a companion title. 

 
ELEMENT LOAD 

 

1 TO 6 PRGY ‐300 
 
 

Charge 2 is a pressure on the elements. A uniform pressure is applied 300kg / m2 on all 
elements. GY indicates that the load is in the global address Y. The negative (-300) indicates that 
the load acts against the overall positive direction. 
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LOAD3 TEMPERATURE LOAD 
 
 

The Case Load 3 starts along with a companion title. 

 
TEMPerature LOAD 

1 TO 6 TEMP 40 

30 

 
 

Charge 3 is a temperature load. All six elements are subjected to a temperature rise in the plane 
of 40 degrees and a temperature variation throughout the thickness of 30 degrees. This increase 
is in the same units as the temperature alpha value specified above under CONSTANT. 

 
LOADCOM101 B 1 + CASE 2 CASE 

 

1 1.0 2 1.0 
 

 
 

The Load Combination 101 starts along with a companion title. The Load Cases 1 and 2 are taken 
into account individually so a value of 1.0, and algebraic factored values are combined. 

 
LOAD COMB 102 + CASE 3 CASE 1 

 

1 1.0 3 1.0 
 
 

The Load Combination 102 starts along with a companion title. Load cases 1 and 3 are individually 
factored by a value of 1.0, and the values are combined algebraically factored. 

 
PERANA FORMPRI LYSISSTA NTTICS CHECK 

 
 
 

The above command instructs the program to proceed with the analysis. A report of static 
equilibrium with the help of words CHECK PRINT statics are also required. 

 
UNIT METKN ER 

 

PRINT ELEMENT STRESS LIST 3 
 
 
 

The tensions and moments of unit width requested in the centroid of the element 3 in KN and 
meter units. 

 
UNIT KG METER 

 

PRINT ELEMENT FORCE LIST 6 
 
 
 

The forces and moments for all 6 degrees of freedom at the corner nodes of the element 6 
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are ordered in units of KG and the subway. 

 
EndISH 

 
 

This command terminates the STAAD run. Let's save the file and get out of the editor. 
 

 

3.9 Carrying out the analysis and design 
 

In order to obtain the displacements, forces, stresses and reactions in the structure due to the 
applied loads, the model must be analyzed. If the Member State simplistic elements and the code 
requirements for steel and concrete is to be determined, which 

involves a process called design. Both processes are started by selecting Analysis> Run 
Analysis. 

Figure 2‐351: 
 

 
 

If the structure is not saved after the last change was made, you must save the structure first using 
the command Save Menu Photo. 

 

As the analysis progresses, several messages appear on the screen as shown in the following 
figure. 

 

Figure 2‐352: 
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At the end of these calculations, two activities take place. a) a button Done becomes active b) 
Three options are available in the lower left corner of the info window. 

Figure 2‐353: 
 

 
 
 

These options are indicative of what will happen after you click Done. 

 
Option View Output File allows us to see the output file created by STAAD. The output file 
contains the numerical results produced in response to different input commands you specified 
during the generation process model. It also tells us if errors were found and if so, whether the 
analysis and design was completed successfully or not. Section 
3.10 (see also section 1.9) provides additional details on viewing and understanding the contents 
of the output file. 

Option Go To Post Processing Mode allows us to go to the graphics part of the program known 
as the postprocessor. This is where one can exhaustively verify the results, see the results graphically, 
draw diagrams of results, produce reports, etc. Section 3.11 explains the post-processing mode in 
more detail. 

Option Stay in Modelling Mode allows us to remain in the mode of generation of the program 
model (in which it is currently) in case we want to make more changes in our model. 
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3.10 Viewing the output file 
 

During the analysis stage, an output file containing the results, warnings and messages associated 
with errors in the output if any, occurs. This file has the extension 
.anl and can be viewed using the display output. Section 1.9 of this manual contains 
information on how to view this file. 

 
In sections 3.6.8 and 3.6.9, we have supplied instructing the program to write some very specific 
results in the output file. Examine the results. 
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3.11 Post-Processing 
 

If no entry errors, the analysis is completed successfully. The spacious comforts of post-processing 
mode can then be used to 

 
1. view results graphically and numerically 

2. assess the adequacy of the structure from the point of view of safety, service and 
efficiency 

 
3. create custom reports 

 

The procedure to enter the post-processing mode is explained in Section 2.11.1 of this manual. 
 

 
The results such as nodal displacements and support reactions are available for all models. The methods 
are explained in the first two tutorials - see sections 2.11.2 to 2.11.7. If the beams are present in the model, 
the results will also be available (see sections 2.11.8 to 2.11.18 for information on these). In this example, 
we see the support reactions. We have no beam in our model, so these results are not available for this 
type of entity. 

 

For boards, the available results are tensions and moments "unit width". Various methods for 
displaying the results, as explained in the following sections. 
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3.11.1 Visualizing stress values in a tabular form 
 

1. Select View> Tables or the right mouse button in the window view and select Tables the 
popup menu. Opens the dialog table. 

Figure 2‐354: 
 

 
 

2. Select Plate Stress Center and click OK. Opens the busy city center of the plate. 

Figure 2‐355: 
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The table has the following tabs: 

Shear, Membrane and Bending 
 

Individual values for each plate for each selected load case is. 
 

Summary 
 

This card contains the maximum for each of the 8 values in the shear tab, 
membrane and bending. 

Principal and Von Mises 
 

Individual values for each plate for each load case selected for the top and bottom 
surfaces of the elements are shown. 

 

Summary 
 

This card contains the maximum for each of the 8 values in the Main tab and Von 
Mises. 

 

Global Moments 
 

The tab provides the overall time on the X, Y and Z axes in the center of each 
element. 

3.11.2 Printing tables 
 

These tables can be printed by clicking the right mouse button on the table area and 
selecting Print out. 

 

Figure 2‐356: 
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3.11.3 Changing the units of the values listed in the tables above 
 

The units of length and strength of tensions and moments appear beside individual column 
headers to the terms. 

 

1. Select Tools> Set Current Display Unit .... 
 

The Options dialog opens 

Figure 2‐357: 
 

 
 
 

2. Select the tab Force Units unit and specify the required fields Stress and 
moment. 

3. Click Apply for the changes to take effect immediately. Once you're sure you have chosen 
the right combination of drive, click OK. 

 

3.11.4 Limiting the load conditions for the results shown 
 

When we entered the post-processing mode, we choose that all cases in the dialog box Setup 
Results. Therefore, the table contains results for all load conditions. 

 

Use the following procedure to change the loading list. 

1. Select Results> Select Load Case .... 
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Opens the Output Settings dialog. 
 

Figure 2‐358: 
 

 
 

2. Choose the load cases from the list of available and click [>]. Selected load cases are 
transferred from the list Available to the list of selected 

3. Click on OK. 
 
 

3.11.5 Efforts curves 
 

Efforts curves are a plot based on the color of the voltage variation or time via the surface of the slab 
or a selected part of it. There are two ways to turn graphics these curves: 

1. Select the tab Plate | Contour 
 

Figure 2‐359: 
 

 
 

Or select Results> Plate Stress Contour. Dialog box opens diagrams 
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Figure 2‐360: 
 

 
 

2. Field Stress typeSelect the specific type of effort that you want to get the outline drawn. 

3. In the selection box Load CaseSelect the number of load case. 

The voltage values are known only at locations exactly centroid of the plate. Everywhere, 
calculated by linear interpolation between the values of voltage center point of adjacent 
plates. The contour type Enhanced 
(Improved) chooses a higher number of points from the outline of the type Normal in 
determining the voltage variation. 

 

4. View Stress Index consisting of a small table is displayed in the numeric range of low to 
high values that are represented in the plot. 

 
Establish the following: 

 Load case: - 102 

 Stress Type: - My Top Von 

 Contour Type: - Normal Fill 

 Index based on Stress Center 

 View Stress Index 

 Re-Index for new view 
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5. Click on Apply. 
 

Figure 2‐361: 

 
 

The following diagram displays. We can still change the settings and click apply to see all 
the different possible outcomes in the previous facility. 



STAAD.Pro V8i MANUAL

279

 

 

 
 

Figure 2‐362: 
 

 
 
 

6. It opens the dialog box to examine the (animation) function explained in the next 
section. 

 
If any portion of the structure is truncated, we can bring that portion given by choosing 
one of the following methods: 

a. Select the tool Zoom Out     to reduce the size of the drawn region. 
 
 

Figure 2‐363: Before and After using the Zoom Out tool 
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b. Select the tool Pan  to change the position of the index structure. 

 
Figure 2‐364: Before and after using the Pan tool 

 



STAAD.Pro V8i MANUAL

281

 

 

 

 

3.11.6 Animation curves efforts 
 

The same dialog box as shown in the previous section can be used to obtain the stress contours 
in an animated view. This is a method to achieve a "dynamic" rather than static representation 
of the graph. 

 

1. After holding elections as explained in that section, click on the animation tab of 
diagrams dialogue. 

2. Select the option Stress and click Apply. 

Figure 2‐365: 
 

 
 
 

3. To stop the animation, select No Animation and click Apply again. 
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3.11.7 Creating AVI files 
 

The video files (Animation Video Files) Are a mechanism by which a dynamic such as a deviation in the 
diagram animation result may be captured and recorded. Currently, this service is available in STAAD for deviation node 
beam displacement section plate mode shape and stress contour plots. These files can then be viewed using Adobe video 
software like Windows Media Player. 

1. Select Tools> Create AVI File. 
 

Create AVI File dialog opens 
 

Figure 2‐366: 
 

 
 

In an animated view, the movement from one end to the other is captured as multiple 
frames. The number of frames that make a movement is controlled by specifying a value 
for the total number of frames. The speed of movement is controlled by the rate of frames 
/ sec. The rest of the options in the dialog above are for the type of diagram which is the 
video file to be created. Certain items such as modal shape and curves efforts on the plate 
does not become active (still dimmed) if the required data such are not present in the 
STAAD file, such as finite element or modal extraction. 

2. After making the appropriate selections, click OK. A dialog box to specify the filename Opens. 
 

 
3. Provide a filename and location for the video file and click OK.The Video Compression 

dialog box Opens. 
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Figure 2‐367: 
 

 
 

4. Select a compression option and set the value of quality. Click OK to start creating the 
video file. 

 

 
Note: Video files can be quite large, and compression is a technique used to reduce the size of these 
files, but the softness of some videos is lost in this process. 

 

When the file is generated, a message indicating that the operation was successful 
appears. 

 

Figure 2‐368: 
 

 
 

5. Click OK to close. 

The AVI file with the extension is saved in the same folder where the STAAD input file is 
located. 

 
 
 
 
 

3.11.8 Viewing results by consulting the plate element 
 

The Query element is a command where you can see several results for a specific element while a 
single dialog box. Exploring this facility for item 4. 

1. Select the tool Cursor Plate. 

2. Double-click the item 4 or 4 and select select element Tools> Query> Plate. Plate dialogue 
opens 
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The various tabs in the query box that let you view various types of information such as 
the geometry of the plate, constant property, voltages, etc., for various load cases and print 
those values. Some tablets example of this dialog box shown in the following figures. 

 
 

Figure 3 141 

 
 
 

Figure 3 142 
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Figure 3 143 

 
 

Figure 3 144 
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Figure 3 145 

 
 
 
 
 

3.11.9 Preparing a report on screen 
 

Sometimes we will come across the need for results under certain restrictions, such as 
displacement of the resulting node to a few selected nodes, for a few selected load cases, ranked 
in order from low to high, with values reported in tabular form. The service allows us to obtain 
such a modified 

customized on the screen is the menu results report (Report) above 
screen. 

Let us elaborate a report consisting of the principal stresses of the plate, for all boards, classified 
in the order from low to high voltage, high-Principal (SMAX) for load cases 101 and 102 (load 
combinations). 

 

1. Select all plates using Plates Cursor  

2. Select Report> Plate Results> Principal Stresses. 
 

The dialog box forces Opens plate. 
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Figure 2‐369: 
 

 
 

 
 

3. Select the tab Loading. 

4. Select load cases 101 and102 available in the list and click [>] to add to the short list. 
 

5. Select the tab Sorting. Choose SMAX low Sort by Plate Stress and select List from Low 
to High how come September Sorting Order. 

Figure 2‐370: 
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6. (Optional) If you want to save this report for future use, select the tab ReportProvides a 
title for the report and set the checkbox Save ID. 

 

7. Click on OK. 

The following table shows the maximum principal stress with SMAX values ranked from 
low to high. 

Figure 2‐371: 
 

 
 

8. To print this table, right-click anywhere within the table and select Print from the menu. 
 

Select the option to print a hard copy of the report to transfer the contents 

of this table to a Microsoft Excel file. 

1. Click the top left corner of the table with the left mouse button. 
Entire table appears checked. 

2. Right-click and select Copy the popup menu. 

3. Open an Excel spreadsheet, click on the desired cell and paste content. 
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3.11.10 Viewing the reactions at the supports 
 

Since the supports are in the nodes of the structure, the results of this type are available along 
with other node results as displacement. 

1. Select the tab Node | Reactions on the left side of the screen. 

Figure 2‐372: 

 

 
 
 

The support reactions are shown on the drawing as shown below. 

Figure 2‐373: 
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The six values - that is, the three forces overall along X, Y and Z and three Mx, My and Mz 
moments in the global axis system - shown in a box for each support node. 

 
Displays one or more of the six terms of each support node can be set off in the following 
manner. 

1. Select Results> View Value .... 
 

Open dialog annotation. 
 

Figure 2‐374: 
 

 
 
 
 

2. Select the Reactions tab. Clear the Global X and Global Z check boxes in the Direct 

category. Select the tab Reactions. Uncheck the boxes Global X andGlobal Z category 
Direct. 
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3. Click Annotate and then Close. 
 

The drawing will contain only the remaining 4 terms (see figure below). 

Figure 2‐375: 
 

 
 
 

To change the load case for which the reactions are displayed, select the desired selection box load 
case. 

 

Figure 2‐376: 
 

 
 

For clarity in displaying the results in the drawing area (and to reduce clutter on the screen), a 
variety of methods are available. For example, hold the mouse button down on the Zoom In and 
see the drawing progressively larger. Use 

button Pan to physically change the drawing around. Also usable other 



STAAD.Pro V8i MANUAL

293

 

 

 
 

options as buttons Print / dynamic reduction (Dynamic Zoom) andzoom in / out window 

(Zoom Window). To restore the original view, click Display Whole Structure (Show all structures). 
(Some of these options are explained in more detail in the section ' 
Tasks often done 'at the end of this manual). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The table to the right of the screen contains the values for all reaction media for all selected 
load cases. 

 

Figure 2‐377: 
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This table can also be viewed from any mode by clicking on the menu  see, Choosing tables, And on the 
support reactions. 

 
The method explained in Section 3.11.3 can be used to change the units in which these values are 
shown. The Summary tab contains the maximum value for each of the 6 degrees of freedom along 
with the case number responsible for this charge. 

Figure 2‐378: 
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Section 3 

Frequently Performed 
Tasks 
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1. Selection toolbar 
 
 

 
 
 
 

Icon 
Item 

Correspondent 
menu 

Purpose  Description 

 

 
 
Nodes Cursor 

 
 

 
 
 

 

Select> Cursor 
Nodes 

It is used to select the 
nodes graphically 

First, select the Nodes Cursor 
tool. Then, click to select the 
nodes. To select multiple nodes, 
hold down the Control key 
while you select or create a 
window style elastic band 
around the desired nodes. 



STAAD.Pro V8i MANUAL

298 

 

 

 

 
 

 
Beams Cursor 

Select> Cursor 
Beams 

It is used to graphically 
select the beams 

First, select the Cursor beams. 
Then, click to select the 
members you want. To select 
multiple members, hold down 
the Control key while you select 
or create a window style band 
around the desired beams. 

 

 
 
 
 
 

Plates Cursor 

Select> 
Cursor Plates 

It is used to select the 
plates graphically 

First, select the Cursor plate. 
Then click dishes to select. To 
select multiple plates, hold down 
the Control key while you select 
or create a window rubber band 
around the desired style plates. 

 
 
 
 
 

Surface Cursor 

Select> Cursor 
Surface 

It is used to select the 
surface graphically 

First, select the Cursor surface. 
Then click the area you want to 
select. To select multiple areas, 
hold down the Control key while 
you select or create a window 
style rubber band around the 
desired surfaces. 

 

 
 
 
 
 

Solids Cursor 

Select> 
Cursor Solids 

It is used to graphically 
select solids 

First, select the Cursor solids. 
Then, click the solids to be 
selected. To select multiple solids, 
hold down the Control key while 
you select or create a window 
style elastic band around the 
desired solid 

 

 
 
 
 
Geometry Cursor 

Select> 
Geometry 
Cursor 

Select any geometry 
graphically. It is a 
mechanism for 
selecting the nodes, 
beams, plates, solid or 
any combination 
thereof, at the same 
time. 

First, select the Cursor 
geometry. Then click the feature 
you want to select. To select 
multiple institutions, hold down 
the Control key while you select 
or create a window style rubber 
band around the desired entities. 
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Load Edit Cursor 

Select> Load 
Edit Cursor 

Used to graphically 
select a component of 
an existing load case 
for modification. 

First, select the edition cursor 
load. Then double-click the 
component diagram of load you 
want to edit. 

 

 
 
 

Edit Cursor 
Support 

Select> Edit 
Cursor Support 

Used to graphically 
select a medium whose 
parameters one wishes 
to modify. 

First select the Cursor editing 
support. Then double-click on 
the help icon on the node where 
you want to edit the details of 
existing aid. 

 
 
 
 

Release Edit 
Cursor 

Select> Edit 
Cursor Release 

Used to graphically 
select and modify an 
existing member 
specification release 

First, select the Edit Cursor 
release. Then double-click the 
member in which a condition of 
initial or final release is currently 
defined to be modified. 

 
 
 
 

 
Select Text 

Select> Text 
Cursor 

Use to enter the edit 
mode text labels 
previously created 

To edit any previously created 
text, first select the text cursor 
label. Then double-click the text 
to edit. 

 

 
 
 
 
Filtered Selection 

Select> Filtered 
Selection 
Cursor 

Used to select various 
types of geometric 
entities (nodes, beams, 
surfaces, etc.) with 
specific attributes in a 
single pass. 

This is used to select various 
types of geometric entities 
(nodes, beams, surfaces, etc.) 
with specific attributes in a 
single pass. 

 
 
 
 
Select Joints 

Select> 
Cursor 
Joints 

Used for 
select together, when 
you use the RAM 
interface connection 
from within STAAD. 

This is used to select joint. With 
this cursor as the active cursor 
selection, one can assign joint 
written design or you can just 
double-click to launch joint 
RAM connection, etc. 
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2. Toolbar rotation 
 

Icon  Description  Example 

 

 
 

 
 
View From Z + 

Shows the structure as seen 
from the front. When the 
global axis is vertical, this is 
the elevation view, and 
looking towards the negative 
direction of the z axis. 

 

 
 
View From - Z 

Shows the structure as seen 
from the rear. When the 
global axis is vertical, it is the 
opinion of elevation, as seen 
looking toward the positive 
direction of the z axis. 

 
 

 
 

 
 
View From + X 

Shows the structure as seen 
from the right side. When the 
global axis is vertical, that is 
the side elevation, as seen 
looking toward the negative 
direction of x axis. 

 

 

 

 
 

 
 
View From - X 

Shows the structure as seen 
from the left side. When the 
global axis is vertical, that is 
the side elevation, as seen 
looking toward the positive 
direction of x axis. 
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Icon  Description  Example 

 

 
 
View From + Y 

Shows the structure as seen 
from the top looking down. 
When the global axis is vertical, 
this is the plan view, as seen 
from the sky looking down. 

 

 
 

 
 
View From - Y 

The structure is shown as if one 
is looking to the sky. 

 

 
 

 
 

 
 
Isometric View 

The structure shown in 
isometric view. The angle 
defining the isometric view is 
generally X = 30, Y = 30, Z = 0 

 
 
 

3.Switching labels for nodes, beams, plates, etc. 
 

  Tags are a way to identify the entities that have drawn on the screen. To demonstrate the 
ease, open EXAMP01.STD as shown in the following figure. 

 
Figure 3‐1: 
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1. To change node labels and beam 

   Select the tool of symbols and labels (Symbols and Labels). 

 
Figure 3‐2: 

 

 
 

or 

    Right-click anywhere in the view area and select from the popup menu labels of 
readjustment 

 

 
Figure 3‐3: 

 
 

or 

    Select View> StructureDiagrams. Open dialog box diagrams. 



STAAD.Pro V8i MANUAL 

303

 

 

 
 

2. Select the Labels tab and select the options for the appropriate tags (examples shown in 
the following figure). Click OK to update the view window and close the dialog box. 

 

Figure 3‐4: 

 
 

The following figure shows the structure with node and beam labels appear on it. 

Figure 3‐5: 

 
 

3. To change the font of the labels of node / beam, select View> Options. The Options dialog box 
opens. 
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Figure 3‐6: 

 
 
 

4. Select the appropriate tab (Node Labels / Beam labels) and click Font... To make the desired 
changes. Click OK to close the Font dialog box. 

 

 
 
 
 

4. Displaying a part of the model 
 

 
 

Sometimes, the large number of entities that are drawn on the screen can make it difficult to clearly 
see the details on any particular region of the structure. In such cases, one is faced with the task of 
removing cluttering the screen or in specific regions or entities while the rest of the structure is removed 
from the point of view. 

There are different methods by which you STAAD.Pro can see a part of the structure. The following 
pages show three different methods. 

 
 

 
Method 1 - View> New View 

 

1. To demonstrate this method, open EXAMP08.STD (C: \ SPro2007 \ STAAD \ examp \ 
AU) as shown in the following figure. 
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Figure 3‐7: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. To see the members who are halfway up, first select the tool by selecting members View From 

Z +   and dragging a rubber band around 
these members in the view window. 

 
Tip: Ensure that the tool Beams Cursor  is the selection tool is active. 

 

Figure 3‐8: 
 
 
 
 
 
 
 
 
 
 

 

3. To visually check that they have been selected the correct members, select the tool 

Isometric View . 
 

Selected members are highlighted. 



STAAD.Pro V8i MANUAL

306 

 

 

 
 

Figure 3‐9: 
 

 
 
 

4. Create a new view by selecting View> New View ....or 

Right-click anywhere in the viewing window and select 

New View ... the popup menu. Opens the New View dialog. 
 

Figure 3‐10: 

 
 
 

The dialog box includes options to open the new view in a new window or to replace 
the current window view. 

5. Select the option Create a new window for the view and click OK. 
 

The portion of the structure that we have selected will now be displayed in a new window 
as shown in the following figure. Auxiliary view multiple windows can be created in this 
way. 
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Figure  3‐
11: 

 
 

Tip: The new windows are useful for performing operations such as adding and removing members, assigning 
properties, loads, stands and more. A new view of a selected portion has the advantage of clearing the screen and limit 
the few elected bodies visualized objects. 

 
6. To return to the main view window, close the new window by clicking secondary view close [X] 

in the upper right corner. 
 

7. Repeat steps 2-4 to start another new view. 

8. Select the option Display the view in the active window and click on OK. 

The original structure and the portion of the structure we have in place selected will be 
displayed in the current view main window as shown in the following figure is hidden. 

Figure 3‐12: 
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9. Select the tool Display Whole Structure to restore the original view. 

Figure 3‐13: 

 

 
 

 

Note: These new insights can be saved by going to the menu View> View Management> Save 

View. Provide a title for the new view. Later these saved views can be opened by going to the menu View> 

Open View. 
 
 

Method 2 - Tools> Cut Section 
 

1. To demonstrate this method, open EXAMP08.STD (C: \ SPro2007 \ STAAD \ examp \ 
AU) as shown in the following figure. 

 
Figure 3‐14: 

 
 

2. Select the tool Symbols and Labels. 

The Diagrams dialog opens. Select the option Node Numbers and click on OK. 
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This will aide to specify a number of nodes in the next step. 

Figure 3‐15: 

 
 

 
3. Select Tools> Cut Section. Open dialog section. 

 

Figure 3‐16: 
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By The Joint Range 
method 

 

Since the beams level is average height containing meeting # 10 (or any of the joints 7-12), 
it would be desirable if we can tell the program to display the entities in the XZ plane and 
going through one of those joints 7 to 12, Facilities of 

record range of joint allow us to do. 
 

4. We select that tab (it is the default). Here, you can select the plane of the section by clicking 
on one of the options - XY, YZ, or XZ. We have to choose the X‐Z plane  for our example. 
Then in the drop down list Node #, 
provide a joint that is located in the sectional plane. In our example, we can choose any of the 
nodes between 7 and 12 We choose With Node # 10. Click OK. 

The following figure shows the cut part of the original structure shown in the 
drawing area. 

 

Figure 3‐17: 
 

 
 
 

5. Select the tool Display Whole Structure to restore the original view. 

Moreover, the dialog box shown in step 4 and click Show All. The Range By Min / Max 

method 

Procedure: 
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Another convenient way to choose the beams in the level of average height specify that 
the beams are in the XZ plane between Y values range from 12 ft - 12 ft over and + a, 
where "a" is an arbitrary value as say 2ft 

 

6. To do this, we select the tab Range By Min / Max. Here again we can select the plane of the section 
by clicking on one of the options - XY, YZ, or XZ. We have to choose the plane X‐Z for our example. Edit 
boxes Minimum and 

Maximum represent the limit of the distances along the axis perpendicular to the plane 
Sectional. All objects between these two distances are displayed. In our example, we provide 
10 how come Minimum and14 and the distance Maximum. (Before doing this, make sure the 
current entries units of length, appears in the bottom corner 

right of the window STAAD program are feet). Then click on OK. 
Figure 3‐18: 

 

 
 

The following figure shows the cut part of the original structure shown in the drawing 
area. 

Figure 3‐19: 
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7. Select the tool Display Whole Structure to restore the original view. 
 

The Select method to 
View 

To demonstrate this method, instead of viewing specific beams, look at the nodes in place. 
 

Steps: 

Using this option, you can select the portion of the structure that we wish to specify the 
objects that are in that part. Option Window / Rubber Band allows to select the part of the 
structure for specifying a window 
rubber around it. Option Highlighted View Only only shows only the objects selected 
(highlighted) on the screen and the members and elements that we want to see must be selected 
before choosing this option. Option Select To View allows us to see 
only beams, plates, or solid, depending on the check boxes that are activated. 

8. In our example, let us choose Select To View and setting the checkbox Node. Then click on 
OK as shown below. 

Figure 3‐20: 
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The following figure shows the view of the structure with only nodes that 
appears. 

 
 

Figure 3‐21: 
 

 
 
 
 

9. Select the tool Display Whole Structure to restore the original view. 
 

 
 

Note: These new insights can be saved by going to the menu View> View Management> 

Save View. Provide a title for the new view. Later these saved views can be opened by going to the menu 
View> Open View. 
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Method 3 - View> Zoom 
 

The menu option Zoom allows us to zoom (zoom in) or out (decrease) in one portion of 
the structure, as one would using a telescope. 

 

1. To demonstrate this method, open EXAMP09.STD as shown in the following figure. 

Figure 3‐22: 
 

 
 

2. Say, we want to expand the portion of the structure shown in the figure below. 

Figure 3‐23: 
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3. To select the plates as shown in the preceding figure by selecting the first tool View From Z 

+. Then select the tool Plates Cursor 
and drag a window around the elements of the plate in the view window as 
shown in the following figure. 

 
 
 

Figure 3‐24: 
 

 
 
 

By the way, seeing the model And from the view +, Or, from the view X and using the 
methods of rubber window can be as effective in the selection of these elements. 

4. Select the tool Isometric View. 

This is useful to ensure that the right entities are selected, as in the previous figure. 
 

5. Expand the selected portion of the structure either by selecting the tool Zoom Window 

Figure 3‐25: 

 

 



STAAD.Pro V8i MANUAL

316 

 

 

 
 
 

o
r 

selecting View> Zoom> Zoom Window. 
 

The mouse pointer changes to a crosshair in the view window. 
 

6. Click and drag a window around the selected portion of the structure. magnified 

view of the selected structure. 

 
 
 

Figure 3‐26: 
 

 
 

 
 

Alternatively, the tool is used Zoom In to expand the view by a predefined factor. 

The tool Dynamic Zoom is used to show the enlarged view in a new window. 
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Figure 3‐27: 
 

 

 
 

 
Select a region by clicking and dragging in the view window, similar to the use of the tool 
zoom in / out window. That region will now be displayed in a new window in the drawing area as shown in 
the following figure. 

 
Figure 3‐28: 

 

 
 
 

7. To restore the view of the entire structure, select the tool Display Whole Structure. 
 

Note: These new insights can be saved by going to the menu View> View Management> Save 

View. Provides a title for the new view. Later these saved views can be opened by going to the menu View> 

Open View. 
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5. Creating groups 
 

Group names are a means to easily identify a collection of entities such as beams, plates or solids 
with a simple nickname. Grouping these entities, we must assign attributes as member properties 
and material constants for the group, a simple process compared to the task of assigning them 
to individual members. 

1. To demonstrate this, open EXAMP01.STD (C: \ SPro2007 \ STAAD \ examp \ AU) as 
shown in the following figure. 

 
Figure 3‐29: 

 
 

 

Consider the members forming the armor is in one of three groups: Chords Top, Bottom 
Chords and Web Members. 

 

2. Select the tool Beams Cursor  and select the inclined in the view window as 
shown in the figure below members. 

Figure 3‐30: 
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3. Select Tools> Create New Group. Opens the Define Name dialog group. 

4. Enter _TOPCOR on behalf of the group. 
 

Note: Group names must begin with the character '_'. 
 

 
Since group names can be assigned to nodes, beams, plates, solids, and a general category 
called geometry, it is very important to choose the appropriate type of entity. Therefore, 
specify Select Type how come Beam and then 

click OK. 
Figure 3‐31: 

 
 

Opens the Create Group dialog box. 

5. Click on Associate. 

The methods of allocating the dialog Create group currently activated 
Associate Selected to Geometry. 

Figure 3‐32: 
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6. Select the members forming the chord of the bottom as shown in the following figure. 

Figure 3‐33: 

 
 
 

7. In the Create Group dialog box, click Create. Follow steps 4 and 5 and assign the group name 
_BOTCOR these members. 

 

8. Now, you can group network members in the armor. Using the mouse, select 
members of the transverse reinforcement as shown in the following figure. 

Figure 3‐34: 
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9. Then follow step 7 except to specify the group name as _TRNTRUS. 

Figure 3‐35: 
 

 
 

 
10. Click Close in the dialog box Create group. 

Now they have created three groups. Select Select> By Group Name to open the Select 
Groups dialog box, which can be used to select a group call. 

 

Figure 3‐36: 

 

 
 

 
Note: If you disabled the option to display the label, labels such as beam numbers will not 
show these specific members, even if the icon is lit beams numbering for the entire structure. 
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6. Showing screen loads 
 

 

1. To demonstrate this feature, open EXAMP08.STD (C: \ SPro2007 \ STAAD \ examp \ 
AU) as shown in the following figure. 

Figure 3‐37: 

 
 

2. Select the tool Loads and then a specific load as Active Load the drop-down list of all 
loads in the input file. 

 

Figure 3‐38: 
 

 
 

o
r 

Select View> Structure Diagrams. In the dialog box diagrams that opens, select the 
tab Loads and Results. select the option Loads and select if you want to load from the list 
box in the cargo box. Then do 
click OK. 

Figure 3‐39: 
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The following figure shows the load case 1 for this example model. 

Figure 3‐40: 

 
 

 

7. Showing the load values on the screen 
 

1. In the previous exercise, we saw the method to turn the icon loads, but the numerical 
value of loads. To see load values, open EXAMP08.STD as shown in 
the figure below. 

Figure 3‐41: 
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2. Select the tool Loads  and then right-click anywhere in the view window and 
select Labels the popup menu. 
or 

select the tool Symbols and Labels   

or 

select View> Structure Diagrams and select the tab Labels in the dialog box diagrams. 

The dialog box opens diagrams Record Labels. 

3. Set the check box Load Values category Loading Display Options 
as shown in the following figure. 

 
Figure 3‐42: 

 

 
 

The following figure shows the example structure with the load values listed in it. 
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Figure 3‐43: 

 
 

4. Select Tools> Set Current Display Unit. 
 

The Options dialog box opens. 

Select the tab Force Units and then change the selection under force to Kip and 
distributed force tokN / m. 

Figure 3‐44: 

 
 

5. Click on OK. 
 

The values are updated with the new units. 
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8. Structural tool options advice 
 
 

Figure 3‐45: 

 
 

Tips structural tool provides a facility to display any custom input custom or output information 
about a node, beams, plate or solid element when the mouse cursor over the structural entity is 
placed. The tool tip is similar to the one shown when the mouse cursor over an icon in the 
toolbar moves. When the mouse cursor is moved away from the site, the information displayed 
is also off. 

1. Select View> Structural Tool Tip Options. 
 

Opens the Options dialog tool tip. 

Figure 3‐46: 
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2. Select the option Show Tool Tip is to ensure that the tooltip can be alternated on. 
 

Box Tip Delay means the amount of time it takes from when the mouse cursor over an entity 
appears first when actually the tooltip appears. This number is expressed in milliseconds (that 
is, 1000 = 1 second). 

 
The options (items that can be displayed) for each entity are shown in the table options. 
A check mark indicates that the particular data item is displayed in the tool tip. An option with a "+" next to it 
means that other 
options can be enabled or disabled. A red "X" indicates that data are not displayed in the 
tool tip. Just click the check box to enable or disable the option. 

Tips structural tool can be configured to display a wide variety of information about an 
entity model, as shown in the following figure. 

 

Figure 3‐47: 
 
 

 
 
 

Note: The tool automatically shows results for the case of active load. All values are reported in the 
current display units. 
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9. Identifying start and end of the beam 
 

When assigning attributes as member freed or compensated member, an additional element of 
information that accompanies this information is if this attribute is applied to the "Start" node 
of a member or the "end" node. Therefore, there must be a way to quickly identify these two 
points without doubt one another. 

1. To demonstrate this facility, open EXAMP01.STD as shown in the following figure. 

Figure 3‐48: 

 
 
 
 

2. There are two ways to identify the start or end of a beam: 
 

a. Place the mouse pointer over a specific beam. The resulting tool tips show the start 
node and end node of the beam in two different colors along with their corresponding 
coordinates. Of course, you must have screen tool tips enabled for this method to 
work. 

Figure 3‐49: 
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b. Right-click anywhere in the view window and select Labels 
the popup menu reset. 

 

The Diagrams dialog opens in the Labels tab. 

Set the check box Beam Ends. To change the color at the beginning or end is displayed, simply 
click on the color palette with options Initial Color orFinal color and choose the color you 
want. Then click on 

Apply to update the changes. Click OK to close the dialog box. 
Figure 3‐50: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The following figure shows the structure with the beginning and end of all beams 
shown in two separate colors. 
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10. Charting from STAAD.Pro 
 

Figure 3‐51: 

 
 

Explanation The following are five methods to trace the STAAD model plane and STAAD result 
diagrams. 

 

 
 

Method 1: Using the current option to print view 
 

1. To demonstrate this facility, open EXAMP14.STD (C: \ SPro2007 \ STAAD \ examp \ AU) 
as shown in the figure below. 
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Figure 3‐52: 



 

 

 

 
2. Select the tool Preview Print Current View to preview the image as it will appear 

on paper. 
 

Figure 3‐53: 

 

 
 

 
Opens the print preview to show the view in a report format. 

 
Figure 3‐54: 

 
 

 
3. Select the tool Print Current View to draw the image. 

 
Figure 3‐55: 

 
 

The Print dialog box Windows standard, which is used to select the printer or plotter you 
want to send the image opens. 



STAAD.Pro V8i MANUAL

331

 

 

STAAD.Pro V8i MANUAL 
 
 

4. Select the desired printer and click OK. 
 

Figure 3‐56: 

 
 

 
Method 2: Using the option of taking photo 

 
1. Select the tool Take Picture. 

 

OEdit> Take Picture. Opens the Picture # dialogue. 
 

2. Enter a picture ID and subtitles. 
 

Figure 3‐57: 

 
 

Figure 3‐58: 
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3. Select File> Report Setup ... Select the tool or Report Setup. 
Figure 3‐59: 

 

 
 
 

Opens the Report Settings dialog. 

4. On the record ItemsSelect Pictures in the list of available items. 

 
Figure 3‐60: 

 

 
 
 

If there is more than one image, select the desired trace by pressing [>]. 
 

5. Select the tab Picture Album and setting the checkbox Full Page. Click OK. 
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Figure 3‐61: 

 
 
 

6. Select File> Print Report. 
 

The outline will be drawn. 

Alternatively, select File> Export Report> MS Word File to create a report you can 
print from Microsoft Word. 

 

In the dialog Save asSpecify a name for the file and click Save. In the dialog box Templates, Select 
the Normal template. 

 

Figure 3‐62: 

 
 
 

Microsoft Word file creation begins with the image on it. Once 
this is complete, the new file opens in Microsoft Word. 
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Method 3: Using the view option to export 
 

STAAD.Pro has a command to export a drawing to a graphic image file. 

1. With the diagram you want to plot is displayed, select the tool Export View in the 
toolbar print 

 

Figure 3‐63: 

 
 
 

Opens the Save As dialog. 

2. Select the chart format in which to save the file (ie, Bitmap, JPEG, TIFF, GIF, etc.) 
 

Figure 3‐64: 

 
 

Provide a file name and save the file. 

3. Open an image editing program text or graphics processing (eg, Microsoft Word or 
Adobe Photoshop). 

 

4. Import or insert the drawing from the previously saved file. Now you can print the 
image file from the graphics program. 
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Method 4: Using the Copy Image 
 

1. Stresses the window containing the diagram you want to plot. This can be done by ensuring 
that the title bar of that window is the color that indicates that it is in focus. 

 

2. Select Edit> Copy Picture. 

3. Open a graphics program able to trim the graphic image to their needs (eg, 
Microsoft Paint, Corel PaintShop Pro, Adobe Photoshop, etc.). 

 
Paste the clipboard contents into an empty file in this program. You will notice that the 
drawing window now STAAD sticks in that program. Using the tools provided by the graphics 
program, you can modify the design if you wish. Now you can print the image file from the 
graphics program. 

 

 
Method 5: Using the Windows clipboard 

 

1. When the diagram you want to plot on the screen is displayed, press PRINT SCREEN or 

PRINT  SCREEN  (For some keyboards, this functionality requires pressing SHIFT  or 

SHIFT + PRINT SCREEN+PRINT SCREEN). Currently in view the entire image is copied to the 
Windows clipboard. 

 

2. Open a graphics program able to trim the graphic image to their needs (eg, Microsoft 
Paint, Corel PaintShop Pro, Adobe Photoshop, etc.). Paste the clipboard contents into an 
empty file in this program. You will notice that all STAAD screen (including the diagram, 
menus, icons toolbar, tables, etc.) is part of the pasted image. 

 

3. Using the tools provided by the graphics program, crop the image in order to retain only 
the drawing and remove unwanted parts. Now you can print the image file from the 
graphics program. 



STAAD.Pro V8i MANUAL

337

 

 

 
STAAD.Pro V8i MANUAL 

 

 
 
 
 

337 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Section 4 

Practical Exercises 
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4.1 Geometric Generating a seven-story building 
 
 
The "New" popup window appears where we 
enter: 
 
Workspace: 

o Space - Design in space (x, y, z). 
o Plane - Design in a plane (x, y) or porch. 
o Floor - Design in a plane (x, z) or floor. 
o Truss - Designed Armor. 

 
File Name (File Name). 
Location (location where the file is saved.) Units of 
Length and Force Units. (Meter and kilogram.) 

 

Select Space, we entered the relevant data 
and we click Next. 
 
Will run into the "Where do you want to go?" 
(Where to go?) Window with the options: 

 

o Add Beam - Add Beams. 
o Add Plate - Add Plates or Slabs 
o Add Solid - Add Solid 
o Open Structure Wizard - Open 

Standar library of structures 
o Open STAAD Editor - 

No graphical interface 
commands STAAD 

o Edit Job Information - Edit 
job information. 

 
 
We will generate different types of 
geometries, like a number of structural 
frameworks that make a building of 7 levels, 
a building of circular cross section and a 
dome. 

 
For the 7-story building, will draw originally a 5x5 frame with open base, for that select the "Snap Node 
/ Beam" tool and begin to draw from the point of origin (0, 0, 0). Essentially this represents each of our 
homes. The general idea is to create a society governed by frames and modulated structure under these 
measures. 

 
We will select the "AddBeams" option and we will work with beams or members and give you the option 
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end. 
 

Workspace where we start to handle the geometry of our project, a building opens. 
 

 
 
It is important to consider using "Snap Node / Beam" (Network Node 
/ Beam) as this creates for us a grid where we can enter our data, 
activate the icon This Snap Node / Beam and select the "Geometry" 
option the left side tab 

 

This Grid can be edited to increase the number of spaces in "x" or 
"y" 

 
 
 
Select it and Translational Repeat the tool we will create a number of copies of our element, we 
start by creating frames one side of our modulation. 
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We do the same in the other direction, but with all the elements to create cloned 
frames downstairs of our project, it is important to always point where we want 
to deploy our copies, in this case on the "x" axis. 

 
 
 
 

 
 
 

 
Finally do the same but now on the "Y" in order to give height to our building. 
Modify only the number of copies that will be the number of floors above that we 
have in this case will be 6 and the shaft, 
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unmarked boxes "link spaces" and therefore "Open Base". We get our building 
and 

 
 
 

. 
Another quickest way to obtain the same result by 
"Structure Wizard" or "Wizard Structures" tool, this 
option provides a library of predefined prototype 
structures, such as: 

 

     Truss Models: Models Armour.      

Frame Models: Models Marcos. 

     Surface / Plate Models: Models of surfaces or plates. 
 

     Solid Models: Models of Solids. 
 

     Composite Models: Models of compound shapes. 

     CAD Models Import: Import models in DXF format. 

For location we go to the "Geometry" (Geometry) and 
at the bottom we find the "Run Structure Wizard" 
option (Run Wizard structures). 

 
We select from among the options "Frame Models", will go to the 
"File" menu select units "Select Units" menu and change the 
imperial to SI / Metric or metric marking the Meters "m" option. 
Now, the options that allows us 
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select "Bay Frame" and configure the pop-up screen, it will ask us the length, width and height of 
our building and the number of "bays" or spaces in each of these elements, the configure as shown 
in the image. 
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We model the path to the desired configuration, the task now is to migrate our Editor STAAD 
interface for that we go to the file menu from the "Merge Model with STAAD appears and. Pro 
Model " 

 
A popup will open to confirm the order to migrate the model, we will click on "Yes" and we will get 
a Paste Options window where we will give indications of where we want to be the origin of our 
drawing, select "By the following X, Y and Z values "(for the following values in X, Y, and Z) we will 
change the value of zero at all, send it to the origin. And we are ready to apply loads in STAAD 
model. 
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4.2 Geometric Generating a domed tower 
 

 
Now chart a circular building plant and for this we will rely again on the "Snap Node / Beam" tool and 
chart a frame 5 x 5 on our network, once this is done we will select our frame and go to the tool 
"Circular Repeat "which we will create a repeat of our figure based on an axis located in a center, as a 
compass which will place on the" Y "and we will place it in X and Z as zero. We assign a 30 ° angle 
and only one repetition. When generating the geometry manually close the figure with the "Beam" tool 
or we can make a "Link Steps" option - Link steps and "Open Base" - Base Open ". 

 

 
 

 
 

We select our new items and select "Repeat Circular," Circular configure 3D window as 
shown in the image, that make a circle 360, resulting in the first floor of our building with 
a ground loop. 
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Now we will give up our building, for it will select all 
our geometry and proceed to the "Traslational Repeat" 
tool will configure the popup window to perform 3D 
Repeat us copies of our framework on the "Y" axis at 
a distance of 5 m. which is the height of our frames. 

 

 
 

We click OK and we generate the floors that make up our building and with it all our geometry. 
We can experiment with the settings and get the tools varied geometries. Now as an example 
and create a dome. 
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With "Snap Node / Beam" tool we will draw the section of our dome, we stand at the origin 
and draw as shown in the figure, but ahore resort to "Add Curved Beam" tool (Add Beam 
curved) giving click Left sustained on the icon "Add Beam", ask us a radius of curvature, 
we will enter 3 as the value and we will draw our curved beam based on the radius of 
curvature. 

 

 
 

 
Now select all elements of your screen and activate the "Circular repeat" tool. The configure to 
rotate about the axis "Y", and the fulcrum is placed at the center of our dome that would be the 
case in point three "X", for a total of 360 and 11 as 
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number of times to repeat, configure link for replays and keep the base open, we can see in the 
picture 
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There are also a number of tools that can aid us, as 
is the case of the measurement tools, the first is 
"Dimension" 

 
This tool will generate the dimensions of all items 
displayed on screen, we click on "Display" and 
"Dimension to view" - Dimensions for truth and 
we click the Display button. 

 

 
 

 
 

 
 
 
 

To remove the procedure is the same except that you select the "Remove" option - 
Remover to remove all the legends. 
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If we require only the measurement of a single item select 
the "Display Node to Node Distance" tool Shows the 
distance from node to node-which will cause your cursor 
cursor automatically switch to Nodes, select the node to 
node distance we need . 

 
 

 
 

To remove them you just have to click on the "Remove All Node To Node Distances Display" 
button - Remove all views distances from node to node- 
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4.3 Geometric Generation, Analysis and Design of 
an industrial building 

 
 

We will now work on developing a geometry to a warehouse for further analysis. 
 

We will select the "AddBeams" option and we will work with beams or members and we end 
option. 

 
Workspace where we start to handle the sampling geometry project, a warehouse opens. 

 
It is important to consider using "Snap Node / Beam" (Network 
Node / Beam) as this creates for us a grid where we can enter our 
data, activate the icon This Snap Node / Beam and select the 
"Geometry" option the left side tab 

 
This Grid can be edited to increase the number of spaces in "x" or "y" 

 
 
 
 

We are presented with the window opening STAAD initial work, with the options of the grid, mesh 
or grid enabled on the right we can see the options to edit the mesh (Create, Edit, Copy, Import). 
We are going to click on the "Edit" button to add our Malla spaces. The idea is to draw a profile of 
a warehouse of 16 m. wide by 7 feet high. 
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At the bottom we find the "Snap Node / Beam" button to start tracing the profile of our ship must 
be activated (turns blue) and draw the profile as shown in Fig. Press "Escape" (Esc) to end. 

 

 
 

Already with the first section that will shape our ship, we proceed to the 3D geometry, we can do this 
in several ways, by pressing Ctrl + C to copy and Ctrl + V to paste, the software will ask how far and 
on what axis we glue the copy of our profile. 
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Importantly, on which axis will move our element, "x", "y" or "z" is "z" where we will copy our element and 
moving to create our ship, we will enter the number 5 ok. With the "Add Beams" option (Add beams) we 
will add the beams that it needs our 
structure 

 

 

 
 

 
 
 
 
 
 
 
To create a representation of us let our rails segment our roof with "Insert Node" (Insert Node) tool. Insert 
six intermediate nodes in each of our covers, for that select the beam where we enter the nodes and we 
click on "Insert Nodes", a popup window where we are asked at what points we want to insert our nodes 
appear, we will select for number of nodes to add, we will enter 5, and we will press the "Add n Points" 
button (Add n points) the software will place them equidistant on the selected beam. We OK and do the 
same with the other three beams. 
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Once this process will join the dots to have the desired geometry. We can do it by "Add 
Beams" tool which is based on the location of the nodes we enter the cover to generate 
the beams and get a graphical representation of our structural elements. 
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Another option to perform this task is to select the "Translational Repeat" tool 
(translational repeat). This tool will create a copy or set of copies of the selected items 
and stick to the distance on the axis indicate. We will select all the elements that make 
up our ship and select the tool, we a popup titled "3D Repeat" (3D Repeat) where we 
asked that we enter the data that we will need appears, we will need 7 copies of our 
profile to a distance of 5 m. on the axis "z", we'll configure from the popup. 

 

 
 

The configure as shown in the image, taking into account the axis on which we want the 
displacement copying our elements, which in this case is on the axis "Z" is made 

 
 
 

 
 

 
And we will prove a more composed our warehouse geometry, the last step 



STAAD.Pro V8i MANUAL

356 

 

 

 
 
 

would add contraventeos upper and side to provide stability. 

 
 

Another option is to perform a certain way and fastest way would be from zero to trace 
the profile of our warehouse without making any copies from our deck beams to the 
appropriate nodes from this point using the tool "translational repeat" configuring in the 
same way but instead of adding 8 and 7 copies selecting different "Link steps" and "base 
Open" to generate an open base. Once this geometry only add Add contraventeos with 
Beams tool. 
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After adding the side and top contraventeos we have 
completed our ship geometry. 

 
We begin by applying media, use the Support Page tool 
located at the top right of the interface program. 

 
We popup window appears, select the "Create" Create option to create a new kind of 
support, we will have different types of support, Built (Fixed), Pinned (Articulated), Etc. 
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Fixed selected and click the "Add" button. 
 

It appears we are now on the menu a 
support 2 "Support 2" with a drawing that 
represents the type of support. We will 
place the cursor on the support and select 
the option "Use cursor to Assign" (Use 
cursor to assign), automatically your 
cursor will change to cursor node, we go 
to the icon "View from Z" to see our ship 
from a front view, (icon, along with all the 
views are in the upper left of the window), 
this will help us to select all nodes through 
a single window selection, once made the 
selection nodes are shown in red and will 
enable and autoseleccionará Option 
"Assign to selected Nodes" (Assign 
Selected Nodes) We click on "Assign" 
(Assign). 
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A popup will open to confirm the selection method, we will click "Yes" and we have the 
support conditions. 
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4.3.1 Creating Groups (for such elements). 
 

Within the selected toolbar TOOLS rear tab, select this option the CREATE NEW 
GROUP. It can also be used as a short command Ctrl + G. 

 

 
 

If you are creating a group for the first time within the project, the following dialog 
appears. 
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Where we enter the name of the group that we create as well as the type of team that 
should be recognized STAAD, depending on our project; For the year to use as the name 
of COLUMN group and type of selection we seek will be beamed, referring to the lines of 
your drawing. 

 
 
 
 

 
 

Once you have entered the data, we click OK and it will open a new dialog. 
 

 
 

 
Here we realize that the name of our group was created correctly, but has not been 
selected beams (lines) that form this group in the drawing, to do so, we return to the 
interface of our model and selected lines formed the group created, once selected we will 
click ASSOCIATE TO SELECTED GEOMETRY, as a last step will click in the box 
ASSOCIATE. 
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It is important to note that when you click ASSOCIATE, Box LIST numbers of lines that 
have been associated with this group appear. 
Do the same with all groups that want to create within the project by clicking on the 
box and deposit data CREATE explained above for each of the cases. 

 

 
 

 
In the window building groups will reflect the groups we create in our project; if we remove 
one of the already created groups, select the group in the list (displayed in blue) and you 
click on the DELETE box as shown in the figure above. 
The utility of creating groups is to select faster than doing it line by line, and when any 
changes are made within a group (change of material properties), the change is reflected on 
all lines belonging this group. 
To select a group, within the selected toolbar 
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tab that says SELECT and then the option GROUP BY NAME. Then we click on the 

group you want it to be selected in the model. 
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4.3.2 Assigning materials. 
 

For the placement of materials within our project PAGE PROPERTY choose the option 
that is within our toolbar with the following logo and will click. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

After this we will open a new window, where we select the database section where the 
existing profiles, we will click on the DATABASE SECTION option. 
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We will generate a new window, in the toolbar, select the STEEL, where the different 
countries and their books unfold database option, select the Mexican book and the types 
of industrial profiles in the market will be deployed in the right side shows the various 
dimensions of profiles depending on the characteristics selected from the list; select the size 
you require for the project and then we click on the ADD window. 

 

 
 

 
And continue with the selection of materials and dimensions of all the different profiles to 
use in the project. Materials that have chosen appear in the List window PROPERTIES - 
WHOLE ESTRUCTURE, which at the beginning was blank. 
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For the allocation of materials, select the material you want to apply and then select the 
group you are going to apply that material, group selection we stand in the SELECT option, 
located in the toolbar and choose the GROUP BY NAME option. 

 

 
 

 
Once you select the group to which we will apply the material within the PROPERTIES 
window - select the ASSIGN WHOLE STRUCTURE BEAMS TO SELECTED option and 
finally we click on ASSIGN. 
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4.3.3 Assigning Loads 
 

Once assigned materials, determine the loads applied to the structure and the elements 
that will be affected by such charges. 
Importantly, the charges will be varied depending on the roof system is applied, the number 
of floors that contain our element and the area in which the project is located. 
To determine the loads will click on PAGE LOAD icon and we immediately open a side 
window called LOAD, within this window will place the burdens be allocated. We stand 
by clicking on LOAD CASES DETAILS tab and once it is highlighted blue we click the 
ADD option. 
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Once this is done, we will open a new popup window called ADD NEW LOAD CASES, 
which give high loads that will be considered within the project and the name of these 
charges; as a first step enter the name of the load, then the option TYPE LOADING 
deploy options and select live, dead or wind, depending on the type of cargo that we are 
adding, and finally we will click ADD. 

 

 
 

 
Once we gave high loads, appear LOAD CASES DETAILS tab. We have not added any 
value to the load placed on it (alive) will click on ADD. 
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After this we will open a new popup window called ADD NEW LOAD ITEMS here assign the value 
of the charges and the manner in which they were generated in our elements. To this list we will 
appear with the following options: 

 

o Selfweigth: Dead weight. 
o Nodal Load: load nodal. 
o Member Load: Load the member. 
o Physical Member Load: Load the physical member. 
o Area Load: Loading area 
o Floor Load: floor or floor load. 
o Plate Loads: Loads of plaque. 
o Surface Loads: Loads surface. 
o Solid Loads: Loads solid. 
o Temperature Loads: Loads of temperature. 
o Seismic Loads: Seismic loads. 
o Time History: History of time. 
o Wind Load: Wind load. 
o Snow Load: Snow load. 
o Response Spectra: Response spectra. 
o Repeat Load: Loads of repetition. 
o Frequency: Frequency. 

 
In this case, for our select SELFWEIGTH live load, which is handled as the weight of the building, it 
only once, so the factor will be -1 as it will negatively on the Y axis, and we click ADD. 
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In the case of the dead load, which in this case refers to the weight of the cover and the way this will 
rest on our members; will click on the NODAL LOAD option, if the armor; and select Fy which is on 
the axis will reload our deck, this option will add the amount of KG coming down on node negative 
way, because as we explained the axis will be positive, while the charge is negative and finally we click 
ADD. 

 

 
 

 
To assign this burden, we stand in the list of charges, select the load assigned as dead, 
we select the nodes to which we apply the burden and we click on the ASSIGN TO 
SELECTED NODES option and finally click ASSIGN. 
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In order to add wind load, you must first enter a factor of intensity, it depends on the place where the 
project is located. 
To assign this value, give DEFINITIONS Double-click the option, where we will display a list of options 
and then we put on WIND DEFINITIONS and we click on ADD. 

 
Once we ADD, opens a popup window called ADD NEW: WIND DEFINITIONS, where the 
number of load generating wind that are generated, it will give equal and just click ADD. 

 

 
 
 
 
 
 
 
 
 
 
 
 
Now in our list of charges in the WIND DEFINITIONS option, a new listing that called TYPE 1 which 
is the kind of wind that just add, as a next step we put ourselves in the TYPE 1 and then we click on 
ADD appears. 
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After this procedure, we stand on the load 3 (wind) and we click ADD, we will open a popup 
window called ADD NEW LOAD ITEMS which contains the list explained above, select the WIND 
LOAD option which will bring us a new window called ADD NEW LOAD ITEMS, within this 
range we assign to which we want to take the wind into our building; what we do is set the range 
on the Y axis, to take this as the minimum range 0 (from the floor) and a maximum range will 
enter the greater height of our element in this case is 5 m. and finally we click on ADD. 

 

 
 

 
Having done this for wind load, should not be assigned to any of the elements, as this is 
determined by an address which was declared earlier in the screen shown above. Importantly, 
this happens only in the case of wind load, the two previous loads and you want to show in the 
project, whether they should be assigned to the components of the geometry of the project. 
This part ends all matters relating to the placement of loads within the project, the next step is to 
determine the deformations that have been generated in our element by force loads that have been 
assigned. 
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Finally we generate a combination of loads, ie generate a single charge which included all that we 
have previously generated. 
For this, we have to select LOAD CASES DETAILS tab will click on the button with the ADD option. 

 
 

 
Where we can generate a new window called ADD NEW LOAD CASES, will click on the DEFINE 
COMBINATIONS option to do this change the interface from which we add the combination of loads 
within the dialog box called CASES AVAILABLE LOAD must appear the previously generated loads 
(live load, dead load and wind). 

 

 
 

 
To define the loads that are within our combination must enter them with the icon on the right side 
of the listing of our loads (>) for this first select the load we want within our combination and once 
labeled (giving a click ) give one more click the (>) icon. 
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Once placed on the right side loads that will make up our combination, we include a factor, which 
refers to dictate we Complementary Technical Norms for this specific case because our steel factor 
is 0.9, so we will include that FACTOR value in the column for each of our burdens, once the 
procedure done will click on the ADD option. 

 

 
 
And now, our combination will appear in our list of charges. 
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4.3.4 View Element Deformation 
 

To make this process as a first step we analyze our structure, which is necessary to run an 
analysis within the program, because what has been done so this step is only allocation of 
materials and loads, without actually reflect whether these Elections are right or wrong. 
As a first step we will go to the COMMANDS option found within our 
toolbar, select the ANALYSIS option and select the option PERFORM ANALYSIS. 

 

 
 

Once this done, we will open a popup window called PERFORM ANALYSIS, where we 
indicate what we want to analyze, we will click on the ALL option click OK. 
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This completes the indication of an analysis, although no analysis has been run for 
this, on our toolbar we click on the ANALYZE option and click on the only option is 
RUN ANALYSIS exists or can be generated also CTRL +5. 

 

 
 

 
In doing so, the analysis sheet, where the elements that we contain within our drawing 
shown is generated, and the procedure we have done to reach those results. This window 
is called STAAD AND ANALYSIS DESING. It is important to verify that in this result 
sheet 0 number of errors are handled, otherwise you will have to go back to the drawing 
geometry and correct the irregularities. 

 

 
With no errors, we will continue with the development of the work, which is solely to 
show the results which gives us the program in terms of deformations once we applied 
loads, to determine if the structure is having an allowable deformation within our 
regulations. 
Which depends on the type of material, type of construction and dimensions of this; where 
we apply the Regulation of Complementary Standards. (Table 7.1. Maximum permissible 
vertical displacements in structural elements). 
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The next step is to see the dimensions of movements that were generated in the structural 
elements when implementing different loads above, for this we must change the display 
mode within our interface; we are currently in the MODELING interface to switch to 
postprocessing select this option from the options bar we have at the top of our drawing. 

 

 
 

Once we change our working interface, the window that is generated has also changed, 
as this will allow us to do other things that were previously impossible. 

 



STAAD.Pro V8i MANUAL

378 

 

 

 

 
 

Once we got to this interface, we can now see if the maximum offset values that were 
generated by assigning different loads. 
For this we go to the RESULTS option that appears in our taskbar and then we 
click on the VIEW VALUE option. 

 

 
 

When you select this option we will generate a popup called ANNOTATION, and to 
display the values will click on the BEAM RESULTS tab, and within DISPLACEMENT 
options, we will click on the box Resultant MAX (maximum performance) and finally 
click Annotate. 
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Once the above procedure we perform our construction is shown with the maximum 
displacements (which were selected) both in the columns and beams of our element. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

We can realize that the information we are getting is too much, so our data are pasting 
with each other, so we are looking only appreciate the vertical displacements (columns) 
that are positioned on the axis of the Y` s; for this we select, for this we will go to the 
SELECT tab in the tool bar and then select BEAMS PARALLEL TO without clicking the 
three axes we have (x, y, z) were deployed and select to see the columns axis Y. 
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Once you have selected the columns, which are the parallel beams on the Y axis, we 
will go to the VIEW option found within our toolbar and will click on the VIEW ONLY 
SELECTED OBJECTS option; and so the lines are not selected, which are those that 
are not currently using went out. 

 

 
 

Now, each time I made this process we are seeing in our interface, the maximum 
displacement that are taking the columns. Achieved which follows seen. 
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4.4. Application of seismic structures 
factors 

 

 
In this exercise, a way to apply seismic factors in STAAD PRO V8i structure without the need for 
a study of soil mechanics, or direct reading with GPS, on the specific point of study show. 

 
This method should be taken with reservation because while methods that are acceptable under 
certain criteria used are not 100% accurate but for practical purposes we can generate approximate 
results rather reality. 

 

In this case, make use of two tools is to use one window Response Spectrum and the other will 
support the program overall geo-positioning Google Earth in its latest version. 

 
Next step will describe the design of a tipocolumna element analyzed with consideration of finite 
elements and the element concerned with seismic spectra. 

 
Procedure 

 
1. First we proceed to generate the geometry of our structure or element in this case as stated 

for our exercise we will work with a guy in the option element to plane geometry with the 
following characteristics: 

 

 Three 15 meter vertical elements one placed above the other. 

 

 
FIG. 1 geometric element composition. 

 
Since we have our well-defined geometry continue with the process of defining the material 
of our items, sections and assigning media. 
This action is done from the Menu Structure Tool submenu Property Page, click the button 
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Sets the dialog screen will be displayed, in this define the geometric shape we want for our 
element and size we require. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Fig. 2.‐dimensional assignment of particular profiles. 

 
2. Assign the material; for this specific example, will be as follows: 

 

 Sections 1 and 2 of concrete with dimensions YD = 2.8m, 1.4m ZD = 
 Section 3 of concrete with dimensions YD = 2.22, ZD = 1.11m 

 

 
 

Fig.3. Definition of material elements. 
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NoteThe process of assigning properties to the structural elements has already been discussed in other sections so for 
practical purposes of this exercise will not be extended explanation. 

 

 
If the material allocation process was successful our element should look like the following figure. 

 

 
 

Fig. 4. material Assignment elements. 
 

3. After that proceed to the allocation of support in a way very similar to the allocation of our 
material structural elements. This procedure is conducted from the Structure Tools menu, sub 
menu Support Page. 

 
For the particular case of this exercise two different types of media were used one will be a 
predefined type of support FIXED and three more will be the type FIXED BUT, this type 
of support is assigned to a node when it wants to establish degree of freedom 

shift and we can choose the window Create Support,  Fixed sub menu 
But, for our exercise the degree of freedom is assigned in FX, but you can assign 
any direction or direction required. 

 
 

Note: The allocation process supports the structural elements has already been addressed in other 
sections so for practical purposes of this exercise, the explanation does not extend. 
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If the allocation procedure was performed properly supports our exercise should look like the following 
figure. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
FIG. 5 Assignment supports our elements. 

 

Note: we can see that at nodes 2, 3 and 4 a symbol of three colors is placed with a particular 
symbology, they are indicating that it is a node with freedom of movement, should not be viewed 
just enough to activate the label Nodes, Support. 

 
4. Now that we have our well defined both geometrically in props and materials, proceed to 

the definition and application of forces and loads acting on different elements of our 
structure. 

 
In the case of our particular exercise will only use lateral loads on the nodes which represent our 
structure seismic forces. Later these forces will be affected by factors of seismic forces. 

 
Following are the steps for performing the method of the above actions. 

 
1. Assign the following nodal forces: 

 

 Nodes 2 and 3 = FX 400 
 Node 4 = FX 200 
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For this, we first define our first charge which we call MASS NODES (FORCES AS), do this from the 
Structure Tools menu, submenu Load Page‐Load Cases Details-New-Load Case. If done correctly the action 
will see a screen 
as in the figure below. 

 

 

 
 

FIG. 6 Defining our group of forces. 
 

2. After our arguments in the group of forces that define and give just click the button New to 
create the forces that we act on our structure, our exercise we will create two nodal forces: 

 

 In nodes 2 and 3 FX = 200 
 In node 4 FX = 400 

 

This can be done from the window Load-New Items-Nodal-Load Load. 
 

3. Immediately after this step we have to do is specify our analysis parameters, which can be 
determined from Load-New-Frequency Load Items- and the two options are Rayleigh 
Frequency and Modal Calculation will be elected. 

 

 
 

Fig.7. Assigning nodal forces and calculation parameters. 
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From this point the only thing we lack is our define seismic spectrum. We do this from the window 
Load-New Items-Load-Response Spectra, correctly follows the procedure will see a screen like the one 
shown below. 

 
 
 

 
FIG. 8 Calculation of Response Spectra. 

 
 
 

For this step the STAAD PRO V8i program asks us to introduce seismic spectra obtained from a 
study of soil mechanics or give us the option we generated a list from the same program with the IBC 
Spectrum Generate button, so we click on that button and we were presented a screen like the 
following. 
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FIG. 9 Seismic Parameters Generation 
Spectrum. 
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We can see that on this screen shows one Latitude and Length and a predetermined Select Zip 
already preset in this screen you can modify the Select Zip and we automatically generates a latitude, 
longitude, and values for the parameters S1 and S2; 
also have an opportunity to change the interval at which we want our results to generate spectra and 
the duration of the seismic event. 

 
To start this procedure first thing we have to do is modify the geographic coordinates since we are not 
assigned by default we want; But how we can get this data? 

 
 

There are several ways to obtain the geographical coordinates we need to generate the data (longitude 
and latitude) STAAD.Pro V8i program that asks us as a requirement for our seismic spectrum, there 
are direct methods and indirect methods. 

 
The most common direct methods are to conduct a survey with a total station, being the owner of 
a Garmin GPS or a satellite, or know how to perform an astronomical orientation for which a 
theodolite must be taken first and a current almanac and neither mentioning that depend on it is 
not a cloudy day. 

 

Because of the complications that can result in the implementation of any of these direct methods 
above are indirect methods which in most are programs that provide the coordinates depending on 
the region you want, some of these programs are free and some others we can buy. In this case the 
use of a free license program and extensive use is proposed, this program is  Google 
Earth. 

 

 
 

Fig. Presentation 10 Display Google Earth 
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If you already know this program or are somewhat familiar know that in the bottom of the main 
screen is going to allow you to see the coordinates of the point you're pointing the pointer but default 
gives the coordinates as Rumbo, but what we want is the coordinates in decimal degrees. 

 
Below are examples of the coordinates in the decimal form and shape Degrees, Minutes and Seconds 
(Rumbo) are given. 

 
Coordinates in decimal. 

 

Latitude  19.432620,  ‐99.133218 
Long 

 
Coordinates as Degrees, Minutes and Seconds (Rumbo). 

 

19 ° 25'57 "N, 99 ° 07'59" W (west) 

 
For us, the coordinates that will help us be the coordinates in decimal and to make the Google Earth 
we generate this type of coordinates we have to set it up very easily just have to open the Tools menu, 
select options and view 3D to show lat. / long and change of Degrees, Minutes, Seconds to Decimal 
Degrees. 

 

 

 
Fig. Configuration 11 coordinates in decimal degrees. 

 
Since we have configured the way coordinates that remains is selecting the area where our structure 
is found and get the coordinates that Google Earth creates us is. 
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This does not have to be as accurate as we know that seismic frequencies do not vary much in small 
sections, so just simply choose an approximate point. 

 

 
 

 
Fig. 12. location coordinates in Google Earth. 

 
The next step is to capture the coordinates in the Spectrum Parameters window so in our case should 
be. 

 
Latitude and Longitude = 19.435738 = -99.143957m, we click on the Calculate S1, SS button, modify 
the duration of the seismic event at 60 seconds and 1 second intervals so that we generate only 60 
points of the spectrum, then you click on the Generate button Spectrum. 

 
After these steps STAAD generate a graph to show the intensities (displacement, velocity and 
acceleration) of the seismic event throughout its duration. 

 
The chart shown below is generated corresponding to the spectrum for our particular exercise. 
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Fig. Grafica 13 seismic acceleration spectrum. 
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This chart is for informational purposes only so that we proceed to close it. 
 

After close back to the window Response Spectrum with Spectrum Table table and with data and a 
chart on this window you can also choose the Combination Method spectrum with the forces being 
the most common SRSS and CQC, the Code section is in Custom , choose the type of interpolation 
between Linear and Logarithmic, note the X direction with a value of 1 and we click on the Add button. 

This is the last step as we can see after assigning spectrum applied in our window Load. 
 

 
Fig.14 seismic spectrum assigned. 

 

 

391 
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This concludes the process of assigning seismic, our structure spectrum. 
 

The process just described throughout this exercise for spectrum allocation is the same for any 
kind of structure. 

 
In this exercise only aims to show the process of spectrum allocation in the simplest form so no load 
combinations or other forces are carried as air, or a variety of combinations of loads that may occur 
include snow in our structures. 

 
To complete the analytical text editor STAAD attached. (In the case of editor spectra are generated at 
intervals of 0.05 sec. Duration of the event and 10 sec.'s Why there are many interpolation points of 
the spectrum.) 

 

STAAD SPACE 
ENGINEER JOB INFORMATION START DATE 09‐Aug‐12 

END JOB INFORMATION 

INPUT WIDTH 79 

JOINT 
COORDINATES UNIT 
METER MTON 

1 0 0 0; 2 0 15 0; 3 0 30 0; 4 0 45 0; 

MEMBER INCIDENCES 

1 1 2; 2 2 3; 3 3 4; 

DEFINE MATERIAL START 

ISOTROPIC 2.02147e 

CONCRETE E + 006 0.17 

POISSON 

DENSITY 2.40262 

ALPHA DAMP 0.05 

1e‐005 

END DEFINE MATERIAL 

AMERICAN MEMBER 

PROPERTY January 2nd PRIS YD 

ZD 2.8 1.4 

PRIS YD ZD 3 2.22 1.11 
CONSTANTS 
SUPPORTS ALL MATERIAL CONCRETE 

1 FIXED 
2 FIXED BUT TO 4 FX 
1 MASS LOAD NODE (AS FORCES) 

JOINT LOAD 

4 FX 200 

March 2 FX 400 
CALCULATE FREQUENCY RAYLEIGH 

MODAL CALCULATION REQUESTED 
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SRSS SPECTRUM SCALE 1 x 1 ACC 0 LIN MY DAMP 
0 0.106863; 0.05 0.108356; 0.1 0.109848; 0.15 0.111341; 0.2 0.112834; 
0.25 0.114326; 0.3 0.115819; 0.35 0.117312; 0.4 0.118804; 0.45 
0.120297; 
0.5 0.12179; 0.55 0.123282; 0.6 0.124775; 0.65 0.126268; 0.7 0.12776; 
0.75 0.129253; 0.8 0.130746; 0.85 0.132238; 0.9 0.133731; 0.95 
0.135224; 
1 0.136716; 1.05 0.138209; 1.1 0.139701; 1.15 0.141194; 1.2 0.142687; 
1.25 0.144179; 1.3 0.145672; 1.35 0.147165; 1.4 0.148657; 1.45 0.15015; 
1.5 0.151643; 1.55 0.153135; 1.6 0.154628; 1.65 0.156121; 1.7 0.157613; 
1.75 0.159106; 1.8 0.160599; 1.85 0.162091; 1.9 0.163584; 1.95 
0.165077; 
2 0.166569; 2.05 0.168062; 2.1 0.169555; 2.15 0.171047; 2.2 0.17254; 
2.25 0.174033; 2.3 0.175525; 2.35 0.177018; 2.4 0.178511; 2.45 
0.180003; 

2.5 0.181496; 2.55 0.182989; 2.6 0.184481; 2.65 0.185974; 2.7 0.187466; 
2.75 0.188959; 2.8 0.190452; 2.85 0.191944; 2.9 0.193437; 2.95 0.19493; 

 
 
 
 
 
 
 

The last point on this line can be 

interpreted as an error by the system 

so the editor will have to move to a 

new line to avoid error in the run 

3 0.196422; 3.05 0.197915; 3.1 0.199408; 3.15 0.2009; 3.2 0.202393; 3.25 0.203886; 
3.3 0.205378; 3.35 0.206871; 3.4 0.208364; 3.45 0.209856; 3.5 0.211349; 
3.55 0.212842; 3.6 0.214334; 3.65 0.215827; 3.7 0.21732; 3.75 0.218812; 
3.8 0.220305; 3.85 0.221798; 3.9 0.22329; 3.95 0.224783; 4 0.226276; 
4.05 0.227768; 4.1 0.229261; 4.15 0.230754; 4.2 0.232246; 4.25 0.233739; 
4.3 0.235232; 4.35 0.236724; 4.4 0.238217; 4.45 0.239709; 4.5 0.241202; 
4.55 0.242695; 4.6 0.244187; 4.65 0.24568; 4.7 0.247173; 4.75 0.248665; 
4.8 0.250158; 4.85 0.251651; 4.9 0.253143; 4.95 0.254636; 5 0.256129; 

5.05 0.257621; 5.1 0.259114; 5.15 0.260607; 5.2 0.262099; 5.25 0.263592; 
5.3 0.265085; 5.35 0.266577; 5.36944 0.267158; 5.41944 0.267158; 5.46944 
0.267158; 
5.51944 0.267158; 5.56944 0.267158; 5.61944 0.267158; 5.66944 0.267158; 
5.71944 0.267158; 5.76944 0.267158; 5.81944 0.267158; 5.86944 0.267158; 
5.91944 0.267158; 5.96944 0.267158; 6.01944 0.267158; 6.06944 0.267158; 
6.11944 0.267158; 6.16944 0.267158; 6.21944 0.267158; 6.26944 0.267158; 
6.31944 0.267158; 6.36944 0.267158; 6.41944 0.267158; 6.46944 0.267158; 
6.51944 0.267158; 6.56944 0.267158; 6.61944 0.267158; 6.66944 0.267158; 
6.71944 0.267158; 6.76944 0.267158; 6.81944 0.267158; 6.86944 0.267158; 
6.91944 0.267158; 6.96944 0.267158; 7.01944 0.267158; 7.06944 0.267158; 
7.11944 0.267158; 7.16944 0.267158; 7.21944 0.267158; 7.26944 0.267158; 

7.31944 0.267158; 7.36944 0.267158; 7.41944 0.267158; 7.46944 0.267158; 
7.51944 0.267158; 7.56944 0.267158; 7.61944 0.267158; 7.66944 0.267158; 
7.71944 0.267158; 7.76944 0.267158; 7.81944 0.267158; 7.86944 0.267158; 
7.91944 0.267158; 7.96944 0.267158; 8.01944 0.267158; 8.06944 0.267158; 
8.11944 0.267158; 8.16944 0.267158; 8.21944 0.267158; 8.26944 0.267158; 
8.31944 0.267158; 8.36944 0.267158; 8.41944 0.267158; 8.46944 0.267158; 
8.51944 0.267158; 8.56944 0.267158; 8.61944 0.267158; 8.66944 0.267158; 
8.71944 0.267158; 8.76944 0.267158; 8.81944 0.267158; 8.86944 0.267158; 
8.91944 0.267158; 8.96944 0.267158; 9.01944 0.267158; 9.06944 0.267158; 
9.11944 0.267158; 9.16944 0.267158; 9.21944 0.267158; 9.26944 0.267158; 

9.31944 0.267158; 9.36944 0.267158; 9.41944 0.267158; 9.46944 0.267158; 
9.51944 0.267158; 9.56944 0.267158; 9.61944 0.267158; 9.66944 0.267158; 
9.71944 0.267158; 9.76944 0.267158; 9.81944 0.267158; 9.86944 0.267158; 
9.91944 0.267158; 9.96944 0.267158; 10.0194 0.267158; 10.0694 0.267158; 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The  last point on this  line can be 
interpreted  as  an  error  by  the 
system so the editor will have to 
move to a new line to avoid error 
in the run 
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10.1194 0.267158; 10.1694 0.267158; 10.2194 0.267158; 10.2694 0.267158; 
10.3194 0.267158; 10.3694 0.267158; 10.4194 0.267158; 10.4694 0.267158; 
10.5194 0.267158; 10.5694 0.267158; 10.6194 0.267158; 10.6694 0.267158; 
10.7194 0.267158; 10.7694 0.267158; 10.8194 0.267158; 10.8694 0.267158; 
10.9194 0.267158; 10.9694 0.267158; 11.0194 0.267158; 11.0694 0.267158; 
11.1194 0.267158; 11.1694 0.267158; 11.2194 0.267158; 11.2694 0.267158; 
11.3194 0.267158; 11.3694 0.267158; 11.4194 0.267158; 11.4694 0.267158; 
11.5194 0.267158; 11.5694 0.267158; 11.6194 0.267158; 11.6694 0.267158; 
11.7194 0.267158; 11.7694 0.267158; 11.8194 0.267158; 11.8694 0.267158; 
11.9194 0.267158; 11.9694 0.267158; 12.0194 0.267158; 12.0694 0.267158; 
12.1194 0.267158; 12.1694 0.267158; 12.2194 0.267158; 12.2694 0.267158; 

12.3194 0.267158; 12.3694 0.267158; 12.4194 0.267158; 12.4694 0.267158; 
12.5194 0.267158; 12.5694 0.267158; 12.6194 0.267158; 12.6694 0.267158; 
12.7194 0.267158; 12.7694 0.267158; 12.8194 0.267158; 12.8694 0.267158; 
12.9194 0.267158; 12.9694 0.267158; 13.0194 0.267158; 13.0694 0.267158; 
13.1194 0.267158; 13.1694 0.267158; 13.2194 0.267158; 13.2694 0.267158; 
13.3194 0.267158; 13.3694 0.267158; 13.4194 0.267158; 13.4694 0.267158; 
13.5194 0.267158; 13.5694 0.267158; 13.6194 0.267158; 13.6694 0.267158; 
13.7194 0.267158; 13.7694 0.267158; 13.8194 0.267158; 13.8694 0.267158; 
13.9194 0.267158; 13.9694 0.267158; 14.0194 0.267158; 14.0694 0.267158; 
14.1194 0.267158; 14.1694 0.267158; 14.2194 0.267158; 14.2694 0.267158; 

14.3194 0.267158; 14.3694 0.267158; 14.4194 0.267158; 14.4694 0.267158; 
14.5194 0.267158; 14.5694 0.267158; 14.6194 0.267158; 14.6694 0.267158; 
14.7194 0.267158; 14.7694 0.267158; 14.8194 0.267158; 14.8694 0.267158; 
14.9194 0.267158; 14.9694 0.267158; 15.0194 0.267158; 15.0694 0.267158; 
15.1194 0.267158; 15.1694 0.267158; 15.2194 0.267158; 15.2694 0.267158; 
15.3194 0.267158; 15.3694 0.267158; 15.4194 0.267158; 15.4694 0.267158; 
15.5194 0.267158; 15.5694 0.267158; 15.6194 0.267158; 15.6694 0.267158; 
15.7194 0.267158; 15.7694 0.267158; 15.8194 0.267158; 15.8694 0.267158; 
15.9194 0.267158; 15.9694 0.267158; 16.0194 0.267158; 16.0694 0.267158; 
16.1194 0.267158; 16.1694 0.267158; 16.2194 0.267158; 16.2694 0.267158; 
16.3194 0.267158; 16.3694 0.267158; 16.4194 0.267158; 16.4694 0.267158; 

16.5194 0.267158; 16.5694 0.267158; 16.6194 0.267158; 16.6694 0.267158; 
16.7194 0.267158; 16.7694 0.267158; 16.8194 0.267158; 16.8694 0.267158; 
16.9194 0.267158; 16.9694 0.267158; 17.0194 0.267158; 17.0694 0.267158; 
17.1194 0.267158; 17.1694 0.267158; 17.2194 0.267158; 17.2694 0.267158; 
17.3194 0.267158; 17.3694 0.267158; 17.4194 0.267158; 17.4694 0.267158; 
17.5194 0.267158; 17.5694 0.267158; 17.6194 0.267158; 17.6694 0.267158; 
17.7194 0.267158; 17.7694 0.267158; 17.8194 0.267158; 17.8694 0.267158; 
17.9194 0.267158; 17.9694 0.267158; 18.0194 0.267158; 18.0694 0.267158; 
18.1194 0.267158; 18.1694 0.267158; 18.2194 0.267158; 18.2694 0.267158; 
18.3194 0.267158; 18.3694 0.267158; 18.4194 0.267158; 18.4694 0.267158; 

18.5194 0.267158; 18.5694 0.267158; 18.6194 0.267158; 18.6694 0.267158; 
18.7194 0.267158; 18.7694 0.267158; 18.8194 0.267158; 18.8694 0.267158; 
18.9194 0.267158; 18.9694 0.267158; 19.0194 0.267158; 19.0694 0.267158; 
19.1194 0.267158; 19.1694 0.267158; 19.2194 0.267158; 19.2694 0.267158; 
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19.3194 0.267158; 19.3694 0.267158; 19.4194 0.267158; 19.4694 0.267158; 
19.5194 0.267158; 19.5694 0.267158; 19.6194 0.267158; 19.6694 0.267158; 
19.7194 0.267158; 19.7694 0.267158; 19.8194 0.267158; 19.8694 0.267158; 
19.9194 0.267158; 19.9694 0.267158; 20.0194 0.267158; 20.0694 0.267158; 
20.1194 0.267158; 20.1694 0.267158; 20.2194 0.267158; 20.2694 0.267158; 
20.3194 0.267158; 20.3694 0.267158; 20.4194 0.267158; 20.4694 0.267158; 
20.5194 0.267158; 20.5694 0.267158; 20.6194 0.267158; 20.6694 0.267158; 
20.7194 0.267158; 20.7694 0.267158; 20.8194 0.267158; 20.8694 0.267158; 
20.9194 0.267158; 20.9694 0.267158; 21.0194 0.267158; 21.0694 0.267158; 
21.1194 0.267158; 21.1694 0.267158; 21.2194 0.267158; 21.2694 0.267158; 
21.3194 0.267158; 21.3694 0.267158; 21.4194 0.267158; 21.4694 0.267158; 

21.5194 0.267158; 21.5694 0.267158; 21.6194 0.267158; 21.6694 0.267158; 
21.7194 0.267158; 21.7694 0.267158; 21.8194 0.267158; 21.8694 0.267158; 
21.9194 0.267158; 21.9694 0.267158; 22.0194 0.267158; 22.0694 0.267158; 
22.1194 0.267158; 22.1694 0.267158; 22.2194 0.267158; 22.2694 0.267158; 
22.3194 0.267158; 22.3694 0.267158; 22.4194 0.267158; 22.4694 0.267158; 
22.5194 0.267158; 22.5694 0.267158; 22.6194 0.267158; 22.6694 0.267158; 
22.7194 0.267158; 22.7694 0.267158; 22.8194 0.267158; 22.8694 0.267158; 
22.9194 0.267158; 22.9694 0.267158; 23.0194 0.267158; 23.0694 0.267158; 
23.1194 0.267158; 23.1694 0.267158; 23.2194 0.267158; 23.2694 0.267158; 
23.3194 0.267158; 23.3694 0.267158; 23.4194 0.267158; 23.4694 0.267158; 

23.5194 0.267158; 23.5694 0.267158; 23.6194 0.267158; 23.6694 0.267158; 
23.7194 0.267158; 23.7694 0.267158; 23.8194 0.267158; 23.8694 0.267158; 
23.9194 0.267158; 23.9694 0.267158; 24.0194 0.267158; 24.0694 0.267158; 
24.1194 0.267158; 24.1694 0.267158; 24.2194 0.267158; 24.2694 0.267158; 
24.3194 0.267158; 24.3694 0.267158; 24.4194 0.267158; 24.4694 0.267158; 
24.5194 0.267158; 24.5694 0.267158; 24.6194 0.267158; 24.6694 0.267158; 
24.7194 0.267158; 24.7694 0.267158; 24.8194 0.267158; 24.8694 0.267158; 
24.9194 0.267158; 24.9694 0.267158; 25.0194 0.267158; 25.0694 0.267158; 
25.1194 0.267158; 25.1694 0.267158; 25.2194 0.267158; 25.2694 0.267158; 
25.3194 0.267158; 25.3694 0.267158; 25.4194 0.267158; 25.4694 0.267158; 
25.5194 0.267158; 25.5694 0.267158; 25.6194 0.267158; 25.6694 0.267158; 

25.7194 0.267158; 25.7694 0.267158; 25.8194 0.267158; 25.8694 0.267158; 
25.9194 0.267158; 25.9694 0.267158; 26.0194 0.267158; 26.0694 0.267158; 
26.1194 0.267158; 26.1694 0.267158; 26.2194 0.267158; 26.2694 0.267158; 
26.3194 0.267158; 26.3694 0.267158; 26.4194 0.267158; 26.4694 0.267158; 
26.5194 0.267158; 26.5694 0.267158; 26.6194 0.267158; 26.6694 0.267158; 
26.7194 0.267158; 26.7694 0.267158; 26.8194 0.267158; 
PERFORM ANALYSIS PRINT ALL 

FINISH 
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4.5 Generation of earthquake loads in the Z 
direction and earthquake loads in the X direction 

 
 
This exercise will be carried out by entering data written to the STAAD editor. Yes you have not yet 
opened a STAAD file, open a new file in the footsteps of past tutorials and practical exercises in this 
section. With the difference in choosing the "Open STAAD Editor" option in the window of "Where 
do you want to go?", As shown in the following figure. 

 

 
 
Dale click Finish to enter the editor interface. Yes you have a file open, you can access the editor 
directly from the STAAD Editor command located in the toolbar. 
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A window like the following appears. This window is the STAAD Editor, where we will enter the 
commands in order of relevance, as the tutorials described in your procedure. 

 

 
 

 
 

The STAAD editor text reflects the step tutorials and prior years typically using the 
graphical user interface (GUI) with graphical methods or structures assistant. So the first step to 
write to the editor are the units (Before sure to delete the last line "FINISH" command: 

 

UNIT METER MTON 
 

 
The next step is to set the coordinates where the nodes are located in the structure: 

 

Node 
Number 

 

 
 
 

JOINT COORDINATES 

 
Coordinate 
X Y Z 

1 0 0 0; 2 3 0 0; 3 0 4 0; 4 3 4 0; 5 0 8 0; 6 3 8 0; 7 0 0 3; 8 3 0 3; 
9 0 4 3; March 10 April 3; 11 0 8 3; 12 3 8 3; 
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The first number indicates the number of the node, the following indicates the coordinate on X, the 
following indicates the Y coordinate so on down to the Z coordinate, the data nodes are separated by 
a semicolon (;). 
It continues to tell the program which few beams and node to which node will be linked as follows: 

 

Initial node (home 
of the beam) 

 

 

Item 
number 

 
MEMBER INCIDENCES 
March 1 4; 2 5 6; 3 1 3; 4 2 4; 5 3 5; 6 4 6; September 7, 10; August 11, 12; 9 
7 9; August 10, 10; 
November 9, 11; October 12, 12; March 13 9; April 14, 10; May 15, 11; June 
16, 12; 

 
 

End node (end of 
the beam) 

 

 
 
 
In a similar way as the nodes, the first number indicates the number of the element, followed by the 
initial node; ie that point begins our beam in question and the following number indicates where it ends, 
each element separated by a semicolon. 

 
Once given the geometry of the structure, the material to be used in the analysis is defined. It is 
important to tell the program that will define a title (DEFINE MATERIAL START), followed by the 
type of material involved and the constants of the same (constants can vary and take into account the 
insertion units), as shown below : 

 
DEFINE MATERIAL CONCRETE 
START ISOTROPIC 
E 2.21467e +006 
POISSON 0.17 
DENSITY 2.40262 
ALPHA DAMP 0.05 
1e‐005 
END DEFINE MATERIAL 

 

 
Then it is necessary to indicate the properties of the elements; that is, the dimensions of the section and 
of which the material is composed. In this case the properties of American standards and concrete 
material to set the whole structure. 

 
MEMBER PROPERTY AMERICAN 
PRIS 1 TO 16 YD 0.2 ZD 0.2 
CONSTANTS 
ALL MATERIAL CONCRETE 

 
Once defined the properties, we proceed with braces indicate starting with writing the word 
"SUPPORTS" in which embedded support (FIXED) was placed in all lower nodes (1, 2, 7, 8) 

 
SUPPORTS 
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1 2 7 8 FIXED 
 
 
 
The next step is to propose the load cases to be presented in the structure, the order of integration is 
to define the number and load case followed by the title we assign. Types of loads (distributed load, 
concentrated, etc.) followed by the listed items to be assigned to these loads are then written. The 
order of the types of loads is indistinct, it is important to be careful with data entry. 

 

LOAD 1 LOADTYPE None TITLE C. M. 
SELFWEIGHT Y ‐1 1 TO 16 MEMBER 
LIST LOAD 
1 2 7 8 13 to 16 UNI GY ‐0.5 
LOAD 2 LOADTYPE None TITLE C.V. 
MEMBER LOAD 
1 2 7 8 13 to 16 UNI GY ‐0.2 
LOAD 3 LOADTYPE None EARTHQUAKE IN TITLE X 
SELFWEIGHT X ‐1 1 TO 16 MEMBER 
LIST LOAD 
1 2 7 8 13 to 16 ‐0.5 UNI GX 
MEMBER LOAD 
1 2 7 8 13 to 16 ‐0.2 GX UNI 
LOAD 4 LOADTYPE None EARTHQUAKE IN 
TITLE SELFWEIGHT Z ‐1 Z LIST 1 TO 16 
MEMBER LOAD 
1 2 7 8 13 to 16 ‐0.5 UNI GZ 
MEMBER LOAD 
1 2 7 8 13 to 16 ‐0.2 GZ UNI 

 

 
In addition to physical loads, a load combination where some factors increase to these loads are applied and 
combined with other defined. As an example, an increase of 10% (1.1) as a combination of load for all cases 
was assumed, you can follow the specific rules; either ACI, LRFD or NTC: 

 
LOAD COMB CASE LOAD COMBINATION 5 5 
1 1.1 2 1.1 3 1.1 4 1.1 

 

 
Within the analysis, only need to define what type of analysis must be used. Because concrete is 
governed by the plastic theories or ultimate strength theories, these theories are not elastic-linear 
(as in the case of steel), so that the analysis used is that PDELTA: 

 

 
ANALYSIS PDELTA 

 
 
 
Finally we proceed to design the concrete elements, for that the initial command, followed by the code 
to which the design is based (in this case will be ACI), then by the design parameters, such as writes 
coatings reinforcement The compressive stress, the yield stress, the type of printing (TRACK). The values 
used in this exercise are the default, you can 
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another basis. For the output file sections with steel reinforcement is displayed, you must indicate the 
"DESIGN BEAM" and "DESIGN COLUMN" to corresponding elements, finalizing the design of 
specific commands. For more information, see section 5 of the technical manual. 

START CONCRETE DESIGN 
ACI CODE 
ALL 0.0381 CLB 
ALL CLS 0.0381 
ALL CLT 0.0381 
ALL FC 2812.3 
FYMAIN 42184.4 ALL 
TRACK 1 ALL 
DESIGN BEAM 1 2 7 8 13 to 16 
DESIGN COLUMN 3 June 9 TO 12 TO 
END CONCRETE DESIGN 

 
To finish the analysis and design, type FINISH as last line. Yes you correctly followed all the above 
steps, the final text will look like below (the difference is only in the date): 

STAAD SPACE 
ENGINEER JOB 
INFORMATION START 
DATE 17‐Jan‐14 END JOB 
INFORMATION INPUT 
WIDTH 79 
UNIT METER MTON 
JOINT COORDINATES 
1 0 0 0; 2 3 0 0; 3 0 4 0; 4 3 4 0; 5 0 8 0; 6 3 8 0; 7 0 0 3; 8 3 0 3; 
9 0 4 3; March 10 April 3; 11 0 8 3; 
12 3 8 3; MEMBER INCIDENCES 
March 1 4; 2 5 6; 3 1 3; 4 2 4; 5 3 5; 6 4 6; September 7, 10; August 
11, 12; 9 7 9; August 10 
10; 
November 9, 11; October 12, 12; March 13 9; April 14, 
10; May 15, 11; June 16, 12; DEFINE MATERIAL START 
ISOTROPIC 2.21467e 
CONCRETE E + 006 
0.17 POISSON 
DENSITY 2.40262 
ALPHA DAMP 0.05 
1e‐005 
END DEFINE MATERIAL 
MEMBER PROPERTY AMERICAN 
PRIS 1 TO 16 YD 0.5 ZD 0.4 
CONSTANTS 
ALL MATERIAL CONCRETE 
SUPPORTS 
1 2 7 8 FIXED 
LOAD 1 LOADTYPE None TITLE C. M. 
SELFWEIGHT ‐1 LIST AND 1 TO 16 
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MEMBER LOAD 
1 2 7 8 13 to 16 UNI GY ‐0.5 
LOAD 2 LOADTYPE None TITLE C.V. 
MEMBER LOAD 
1 2 7 8 13 to 16 UNI GY ‐0.2 
LOAD 3 LOADTYPE None EARTHQUAKE IN TITLE X 
SELFWEIGHT X ‐1 1 TO 16 MEMBER 
LIST LOAD 
1 2 7 8 13 to 16 ‐0.5 UNI GX 
MEMBER LOAD 
1 2 7 8 13 to 16 ‐0.2 GX UNI 
LOAD 4 LOADTYPE None EARTHQUAKE IN TITLE 
SELFWEIGHT Z ‐1 Z LIST 1 TO 16 
MEMBER LOAD 
1 2 7 8 13 to 16 ‐0.5 UNI GZ 
MEMBER LOAD 
1 2 7 8 13 to 16 ‐0.2 GZ UNI 
LOAD COMB CASE LOAD COMBINATION 5 5 
1 1.1 2 1.1 3 1.1 4 1.1 
ANALYSIS PDELTA 
ACI CONCRETE DESIGN CODE 
START 
ALL 0.0381 CLB 
ALL CLS 0.0381 
ALL CLT 0.0381 
ALL FC 2812.3 
FYMAIN 42184.4 ALL 
TRACK 1 ALL 
DESIGN BEAM 1 2 7 8 13 to 16 
DESIGN COLUMN 3 June 9 TO 12 TO 
END CONCRETE DESIGN 
FINISH 

 
You give save button located in the toolbar of the editor window STAAD. Then, you set yourself on 
the FILE tab, select the EXIT option to exit the editor. 
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The structure with details of load cases written with STAAD editor should be displayed like the 
following figure: 

 

 
 
 
 
The next step is to define the seismic spectrum (Response Spectrum) that occurs at the site of the 
building that is being designed. For this we place ourselves in the case of load EARTHQUAKE IN 
X, then give ... Add / Response Spectra / Response Spectrum and the following window will open. 
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Unlike the previous practical exercise, we will not use any other program to obtain the required 
parameters. This time we will use values previously collected by the Environmental Attorney and 
Zoning of the Federal District in its regulation of the additional technical standards (NTC-DF) as the 
location where "build" building example in the Mexican capital. The values are shown in the following 
table: 

 

T  C  ao  Ta  Tb  r  to  Q  Q '  a / Q ' 

0.00  0.16  0.04  0.20  1.35 1.00 0.04 2.00 1.6  0,025

0.20  0.16  0.04  0.20  1.35  1.00  1.08  2.00  1.6  0,675 

0.40  0.16  0.04  0.20  1.35  1.00  0.54  2.00  1.6  0,338 

0.60  0.16  0.04  0.20  1.35  1.00  0.36  2.00  1.6  0,225 

0.80  0.16  0.04  0.20  1.35  1.00  0.27  2.00  1.6  0,169 

1.00  0.16  0.04  0.20  1.35  1.00  0.22  2.00  1.6  0,135 

1.20  0.16  0.04  0.20  1.35 1.00 0.18 2.00 1.6  0,113

1.40  0.16  0.04  0.20  1.35  1.00  0.15  2.00  1.6  0,096 

1.60  0.16  0.04  0.20  1.35  1.00  0.14  2.00  1.6  0,084 

1.80  0.16  0.04  0.20  1.35  1.00  0.12  2.00  1.6  0,075 

2.00  0.16  0.04  0.20  1.35  1.00  0.11  2.00  1.6  0,068 

2.20  0.16  0.04  0.20  1.35  1.00  0.10  2.00  1.6  0,061 

2.40  0.16  0.04  0.20  1.35 1.00 0.09 2.00 1.6  0,056

2.60  0.16  0.04  0.20  1.35  1.00  0.08  2.00  1.6  0,052 

2.80  0.16  0.04  0.20  1.35  1.00  0.08  2.00  1.6  0,048 

3.00  0.16  0.04  0.20  1.35  1.00  0.07  2.00  1.6  0,045 

3.20  0.16  0.04  0.20  1.35  1.00  0.07  2.00  1.6  0,042 

3.40  0.16  0.04  0.20  1.35  1.00  0.06  2.00  1.6  0,040 

3.60  0.16  0.04  0.20  1.35 1.00 0.06 2.00 1.6  0,038

3.80  0.16  0.04  0.20  1.35  1.00  0.06  2.00  1.6  0,036 

4.00  0.16  0.04  0.20  1.35  1.00  0.05  2.00  1.6  0,034 

4.20  0.16  0.04  0.20  1.35  1.00  0.05  2.00  1.6  0,032 

4.40  0.16  0.04  0.20  1.35  1.00  0.05  2.00  1.6  0,031 

4.60  0.16  0.04  0.20  1.35  1.00  0.05  2.00  1.6  0,029 

4.80  0.16  0.04  0.20  1.35 1.00 0.05 2.00 1.6  0,028

5.00  0.16  0.04  0.20  1.35  1.00  0.04  2.00  1.6  0,027 

 
 
In the section of the popup in STAAD called Spectrum Table, put the values shown in the table 
above, using nothing but green columns. The column named T sticks called Period column and the 
last column named a / Q ' is 
paste in the column entitled Acc (m / sec 2). As shown below. 
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After only activate the option in paragraph X direction, giving a value of 1 We write 9.81 as the scale 
in paragraph Others, leaving all the default options. As shown in the figure below: 
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Then we give Add, then click Close to close the window and perform the same step for the load case 
EARTHQUAKE IN Z, with the only difference that activate the option in the Z direction section also 
giving a value of 1. 

 

 
 
 
 

Once entered the data of seismic response spectrum in both horizontal directions (X and Z), the next 
step is to run the analysis and program design and engine following steps outlined in both tutorials 
as previous years. See section 5 of STAAD.Pro V8i Technical Manual for more information. 
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After giving click the located in the menu bar of the program Analyze command, a popup window will 
appear, as shown below. 

 

 

 
 
 
 
Then we click on the Command Output file located in the toolbar 

 

 
 
Or directly in the popup window "STAAD analysis and design", we click on the View Output file 
option. Window shown in the following figure appears: 
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In the Output File shown in the results section of "Participation Factors" shows the percentage of the 
mass of the structure which is subjected to the stresses caused by the "trembling" that may occur at the 
site. A "mode" refers to the different vibration modes in which you can present in the structure. 

 

 
To interpret and understand perfectly the values shown in the STAAD output file. You need to know the 
theories, fundamentals and principles on which, studies on the behavior of natural phenomena in the 
different types of existing buildings are based. Also the commands used and the captured results are 
explained in detail in the Technical Manual (Volume II). 

 

 
Tip: For more information about the efforts that cause tremors in buildings and how they behave for further 
design. See the book "Buildings Seismic and wind resistant, criteria for calculation and design"Jos é Cre xe i ll 
i the Edi tor the  
Limusa 
(UNAM) 

 

 
 

Citing Suggested text book (Creixell, 1993): 
 

"To simplify problems, it is often assumed that an earthquake occur, the building will be subject to a horizontal 
or vertical forces, and the different elements of it are calculated statically to support them, regardless of their 
movements.  This  type  of  calculation  is  called  static,  but  in  fact  this  name  is  not  correct,  because  the 
calculation itself can not be dynamic not static. 

 
It is designated as "dynamic analysis" that is used for the elements of the structure, if it considers the actions 
of  the seismic  forces are not constant and movements  that cause construction. The dynamic calculation, 
besides giving a clear view of the real problem, shows the position to assess to what extent and with what 
limitations you can use the static calculation. " 
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1.1 Introduction 
 

 
The STAAD.Pro V8i Graphic User Interface (GUI) is normally used to create all the input specifications 
and display all output reports. These input specifications of structural modeling and saved in a text 
file with the ".STD" extension. When the GUI opens a file to start a session with an existing model 
receives all this information file STD. A user can edit / create this file and have the STD GUI and 
engine analysis, both reflect the changes. 

 
STD file is processed by the STAAD analysis "engine" to produce results that are stored in multiple 
files with extensions such as ANL, BMD, TMH, etc. ANL text file containing the printout created by 
the specifications in this manual. The other files contain the results (displacements, forces in the 
members / elements, mode shapes, forces / moments / movements of the section, etc.) that is used by 
the GUI mode processing. 

 
This section of the manual contains an overview of the availability of the analysis and design of the 
STAAD engine. Specific information on steel and concrete are available in Sections 2 and 3 manual, 
it respectively. The details of the STAAD engine and commands Archives STD and other specific 
information for the user are presented in Section 5. 

 
The aim of this section is to familiarize the user with the basic principles involved in the application 
of the various means of analysis / design offered by the STAAD engine. As a general rule, the sequence 
in which the facilities are discussed following the recommended use of the input file data stream STD. 

 
 

1.2 The Generating input data 
 
 
 

The GUI (or user) communicates with the STAAD analysis engine via the input file STD. This input 
file is a text file consisting of a series of commands that are executed sequentially. The orders contain 
instructions or data that allow analysis and / or design. The elements and conventions of language 
STAAD commands are described in Section 5 of this manual. 

 
The STAAD input file can be created through the text editor or the GUI ease of modeling. In general, 
any text editor can be used to edit / create the input file STD. Ease of Modeling GUI creates the input 
file through an interactive menu-oriented graphical procedure. 
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1.3 Types Structures 
 
 
 
 
For input, 
see section 
5.2 

A STRUCTURE can be defined as a collection of elements. The STAAD is capable of analyzing 
and designing structures consisting of frames and / or plate / shell and solid elements. Almost 
any type of structure can be analyzed by STAAD. 

 
    Structure SPACE  (SPACE)  which  is  a  frame  structure  in  three 
dimensions with loads applied at any level, is the most usual. 

 

    Structure FLAT (PLANE) is limited by an XY coordinate axis in a global 
system loads in the same plane. 

 

    A kind structure ARMOR (TRUSS) consists of members armor type that 
can have only axial forces in the members and no bending members. 

 

    A kind structure FLOOR (FLOOR) is one of two or three dimensions that 
have no horizontal motion (global X or Z) in the structure [FX, FZ 
and  MY  restrict  in  each  joint].  The  floor  frame  (in  global 
coordinates in the XZ plane) of a building is a perfect example of a 
structure of type. They also modeled the columns with floor condo 
in a structure provided that the structure has no horizontal load. If 
there  is  any  horizontal  load  should  be  analyzed  as  a  SPACE 
structure. 

 
The specification of the correct type of structure reduces the number of equations to be solved 
during analysis. This results in a faster and more economical solution to the user. The degrees 
of freedom associated with the frame members of different types of structures are shown in 
Figure 1.1. 

 

Types of Structure 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1.1 
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1.4 Systems Units 
 
 

For input, 
see Section 
5.3 

 
FPS is usually the user allowed to enter data and receive results in almost all commonly used 
unit systems engineering including MKS, SI. In the input file, the user can change the units as 
many times as required. Mix and match between length and force units of the systems of different 
units is also allowed. The input units for angles (or rotations) are degrees. However, the output 
of the SEALS OFFSET, rotations are given in radians. For all outputs, the units are clearly 
specified by the program. 

 

1.5 Structure and Geometry of Coordinate 
Systems 

 
A structure is an assembly of components such as beams, columns, slabs, plates etc. To Staad, 
may use elements of the frame and floor elements to model the structural components. 
Typically, modeling the geometry of the structure consists of two steps: 

A. The identification and description of joints or nodes. 
 

B. Modeling of members or elements through the specification of its connectivity 
(incidents) between joints. 

 
 

For 
input, 
see 
Sections 
5.11 to 
5.17 

 
In general, the term MEMBER (MEMBER) is used to refer to elements and the end frame 
member (element) is used to refer to the plates / shells and solids. Connectivity can be provided 
to Members through the MEMBER command of IMPACT (MEMBER INCIDENCES) while 
connectivity for elements can be provided through the command of IMPACT ELEMENT 
(ELEMENT INCIDENCES). 
 
Staad uses two types of coordinate systems for defining the geometry of the structure and load 
patterns. GLOBAL coordinate system is an arbitrary coordinate system in space that is used to 
specify the overall geometry and loading pattern of the structure. A LOCAL coordinate system 
is associated with each member (or element) and used at the output of the EXTREME FORCES 
MEMBERS or local load specification. 

 

1.5.1 Global Coordinate System 
 

The following coordinate systems are available for the specification of the geometry of the 
structure. 

 

 
A. The conventional Cartesian coordinate system: This coordinate system (Fig. 1.2) is 

a rectangular coordinate system (X, Y, Z) which follow the rule of the orthogonal 
right hand. This coordinate system can be used to define the location of the meeting 
and the directions of the loads. The translational degrees of freedom are denoted 
by u1, u2, u3 and the degrees of freedom of rotation are denoted by the u4, u5 and 
u6. 

 

B. The cylindrical coordinates system: In this coordinate system (Fig. 1.3) the coordinate 
axis X and Y of the conventional Cartesian system is replaced by R (the 
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radio) and Ø (angle in degrees). The Z coordinate is identical to Z of the Cartesian 
coordinate system and its positive direction is determined by the right hand rule. 

 
C. Inverse System Cylindrical Coordinates: This is a cylindrical coordinate system type 

(Fig 1.4.) Where R is in the plane corresponding to the plane Ø X Z of the Cartesian 
system. The right hand rule is followed to determine the positive direction of the 
Y axis 

 

And 
 

 

or 
5 

 

 
 
 
 
 

or 
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or or 

1 4 

or3 

 
or 
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Cartesian Coordinate System (Rectangular) Figure 
1.2 
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Figure 1.3 
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R 
 
 
 
 
 
 
 

 
Inverse System Figure 1.4 Cylindrical 

Coordinates 

 
 
 

1.5.2 Local Coordinate System 
 

 
A local coordinate system is associated with each member. Each axis orthogonal system of local 
coordinates is also based on the rule of the right hand. Fig. 1.5 shows a member of the board of 
the beam with the start 'i' and the final meeting 'j'. The positive direction of the x local axis is 
determined attaching 'i' to 'j' and projecting in the same direction. The right hand rule can be 
applied 
for the positive directions of the local axes "y" and "z". Local "and" axis and "z" match 
with the axes of the two principal moments of inertia. Note that the local coordinate system is always 
rectangular. 

 
A wide range of sectional shapes can be specified for analysis. These include rolling steel, prismatic 
forms that the user specified, etc. The Fig. 1.6 shows the local axes system for these forms. 
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Local Axis System 
For the different sections when the "Z UP" command is specified. 
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1.5.3 The relationship between Global and Local Coordinates 
 

 
From the entrance to the loads of the member may remain in the system of local and global 
coordinate and the output of the extreme forces of the Member will be printed in the local 
coordinate system, it is important to know the relationship between the systems of local 
coordinates and Global. This relationship is defined by an angle measured in the following 
manner. This angle is defined as beta (). For members of the beta displaced reference angle 
indicate that the features are based on the position of the displacement of the local axis, and not 
positions of the joint. 

 

 
 
 
 
For input, 
see section 
5.26 

Beta Angle 
 
When the local x-axis is parallel to the Y axis global, as in the case of a column in a structure, 
the angle beta is the angle through which the local z-axis is rotated about the local axis x from 
a position parallel and in the same positive direction of the global axis Z. 

 
When the local axis x is parallel to the overall axis, the angle beta is the angle through which 
the local coordinate system is rotated about the local axis x of the position of having the local 
z axis parallel to the plane of Global and local XZ axis in the same direction as the overall 
positive axis Y. Figure 1.7 outlines the beta positions equal to 0 degrees or 90 degrees. By 
providing loads of member local axis of the member, it is useful to refer to this figure for a 
rapid determination of the local axis system. 

 

The Benchmark 
 
An alternative to provide Member orientation is get the coordinates (or a number of the board) 
which will be a reference point located in the xy plane of the member but not in the axis of 
the member. From the location of the reference point, the program calculates the xy plane 
orientation of the member automatically. 
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Figure 1.7 
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1.6 The Information finite element 
 

 
 

STAAD is equipped with an innovative condition plate / shell and solid finite element. The 
characteristics of each are explained below. For input, see Sections 5.11, 5.13, 5.14, 5.21, 5.24, and 
5.31.3 

 

 
 
 

1.6.1 Element Plaque / Smudge 
 

 
The finite element Plaque / Smudge is based on the formulation of the hybrid cell. The element 
can be 3 knots (triangular) or 4 knots (ring). If all four nodes of a quadrilateral element does 
not lie in a plane, it is advisable to model as triangular elements. The thickness of the element 
may differ from one node to another. 

 
The "surface structures" such as walls, slabs, plates and shells can be modeled using finite 
elements. For convenience in generating a finer mesh of plate / shell within a large area, a 
choice of mesh generation is available. The option is described in detail in Section 5.14. 

 

The user can also use the element for PLANAR EFFORTS action only (for example the rigidity 
of the membrane / in one plane only). The command EFFORTS IN PLANAR ELEMENT 
should be used for this purpose. 

 
 
 

Considerations in the Modeling of Geometry 
 

 
 

The following rules related to geometry modeling to remember when you are using the element 
plate / shell 

 

 
1) The program automatically generates a fifth knot "O" (the center knot - see Fig. 

1.8) to the center of the element. 
 

2) While the nodes are allocated to an element in the input data, it is essential that the 
nodes are specified either in the direction of clockwise or counter-clockwise (Fig. 1.9). 
For efficiency, similar elements must be numbered sequentially. 

 

3) The aspect ratio between elements should not be excessive. They should be in the 
order of 1: 1, and preferably less than 4: 1. 

 

 
4) No individual elements are distorted. The angles between adjacent sides of the element 

must not be larger than 90 and never exceeding 180 degrees. 
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Specifying Element Loading 
 

The following specifications of charges are accepted: 
 

1) Loads on the boards at the nodes of the elements in the global addresses. 
 

2) Concentrated loads at any point specified by the user within the element in global or 
local addresses. 

 
3) Uniform pressure on the surface of the element in the global or local addresses 

 

4) Uniform partial pressure the user to specify a portion of the surface of the element in 
the global or local addresses 

 
5) Linearly varying pressure on the surface of the local addresses. 

 
6) Temperature load due to an increase or decrease in temperature. 

 

7) The load due to temperature difference in the temperature between the upper and 
lower surfaces of the element. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

Generated Node 
(Node Center) 

 

 
 

Figure 1.8 

 
 
 
 
 
 
 

Correct numbering 
 

 
 
 
 
 

Incorrect numbering 
 

Figure 1.9 
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Theoretical 
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The finite element Staad plate is based on the finite element hybrid formulations. Full 
distribution is assumed quadratic efforts. For the action of forces in a plane, the stress 
distribution is supposed to be as follows. 
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a1 to a13 = efforts polynomial constants. 



TECHNICAL MANUAL STAAD.Pro 

30 

 

 

 
 
 

The distinctive features of this finite element are: 
 

1) Compatibility between the component displacement efforts in an element plane and the 
bending component of an adjacent plate element which forms an angle with the first 
(see Fig. Below) is reached. This compatibility requirement is usually ignored in most of 
the flat elements of shell / plate. 

 

 
 
 

2) The rotational stiffness out of the plane of the planar portion of the efforts of each 
item is properly built and not treated as a simulation as is usually done in most 
commonly available commercial software. 

 

3) Despite the incorporation of the aforementioned rotational stiffness, the elements 
satisfy the verification test completely. 

 
4) These elements are available as triangles and quadrilaterals with knots at the corners 

only, and six degrees of freedom at each node 
 

 
5) These elements are the simplest forms of shell / plate planes possible with knots at 

the corners only six degrees of freedom per node. Nevertheless the solutions to solve 
the problems converge quickly and accurate even with large mesh size responses. 

 
6) These elements may be connected to the planar members / or spatial frame with full 

support of displacement. No restrictions / additional relaxation is required. 
 

7) Cutting out of the plane of the shear strain energy is incorporated into the formulation 
of component plate bending. As a result, the elements correspond to the Poisson 
boundary conditions which are considered more accurate than the usual boundary 
conditions Kirchoff 

 

8) The bending portion of the plate can be considered thick and thin plates, thus 
extending the usefulness of the plate elements a number of problems. Further, the 
thickness of the plate is taken into account by calculating the cutting out of the plane. 

 

 
9) Efforts triangular plane behaves almost on par with the well-known triangle of linear 

stresses. Triangles of the flat elements of the most similar triangular shells incorporate 
constant effort convergence has very low proportions. Thus the triangular shell element 
is very useful in problems where the quadrilateral double-curved element can not be 
used. 

 
10) The recovery of nodal forces at any point within the element. 



TECHNICAL MANUAL STAAD.Pro 

31

 

 

 
 
 

Local Coordinate System Element 
 

The precise orientation of the local coordinates is determined as follows: 
 

1) Denoting the midpoints of the four or three sides of the IJ, JK, KL, LI by M, N, O, P 
element respectively. 

 
2) The vector pointing from P to N is defined to be the x axis locally (in a triangle, 

that is always parallel to IJ). 
 

3) The vector product of PN and MO vectors (for a triangle, ON and MK) defines the 
local z axis, ie, z = PN x MO. 

4) The vector product of vectors z and x defines the local axis, that is, y = (z) 

(x). The sign convention of the force and moment resulting protrusion is shown in 

Fig. 1.13. 
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I 

 
Figure 1.12 

 
 

 
Output Element Forces 

 

The results of the command FORCE ELEMENT (ELEMENT FORCES) are available in the 
following situations: 

 

 
A. At the center point of the element. 
B. In every corner of the element nodes. 
C. At any point specified by the user within the element. 

The following are the items included in the output EFFORTS ELEMENT. SQX, SQY

 Shear stress (force / unit Long. / Thickness) 
SX, SY, SXY Efforts Membrane (Strength / Long unit. / Thickness) 
MX, MY, MXY bending moments per unit width (Time / Long drive.) SMAX, 
SMIN Principal stresses (force / unit area) 
TMAX Maximum shear (force / unit area) ANGLE
 The orientation of the principal plane (Grades) 
VONT, Von Mises VONB efforts where 

VM 0.707 SMAX SMIN 2 SMAX 2 
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SMIN2 
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Notes: 

 
1) All results of the efforts of the member are in the local coordinate system. The direction 

and sense of the efforts of the element in Fig. 1.13 are explained. 
 

 
2) For efforts element at a specified point in the element, the user must provide the 

coordinate system of the element. Note that the origin of the local coordinate system 
coincides with the center of the element node. 

 
3) The main efforts (the SMAX and SMIN), the maximum shear (TMAX), the orientation 

of the principal plane (ANGLE), and efforts Von Mises (VONT and VONB) are also 
printed to the upper and lower surfaces of the . The upper and lower surfaces are 
determined based on the z axis of the local address. 

 
 
 
 

Signs Convention Forces the Elem ents 
 

Figure 1.13 
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Local and 
 

 

dy 
Local x 

 

 
 
 

SQX 
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Out-of plane shear stresses (SQX and SQY) 
 

 
 
 
 

Keep in mind the following restrictions on the use of finite element STAAD: 
 

1) Frame members and the finite element can be used together to Staad analysis. The 
mandate of ELEMENT INCIDENTS entry must follow MEMBER INCIDENTS 
immediately. 

 
2) The dead weight of the finite element becomes loads in the joints in the connected 

nodes and not used as a pressure element. 
 

3) Element forces are printed on the centroid and joints, but not along any edge. 
 

4) In addition to the forces shown in Fig. 1.13 Von Mises forces on the part of the upper 
and lower surfaces of the element are also printed. 

 

 
Numbering Elements 

 
During the generation of the element stiffness matrix, the program checks if the element is the 
same as above. If it does not repetitive calculations. The sequence in which the element stiffness 
matrix is generated is the same as the sequence in which the elements enter in the incidences of 
the element. 

 

Therefore, to save some computer time, must be sequentially numbered like elements. Fig. 1.14 
shows examples element numbering efficient and inefficient. 
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However, the user must decide whether to adopt a numbering system which reduces the 
computation time with a numbering system that increases the ability to define the geometry of 
the structure. 

 

 
 
 

1 
2 3 4 

 
5 6 7 8 

 
Efficient Element numbering 

 

1 3 5 7 

 

2 4 6 8 

 
Inefficient Element numbering 

 
 
 

Figure 1.14 

 

1.6.2 Solid Elements 
 

 
The solids give the solution to the structural problems involving three-dimensional efforts. 
There is a class of problems such as stress distribution in concrete dams, soil and rock strata 
where the finite element analysis using solid elements providing a powerful tool. 

 

Rationale 
 

The solid element is used to Staad isoparametric type eight knots. These elements have three 
translational degrees of freedom per node. 

 

 
 

Collapsing several nodes together, a solid element of eight nodes can degenerate to the 
following forms with four to seven knots. 
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The stiffness matrix of the solid element is evaluated by numerical integration with eight points 
Gauss-Legendre. To facilitate numerical integration element geometry interpolating function is 
expressed using the natural coordinate system (r, s, t) of the element with its origin at the 
center of gravity. The interpolation functions are shown below: 

 

8 8 8 

x hixi, and hiandi, z hizi 
i 1 i 1 i 1 

 
 

Where x, y and z are the coordinates of any point on the element and xi, yi, zi, i = 1, .., 8 are the 
coordinates of nodes defined in the global coordinate system. Interpolation functions hi defined in 
the natural coordinate system, (r, s, t). Each of r, s and t ranges from -1 to +1. The fundamental 
property of the interpolation functions hi is unknown values in the coordinate system of natural 
units are at node i, and 0 in the other nodes of the element. The displacement of the element is 
also interpreted in the same way as the geometry. For completeness, the functions are given below: 

 

8 8 8 

u = hiori, V = hivi, W = hiwi 
i 1 i 1 i 1 

 
 

Where u, v and w are the displacements at any point in the element and ui, vi, wi, i = 1,8 
correspond to the nodal displacements in the coordinate system used to describe the geometry. 

 
Three functions of "bubble" with zeros 
additional displacement surfaces and 
displacements in each direction is added for 
improving the development of shear to form 
a 33x33 matrix are added. The static 
condensation is used to reduce this matrix to 
a 24x24 matrix in the corners of the joints. 

 

Local Coordinate System 
 

 
The local coordinate system used in the 
solid element is equal to the overall system 
shown below: 

 

 
 
 
 

Figure 1.15 
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Properties and Constants 

 
In the different members and shell elements (plate), any property to the solid elements is 
required. However, the constant as the elastic modulus and Poisson's ratio must be specified. 

 
Also, the density needs to be provided if the weight is included in any load case. 

 

 
 
 

Results Forces of the Elements 
 

Element forces can be obtained at the center and on the boards of the solid element. The items 
to be printed are: 

 

 
Normal stresses: SXX, SYY and 
SZZ cutting efforts: SXY, SYZ and 
SZX Major Efforts: S1, S2 and S3. 
Von Mises Stress: 

 
 
 

 
Direction cosines: 6 are printed cosine addresses following the DC term, corresponding 
to the first two directions of principal stress. 

 

 
 
 

1.7 Member Properties 
 

 
The following types of specifications of member properties are available in STAAD: 

 
 

See 
section 
5.20 

 

A. The specifications of prismatic properties 
 

B. Steel profiles standard library 
 

C. Steel tables that the user created 
 

D. The TAPERED sections (variables) 
 

E. Through the ASSIGN command 
 

F. The specification CURVE 
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D 

   

 

 
 
 

1.7.1 Prism Properties (Prismatic Properties) 
 

Prismatic the following properties are required for analysis: 
 

 
See 
section 
5.20.2 

AX = Area of the cross section IX 
= Torsional constant 
IY = Moment of inertia about the axis. IZ 
= Moment of inertia about the z axis. 

 

 
Additionally, the user can choose to specify the following properties: 

 
AY = The effective cutting area for cutting force parallel to the axis and 
local. AZ = The effective cutting area for cutting force parallel to the local 
z axis. YD = The depth of the section parallel to the axis and local. 
ZD = The depth of the section parallel to the local z axis. 

 

To specify a T beam or a trapezoidal beam, the following additional properties to be provided. 
 

YB = The depth of the soul of the T section [See figure below] 
ZB = The width of the core section or the width T of the bottom of the trapezoidal section. 

 

To specify the T beam, the user must specify YD, ZD, YB and ZB. Similarly for Trapezoidal 
sections, YD, ZD and ZB be provided. 

 

 
If the cutting areas are given, the program will consider shear deformations automatically in the 
analysis, and if omitted, the shear deformation is ignored. In a frame structure, the ratio of shear 
strain at bending deformation is so small that in most cases can be ignored. The depths in the 
two major directions (YD and ZD) are used in the program to calculate the section modulus. 
They need only to calculate efforts or members for the design of concrete. You can skip YD and 
ZD values if efforts or the design of these members are not of interest. The default value is 254 
mm (10 inches) for YD and ZD. Each prismatic properties are given in the local coordinates 
of the member. 

 

 

ZD ZD 
 
 
 
 

 
And YB YD 

 

 
 
 
 

ZB ZB 
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To define a concrete member, you should not provide the AX, But instead should provide YD 
and ZD for a rectangular section and YD only for a circular section. If no moment of inertia 
or cutting areas are provided, the program will calculate them automatically YD and ZD. 

 
Table 1.1 provides the user with help in specifying required values section. List by structural 
type, the section properties required for any analysis. For FLOOR PLAN or analysis type, the 
choice of the moment of inertia required depends on the beta angle. If BETA equals zero, the 
desired property is IZ. 

 

Table 1.1 Required Properties Type

  Properties 
Structure  Structure 

Required ARMOUR    AX 

FLAT Structure  AX, IY or IZ 
Structure FLOOR    IX, IY or IZ 

Spatial Structure  AX, IX, IY, 
IZ 

 

 

1.7.2 Library Rolled Steel Sections 
 
 

 
See Section 
2.2.1 and 
5.20.1 

 

This feature of the program allows the user to specify the names of the standard section steel 
profiles manufactured in different countries. Information concerning the forms of American 
steel is available in Section 2. 

 

Since the cutting areas of the sections are built in tables, the shear deformation is always 
considered for these sections. 

 
 
 
 
 

1.7.3 Steel Table Provided by the user 
 
 
 
 

See 
sections 
5.19 and 
5.20.4 

 
The user can provide custom steel table designated proper names and corresponding properties. 
The program can then find the member properties of those tables. The member selection can 
also be done with the program that selects the members of the tables that are provided only. 

 
These tables can be provided as a part of the STAAD input files created separately or as of 
which the program can read the properties. The user does not use the standard forms shifty 
or who uses a limited number of specific forms can create permanent archives of member 
properties analysis and design can be limited to sections in these files. 
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1.7.4 Sections variables (Tapered Sections) 
 
 
See 
section 
5.20.3 

I variables section properties can be provided through the MEMBER PROPERTY specifications. 
Giving the key dimensions of the section, the program can calculate the cross-sectional properties 
used in the analysis result. The VARIABLES specification sections described in Section 5 of this 
manual. 

 

 
 
 
 

1.7.5 Command Assign (Assign) 
 
 
 
 
See 
section 
5.20.5 

 
Through this command, the user can instruct the program to automatically select a steel section 
of the table for subsequent analysis and design. Section types that can be assigned include 
BEAM, COLUMN, CANAL, DOUBLE ANGLE and ANGLE. When a BEAM COLUMN or 
specified, the program will assign a section of I-beam (WF for AISC) and subsequently the 
selection of the member or optimization is performed with a section of similar type. 

 
 
 

 

1.7.6 Curved Members 
 
 
See 
section 
5.20.7 

Any section can be assigned to a curved member. Elbows can also be assigned to a pipe 
ASME code based on the reduction of flexibility. 

 

 
 
 

1.8 Degrees of freedom of Members 
 
 

 
 
See 
section 
5.22 

 
STAAD allows members freedom and stop elements. They may be left at liberty one or both 
ends of a member or element. It is assumed that members / elements are rigidly connected at 
joints with structural type specified. When this rigidity is not complete individual components of 
the forces, either at either end of the member may be reset with the statutes of relaxation of the 
member. Relaxation specifying components, the individual degrees of freedom are removed from 
the analysis. Relaxation components are given in the local coordinate system for each limb. Note 
that the relaxation time is also allowed PARTIAL. 

 

Only one of the properties of sections 1.8 and 1.9 can be assigned to a Member. The last entry 
will be used. 
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1.9 Armor / Tension / Compression - Members Only 
 
 

See 
section 
5.23 

 
For analyzes involving members having only axial loads, ie the reinforcement members, there 
are two ways to specify this condition. When all members in the structure are members armor, 
the type of structure is declared as ARMOR (TRUSS) while when only some of the members 
are the armature members (eg bracing of a building), the ARMOR order MEMBER can be used 
where those members are identified separately. A considerable amount of analysis and design 
time saves declaring an axial member as a member ARMOR, the specification of such members 
as the members of the articulated frame with both ends should be avoided wherever possible. 

 
In STAAD, commands the MEMBER TENSION (MEMBER TENSION) and MEMBER in 
COMPRESSION (MEMBER COMPRESSION) can be used to constrain the direction of the 
load that the member may have. The analysis will be performed accordingly. Refer to Section 
5.23.3 for details of this option. 

 

 
 
 

1.10 Tension / Compression - Solo Springs 
 
 
See 
section 
5.23 

 

In STAAD, the commands in TENSION SPRING (SPRING TENSION) and SPRING in 
COMPRESSION (COMPRESSION SPRING) can be used to limit the direction of the load 
that can be supported. The analysis will be performed accordingly. Refer to Section 5.23.4 for 
details of this facility. 

 

 
 
 

1.11 Member Type Cable 
 
 
 
 

1.11.1 Member Type Linear Cable 
 
 
 
 
 
See 
section 
5.23 

 
The wire-like members can be specified using the command MEMBER CABLE (MEMBER 
CABLE). When members are specifying type cable, the initial tension in the cable must be 
provided. The following paragraph explains how the stiff wire is calculated. 

 

The increase in the length of a live wire is a combination of two effects. The first component 
is the elastic stretch, and is governed by the common ratio springs: 

 
 

F Kx where K 
EA 

elastica L 

 

The second component of elongation is due to a change in the geometry (such as a cable is 
pulled, the buckling is reduced). This relationship can be described by 
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F Kx but here K 12T 
3

 

1.0 

sag 

w2L3 COS 2 

 
 

Where 
 

w = weight per unit length of the cable 
T = tension in the cable 

= The angle to the cable axis makes with a horizontal plane (= 0, the cord is 
horizontal; = 90, the wire is vertical). 

 
Therefore, the "stiffness" of a cable depends on the initial voltage applied (or buckling). These 
two effects can be combined as follows: 

 
 

Kcomb 

 
 

1 / 
Ksag 

1 

1 / Kelastic 

 
 
 

 
 

Kcomb 

EA 

L 
1 w2L2EA COS 2 

12T 3
 

 
 

Where T = infinity, Kcomb = 
EA / L where T = 0, Kcomb = 
0 

 
It may be noted that increasing the pressure (decrease the buckling) the combined stiffness 
approaches the pure elastic situation. 

 
The following points need to consider using cable STAAD member: 

 
1) The cable member is just a frame member whose properties buckling factor and voltage 

can accommodate. Member conduct cable is identical to that of an individual armor. 
You can only carry axial loads. As a result, the basic rules involved in modeling armor 
members have to be followed when members of the cable model. For example, when 
two wire members are in a common seal, if there is no support or 3rd member 
connected to that board, is a point of potential instability. 

 
2) Because the reasons specified in 1) above, apply a transverse load on a cable member is 

not advisable. The burden will become two concentrated loads in the 2 ends of the cable 
and the true model of the deflection of the cable will never get done. 
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3) A wire member does not resist a compressive force applied to its ends. When the end 
of the member together with a compressive force are attached, they yield causing the 
wire to buckle. Under these circumstances, the 
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Cable has zero stiffness member and this situation has to be considered in the stiffness 
matrix and displacement have to be recalculated. But in STAAD, declaring the member 
merely to be a cable member is no guarantee that behavior will be considered. It is 
also important that you declare the member to have single stress using the STRESS 
MEMBER command after command CORD. This will ensure that the program will 
test the nature of the force in the member after analysis and compression if the member 
is off and the stiffness matrix is recalculated. Please read the requirements TENSION 
MEMBER command (MEMBER TENSION) recalling the RUN ANALYSIS 
(PERFORM ANALYSIS) and commands CHANGE (CHANGE) with each load case; 
SET command and NL. 

 
4) Because of potential instability problems explained in item 1 above, users should also 

avoid modeling a catenary breaking it in several straight line segments. Member to Staad 
cable can not be used to simulate the behavior of a catenary. For the overhead, we are 
referring to these structural components and having a curved profile and develop axial 
forces due to its own weight. This behavior is in reality a non-linear behavior where the 
axial force is caused due to a change in the profile of the member or is induced by large 
displacements no such assumptions are valid in an elastic analysis. A typical example of 
a catenary is the U shape of the main wire used in suspension bridges. 

 
5) Increased stiffness of the cable as the tension on it increases under applied load that 

is updated after each iteration if the members of the cable are also declared to be in 
TENSION MEMBER. However, the iteration stops when all the tension members are 
in tension or loose; When no wire tension converges. For integer multiple iterations, 
the RUN command consecutive ANALYSIS; will make a further iteration then for each 
entered command. 

 
 

1.11.2 Members cable type Nonlinear 
 
 
 
See 
section 
5.23 

The wire members for Nonlinear Analysis of Cable can be specified using the command type 
LEAD MEMBER. While wire-like members, the initial tension in the cable or cable length 
effortlessly be provided are specified. 

 
 
 
 

1.12 Member of the Board was 
 
 
See 
section 
5.25 

 
Some members of a structure can not concur with the incidents together creating a member 
off the board. This distance outside the ring is specified in the system of global or local 
coordinates (ie X, Y and Z distances from the incident together). Induced secondary forces due 
to off the board this connection, are taken into account when analyzing the structure and also 
to calculate individual member forces. The new centroid outside the gasket can be in the 
incidence of start or end point of the new asset will also be the new start or end of the member. 
Therefore, any reference beginning or end of that member will always be new points off the 
board. 
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MEMBER OFFSET 
7 ' 1 START 7 

6 ' 1 END -6 
2 END -6 -9 

 

9 ' 
 

 
 
 
 
 
 
 
 

Figure 1.15 

 

1.13 Constants Materials 
 

 
 

 
 
 
 
See 
section 
5.26 

 
The constants of the materials are: the modulus of elasticity (E); weight density (DEN); 
Poisson's ratio (POISS); coefficient of thermal expansion (ALPHA), Composite damping ratio 
and angle beta (BETA) coordinates for any point of reference (REF). 

 
The value of E shall be provided for analysis or fail. The density (DEN) is only used when the 
weight (selfweight) structure is taken into account. Poisson's ratio (POISS) is used to calculate 
the shear modulus (normally referred to as G) by the formula, 

 
G = 0.5 x E / (1 + POISS) 

 
If Poisson's ratio is not provided, STAAD assume a value for this amount based on the value of 
E. The coefficient of thermal expansion (ALFA) is used to calculate the expansion of the members 
if the temperature loads are applied. The temperature unit for loading ALFA temperature and 
must be the same. 

 

The composite damping ratio is used to compute the damping ratio for each mode in a dynamic 
solution. This is only useful if there are several materials with different damping ratios. 

 
The BETA angle and point of reference are discussed in Section 1.5.3 and they get as part of the 
constant member. 

 
Note:  The  Poisson  ratio must  always  be  defined  after  the Modulus  of 
Elasticity for a given element or member. 
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1.14 Stands 
 
 

See 
section 
5.27 

STAAD allows media specifications that are parallel and inclined to the global axes. 
 

 
Braces are specified as ARTICULATED (PINNED), wardrobes (FIXED) or wardrobes (FIXED) 
with different relaxations. An articulated support has restrictions against any translational 
motion and none against rotation. In other words, an articulated support for the reactions have 
all forces but resist any time. A recessed holder has restrictions from all directions of motion. 

 

They can also relax the constraints of a fixed support in any desired direction as specified in 
Section 5. 

 

 
You can also specify translational and rotational springs. The springs are represented by the 
relation to their spring constants. A translational spring constant is defined as the force for 
replace a board supporting a unit of length in the specified global address. Similarly, a rotational 
spring constant is defined as the force to rotate the support board a degree about the global 
address specified. 

 

For the static analysis supports Multi-linear spring may be used to model the variation, nonlinear 
resistance of a medium (eg soil). See section 5.27 for descriptions of options for shoes and 
foundation slabs in an elastic medium. 

 

 

1.15 Joints Master / Slave (Master / Slave Joints) 
The choice of master / slave is provided to allow the user to model the rigid links in a 
structural system. This can be used to model the elements 

See 
Sectio
n 5.28 

special structural and rigid floor diaphragm. Some boards working as a slave which can be 
given to the same displacement as the board of the master will be assigned. The user also has 
the flexibility to choose the specific degrees of freedom for movement restrictions are imposed 
on the boards worked as a link. If all degrees of freedom (Fx, Fy, Fz, Mx, My and Mz) are 
provided as the constraints, it is assumed that the joints are rigidly connected. 

 
 

1.16 Loads (Loads) 
 
 

Loads can be specified in a structure as loads on the board, member loads, temperature loads 
and loads of cupboard at one end member. STAAD can also generate the weight of the structure 
and can use it as uniformly distributed loads member in the analysis. Any part of this own 
weight can be applied in any desired direction. 
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1.16.1 Loads on Boards (Joint Load) 
 
 

 
See 
section 
5.31.1 

The loads on the joints, forces and moments can be applied to any free board structure. These 
loads act in the global coordinate system of the structure. Positive forces act in the directions 
of positive coordinates. Any number of loads can be applied in a single meeting, in which case 
the charges will be add-on that board. 

 

1.16.2 Loads on Members (Member Load) 
 
 

 
See 
section 
5.31.2 

 
Three types of load member can be applied directly to a member of a structure. These charges 
are uniformly distributed loads, concentrated loads, and linearly varying loads (including 
trapezoidal). The Standard loads act in the full or partial length of a member. The concentrated 
loads act at any intermediate point specified. Linearly varying loads acting on the total length of 
a member. V linearly varying loads acting on the full or partial length of a member. Trapezoidal 
loads in a uniform load and concentrated loads some converted. 

 
Any number of loads can be specified to act on a member in any independent loading condition. 
Member loads can be specified in the coordinate system of the member or the global coordinate 
system. Uniformly distributed loads can be specified in the member in the global coordinate 
system to act along the whole or the projected length of the member. Refer to Fig. 1.3 to find a 
member's relationship to the global coordinate system to specify the member loads. Positive forces 
acting on the directions of the positive, local or global coordinates, as appropriate. 
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The Load Settings Member ‐ Figure 1.16 
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1.16.3 Cargo Area or Floor (Area / Floor Load) 
 
 
 
 
 
See 
section 
5.31.4 

 
Often a floor (limited by the XZ plane) is subjected to a uniformly distributed load. It could 
require a lot of work to estimate the burden of membership for individual members on that 
floor. However, with the LOAD command or LOAD FLOOR AREA, the user can specify the 
load area (unit load per unit of area) for members. The program will calculate the tax area for 
these members and provide loads the appropriate member. The load area is used for a 
distribution in one direction and the load floor is used for distributions in two ways. 

 

The following assumptions are made when loading cargo area and floor-to-member load is 
transferred: 

 
1) It is assumed that the load of the member is a linearly varying load values for start and 

end may be of different magnitude. 
 

 
2) The tributary area of a member with a load area is calculated based on half the space 

nearby on both sides approximately parallel members. If space is greater than or equal 
to the length of the member, the load area is ignored. 

 
3) Do not load specified Area / Flat for members declared MEMBER CABLE ARMOR 

MEMBER MEMBER in TENSION, COMPRESSION MEMBER in or CURVO. 
 
Figure 1.17 shows a floor structure with a specification of 0.1 area load. 

 
6m 4m 5m 5m X 

 

 

6 7 8 9 
 
 
 
 
 

1 2 3 4 5 
 

 
 
 
 
 
 
 

10 11 12 13 
 

4m 6m 
 

 
 
 

Z 
Figure 1.17 

 

The member 1 has a linear load of 0.3 to 0.2 at one end and other end. The members 2 and 
4 have a uniform 0.5 of the total length up load. Member 3 will have a load 
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0.45 and 0.55 line in the respective ends. Member 5 will have a uniform load of 0.25. The remaining 
members, 6-13, will not have the burden on taxpayers because the area closest parallel members 
are separately over each of the lengths of the member. However, the reactions of the members 
shall be considered to the beam. Solid plates and these commands are ignored. 

 

1.16.4 Built-in member loads in Far 
 

See 
section 
5.31.7 

 
You can also specify loading effects on a member as it relates to their charges fixed end. These 
charges are defined in terms of the coordinate system of the Member and directions will be 
opposite to the actual load on the member. Each end of a member can have six forces: axial; 
cutting; cutting z; torsion; time and time and z. 

 

1.16.5 Loads for Prestressed and Post Stressed in Members 
 
 

See 
section 
5.31.5 

 
Members in a structure may be subject to prestressing loads so the load distribution in the 
structure to be investigated. Prestressing loads can be applied in a Member axially or 
eccentrically. Eccentricities be provided to the board start, middle, or end. These eccentricities 
are only on the local axis. A positive eccentricity is positive Y. Only local address in the local 
axis eccentricities are provided and care should be taken to provide the prismatic properties or 
to specify the correct angle BETA when necessary rotate the coordinates of the member. Two 
types of prestressing load specification are available; PRESTRESSING (prestress) where the 
effects of the load the rest of the structure is transmitted, and (POST-TENSIONING) 
POSTSTRESS where charging effects are only experienced by members in that it is applied. 

 

1) It is assumed that the cable has a generalized parabolic profile. It is assumed that the 
equation of the parabola is 

 

and ax2
 

 

bx c 

 
 

Where:
 t
o 

 
1 2es 

L2
 

 
4em 

 
2ee 

 

b  
1 4em ee L

 
 

3es 

c is  
 

 

Where is = 
 

eccentricity of the cable to the beginning of the member 
ee 
e

= 
= 

the eccentricity of the cable through the member (local axis) 
eccentric cable end member (local axis)

L = Limb length 
 

 

2) The tilt angle of the cable with respect to the local x axis (a straight line connecting 
the start and end joints of the limb) the start and end points are small which gives 
rise to the presumption that 

 

run out dy / dx 
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Hence, if the axial force in the cable is P, the vertical component of the force to the end is P (dy / 
dx) and the horizontal component of the rope force is, 

 

dy  
2
 

P 1 
dx 

 
Users to ensure that your profile meets this requirement cable is advised. Less than 5 degrees are 
recommended 

 

 
3) The member is tested for the effects of prestressed or post-tensioned using the equivalent 

load method. This method is well documented in most books recognized in the Analysis 
and Design of Prestressed Concrete. The magnitude of the uniformly distributed load is 
calculated as 

 

 
u d l   

8 Pe  
 

L 

and 
s ee 

em
 

2 
 
 

Where: 
 

P = axial force on the 
wire L = length of the 
member 

 
4) It is assumed that the force on the cable is the same along the length of the member. 

No reduction is taken into account in the cable due to friction or other losses. 
 

5) PRESTRESSED MEMBER The term as used in STAAD means the following condition. 
The structure is built first. Then, the prestressing force is applied to the relevant 
members. As a result, members are deformed depending on the conditions of its ends, 
the forces are transmitted to other members in the structure. In other words, "PRE" 
refers to the time of placing the member on the structure relative to the time of pre-
stressing. 

 
6) The POST-TENSIONING MEMBER term as used in the following condition Staad 

means. members in which such charge is applied are first molded in the factory. After 
this, the prestress force is applied to them. Meanwhile, the rest of the structure is built 
on the building site. So prestressing members are brought and placed in position on 
the partially built structure. Because this sequence, the effects of prestressing are 
"experienced" by prestressing members only and not transmitted to the rest of the 
structure. In other words, the "POST" refers to the time of placing the member on the 
structure relative to the time of esforzamiento. 

 
7) As may be evident from Article (6) above, it is not possible to estimate the 

displacements of the ends of the members post-tensioned to the effects of post-
tensioning and is assumed to be zero. As a result, intermediate displacements of 
sections l (See SECTION OFFSET command) are measured by relating as a straight 
line connecting the start and the end of the boards of member defined by its 
coordinates in the initial BOARD. 
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1.16.6 Load Temperature / Voltage (Temperature / Strain Load) 
 
 

See 
section 
5.31.6 

 
Uniform temperature differences along the members and items can be specified. Temperature 
differences across both sides of the members and through the thickness of plates can also be 
specified (the temperature is uniform only for solids). The program calculates the axial strain 
(elongation and shrinkage) due to the different temperatures of the members. This calculates 
the induced forces in the member and the analysis is done accordingly. They can get the 
voltage ranges elongation and shrinkage directly. 

 

1.16.7 Load by Displacement the Support (Support Load 
Displacement) 

 
 

 
 

See 
section 
5.31.8 

 
A static structure thus refers to the displacement of the supports may be applied loads. The 
displacement can be translational or rotational. Translational movements in units of length are 
provided while rotational movements are always in degrees. Note that you can only specify the 
displacements in directions in which the support has a specification "force" in the Command 
Support. 

 
 

1.16.8 Loading in the Elements (Loading on Elements) 
 

The elements of plate / Eggshell, load Allowable types are: 
 

1) Pressure loads consisting of loads acting perpendicular to the surface of the element. 
Pressure loads can be of uniform or trapezoidal intensity and intensity variation on a 
small or on the entire surface of the element portion. 

 

2) The loads on the board are forces or moments are applied at the joints in the direction 
of the global axes. 

 

 
3) The loading temperature may be constant throughout the plate element (causing only 

elongation / or shortening) may vary through the depth of a plate bending element 
causing the plate element. The coefficient of thermal expansion for the material of the 
element shall be provided to facilitate the calculation of these effects. 

 

4) The weight of the elements can be applied using the load condition SELFWEIGHT. 
The density of the elements has to be given to facilitate the calculation of the own 
weight. 

 

 
In the Solid Elements, The only three available charging types are 

 
1) The weight of the solid elements using load condition SELFWEIGHT may apply. The 

density of the elements has to be given to facilitate the calculation of the own weight. 
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2) The load on the joints which are forces or moments are applied at the joints in the 
direction of the global axes. 

 

 
3) The loading temperature may be constant along the solid elements (causing only 

lengthening / shortening). The coefficient of thermal expansion for the material of the 
element should be to facilitate the calculation of these effects. 

 
 

Note: Only the translational stiffness is supported on solids. Thus, at the 
joints where solids only, no moments are applied. For best efficiency, the 
rotational supports should be used in these joints. 

 

1.17 Load Generator (Load Generator) 
 
 

STAAD is equipped with built-in algorithms to generate moving loads and seismic lateral loads 
(Uniform Building Code and the 1893 IS Code) in a structure. Using the application load 
generation consists of two parts: 

 
1) The definition of the system (s) load. 

 
2) Primary charge generation using the system (s) predefined load). 

 

The following sections describe the salient features of the moving load generator, the generator 
of seismic load and wind load generator available. 

 

1.17.1 Loads Generator Mobile (Moving Load Generator) 
 
 
 
 
See 
Sections 
5.30.1 
and 
31/05/12 

 
This feature allows the user to generate moving loads in the members of a structure. The 
system (s) of moving load is concentrated load to specified fixed distance in both directions in 
a plane and can be defined by the user. If a user specified number of primary load cases as a 
result will be generated by the program and will be considered in the analysis. Loads of The 
American Association of State Highway and Transportation Officials (AASHTO, 1983) are 
available within the program and can be specified using normal AASHTO designations. 

 

1.17.2 Seismic Loads Generator UBC / IBC (UBC / IBC Seismic Load Generator) 
 
 

 
 
 

See 
Sections 
5.30.2 an

d 
31/05/12 

 

In STAAD seismic load generator follows the UBC or UBC procedure equivalent lateral load 
analysis. It is assumed that the lateral loads shall be applied in the X, Y and Z be the direction 
of the gravity loads. Thus, for a model of the building, the Y axis is perpendicular to the floors 
and point upward (positive coordinates of all joints Y). The user must provide their model 
accordingly. The total lateral seismic force or base shear is calculated automatically by using 
STAAD UBC appropriate equation. 

 

To generate load codes, requires the user to provide the coefficients of the seismic zone, 
importance factors, periods, etc. See Section 5.31.2 for detailed input required for each code. 
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Instead of using UBC approximate formulas for estimating the period of the building at a 
certain address, the program calculates the period using the Raleigh ratio technique. This 
period is then used to calculate the seismic coefficient C. 

 

 
After the base shear is calculated from the appropriate equation is distributed among the various 
levels, extending UBC specifications. The cutting basal are then distributed as lateral loads applied 
to the structure. These loads can then be used as normal load cases for analysis and design. 

 

1.17.3 Wind Loads Generator (Wind Load Generator) 
 
 
 
 
See 
Sections 
5.30.3 an

d 
31/05/12 

 

The loading STAAD Wind is able to calculate wind loads on the boards of a structure when 
the user specified Wind intensities and exposure factors. Can be specified for different 
intensities of wind different areas of the structure height. They can be shaped openings in the 
structure using the exposure factors. An exposure factor is associated with each joint of the 
structure and is defined as the fraction of the catchment area in which they operate wind loads. 
Built-in algorithms calculate the exposed area based on automatically limited by the Member 
(not considered plates and solid), then calculates wind loads of intensity and exposure and 
tucked distributes loads and lateral loads on the joints areas. 

 

1.18 Options Analysis 
 
 
 

ANALYSIS The following options are available in STAAD. 
 

1) Stiffness Analysis / Linear Static Analysis 
 

2) Static Analysis of Second Order 
 

a. P-Delta Analysis 
 

b. Nonlinear Analysis 
 

c. Linear Multi Spring Bracket 
 

d. Only Member / Spring Tension / Compression 
 

3) Dynamic Analysis 
 

a. Through Time 
 

b. Response Spectrum 
 

Salient features of each type of analysis in the following sections are discussed. The detailed 
theoretical treatments of these features are available in the standard textbooks of structural 
engineering. 
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1.18.1 Analysis of Stiffness 
 
 

 
 
See 
section 
5.35 

 
The stiffness tests performed on Staad is based matrix displacement method. In the analysis of 
the array of structures to the displacement method, the first idealized structure an assembly of 
discrete structural components (members of the frame or finite element). Each component has 
a scroll shape assumed in a manner which satisfies the balance of power and compatibility of 
the displacement of the joints. 

 
The structural system as slabs, sheets, approximately square foundations, etc., that transmit 
loads in two directions have to be discretized in finite element 3 or 4 nodes connected to each 
other. Charges may apply in the form of distributed loads on the surfaces of the element or 
as concentrated loads at the joints. The effects of voltage levels and the effects of bending of 
the plate taken into account in the analysis. 

 

 

Analysis The consideracione s 
 

For a complete analysis of the structure, the necessary matrices are generated based on the 
following assumptions: 

 

 
1) The structure is idealized into an assembly of beams, plates and solid type elements 

joined at their vertices (nodes). The structure is loaded and reacts to concentrated loads 
acting at the knots. These loads may be forces and moments that can act in any 
direction specified 

 
2) A beam member is a longitudinal structural member having a constant, a doubly 

symmetrical or near symmetrical doubly through its cross-sectional length. Beam 
members almost always carry axial forces. They can also be subjected to shear and 
bending in two arbitrary perpendicular planes, and can also be subjected to torsion. 
From this point of view these beam members are called "members" in the manual. 

 
3) A plate element is a flat element that three or four nodes have the constant thickness. 

A three-dimensional solid element is an element of 4-8 knots. These plates and solid 
elements are called "elements" in the manual. 

 
4) Internal and external loads acting at each node are balanced. If the torsional or flexural 

properties are defined for any member, six degrees of freedom are considered at each 
node (that is, three translational and three rotation) in the generation of the relevant 
matrices. If the member is defined as reinforcement member (ie carrying only axial 
forces) then only the three degrees (the translation) of freedom is considered at each 
node. 

 

5) Two types of coordinate systems in the generation of the required matrices are used and 
are called local and global systems. 

 

 
Local coordinate axes are assigned to each individual element and is oriented such that the 
computation effort for the element stiffness matrices generalizes and minimized. The axes of 
the world coordinates are a common data set for all idealized elements to the element force 
and displacement can be related to a common frame of reference. 
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The  Basic 
Equation 

 

The matrix of complete rigidity of the structure is obtained by systematically adding the 
contributions of the various members and stiffeners. External loads on the structure are shown 
as discrete action of concentrated loads acting only at the nodal points of the structure. 

 
The stiffness matrix relates these loads to the movement of the nodes by the equation: 

 
Aj= Aj+ Sjx Dj 

 
This formulation includes all joints of the structure, either if they are free to move or restricted 
for the supports. These components of displacements of the board you are free to move are 
called the degrees of freedom. The total number of degrees of freedom is the number of 
unknowns in the analysis. 

 

 

The Resolve method pa ra zamientos Desplà 
 

There are many methods to solve the unknowns in a set of simultaneous equations. An 
approach which is particularly suitable for the structural analysis method is called 
decomposition. This method was selected for use in STAAD. Since the stiffness matrices of all 
elastic structures are always linearly symmetrical, a particularly efficient form of decomposition 
called Modified Cholesky method can be applied to these problems. This method is very 
accurate and very suitable for the Gauss elimination process by solving the simultaneous 
equations. 

 

 

Consideration Bandwidth 
 

The decomposition method is particularly effective when applied to an array of symmetric 
band. For these types of matrix calculations are required less due to the fact that outside of 
the band elements are all zero. 

 
STAAD takes full advantage of the concept of bandwidth during the solution, to seek to have 
the lowest bandwidth for the most effective solution. For this purpose, STAAD offers features 
for which the program can internally reorder the numbering of the joints to provide better 
bandwidth. 

 
Integrity ructural Est 

 
 

The integrity of the structure is a very important requirement that must be satisfied for all 
models. Users should ensure that the developed model represents only one structure, not two 
or more separate structures. 

 
A structure "whole" or "a" structure can be defined as a system where appropriate "rigid 
connections" between members / elements. The functions of the complete model are taken as 
a single integrated load resisting system. Two or more independent structures within a model 
result in erroneous mathematical formulations and therefore generates numerical problems. 
Staad structural integrity check using a sophisticated algorithm and provides reports of multiple 
structures in the model. 
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Numerical Modeling Issues and Instability 
 
 

Instability problems can occur due to two primary reasons. 
 

1) Modeling Problem: There are a variety of problems in modeling can 
lead to unstable conditions. They can be classified into two groups. 

 
a. The local instability ‐ A local instability is a condition where 

the conditions of embedment in the end (s) of an individual 
is  such  that  cause  instability  in  the member  about  one  or 
more degrees of freedom. Examples of local instability are: 

 
i. Relaxation member: Members released at both ends for 

any of the following degrees of freedom (FX, FY, FZ and 
MX) will be subject to this problem. 

 
ii. A designed with columns and beams structure where 

the columns are defined as members "ARMOR." Such a 
column has no ability to transfer shear or moments of 
the superstructure to supports. 

 
b. The Global  Instability  ‐  It  is  caused when  the  supports of  the 

structure are such that they can not resist to slide or overturn 
the structure  in one or more directions. For example, a 2D  (a 
frame  in  the XY plane) structure  that  is defined as a SPATIAL 
FRAME with articulated supports and subjected to a force in the 
direction  of  Z  will  dump  over  the  rotating  axis  X.  Another 
example  is  that  of  a  spatial  framework with  all  the  supports 
released for FX, FY and FZ. 

 
2) Precision  Mathematics:  An  error  occurs  when  mathematical 

precision numerical instabilities occur in the decomposition of the 
matrix (investment) process. A condition of equilibrium equation 
takes the form 1 / (1‐A), where A = k1 / (k1 + k2); k1 and k2 being the 
stiffness coefficients of two adjacent members. 

 
When a member very "rigid" is adjacent to a very "flexible" member, vis., When the k2 
>> k1, k1 + k2 or k1, A = 1 and, hence 1 / (1-A) = 1 / 0. So, do not allow large variations 
in the stiffness of adjacent members. Artificially high values of E or I should be reduced 
when this occurs. 

 
It also causes error mathematical precision when the units of length and strength to 
properly lengths member is not defined, member properties, constants, etc. 

 
Users also have to ensure that the defined model structure represents only one, not 
two or more separate structures. For example, in an effort to model an expansion joint, 
the user may end up defining separate structures within the same input file. Multiple 
structures defined in the same file can lead to grossly erroneous results. 
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1.18.2 Analysis of Second Order (Second Order Analysis) 
 
 

 
See section 
5.35 

 
 
 
 
 
 
See section 
5.35 

STAAD provides the ability to perform stability analysis of second order. Two methods are 
available a simplified method called the P-Delta analysis and a detailed method called Nonlinear 
Analysis. Both methods are explained below. 

 
 

1.18.2.1 P-Delta Analysis 
 

 
Structures subjected to lateral loads often experience secondary forces due to moving the point 
of application of the vertical loads. This side effect, commonly known as the P-Delta effect, 
plays an important role in the structure analysis. In STAAD, a single procedure has been 
adopted to incorporate the effect of P-Delta analysis. The procedure involves the following 
steps: 

 

1) First, the primary deflection is calculated based on the application of external loads. 
 

2) Are then combined primary loads deviations originally applied to create the secondary 
loads. The load vector is then revised to include the side effects 

 

 
 
Note: The side load must be submitted concurrently with the vertical 
load  for  proper  consideration  of  the  effect  of  P‐Delta.  The  option 
REPEAT  LOAD  command  (REPEAT  LOAD)  (see  Section  5.32.11)  was 
created with this requirement in mind. This option allows the user to 
combine  the  cases  of  pre‐defined  primary  charge  to  create  a  new 
primary charging case. 

 
 

3) A new analysis of rigidity is carried out based on the revised load vector to generate 
new deflections. 

 
4) The forces in the Element / Member and reactions are calculated based on the new 

deflections. 
 

 
It may be noted that this method yields very accurate results with small displacement problems. 
Allows the user to Staad through multiple iterations of the procedure of P-Delta if necessary. 
Allows the user to specify the number of iterations depending on the requirement. To set the 
convergence tolerance of displacement between the SET DISP command before the coordinates 
of the Board. If the change in the rule of displacement from one iteration to another is less than 
f then converge. 
 
The P-Delta analysis is recommended by various design codes such as ACI 318, LRFD, IS456-
1978, etc. instead of time amplification method to calculate more realistic forces and moments. 
 
The P-Delta effects are only calculated for framing members and elements of the plate only. 
They are not calculated for the solid elements. The P-Delta and Nonlinear analysis restricted 
to structures where members and plate elements carry the vertical load from one level to the 
next structure. 
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1.18.2.2 Nonlinear Analysis 
 
 
 
 
 
See section 
5.35 

 
STAAD also offers the ability to perform nonlinear static analysis based on the geometric 
nonlinear analysis. The algorithm of nonlinear analysis incorporates both geometric corrections 
member stiffness and secondary loads. 

 
The Nonlinear analysis methodology is generally adopted for structures subjected to large 
displacements. As large displacements generally produce significant moves the point of 
application loads, consideration of secondary loads becomes an important criterion. In addition, 
the geometric stiffness corrections to take into account the modified geometry apply. Since 
geometric stiffness corrections are based on the generation of movement are different for 
different load cases. This makes the analysis option is non-linear load dependent. Staad 
algorithm of nonlinear analysis involves the following steps: 

 
1) First, the primary movements are calculated for the applied load. 

 
2) Stiffness corrections are applied in the Member / plate based on stiffness matrix shifts 

observed in the element. The new global stiffness matrix is assembled based on the 
stiffness matrices revised member / element which uses the coordinates of the board 
updated. 

 

3) Load vectors are revised to include the side effects due to the primary movement. 
 

4) The new set of equations is solved to generate the new displacement. 
 

5) Forces on Elements / Members and the support reactions are calculated from these 
new displacement. 

 

 
6) STAAD algorithm of non-linear analysis allows the user to go through multiple 

iterations of the above procedure. The number of iterations can be specified by the 
user based on the requirements. It may be noted, however, that multiple iterations 
may increase the requirements of computer resources and execution time substantially. 

 

Note:  The  following  points  should  be  noted  with  respect  to  the 
choice of non‐linear analysis 

 
7) Since the procedure is dependent on the load, the user is required to use the SET NL 

command and the command CHANGE properly. NL SET command be provided to 
specify the total number of cases of primary charging. CHANGE command should be 
used to restore the stiffness matrices after each load case. 

 

8) When geometric corrections are based on displacement, all loads that are capable of 
producing significant shifts should be part of the case (s) charge for the non-linear 
analysis. 

 

 
9) To set the tolerance of divergence of displacement, a SET DISP f is entered before the 

coordinates of the Board. If any shift in any iteration exceeds f, then the solution is 
diverging and terminated. Value 
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f is preset for the largest overall width, height, or depth of the structure divided by 120. 
 

The P-Delta and Nonlinear analysis restricted to structures where members or plates carry the 
axial load from one level to the next structure. 

 
 

1.18.2.3 Multi-Linear 
Analysis 

 

 
When the ground is modeled as spring supports, the resistance change due to external loads 
can be modeled using this option, as well as their behavior differs from tension to compression 
behavior. The characteristics of soil stiffness-displacement can be represented by a multi-linear 
curve. The amplitude of the curve will represent the ground spring characteristic different offset 
values. The load case on an analysis of Multi-linear springs must be separated by the CHANGE 
command and should be done with the ANALYSIS EXECUTE command. The SET-NL 
command be provided to specify the total number of cases of primary charging. There can be 
no PDELTA, NONLINEAR, dynamic, or membership in cases TENSION / COMPRESSION. 
The command of Multi-linear spring start an iterative analysis continues until convergence. 

 
 

1.18.2.4 Analysis of Tension / Compression Only 
 

 
When members or support springs are linear but carry only tension (or compression only), 
then this analysis can be used. This analysis is automatically selected if any member or spring 
has been characteristic only tension or compression. This analysis is an iterative analysis 
continues until convergence. Any member / spring fails in his opinion be inactivated (not 
shown) in the next iteration. The iteration continues until all members have the appropriate 
load address or are inactive (the predefined iteration limit is 10). 

 
This is a simple method that can not be worked in some cases because the members are 
removed at internal iterations because they are needed for stability. If messages appear 
instability at 2 and subsequent iterations that did not appear in the first cycle, then use the 
solution. If this happens in cases where the springs are the only entities tension / compression, 
then use the analysis of Multi-linear spring. 

 
The load cases on an analysis of tension / compression must be separated by the CHANGE 
command and should be performed with the RUN command from the ANALYSIS. NL SET- 
command be provided to specify the total number of cases of primary charging. There can be 
no case of Multi-linear springs, NONLINEAR, or dynamic cases. 

 
 

1.18.2.5 Nonlinear Analysis Cable / Armor 
 

 
When all members and supports spring elements are linear except the cable and truss members, 
then this analysis can be used. This analysis is based on applying the load balancing steps with 
iterations until convergence in each step. The step size starts small and gradually increases (15 
steps is the default), the iteration continues until each step change in strain is 
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little before proceeding to the next step. If there is no convergence, then the step is repeated 
with step size low (once). If you have not converged, then the solution is stopped. The user can 
then select more steps or alter the structure and reanalizarla. Conversely, if several consecutive 
steps easily converge, then the step size is increased automatically. 

 
Structures artificially stabilized during the first load steps if the structure is initially unstable (in 
the small linear static displacement, in a theoretical sense). 

 

The user has control over the number of steps, the number of iterations for step, tolerance of 
convergence, and artificial stiffness stabilizer 

 

 
This method assumes small displacement theory for all members / armor / items rather than 
cables and preloaded reinforcement. Cables and preloaded armor can have large or moderate 
/ great efforts displacements. It is assumed that the wires only carry loads of shear stress to 
the wire at each point. Preloaded armor may only carry only tension and compression or 
tension. The claim is necessary to stretch the cable / armor without straining its length to 
allow it to fit between the two end joints strength. Alternatively, you can enter longitude for 
cables without straining. 

 

The cable / preloaded course armature is automatically loaded by the weight, and optionally 
temperature. Moreover loads applied to the cables / Preloaded armor are ignored. Is it right to 
interrupt the cable / armor several members and apply forces to the intermediate joints. 

 
It is assumed and 
upward. 

 
In this analysis, the geometrical beams have armor and rigidity. 

 

The strength of the member for printed wire is tangent to Fx and deformed wire board (not 
along the line of the cord). 

 

 
The load cases in a nonlinear analysis of the cable must be separated by the CHANGE 
command and must be made by the RUN command ANALYSIS CABLE. The SET-NL 
command be provided to specify the total number of cases of primary charging. There can be 
no case of Multi-linear spring, compression only, PDELTA, NONLINEAR, or dynamic cases. 

 
 

1.18.3 Dynamic Analysis 
 

 
The means of dynamic analysis currently available include solving the problem of free vibration 
(the eigenproblem), response spectrum analysis and forced vibration analysis. 

 
 

See 
Sections 
5.29, 
05/31/10, 
5.33 

 

Solution of Eigen problem 
 

The eigenproblema is solved for the frequencies of the structure and the mode shape 
considering a diagonal matrix of concentrated masses, masses possible in all 
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possible assets d.o.f. included. The subspace iteration method for all sizes of the problem (the 
default), and the optional method of determining search for small problems: They can be used 
two methods of solution. 

 
 
 
 

Mass Modeling 
 

The natural frequencies and mode shape of a structure are the primary parameters that affect 
the response of a structure under dynamic loading. The free vibration problem is solved to 
extract these values. Since no external forces function is involved, the natural frequencies and 
mode shapes are direct functions of the stiffness and mass distribution in the structure. The 
results of calculations of the frequency and mode shapes can vary significantly depending on 
the modeling of the masses. 

 
This variation, in turn, affects the response spectrum analysis and the results of forced vibration. 
Thus, extreme caution must be exercised in modeling the masses into a problem of dynamic 
analysis. 

 
In STAAD, modellation all bodies that are able to move as loads applied in all possible 
directions of movement. Although it is known that the load will be in one direction there is 
usually mass movements in other directions in some or all joints and these directions of the 
masses (the "charges" in weight) must be entered to be correct . Moments of the board that 
are admitted are 

shall consider are moments of inertia weight (in units of force-length2 
 
 

Please enter the weight and loads on the joints and elements in the global addresses with the 
same sign as much as possible so that the "masses" are not canceled. Member loads / element 
may also be used to generate translational masses joints. 

 
Note: The moments in joints extreme members generated by the load on 
the member (including concentrates now) is dismissed as irrelevant to the 
dynamics. Enter the moments of inertia, if necessary, at meetings of the 
board as moments. 

 
STAAD uses a diagonal matrix mass of 6 equations for mass concentrated together. The weight 
or loads evenly member 50% focus on each end joint without rotational mass moments of inertia. 
The other elements are integrated, but talking real sense the weight is equally distributed between 
the joints of the element. 

 
The members / elements in the theory of finite element are simple mathematical 
representations of deformation applied over a small region. FEA procedures converge if you 
subdivide the elements and run the analysis again; then subdivides the elements that have 
significantly changed the results and run the analysis again; etc. until significant results 
converge to the accuracy needed. 

 
An example of a simple beam problem that needs to subdivide the real members to better 
represent the mass distribution (and the dynamic response and the force distribution along the 
member) is a single-beam floor between 2 columns 
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put all the mass in the joints of the spine. In this example, a vertical ground motion will not 
bend the beam even when a concentrated force (weight) to the clearing. 

 

 
Furthermore, the dynamic results will not reflect the situation of a body within a Member (ie 
the masses are concentrated at the joints). This means that the movement of a large mass in 
the half of the member connected to the ends of the member, is not considered. This can affect 
the frequencies and mode shapes. If this is important to the solution, cut the member in two. 

 
Another effect of moving the masses to the boards is that the distribution of shear / moment 
resultant are based as if the masses were within the member. Also note that if one end of a 
support member is, then half of that mass is concentrated to the support member and will not 
move during the dynamic response. 

 
 

Modeling Damping 
 

The damping values can be specified for each sticking mode, or using a formula based on the 
first two frequencies, or using the composite modal damping. The modal damping compound 
to calculate the damping of a mode different damping ratios for different materials (steel, 
concrete, soil). 

 
Modes which would deform the steel mainly damping ratio of the steel, while modes mainly 
deform the floor, should the soil damping ratio. 

 

 
 
 
 

 
 
 
See 
section 
05/31/10 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
See 
Sections 
5.30.6 
and 
5.31.10.2 

Analysis Espe ct ro Response (Spect rum Analysis) 
 
This capability allows the user to analyze the structure for seismic loading. For any response 
spectrum that provided (or any acceleration against displacement against time period), 
displacement of the joint forces in the members, and can be calculated support reactions. They 
can be combined modal responses using the methods of the square root of the sum of squares 
(SRSS), the complete quadratic combination (CQC), the ASCE4-98 (ASCE), the Ten Percent 
(TEN) or absolute (ABS) to obtain the resulting responses. 
 
They can be combined spectrum analysis results of response to the results of static design for 
subsequent analysis. To account for the reversibility of seismic activity, load combinations can be 
created to include the positive or negative contribution of the seismic results. 

 
 
 
 

Response Analysis Over Time (Response Time History Analysis) 
 

 
STAAD is equipped with a facility for a response history analysis on a structure attached to a 
function of variables forces eventually loads at joints and / or 
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ground motion at the base. This analysis is performed using the modal superposition method. 
 

 
Hence, all masses must be modeled as active loads to facilitate the determination of modal shapes 
and frequencies. Please refer to the section above on "modeling mass" for additional information 
on this topic. In the mode superposition analysis, it is assumed that the structural response can 
be obtained from the lowest modes "p". The equilibrium equations are written as 

.. . 
[M] {x} + [c] {x} + [k] {x} = {Pt} ... ... (1) 

 
Using the transformation 

 

p 

x iqi 

i 1 
 

Equation 1 reduces to "p" to separate equations of the form 
 

qi2 i iqi 
 

iqi 

 

Ri(T) 

 

Where is the modal damping ratio and the natural frequency for the ith mode. 
 

These are solved by the Wilson method - which is an unconditionally stable scheme step by 
step step. The passage of time for response is chosen as 0.1 T where T is the period of the 
highest mode to be included in the response. The qis is substituted into equation 2 to obtain 
the displacements {x} at each time step. 

 
 
 
 
 

Analysis through Time pa ra d a a struc aa ra Sujet Harmonic 
Loads 

 
 

A harmonic load is one in which can be described using the following equation 
 

F (t) F0sin (t ) 

 
 

In the above equation, 
 

F (t) = The value of the function of force at any instant of time "t" F0
 = Maximum value of the power function 

= Frequency of the forcing function 
= The phase angle 

 
 

A drawing in the above equation is shown in Figure below. 
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Note: Results are the maximum of the total time, including transients 
at first, not tied to any results‐constant response. 

 

 
Defining Entry into STAAD tion for Fun Force Prve r 

 
 

As can be seen from its definition, a function of force is a continuous function. However, 
Staad, a set of pairs of discrete time-force generated by the force function and an analysis was 
performed using these discrete pairs of force over time. What it means is that based on the 
number of cycles that the specific user for loading, Staad generates a table consisting of the 
magnitude of the force to the various time points. Time values are chosen from time 0 to n * 
tc in steps of "STEP" where n is the number of cycles and tc is the duration of a cycle. STEP 
is a value that the user can provide or choose the preset that is built into the program. STAAD 
to adjust the STEP ¼ cycle is divided into one or more steps. Users can refer to section 5.31.4 
of this manual for a list of input parameters that need to be specified for Analysis Over Time 
in a structure subjected to a harmonic load. 

 

The relationship between variables in STAAD entries and the corresponding terms in the 
equation shown above is explained below. 

 
F0 WIDTH = 

= FREQUENCY 
PHASE = 

 
 
 

1.19 Forces in the ends of the member 
 
 
 
See 
section 
5.41 

 
The forces and moments on the end of a member are a result of loads applied to the structure. 
These forces are in the coordinate system of local member. Figure 1.18 shares samples at the ends 
of members with their addresses. 
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Figure 1.18 
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Note: The local X axis goes into the page; And overall is vertically upwards; 
The shaded area indicates the area under compression; Non‐shaded area 
indicates the area under the stress 

 

 
 
 

1.19.1 The Secondary Analysis 
 
 

See 
Sections 
5.38, 5.41, 
5.42 and 

5.43 

 
The solution of the equations of stiffness resulting displacements and forces in the joints or 
end points of the member. STAAD is equipped with the following options for secondary 
analysis results at intermediate points within a Member. 

 
1) Member forces in the middle sections. 

 
2) The movement of the member in the middle sections. 

 
3) Efforts in the member specific sections. 

 
4) Grouping loads (Load Envelope) to 

 
The following sections describe the options for secondary analyzes in detail. 

 

1.19.2 Member forces in the Middle Sections 
 
 
 

See 
Sections 
5.39 and 
5.41 

 
With the SECTION command, the user can choose any intermediate section of a member 
where the forces and moments need to be calculated. These forces and moments can also be 
used in the design of the members. The maximum number of specified sections can not exceed 
five, including those who are at the beginning and end of a member. If no intermediate section 
is required, the program will consider the forces at the beginning and end of the member for 
design. However, only the sections that are proportionate, will be taken into consideration in 
the design. 

 

1.19.3 Travel by Members in the Intermediate Sections 
 

See 
Sections 
5.39 and 
5.41 

 
As the forces, displacements can be printed or plotted onto intermediate sections of the 
members. This command can not be used for reinforcement or wire-like members. 

 

1.19.4 Efforts on Specific Sections Members 
 

 

See 
Sections 
5.39 and 
5.41 

 

Efforts can be printed in the members specified intermediate sections as well as the start and 
end joints of the limb. These efforts include: 

 
a) Axial stress is calculated by dividing the axial force by the area of the particular 

cross-section, 
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b) And bending stress is calculated by dividing the time by the local address and the 
section modulus in the same direction, 

 

 
c) Z bending stress is the same as above except that it is in the local z direction, 

 
d) The shear stresses (in directions y, z), and 

 
e) Combined effort is the sum of efforts axial, bending and bending and Z. All 

efforts are calculated by taking the absolute value. 

1.19.5 Grouping Loads 
 
 
 
 
See section 
5.42 

 

The envelopes of forces of a force in the FX (axial force), FY member (Cut in-y) and MZ (the 
moment about the local axis z, that is the major axis) may be printed for any number of 
intermediate sections . The force values include the maximum positive and maximum negative 
value. The following is the sign convention for maximum and minimum values: 

 
FX: A positive value is compression, and negative voltage. 
FY: A positive value is the cut in the positive y direction, and negative in the negative direction. 
FZ: Same as above except the local z direction. 
MZ: A positive time means a time that causes the tension in the upper member. Conversely, 

when a negative voltage will cause the bottom of the member. The top of a member is 
defined as one that is in the positive direction of the local axis. 

MY: Same as above, except that it is on the local z axis. 
 

 
 

1.20 Multiple Analysis 
 
 

The analysis / structural design may require multiple analyzes in the same run. STAAD allows 
the user to change the input data as member properties, support conditions etc. in an input 
file to facilitate multiple analyzes in the same run. They can be combined the different analysis 
results for design purposes. 

 
For shoring structures, it may be necessary to make certain inactive participants for a particular 
load case and subsequently activate them to another. STAAD contains INACTIVE option for 
this type of analysis. The INACTIVE option is discussed in detail in the following paragraph. 

 
 

 
 
See section 
5.18 

Inactive Members 
 
With the IDLE command (INACTIVE), inactive members do. These inactive members are not 
considered in the analysis of stiffness or in any of the prints. Members made inactive by the 
INACTIVE command are made active again with the command CHANGE (CHANGE). This 
can be useful in an analysis where only the desired tension bracing, this way only a certain 
group members will be inactive for certain load cases. This can be achieved as follows: 
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a) making the desired inactive members; 
 

b) providing relevant load cases for which the members are inactive; 
 

c) performing the test; 
 

d) using the CHANGE for all active command inactive members; 
 

e) and making another set of inactive members and providing appropriate load cases to 
which members are to take inactive, and performing analysis by repeating the above 
procedure as many times as required 

 
 
 
 
 

1.21 Design of Steel / Concrete 
 

See 
Sections 2 
3 and 4 

 

 
STAAD has extensive design capabilities for steel sections, concrete and wood (the latter will not 
be seen). The details about the design of steel and concrete information is presented in Sections 
2 and 3 respectively. 

 
 
 

1.22 Design of Foundations 
 
 

The option for the design of foundation is able to design individual foundations for support 
(s) the user specified. All cases of active load are verified and the design is made for support 
reactions requiring the maximum size of the foundation. Parameters can control the design. 
The output includes the dimensions of the foundation and reinforcement details. The anchor 
rods and development lengths are also calculated and included in the result of design. A 
description and specification (s) for the design of the command you are available in section 
5.48 of this manual. 

 
 

1.23 Printing Facilities 
 

 
 

All input and output data and the results can be printed using the PRINT command (PRINT) 
available in STAAD. The input data are usually repeated in the output file. This is important 
from a viewpoint of the documentation. However, if required, they can be omitted. 

 

 
Extensive options listed are provided in almost all PRINT commands allow the user to select 
boards or members (elements) for which values are required. 
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1.24 Plotting Facilities 
 

 
Please refer to STAAD.Pro Graphical Environment Manual for a complete description of the 
wide screen and printing graphic media available and how to use them. 

 

1.25 Miscellaneous Facilities 
 

 
 
See 
section 
5.17 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
See 
section 
5.15 

 

STAAD offers the following miscellaneous means for troubleshooting: 
 
 
 
 
 

Perform ROTATION 
 
This command can be used to rotate the shape of the structure through any desired angle for 
any global axis. The rotated configuration can be used for further analyzes and designs. This 
command can get after the coordinates of the Board or between two commands Coordinate 
Board or after all Trouble Member / Element are specified. 

 
 
 

SUBSTITUTE  (S  ustit 
ution) 

 
You can redefine numbering Staad members together and through the use of SUBSTITUTE 
command. After that a new set of numbers is assigned, the values of input and output agree 
with the new numbering scheme. This option allows the user to specify numbering schemes that 
produce input specifications simple and easy interpretation of the data. 

 
 
 

The calcu ass of Cen ter G ravity 
 

Staad is able to calculate the center of gravity of the structure. The CG PRINT command can 
be used for this purpose. 

 

 
 
 
 

1.26 Post Facilities Process 
 
 
 

All outputs of the STAAD run can be used in subsequent processes by STAAD.Pro GUI. 
Please refer to STAAD.Pro Manual (Volume I) for a complete description of the extended 
screen and printing graphic media available and how to use them. 
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Section 2 

American Steel Design 
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2.1 Operations Design 
 
 

STAAD contains a wide variety of resources for the design of structural members, as individual 
components of a structure analyzed. The resources which account for the design of members, 
give the user the ability to perform many different operations design. These options can be 
selectively used according to the requirements of the design problem. The operations to make a 
design are: 

 

    Specify members and load cases to be considered in the design. 
 

    Specify whether run either code check or selecting members. 
 

    Specify the values of the design parameters when they are different from the values assigned by 
default. 

 

These operations can be repeated by the user as often as necessary, depending on the specific 
requirements of the design. 

 
The steel design can be performed based on the following codes: AISC-ASD, AISC-LRFD and 
AASHTO. A brief description of each is presented in the following pages. 

 

 
STAAD currently supports the design of steel wide runner (W), S, M, HP, angle, double angle, 
channel, dual channel with cover plate beams, joists and verification code prismatic properties. 

 
 
 

 

2.2 Properties Member (Member Properties) 
 
 

For specification of member properties of standard American steel sections, the library of available 
steel sections can be used in STAAD. The syntax for specifying the names of built-in steel forms 
are described in the next section. 

 
 

2.2.1 Made of Steel Sections Library 
 

The following sections describe the specifications of the AISC steel sections (9th Edition, 1989) 
Tables of Steel. 

 
 

 
A IS C T ab l A ce ro 

 

Most forms of AISC steel are available for entry. Then described are all types of sections are 
available: 
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Pa ti ne s an ch or s (Pe rfi l W) 
 

All wide-flange sections listed in AISC / LRFD-89 are available from the way they are 
written, for example W10X49, W21X50, etc. 

 

 

20 TO 30 AT ST W10X49 
ST 33 36 TA W18X86 

 
 

F o rm a s C, M C, S, M, HP 
 

The above forms are available as listed in AISC (9th Edition) without the decimal points. For example, 
C8X11.5 be entered as C8X11 and S15X42.9 to be entered as S15X42, omitting the decimal points. 
(Except: MC6X151 as MC6X15.1 and MC6X153 as MC6X15.3.) 

 
10 TO 20 BY 2 TA ST C15X40 
February 1 TA ST MC8X20 

 
 

Double Channels 
 

Double channels back to back, with or without space between them, are available. The letter D 
in front of the section name specified by a double channel. 

 

 

21 22 24 TA D MC9X25 
55 TO 60 TA D C8X18 

 
 

Angles 
 

Specifications in STAAD angles are different from those in the AISC manual. The following 
example illustrates the specifications of the angle. 

 

L = LD 40 35 6 4 x 3-1 / 2 x 3/8 
 

 

Sign Angulo Thickness in 1/16 inch 
 

10 times 10 times the length length 
inch from side across inch 

 
Similarly, L505010 = L 5 "x 5" x 8.5 "and L904016 = L 9" x 4 "x 1" 

 

 
At present there are two ways to define the local axes and Z axes for a local angle section. To 
make the transition from AISC Manual data easily to program the standard section for an 
angle specified: 

 
ST TA 51 52 53 L40356 

 

 
This specification has the local z-axis (that is, minor axis) corresponding to the axis specified 
in Tables ZZ steel. Many engineers are familiar with a convention 
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used by some other programs in the local y-axis is the minor axis. STAAD adhere to this 
convention accepting the command: 

 

 

TA RA 54 55 56 L40356 (RA denotes the reverse angle) 
 
 

Angles is Dobl 
 

Double angles with short side back to back with the long side or back to back can be specified 
by entering the word SD or LD, respectively, before the size of the angle. In case of an angle 
with equal sides or LD or SD will serve the purpose. 

 
14 TO 20 TA 0.5 SP LD L35304 Long Side Back to Back L3 -1/2 "x3" x1 / 4 " 

with 0.5 "space 
 

SD 23 27 TA L904012 Short side back to back L9 "x4" x3 / 4 " 
 
 

Profile T (Tees) 
 

T profiles are not paid by their real names, as listed in the AISC manual, designating instead 
of the shape of the beam (W and S) which were cut. For example, 

 

 

1 2 5 8 TA T T W8X24 W8X24 the cut of what WT4X12 
 
 

Pipes (Pipes) 
 

Two types of specifications for sections of this type may be used. Generally tubes (pipes) can be 
defined by its outer and inner diameters. For example, 

 

 

1 TO 9 TA ST PIPE OD 2.0 ID 1875 shall mean a tube with O.D. 2.0 and I.D. 
1,875 units in the system in use. 

 
 

Sections of pipe listed in the AISC manual can be specified as follows. 
 

5 TO 10 ST TA PIPX20 
 
 

PIP X 20 denotes extra strong pipe 2 "diameter 
 

Symbol Tube 10 x diameter in inches 
Specify only portion before 
the decimal point 

Spec. Resistance 
(S = Standard, X = Extra-strong, D = Double extra strong) 
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Rectangular Tubular (Tube) 
 

The rectangular hollow section AISC tables can be specified as follows. 
 

5 TO 10 ST TA TUB120808 
 

TUB 120 80 8 
 

Symbol Tub. Rec. Thickness in 1/16 inch 
 

Alto x 10 (in.) Width x 10 (in.) 
 

The rect tubular profiles. (Tubes) and tube (pipe), can be defined by its dimensions (height, 
width and thickness) as follows. 

 

 

6 TA DT ST TUBE WT 8.0 6.0 0.5 TH 
rect is a tubular profile. having a height of 8 ", a width of 6" and a wall thickness of 0.5 
". 

 

 
The team member can not be performed at specified tubes latest fashion. Only code checks 
may be made in these sections. 

 
 
 

Sun Beams Plates given 
 

Beams welded plates AISC manual can be specified as follows. 
 

B 61 October 20 
 
 

Symbol section manufactured Flange thickness in inches x 10 
............................................................ ...(Only the portion used before point 
...............................................................decimal) 

 

Nominal superelevation in inches Nominal width shoe (inches) 
 

Example: 
 

 
1 TO 10 ST TA B612017 
ST RT 15 16 B682210 

 

2.3 Permissible tolerances AISC Code 
 
 

For steel design, STAAD compares actual efforts as allowable stresses are defined by the Code 
of the American Institute of Steel Construction (AISC). The ninth edition of the AISC Code, 
published in 1989, is used as the basis of this design (except for the tensile stresses). Due to the 
large number and complexity of the AISC Code, it would be impractical to describe every aspect 
of the design of steel in this manual. Instead, a brief description of some of the largest allowable 
stress described below. 
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2

 

2.3.1 Tension Effort 
 

Efforts allowable tension in the net section is calculated as 0.60 Fy. 
 

2.3.2 Cutting Effort 
 

Allowable shear stress on the gross section, 
 

Fv= 0.4Fand 
 

 
For the shear in the soul, the entire section is taken as the product of the total depth and web 
thickness. For shear (cut) in the skates, the total cross section is taken as 2/3 of the total areas 
of the skates. 

 

2.3.3 Compressive stress due 
 

 
The allowable compressive stress in the overall section axially loaded compression members 
are calculated based on the formula E-1 AISC Code, when most slenderness ratio (Kl / r) is 
less than Cc. If Kl / r Cc exceeds the allowable compressive stress is decreased by the formula 
1E2-2 Code. 

 

Cc 2 E / Fand 

 
2.3.4 Flexural Strength 

 
The allowable bending stress, tension and compression, for a symmetrical member loaded in the 
plane of its minor axis, as given in section 1.5.1.4 is: 

 
Fb= 0.66Fand 

 

 
Yes meets the requirements of this 
section: 

 

a) bf / 2tf is less than or equal to 
65 / Fy 

b) bf / tf is less than or equal to 
190 / Fy 

c) d / t is less than or equal to 640 (1-3.74 (fto/ Fand)) / Fandwhen (fto/ Fand) <0.16, or 257 / Fandif 
(fto/ Fand) 
> 0.16 

d) The laterally unsupported length does not exceed 76.0bf / Fy (except for tubes or pipes 
rectangular), or 20,000 / (dFy / Af) 

e) The ratio of diameter to thickness of pipes shall not exceed 3300 
/ Fy 

 

Yes to these symmetric members, bf / 2tf exceeds 65 / Fy, but less than 95 / Fy, Fy = Fb (0.79 to 
0.002 (bf / 2tf) Fy) 
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For other symmetric members who do not comply with the above, Fb is determined as the 
greatest value based formulas or F1-7 F1-6 AISC and F1-8, but not greater than 0.60Fy. A rigid 
member not subjected to axial compression due to compression or bending is considered fully 
effective when the width-to-thickness ratio is not greater than: 
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76.0 / Fy, for single or double angles with dividers. 95.0 / Fy 
for double contact angles. 
127.0 / Fy, for the soul of beams T. 

 

When the actual width-thickness ratio exceeds these values, the allowable stress is governed by 
B5 AISC code. 

 

 
Tension and compression for doubly symmetric sections (I and H) with bf / 2tf less than 65 / Fy 
and folded about its minor axis, Fb = Yes 0.75Fy bf / 2tf exceeds 65 / Fy, but less than 95 / Fy 
, Fb = Fy (1075-0005 (bf / 2tf) Fy) 

 
For tubes, b and c are subsections of this section folded over the minor axis, Fb = 0.66Fy; if 
subsections b and c are not met that the width-thickness ratio is less than 238 / Fy, then Fb = 
0.6Fy. 

 
 

2.3.5 Combined Compression and Bending 
 

 
Members subjected to both axial efforts compression and bending are provided to meet the formula 
and H1-2 H1-1 AISC when fa / Fa is greater than 0.15 otherwise H1-3 formula is used. It should 
be noted that during code review or member selection, yes fa / Fa exceeds unity, the program 
will calculate the second and third part of the formula H1-1, because this would result in a 
virtually misleading reason. Cm coefficient value is taken as 0.85 and 0.6 for contraventeados 
members - 0.4 (M1 / M2), but not less than 0.4 to not contraventeados. 

 
 

2.3.6 Sections Symmetric alone 
 

For double Tee's angles and having only one axis of symmetry, the ratio KL / r about the YY 
axis is determined locally using the terms specified on pages 3-53 AISC Manual. 

 
 

2.3.7 The Twist by Publication T114 
 

 
The code 89 to the AISC Steel Design currently has no prevention for designing specific 
sections for the torsion. However, AISC has published a separate document called the 
"Torsional Analysis of Steel Members" that provides the standard for torsional moments 
transform normal stresses and shear stresses can be incorporated into the equations of 
interaction explained in Chapter H AISC code 89. publication guidelines are now incorporated 
in the 89-AISC steel design modules STAAD. 
To consider the stresses due to torsion code review or member selection procedure, TORQUE 
parameter with a value of 1.0 is specified. See Table 
2.1 for more details. 



TECHNICAL MANUAL STAAD.Pro 

83

 

 

 

Methodolog
y 

 

 
If the user were to ask the design for torsion, torsional properties required to calculate the 
warping normal stresses, the shear buckling and pure cutting efforts are first determined. These 
depend on the conditions of "limit" prevailing at the ends of the member. These boundary 
conditions are defined as "Free", "Articulated" or "Flush". Are explained below: 

 
Free: "Free" is the boundary condition that there is an open‐end beam flown. 
It means that no other member connected to the beam at that point. 

Articles:  "Articulated"  represents  the  condition  corresponding  to  a  pinned 

support  defined  in  the  board  through  the  support  (SUPPORT)  command  or 

relaxation of any of 
moments in the joint through a specification of relaxation Member (MEMBER 
RELEASE). 

 
Built  "Built"  represents  the  condition where  there  is  a  support  embedded  in  the 
board.  In  the absence of a  support on  that board,  represents a condition where a 
connection between  the rigid  frame member given me at  least one other member 
connected to that board. Also, any relaxation of the member must be present at that 
meeting in the given member. 

 
After the boundary conditions are determined, the normal stresses and shear stresses are calculated. 
The guidelines in the publication T114 concentrated torsional moments acting at the ends of the 
specific member to calculate these efforts are used. 

 
The warping normal stresses are added to the axial forces caused by the axial load. These are 
then substituted into the equations of interaction in Chapter H of AISC 89 code to determine 
the relationship. Cutting forces in the plane of roll to shear forces due to actual cutting and 
compared against the allowable shear efforts on the cross section is added. 

 

 
Restrictions 

 

 
This facility is currently available for wide forms of skate (the W, M and S), Flat, forms T, 
Rectangular Pipes and Tubular. Not available for Single, Double Angles Angles, members with 
PRISMATIC specification property, Composite sections (wide-flange shapes with concrete slab 
or plate on top), or Double Channels. Also, efforts are computed based on the rules for 
concentrated torsional moments acting on the ends of the member. 

 

2.3.8 Sections of Alma Design Variable 
 

 
Appendix F of AISC-89 contains the design specifications members Alma variable section. 
These specifications have been incorporated in STAAD for verification code in the forms of 
variable wide-flange web (web-tapered). Please note that the selection of a member can not be 
performed on members of variable section Alma. 
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2.4 Design Parameters 
 

 
The program contains a large number of names of parameters needed for the design and code 
review. These parameter names with their default values are listed in Table 2.1. These 
parameters communicate design decisions to software engineer. 

 
 
 
 
 
See Table 
2.1 and 
Section 
5.44.1 

 
The default values of the parameters have been selected such that they are the most frequently 
used in the conventional design. Depending on the requirements of the analysis of a particular 
design, some or all of these parameter values have to be modified to get the exact model of 
the physical structure. For example, the default value of KZ (k value in the local z axis) of an 
individual is set as 1.0, while in the actual structure may be 1.5. In that case, the value in the 
program KZ can be changed to 1.5, as shown in the directions of the entry (Section 6). 
Similarly, the value of a member of TRACK is set to 0.0 which means that any allowable stress 
of the member are not printed. If the allowable stresses to be printed, the value should be set 
to 1.0 TRACK. 
Note that the names of PROFILE, DMAX and DMIN parameter is only used in the 
member selection. 

 

2.5 Code Review 
 
 

 
See Section 
5.44.2 

 
The purpose of code review is to verify whether the properties of the sections provided to 
members are appropriate. The sufficiency is verified according to AISC-89. Code review is 
performed using the forces and moments in the specified sections of the members. If no section 
is specified, the program uses the start and end forces member for code review. 

 
When reviewing the code is selected, the program calculates and prints if the members have 
passed or failed the code; critical code AISC state (as either AISC specifications compressive 
stress, cutting, etc.); the value of the ratio of the critical condition (overstrain to a value greater 
than 1.0 or any other value of RATIO (RATIO) specified); governing load case, and the 
situation (distance from the start of the member) of forces in the member where the critical 
condition occurs. 

 
 

The code review can be made of any type steel section in Section List 
2.2 of this manual. 

 

2.6 Selecting Members (Member Selection) 
 
 

Staad is capable of performing operations specified design on members. Once the analysis has 
been run, the program can select the most economical section, ie the lightest section, which 
meets the requirements of the code for the specified member. The selected section will be the 
same type section of the member who originally is being designed. A wide-flange, will be selected 
to replace a wide-flange, etc. .. Several parameters are available to guide you in the selection. If 
the parameter PROFILE (PROFILE) is provided, the search for the lightest section is restricted 
to that profile. Up to three (3) different types of profiles can be set for when the section of a 
member is 
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being selected. The member selection can also be restricted by DMAX and DMIN parameters 
that limit the maximum and minimum depth of the members. Note that if the parameter 
PROFILE (PROFILE) is provided in specific members, DMAX and DMIN parameters are 
ignored by the program in the selection of these members. 

 

The member selection can be executed with all types of steel sections listed in Section 2.2 of 
this manual. Note that for beams with cover plates, the size of the cover plates are kept constant 
while the beam section is iterated. 

 
The selection of members for those properties that are originally given from a self-generated 
catalog will be limited thereto. 

 
The member selection can not be made to members whose section properties are given as 
prismatic. 

 

2.6.1 The selection member for Optimization 
 
 
 
 
 
 

See Section 

5.44.4 

 
The properties of a catalog for a complete steel structure can be optimized with STAAD. This 
method involves optimization technique, which requires multiple automated analysis. You can 
start without defining the properties for the members, but provided the kind of profile you 
have (eg BEAM, COLUMN, CHANNEL, ANGLE, etc.). Member sizes are optimized according 
to their contribution of stiffness and the number of loads they are receiving. Based on this, a 
measured size for each member is selected. This method requires a large amount of computer 
time, therefore, should be used with caution. 

 

2.6.2 Review of Deflection in Steel Design 
 

This facility allows the user to consider the deflection as a criterion in the process REVIEW 
CODE (CODE CHECK) and SELECT MEMBER (SELECT MEMBER). 
The revision of the deflection can be controlled by using three parameters described in Table 
2.1. 

 
Note: The deflection also uses and other efforts  related  to  the  stability 
criteria. The calculation of the local deflection is based on the latest test 
results. 

 
 

2.7 Members Armour (Truss Members) 
 
 

As mentioned at the beginning, a reinforcement member is able to sustain only axial forces. 
So in the design, no time is spent calculating the allowable bending or shear, greatly reducing 
design time. Therefore, if there is any member armor in an analysis (upwind or as a prop, 
etc.), it is wise to declare it as a member of armor instead of as a member of the regular frame 
with both ends hinged. 
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2.8 Asymmetrical Sections 
 

 
For asymmetric sections (like the angle, bend angle and T), Staad considered the smallest module 
to verify bending section. For some cases, this approach may produce slightly conservative results. 

 
Appendix C of the AISC code has also been incorporated to reduce the effort of compression 
elements without stiffness. Furthermore, AISC specification for the design of simple ANGLES 
fully included the effects of lateral torsional buckling. 

 

 
Table 2.1 ‐ Parameters of AISC 

 

 
Name 
parameter 

Default Value 
Description 

KY 1.0 K value in the local y axis. Usually this is 
the minor axis.

KZ 1.0 K value in the local z axis. Usually, this is 
the major axis.

LY The length of the 
Member 

Length on the local axis and calculate the 
slenderness ratio for buckling. 

LZ The length of the 
Member 

Same as above, except that on the z axis 
(major axis).

FYLD 36 KSI Yield strength of steel units in use. 

FU 60 KSI The last effort of steel stress in the units in 
use.

NSF 1.0 Factor for net section tension members. 

UNT Length of Member Unsupported length of the top flange in 
compression to calculate the allowable 
bending stress. Only used if the 
compression bending is in the top flange. 

UNB Length of Member Unsupported length of the bottom flange in 
compression to calculate the allowable 
bending stress. Only used if the 
compression bending is in the bottom 
flange.

CB 1.0 Cb value as used in Section 1.5 of AISC. 
Cb = 0.0 means that the value will be 
calculated. Any other value will be used in 
the design.

SSY 0.0 0.0 = Bracing in the local y axis. 
1.0 = Not contraventeado 

SSZ 0.0 Same as above except that the local z axis. 

CMY 
CMZ 

0.85 for contraventeado 
and calculated

The value of Cm in local y and z axes 
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  Non contraventeado

MAIN 0.0 0.0 = slenderness review 
1.0 = suppress slenderness review 

STIFF Length of Member Spacing of stiffeners for the design of plate 
girders

TRACK 0.0 Controls the level of detail with which the 
results are reported. 
0 = Detail 
1 = Intermediate Level 
2 = Maximum detail (See Figura2.1) 

DMAX 45 inches Maximum allowable superelevation. 
DMIN 0.0 inches Minimum allowable superelevation. 
RATIO 1.0 The relationship between forces acting 

against allowable stresses.
WELD 1 for closed sections 2 for 

open sections 
Welding type, as explained in Section 2.11. 
A value of 1 means that only one side 
welded except for skates and wide sections 
where T is always assumed that the soul is 
welded on both sides. A value of 2 means 
that both sides are welded. For closed 
sections such as rectangular pipes and tubes, 
welding will be on one side. 

BEAM 1.0 0.0 = only design end moments or those 
locations specified by the SECTION 
command. 
1.0 = extreme and designed for each twelfth 
point along the length of the member. (The 
default)

WMIN 1/16 inch Minimum weld thickness.
WSTR 0.4 x Fyld Allowable Effort welding.
DFF None (Required 

for 
reviewing deflection)

"Deflection Length" / Maximum allowable 
deflection Local 

DJ1 Start Nudo 
member 

Board No. denotes the starting point for the 
calculation of "Deflection Length" (See Note 1) 

DJ2 Knot the end of the 
member 

Board No. denotes the end point for the 
calculation of "Deflection Length" (See Note 1) 

TORSION 0.0 0.0 = No review performed torsion. 
1.0 = Make twisting reviewing rules based 
on AISC T114.

TAPER 1.0 0.0 = The I-beam design variable section just 
based on the rules of Chapter F and 
Appendix B. Do not use the rules of 
Appendix F. 
1.0 = The I-beam design variable based on 
the rules section of Appendix F of AISC-89. 
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* The top and bottom represent the positive and negative side of the local axis (local Z if Z 
SET UP (up) is used). 

 
NOTES: 

1) The "deflection length" is defined as the length used for the calculation of local deflections 
within a Member. It may be noted that for most cases the "Length Deflection" may be equal 
to the length of the member. However, in some situations, the "Length Deflection" may be 
different. For example, it refers to the figure below where a beam that has used four and 
three members together has been modeled. Note that the "length of the deflection" for the 
three members be equal to the total length of the beam in this case. The parameters to be 
used are DJ1 and DJ2 to model this situation. Also the straight line joining DJ2 DJ1 and is 
used as the reference line at the local deflections are measured. Thus, for all three members 
here, DJ1 should be "1" and DJ2 should be "4". 

 
1 2 3 

1 2 3 
4 

EXAMPLE: PARAMETERS 
D DFF 300 ALL 

DJ1 1 ALL 
DJ2 4 ALL 

D = Local Maximum deflection for members 
January 2 and 3. 

 

2) If not used DJ2 DJ1 and the "Deflection Length" will have as the default length of the limb 
and the local deflection of the line of the original member is measured. 

3) It is important to note that unless a specified value of DFF, STAAD not conduct a review 
of the deflection. This agrees with the fact that no default for DFF (see Table 2.1). 

4) A critical difference between the UNT / UNB parameters and parameters LY and LZ. The 
parameters UNT / UNB represent the length skate without lateral support compression. 
Defined in Chapter F, page 5-47 of the specifications in the 1989 AISC ASD manual as 
the distance between cross sections secured against buckling or lateral displacement of the 
compression flange. Parameters UNT / UNB are used to calculate the allowable 
compressive stress (FCZ and FCY) for behavior as a beam. LY and LZ are, moreover 
lengths without contraventear for behavior as a column and used to calculate the 
proportions of KL / r and the allowable axial compressive stress FA. 
SSY and CMY are two parameters that are based on 2 values defined on page 5-55, Chapter 
H of AISC 9th edition manual. SSY is a variable that allows the user to define either if 
there is contraventeado or member in the local address Y. CMY is a variable used to define 
the term called Cm in AISC manual. When SSY is set to 0 (which is the default) means 
that the bracing member is subject to local Y. When SSY address is set to 1.0, means that 
the member is not subject to local bracing direction . SSY The only effect that has is causing 
the program to calculate the appropriate value of CMY. If SSY is set to 0 and not provided 
CMY, CMY STAAD calculated as 0.85. If SSY is set to 1 and not provided CMY, CMY 
STAAD calculated from the equation on page 5-55. However, if the user provides CMY, 
the program will use this value rather CMY calculated without taking into account at all, 
what you define for SSY. 
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Terms used to calculate slenderness ratios KL / r for local Y and Z 
 
 
 

 

2.9 Composite Beam Design AISC-ASD 
 
 

Description 
 

STAAD now supports the design of a flexural member composed by the AISC-ASD code. Full 
composite action and are assumed uniformly distributed load. Shear connectors will be continued 
in the area of negative moment. Steel deck formed is assumed to be perpendicular to the member. 
If it is parallel to the member, the number of shear connectors shall conform. 

 

The following additional parameters have been introduced to support the design of the 
composite member. 

 
 

Table 2.2 Parameters for AISC-ASD joists 
 

Name 
Parameter 

Value 
Defaults 

Description 

CMP 0 The composite action with the 
connectors 0 = no composite action 
1 = composite action

DIA 0.625 inch The diameter of shear connectors 
HGT 2.5 inch The height of shear connectors after 



TECHNICAL MANUAL STAAD.Pro 

91

 

 

 

 
  welding

DR1 0.4 The proportion of time due to dead load 
applied before the concrete hardens the total 
time

WID 0.25 times the length of 
the member

Effective width of the concrete slab 

FPC 3.0 ksi Compressive strength of concrete at 28 days 

PLT 0.0 Thickness of the cover plate welded to the 
bottom flange of the composite beam 

PLW 0.0 Width of cover plate welded to the bottom 
flange of the composite beam 

RBH 0.0 The height of the rib of the steel deck 

RBW 2.5 inch The width of the rib of the steel deck 

SHR 0 The underpinning temporal during
 construction 
0 = no shore 
1 = underpinned

THK 4.0 inch The thickness of the concrete slab or the 
thickness of the concrete slab on steel deck 
steel.

 
UNIT 
PARAMETER 
CODE AISC 
INCH BEAM 1 
ALL 
TRACK 2 ALL 
DR1 ALL 0.3135 
WID 69 525 ALL 
FPC 3.0 ALL 
THK 4.0 CMP 
ALL 1 ALL 
CHECK CODE ALL 
SELECT ALL 

 
 
 
 

2.10 Armed Trabes 
Plate girders can be designed according to Chapter G of the AISC specifications. Widespread 
ISECTION option specification in the catalog can be used to specify sections of plate girders. 
Forms for welded plate girders AISC (pages 2-230 and 2-231 AISC 9th Edition) are contained 
in the library of steel sections of the program. Both the review of the code as member selection 
can be implemented in a catalog of AISC standard sections for armed or through widespread 
ISECTION option girders. The STIFF parameter (see Table 2.1) can be used to specify the 
spacing of the reinforcements, such that appropriate shear 
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are calculated allowable. The program automatically calculates efforts skates according to the 
requirements of the G2 section. 

 

2.11 Tabulated Results of Steel Design 
 

 
To review the code or member selection, the program produces the results of a free mode. Items 
in the output table are explained as follows: 

 
a) MEMBER (MEMBER) refers to the number of member for which the design has been 

executed. 
 

b) TABLE (TABLE) refers to the name of the AISC steel section has been compared with the 
steel code, or has been selected. 

 
c) Impressions RESULT (RESULT) if the member has past (PASS) or failed (FAIL). If the 

result is FAIL, there will be an asterisk (*) in front of the member number. 
 

d) CRITICAL CONDITION (CRITICAL COND) refers to the section of the AISC code, which 
governs the design. 

 

 
e) RELATIONSHIP (RATIO) prints the ratio of actual to allowable stresses for the critical 

condition efforts. Usually a value of 1.0 or less means that the member has passed. 
 

f) LOADING (LOADING) defines the number of load case governed the design. 
 

g) FX, MY and MZ defined axial force, when the local time in the y-axis and z local axes 
respectively. Although STAAD considers all the forces and moments on the member for 
the design, only FX MY and MZ are printed, because these are the most important in most 
cases. 

h) The LOCATION (LOCATION) specifies the actual distance from the beginning of the 
member to the section where the design forces govern. 

 
i) If the TRACK parameter is set to 1.0, the program block of the table and print efforts 

allowable bending compression (FCY and FCZ) and tension (FTY and FTZ), the allowable 
axial stress in compression (FA), and Allowable shear stress (FV), all in kips per square inch. 
Besides print, limb length, area, section modulus, which govern the rate of KL / r CB. 

 
j) At the exit to TRACK 2.0, Fey and Fez items is as follows: 

 
 
 

Fey 
12  2 

2 

23 KAndLAndrAnd 
 

 
 
 

Fez 
12  2 

2 

23 KZLZrZ 
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Figure 2.1 
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2.12 Welding Design 
 
 

 
 

See 
Section 
5.44.5 

 
STAAD is capable of selecting the thickness of solder connections and tabulate the various efforts. 
The design of welding is limited to only those members who have properties catalog as 
rectangular sections wide-flange, flange beam, single angle, single channel, tubular and tubular 
loop. The WELD, and WSTR WMIN parameters (as described in Table 2.1) governing the design 
of welds. 
Since the thickness of a weld is very small compared to its length, the 
weld properties can be calculated as if they were linear members. Therefore, the cross-sectional 
area (AZ) of the solder actually be the length of the weld. Similarly, the units for the modules 
section (SY and SZ) will square length and polar moments of inertia (JW) is cubic length. The 
following table shows the different linear welds available; their types and their coordinate axes. 

 

 
WELD 
TYPE ANGLE WIDEFLANGE TEE CHANNEL PIPE TUBE 

 

and and and and and and 

 

1 z z z z z 
 

z 
 

and and and and 
 

z z z 
2 

z 
 

 

Actual efforts, calculated from the forces in the members, can be defined by three names, 
according to their directions. 

 
    Horizontal stress - caused by the cutting force in the local z direction and the torsional moment. 

 

    Vertical load - caused by the shear force in the axial direction, and the torsional moment. 
 

    Direct stress - the axial force produced by bending moments and local y and z in directions. 
 

Combining efforts as the square root of the sum of the squares of the above three principal 
stresses is calculated. 

 

 
Then the equations are: Forces 

MX = Torsional Moment 
MY = Deflection local axis 
and MZ = Bending local z 
axis FX  = Axial Force 
VY  = Shear in the local y axis VZ  
= Shear in the local z axis 
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Welding Properties 
 

AX  = The area of the weld as a linear member SY
 = Modulus of Section around the local y axis 
SZ = Modulus of Section around the local z 
axis JW  = Polar moment of inertia 
CH = Distance from the extreme fiber to the horizontal forces (local z) 
CV  = Distance from the extreme fiber to the horizontal forces (local 
and) 

 
 

Efforts equations: 
 

VZ 
Effort Horizontal, Fh 

AX 

 

MX CH 

JW 

 

VY 
Vertical Effort, Fv 

AX 

 

CV MX 

JW 

 

 
Direct Effort, Fd 

 

FX MZ 
* 

 

AX SZ 

 

MY*
 

 

SY 

 

* Note: MY and MZ are taken now in its absolute value, which could lead 
to conservative results for asymmetric as the angle sections, T and 
channel. 

 
 

2 2 2 

Combined Forces Fcomb Fh+ Fv+ Fd 

 

 
Weld Thickness 

Fcomb 

Fw 

 
 

Where: 
 

Fw = Allowable Effort in welding, the default value is 0.4 Fyld (Table 2.1). 
 

The thickness t is rounded to the nearest value 1/16 and all efforts are recalculated. The printout 
shows the latest efforts calculated. If the TRACK parameter is defined as 1.0, the printout will 
include the properties of the weld. Note that the program does not calculate the minimum 
thickness of welding as required by some codes, but only compared to the minimum thickness 
you defined (or every 1/16 inch if not provided). 

 
When the ARMOR (TRUSS) command with the command to select Welding (WELD SELECT) is 
used, the program designs welds required for the angle of armor and double angles are attached to 
the splice plates. The program reports the number of welds (two for simple angles and four for 
double angles), and the required length for each weld. The thickness of the weld is taken as 1/4 inch 
(6 mm) to 1/4 inch members (6 mm) thick, 1/16 inch and less (1.5 mm) thickness for the largest 
angle members 1/4 inch (6 mm) thick. The minimum weld length is taken as four times the thickness 
of the weld. 
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Figure 2.2 - Design WELD Welding SELECT TRUSS. 

 

2.13 The steel design by AASHTO Specifications 
 

2.13.1 General Comments 
 

 
This section presents some general guidelines regarding the adjustments to the American 
Association of State Highway and Transportation AASHTO (American Association of State 
Highway and Transportation Officials) for STAAD steel design. The design philosophy and 
logistical process for the selection of members and code review is based on the principles of 
design allowable stress. Two major shortcomings are recognized: deficiency due to over-exertion 
and deficiency due to stability considerations. The following sections describe salient features 
of the calculated allowable stress and stability criteria used. Members are defined in such a way 
as to withstand design loads without exceeding the allowable stresses and is the most 
economical section is selected based on the criterion of minimum weight. Part of the program 
for the revision of the code, it also reviews the slenderness requirements, minimum metal 
thickness and width-thickness. Usually it is assumed that the designer will take due care in the 
detailed requirements, such as definition of stiffness and reviewing local buckling effects skates, 
tearing of the beam web, etc. .. 

 

2.13.2 Eligible efforts according to AASHTO Code 
 

 
As mentioned above, the design and code review members Staad is based on the design method 
of allowable stress. Which is the definition of structural members using the design loads and 
forces, allowable stresses and design limits for the appropriate material under service conditions. 
Due to practical reasons, is beyond the scope of this manual describe each of the aspects of 
the AASHTO specifications for structural steel design. This section will discuss only the salient 
features of the allowable stresses specified by the AASHTO code. Table 10.32.1A AASHTO 
code specifies the allowable stresses. 
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a

 
 

Axial Effort 
 

The allowable tension stress, as calculated in AASHTO, is based on the net section. This tends 
to produce a slightly conservative result. The allowable stress in the net section stress is given 
by, 

 

Ft 0.55Fand 

 

The allowable stress in the overall compression section subject to compression members axially 
loaded is calculated based on the following formula: 

 
 

Fand (1- (Kl / r) 
FandFto 

 
when (Kl / r) Cc 

F. S. 42E 

 

2E 
F to 

F. S. (Kl / 
r)2

 

 
when (Kl / r) Cc 

 

with Cc (2  2E / F )Hal

f 
and 
F. S. 

2.12 

 

It may be mentioned here, that lacks AASHTO no option to increase the allowable stress for a 
secondary member as 1 / r exceeds a certain value. 

 
 
 

Effort ection d e Fl 
 

The allowable stress for compression deflection profiles for sections of beams whose armed 
skates compressions are supported laterally by means of its total length drowned in concrete 
is given by 

 

Fb 0.55Fand 

 

For similar length members supported or not supported partially skates, the permissible bending 
stress of compression is given by 

(1 / r)2F 
Fb 0.55Fand(1 and) 

42 E 

when (kl / r) Cc 

with (r 2) b2/ 12 

 
 

The AASHTO code does not have a specification for the maximum stress allowable stress for 
members subject to bending. The AISC specification is relevant for compact symmetric 0.66Fy 
assembled sections or hot forged, and loaded in the plane of the minor axis and meeting other 
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requirements of Section 1.5.1.4.1 for AISC specifications. A common practice among designers of 
bridges, 0.55Fy is used as the tensile stress by permissible for members who meet other 
requirements of Section 1.5.1.4.1 of the AISC specifications flexion. This practice is slightly 
conservative and used to adapt the code in STAAD AASHTO steel. 
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Effort d e Court 
 

The effort allowable cut in the total cross section is given by 
 

Fv 0.33Fand 

 
 

For shear in the soul, the total cross section is defined as the product of the total depth of the 
beam and the web thickness. The AASHTO code does not specify anything about the allowable 
stress for the shear on skates. The program assumes the same effort allowable cut (0.33Fy) to 
shear on souls and skates. For shear skid, the total cross section is taken as 2/3 times the area 
of the total skate. 

 

Interaction between Esf uerzos Axial and Bending 
 

Members subject to both axial forces and bending are provided pursuant to section 10.36 of 
steel AASHTO code. All members subjected to bending and axial compression shall satisfy the 
following formulas: 

 
 

fto 

Fto (1 

 

Cmxfbx 

fto/ Fex ) 
Fbx 

Cmyfby 

(1 fto/ Fey ) Fby 

 
1.0 

 
 

At intermediate points, and 
 

fto 

0.472Fand 

 
 
 

fbx 

Fbx 

 
 
 

fby 

Fby 

 

 
 
 

1.0 

 
 

In support points. 
 

AASHTO steel code provides no specification for the combined interaction of axial tension 
and bending. The AISC review procedure for the interaction of axial-bending stress is used in 
the adaptation of AASHTO in STAAD. All members subject to combined axial tension and 
bending are required to satisfy the conditions 
1.6.2 AISC. 

 

2.13.3 Stability Requirements for the AASHTO Code 
 

 
According to the AASHTO code for compression members, the slenderness ratio, KL / r, will 
be limited to 120 to 140 for main members and secondary members. The AASHTO code defines 
child members as those whose primary purpose is to contraventear structure against longitudinal 
and lateral force, or to reduce the length that no other bracing members, primary or secondary. 
For tension members, KL / r is 200 for the main and side members to 240 members. 

 

2.13.4 Requirement Minimum thickness of Metal 
 

The AASHTO code has a minimum thickness requirement for the whole structure 
steel. According to this requirement, all steel structures, except for certain souls of rolled 
shapes, ribs closed in orthotropic decks, fillers and handrails, shall not be less than 0.3125 
inches. The thickness of the web of the beam, glulam 
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grooved or should not be less than 0.23 inches. These requirements have been incorporated 
into the adaptation of AASHTO in STAAD. 

 

2.14 Design of Steel by AISC Specification / 
LRFD 

 

2.14.1 General Comments 
 

 
The design philosophy involved in the LRFD (Load and Resistance Factor Design) specification 
is grounded in the concept of limit state design, the innovative power in structural engineering. 
The structures are designed and proportionate taking into account the yield point of the total 
load which would become unfit for use on intended. Two main categories of limit state are 
recognized; ultimate load and serviceability. The primary considerations in the design yield 
strength of the ultimate load are the strength and stability, while for the serviceability deflection 
is used. Appropriate load and resistance factors are used to achieve a uniform operational safety 
for all steel structures under various load conditions while boundary changes that may be 
exceeded are considerably remote. 

 
In adapting to LRFD STAAD, members are provided to withstand design loads without 
exceeding the limit states of resistance, stability and serviceability. Also, the cheapest section 
based on the criterion of lowest weight is increased by the designer in specifying allowable 
depth of the member, type of desired section, or similar parameter set. Part of the code review, 
review the code requirements for each section are identified and selected under the ruling 
consistent criterion. 

 
The following sections describe the salient features of the adaptation of the LRFD specifications 
in the design of steel STAAD. A detailed description of the design process with their implicit 
concepts and assumptions are contained in the LRFD manual. However, since the design 
philosophy is drastically different from the conventional ASD (Allowable Stress Design), 
presented here, a brief description of the basic concepts to start it in the design process. 

 

2.14.2 Fundamentals of LRFD 
 

The primary objective of the LRFD specification is to provide a uniform operational safety for 
all steel structures under various loading conditions. This uniformity can not be obtained in 
the form of allowable stress design (ASD). 

 

 
 

ASD method can be represented by the inequality 
 

Qi Rn/ F. S. 
 

The term on the left side of the inequality is the required strength, which is the sum of the 
effects of load Qi (forces and moments). The term on the right side, the 
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design strength is the nominal resistance and resistance Rn divided by a safety factor. When 
divided by the appropriate property of the section (area or section modulus), the two sides of 
the inequality become the actual effort and effort 
permissible respectively. ASD, then, is characterized by the use of fillers in "work" no 
factored in conjunction with a single safety factor applied to the resistor. Due to the high 
variability and hence the unpredictability of the live load and other loads compared to the dead 
load, security uniform operating is not possible. 

 
LRFD, as its name implies, uses separate files for each load and resistance factors. Since 
different factors reflect the degree of uncertainty of different loads and load combinations and 
precision for predicting resistance, smoother operation safety is not possible. The LRFD method 
can be synthesized by the inequality 

 

andiQi Rn  
 
 

On the left side of the inequality, the required strength is the sum of the effects of loads, Qi, 
multiplied by their respective load factors, he yi. The design strength, the term of the right 
hand, is the nominal resistance or Rn, multiplied by a resistance factor, Ø. 

 
In adapting LRFD in STAAD, it is assumed that the user will use the appropriate load factors 
and load combinations will create necessary for analysis. The share of program design takes 
into account the effects of load (forces and moments) obtained from the analysis. Calculations 
for resistance elements (beams, columns, etc.), resistance (the nominal resistance) and strength 
factor will be considered applicable automatically. 

 

2.14.3 Requirements Analysis 
 

 
Construction types recognized by AISC specifications have not changed, except that both the 
"semi-rigid" "simple frame" (formerly Type 2) and frame (type 3 above) have been combined 
into the same category, Type PR (partially fixed). "The rigid frame" (formerly Type 1) is now 
the (fully fixed) FR type. The type of construction FR is allowed unconditionally. The type of 
construction PR, it may require some inelastic deformation of steel structural member. Thus, 
when you specify type PR construction, the designer should consider the effects of partial 
restriction on the stability of the structure, lateral deflections and bending moments of second 
order. As proposed in Section C1 LRFD Specification, it requires an analysis of the effects of 
second order. Thus, when the LRFD code is used for the design of steel, the user must use 
option P-Delta deSTAAD analysis. 

 
 

2.14.4 Classification of Sections 
 

 
 

The specification allows LRFD inelastic deformations considered in sections of the elements. 
Thus, the local buckling becomes an important criterion. Steel sections are classified according 
to their characteristics of local buckling, as compact, noncompact or slender element sections. 
This classification is based on the geometrical properties of the section. Design procedures will 
differ depending on the 
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class section. Staad is able to determine the type of section to the standard shapes and forms 
that have been user-defined and designed according to these. 

 

2.14.5 Axial Tension 
 

 
 

The criteria governing the tensile strength of members is based on two boundary conditions. 
The limit yield condition in the overall section is intended to prevent the over-extension of the 
limb. The second boundary condition involves the broken section in the minimum effective 
net area. The net section area can be specified by using the NSF parameter (see Table 2.2). 
STAAD calculates the voltage rating of a given member, based on these two types of boundary 
conditions and proceeds with the selection of the member or code review in due form. 

 

2.14.6 Axial Compression 
 

 
 

Resistance equations flambeo LRFD were reviewed to take into account the inelastic 
deformation and other recent research related to the behavior of columns. Two equations 
governing flambeo resistance are available, one for inelastic buckling and another for the elastic 
or Euler buckling. Both equations include the effects of residual stresses and initial deflection. 
The compressive strength for a particular member to Staad is calculated according to E outlined 
in Chapter LRFD Specification procedure. For slender elements, the method described in 
Appendix B5.3 used. 

 
Individual members with symmetric or asymmetric compression are designed based on the 
boundary conditions of torsional bending and torsional. Appendix procedure E3 is adapted for 
determining the design strength to these boundary conditions. 

 
The effective length for calculating the compressive strength can be defined through the KY, 
KZ and / or LY, LZ parameters. If none of them is defined, the total length of the member 
shall be taken into consideration. 

 
To the criterion of resistance to compression, the compression members are required to satisfy 
the constraints of slenderness, which are a function of the nature of use of the member, (the 
main component resisting load bracing members, etc.) . In the process of member selection 
and verification code, STAAD immediately reviews the slenderness appropriate members before 
continuing with other procedures to determine the adequacy of a given member. 

 

2.14.7 Flexural Design 
 

 
In LRFD, the design of the flexural strength of a member is determined by the boundary 
condition at the lateral torsional buckling. Inelastic flexure is permitted and basic measure of 
bendability is the plastic moment capacity of the section. The flexural strength is a function of 
the capacity of the plastic moment, laterally braced not effective length, non-limiting length 
braced laterally bending moment and flexural modulus. The length Lr does not laterally braced 
and buckling moment Mr are functions of the geometry of the section and are calculated 
according to the procedure 
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Chapter F. The purpose of bending coefficient Cb is to consider the influence of the gradient 
of the moment about the torsional buckling. This coefficient can be specified by the user 
through the use of CB parameter (see Table 2.2) or calculated by the program (if CB is 
specified as 0.0). In the absence of CB parameter, a default value of 1.0 is used. The procedure 
for calculating design resistance to bending, also considers the presence of residual stresses in 
the bearing. To specify the not laterally braced length, the UNT / UNB parameters can be 
used (see Table 2.2). 

 

2.14.8 Combined Axial Force and Bending 
 

 
The interaction of axial forces and bending in simple and double symmetrical shapes, it is governed 
by the formulas and H1-1b H1-1a. These formulas interaction cover the general case of biaxial 
flexural strength combined with axial. Which are also valid for uniaxial bending and axial force. 

 

2.14.9 Design by Court 
 

 
The method of Section F2 of the LRFD specification used in STAAD to design shear forces in 
the members. The shear strength, as calculated in LRFD, is governed by the following boundary 
conditions: The F2-1a equation for the provenance of the beam web; F2-2a equation for the 
inelastic buckling; F2-3a equation for elastic buckling. The shear or shear skates for wide 
channels and sections is resisted by the web area of the beam, which is taken as the time of 
the total depth to the thickness of the beam web. 

 

2.14.10 Design Parameters 
 
 

See Table 
2.2 and 
Section 
5.44.1 

For LRFD design specifications required by using the parameter CODE (CODE) (see Section 
5.44). Other applicable parameters are summarized in Table 2.2. These parameters communicate 
the decisions of the engineer to the program, allowing you to control the design process to meet 
a particular application. 

 

 
The default values of the parameters have been selected such that are most frequently used in 
the conventional design. Depending on the particular design requirements, some or all values 
of the parameters can be changed to accurately model the physical structure. 

 
The DMAX and DMIN parameters apply to the selection of the member only. 

 

2.14.11 Code Review and Team Member 
 

The two options for code verification and selection of members are contained in adapting to 
STAAD LRFD. For general information on these options, refer to Sections 2.5 and 2.6. For 
information on specifying these commands, refer to Section 5.44.1. 

 

2.14.12 The Tabulated Results of Steel Design 
 

Results of code verification and selection of members are presented in a tabular format. A detailed 
discussion of the format is provided in Section 2.11. Note 
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the following exceptions: CRITICAL CONDITION (CRITICAL COND) refers to the section 
of the LRFD specifications that governed the design. 

 

 
 

If TRACK is set to 1.0, the design strength of members will be sent to print. 
 
 
 

Table 2.2 Parameters of the LRFD 
 

 
 

Name 
parameter 

Default Value  Description 

KX 1.0 K value for the bending-torsional buckling. 
KY 1.0 K value Y. Usually local axis is the minor axis. 

KZ 1.0 K value Z. Usually local axis is the major axis. 

LX Limb length Length for flexural-torsional buckling. 
LY Limb length Length to calculate the aspect ratio of the local 

buckling axis Y.
LZ Limb length Length to calculate the aspect ratio of the local 

buckling axis Z.
FYLD 36.0 ksi Creep resistance of the steel.
FU 60.0 ksi Tensile Strength Steel Last.
NSF 1.0 The factor of net section stress members. 

UNT Limb length Unsupported length (Lb) * Skate superior to the 
bending force calculated. Only used if the 
compression bending is in the top flange. 

UNB Limb length Unsupported length (Lb) Of the bottom flange * 
to the bending force calculated. Only used if the 
compression bending is in the bottom flange. 

STIFF Limb length Spacing of stiffeners for beams for shear design. 

CB 1.0 Coefficient CbChapter by F. If Cbwill please to 
0.0, calculated by the program. Any other value 
will be used directly in design. 

TRACK 0.0 0.0 = Deletes all design forces. 
1.0 = Print all design forces. 
2.0 = Print out the extended design. 

DMAX 45.0 inch. Allowable maximum cant
DMIN 0.0 inch. Minimum allowable superelevation. 
RATIO 1.0 The allowable ratio of actual load and resistance 

design.
BEAM 1.0 0.0 = design at the ends and those situations 

specified by the SECTION command. 
1.0 = design at the ends and at each point 
1/12 along the length of the member. (The default) 
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* The top and bottom represent the positive and negative side of the local axis (local Z Z ZET 
UP if used). 

 
Note: For review of the deflection, the DFF, DJ1 and DJ2 parameters of 
Table 2.1 can be used. All requirements remain the same. 

 
 
 

 

2.15 Design by the American Code of Cold 
Formed Steel 

 

 
General 

 

 
The projections of the AISI Specification for the Design of Structural Steel Members Cold 
Formed, 1996 Edition has been implemented. The program allows the design of single (non-
composite) members in tension, compression, bending, shear, as well as their combinations 
using the LRFD method. For members in bending, Section Nominal Resistance is calculated 
based on the initiation of provenance in the effective section (Method I). The increase in 
strength due to manufacturing Cold Work is a user option. 

 

Cross Section Properties 

 
The user specifies the geometry of the cross section by choosing one of the designations shaped 
section Tables Steel STAAD for sections cold formed reflecting Tables Property Section Thick 
published in the "Manual of Steel Design Formed in cold "AISI, 1996 Edition. 

 

Tables are now available for the following forms:     Canal 

with Lips 

    Canal without 

Lips 
 

    Angle with Lip     

Angle without 

Lips     Z with 

Lips 

    Z without 

Lips 
 

    Hat 
 
 

The shape selection can be done using the properties page of a member of the graphical user 
interface (GUI) or by specifying the section designation symbol in the input file. Details of the 
latter are explained below. 
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The AISC Steel Section Library: 
 

The syntax of the command to assign line-steel sections AISC library is explained below: 
 

S e ction C co n s i o L ab 
 

20 TO 30 AT ST 14CS3.75X135 
ST 33 36 TA 12CS1.625X102 
ST 42 43 TA 4CS4X060 

 
 

S e ction C i s i o n s L ab 
 

50 TO 60 AT ST 10CU1.25X071 
ST 32 33 TA 3CU1.25X057 
TA 21 28 ST 1.5CU1.25X035 

 

 
 

S e ction co Z i o n s L ab 
 

January 3 4 TA ST 12ZS3.25X135 
33 45 TA ST 10ZS3X060 
December 13 TA ST 6ZS2X048 

 

 
 

S e ction Z i s i o n s L ab 
 

March 2 TA ST 8ZU1.25X105 
May 4 TA ST 4ZU1.25X036 
June 7 TA ST 1.5ZU1.25X048 

 

 
 
 
 

Á L ngu s what I Ig or ale ad co n s L ab ios 
 

August 9 TA ST 4LS4X105 
November 10 ST TA 3LS3X060 
December 13 TA ST 2LS2X075 

 

 
 

Á L ngu s what I Ig or ale ad wWithout L ab ios 
 

May 1 ST TA 4LU4X135 
July 8 TA ST 2.5LU2.5X105 
April 9 TA ST 2LU2X060 
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S and S cci or ne s o m b e ro n i s i or s L ab 
 

4 8 TA ST 10HU5X075 
5 6 TA ST 6HU9X105 
January 7 TA ST 3HU4.5X135 

 

 
 
 
 
 

Current Limitations: 
 

 
Currently, only simple sections are available for standard specification. Options such as double 
angles, double channels, and sections provided by the user even tubes and rectangular tubes 
available shortly. Additionally, sections combined, as an angle above as a channel, or a plate 
welded on the top flange, bottom or side of the above forms are not available at this time. 

 

STAAD.Pro uses the properties of the section without any reduction in the analysis phase of the 
structure. Both sections without cutting and the effective properties of the section in the design 
phase, as applicable. 

 

 
 

Design Procedure 
 
 
 

The following two design modes are available: 
 

1. The Code Review 
The program compares the strength members to the effects of applied load, according 
with Method of AISI LRFD code. Code review is conducted for situations specified by the user via the 
SECTION (SECTION) command or the BEAM (BEAM) parameter. The results are presented in the 
form of an identifier PASS / FAIL and a RELATIONSHIP (RATIO) of the effects of load resistance 
for each verified member. The user can choose the level of detail in the data output by setting the 
TRACK parameter. 

 

 
 

2. The Member Selection 
The user can ask the program to search the forms of cold‐formed steel base 
data (AISI standard sections) for alternate members who pass code review and are at the discretion 
of lower weight. In addition, a minimum / maximum acceptable depth of member can be specified. 
Initially the program will then evaluate all sections of the specified database type (ie, channel, angle, 
etc.) and, if a suitable replacement is located, presents the results of the design for that section. If 
any section that satisfies the constraints of depth or lightness in the home can be found, the program 
stops the member unchanged, regardless if it passes code review or not. 
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The program calculates the properties of the effective section in accordance with the following 
sections: 

 
B2.1 Uniformly Compressed Elements stiffened. B2.3, Almas and 

stiffened elements with stress gradient B3.1, Uniformly 

Compressed Elements without Atiesamiento 

B3.2, without stiffening elements and Edge Stiffeners with Stress Gradient B4.2, 

Uniformly Compressed Elements with stiffener at the Edge 

Cross-sectional properties of members to comply with the following Sections are checked: 
 

B1.1 (a) The radii of Plano-width-to-thickness maximum, and 

B1.2, The maximum depth within thick soul -a 

The program verifies the strength of the member in accordance with Chapter C of the 
specification as follows: 

 
Members in tension. 

 
The resistance is calculated in accordance with Section 

C2. Flexural Members. 

a) C3.1, only bending efforts: 
C3.1.1, the nominal Efforts Section C3.1.2 Procedure I, lateral 
buckling Efforts 

 
b) C3.2, efforts by the Court only. 

 
c) C3.3, Efforts to Cut Combined Bending and 

Compression Members Charged Concentric. 

 
a) C4.1, Sections not subject to torsion or twist of flexion, and 

 
b) C4.2, Single or Double Symmetrical Sections subject to Bending Torsion or Twist by. 

Combined Bending and Axial Load. 

 
b) C5.1, Axial Tensile and Combined Bending and 

 
d) C5.2, Axial Compressive Load and Bending Combined. 
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The following table lists the input parameters to specify the values of the design variables and 
selecting design options. 

 
The design parameters of cold‐formed steel AISC 

Name 
Parameter 

Default Value  Description 

BEAM 1.0 When this parameter is set to 1.0 (the default), 
the adequacy of the member is determined by 
checking a total of 13 equally spaced locations 
along the length of the member. If the value is 
0.0 BEAM, 13 locations checks are not done, and 
instead, verification is done only at the locations 
specified by the order of the SECTION 
(SECTION) (See manual for details STAAD ). If 
neither parameter BEAM (BEAM) or any 
specified SECTION command, STAAD end the 
run and ask the user to provide one of those 2 
commands. This rule does not gives to members 
of WEAVE (TRUSS) type. 

CMZ 1.0 The coefficient extreme bending moments on the 
axis Z. See AISI C5.2.2. Used for the design of 
axial load and bending combined. The values 
range from 0.4 to 1.0.

CMY 0.0 The coefficient extreme bending moments about 
the axis Y. See AISI C5.2.2. Used for the design 
of axial load and bending combined. The values 
range from 0.4 to 1.0.

CWY 0 Specify whether the job cold rolling should be 
included in the calculation of the resistance. See 
AISI A7.2. 
Values: 0 ‐the effect is not to be included 

1‐the effect should be included 
DMAX 1000.0 The maximum allowable depth for the section 

during the selection of the member. This value 
must be provided in the current units. 

DMIN 0.0 REQUIRED The minimum depth for the section 
during the selection of the member. This value 
must be provided in the current units. 

FLX 1 Specify if either flexural or torsional 
buckling is not necessary for the member is 
restricted. See AISI C4.1 
Values: 
0‐Section subject to buckling flex 
no torsional constraint is provided 
1‐provided or unnecessary restriction 

FU 58 ksi The ultimate tensile strength of steel in the 
current units.

FY L D 36 ksi Yield stress of steel in the current units. 

KT 1.0 The factor of effective length for buckling 
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The design parameters of cold‐formed steel AISC 

Name 
Parameter 

Default Value  Description 

    torsional. It is a fraction without units. The 
values can range from 0.01 (for a completely 
prevented torsional column buckling) to any 
specification of a large value for the user. It 
is used to calculate the proportion of KL / R 
for bending for the ability to axial 
compression. 

KY 1.0 The effective length factor for column 
buckling about the local Y axis. It is a 
fraction and is unitless. The values can 
range from 
0.01 (for a completely prevented column 
buckling) to any large value that the user 
specified. It is used to calculate the ratio of 
KL / R for determining the axial 

KZ 1.0 The effective length factor for column 
buckling in the local Z .. and it's a fraction 
without units. The values can range from 
0.01 (for a completely prevented column 
buckling) to any large value that the user 
specified. It is used to calculate the ratio of 
KL / R for the ability to axial compression. 

LT Length of Member The length without contraventear for 
twisting. You enter in the current length 
units. The values can range from 0.01 (for a 
completely prevented torsional column 
buckling) to any large value that the user 
specified. It is used to calculate the 
proportion of KL / R by twisting for the 
ability to axial compression. 

LY Length of Member The buckling length for the column in the 
local Y axis is entered in the current length 
units. The values can range from 0.01 (for a 
completely prevented column for buckling) 
to any large value that the user specified. It 
is used to calculate the ratio of KL / R to 
determine the ability to axial compression. 

LZ Length of Member The effective length for buckling column in 
the local Z axis. You enter in the current 
length units. The values can range from 0.01 
(for a completely prevented column 
buckling) to any large value that the user 
specified. It is used to calculate the ratio of 
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The design parameters of cold‐formed steel AISC 

Parameter 
Name 

Default Value  Description 

    KL / R to determine the allowable stress in 
axial compression.

NSF 1.0 Factor for the net section tension members, 
see AISI C2.

ST I FF Length of Member The spacing in the longitudinal direction of 
shear stiffener elements for reinforced soul. 
You enter in the current length units. See 
section C3.2 AISI 

T RA C K 0 This parameter is used to control the level 
of detail in the design output is reported in 
the output file. Acceptable values are: 
 
0 - Prints only the member number, section 
name, relationship, and state PASS / FAIL 
(PASS / FAIL). 

 

1 - Additionally print the design summary in 
addition to the printed by TRACK 1 
 

2 ‐Print Members and material properties in 
addition to the printed by TRACK 2. 

T SA 1 Specifies whether supports and intermediate 
transverse if atiezadores are present. If this 
is true, the program uses the most liberal 
group in AISI interaction equations C3.3.2. 

 

Values: 

0‐Beams reinforced with soul 
1‐The beams with stiffeners soul 
transverse 
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Section 3 

American Concrete Design 
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3.1 Operations Design 
 
 

STAAD has the necessary means for the design of concrete. It will calculate the reinforcement 
required for specified concrete section. All concrete design calculations are based on the current 
ACI 318. 

 
 

3.2 Types Sections for the Design of Concrete 
 

The following types of sections for concrete design can be defined. For 

Beams Prismatic (Rectangular and Square), Keystone and forms T 
To Columns Prismatic (Rectangular, Square and Circular) 
Slab Finite element with specific thickness. 
Walls / Boards 

 

AndAndDD ZD ZD 

 

 
 

AndAndDD 
 

 
 

YDYD 
 
 
 

ZD 
ZD 

PRISMATIC 
PRISMATIC 

 
 

CIRCULAR 
CIRCULAR 

 
 

ZB 
ZB

 

 
YD ZD 

ZD 

 

TEE 
ZTDEE 

 
 

YD 
 

YD And YB 
YB 

 
 

D 
 

ATI
C 

ZB 
ZB  CIRCULAR ZB 

  KEYSTONE  
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Figure 3.1 Different types of concrete sections 

 

TRAPEZOIDA 
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3.3 Dimensions of Members 
 

 
For concrete members that will be designed with the program, they must define certain properties 
of the section, under the command MEMBER PROPERTY (MEMBER PROPERTY). The 
necessary input data are shown in the following example: 

 

 

INCH UNIT 
MEMBER PROPERTY 
March 1 TO 18 YD July 9 PRISM 2916 ZD 12 IZ IY 1296 
November 13 PR 12 YD. 
TO PRIS YD 14 16 24 18 YB ZB ZD 48 12. 
PR 17 TO 19 YD 24 ZD 18 ZB 12. 

 
 

In the previous post, the first group defines a rectangular members (18 inches deep and 12 inches 
wide) and the second group, only provided depth and no width defines a circular member 12 
inches in diameter. Note that the area (AX) is not defined for these members. For the design of 
concrete, this property does not have to be provided. If the cutting areas and moments of inertia 
are not provided, the program calculates these values of YD and ZD. Consider, as in the previous 
example, the values provided to IY and IZ are really 50% of the values calculated using YD and 
ZD. This is conventional practice, taking into account parameters revising section due to cracking 
of the section. 

 
Note that the third and fourth group of the above example, defining T-shaped members and 
trapezoidal, respectively. Depending on the properties include (YD, ZD, YB, ZB, etc), the 
program will determine if the section is rectangular, trapezoidal or U shape and the design of 
beam (BEAM) will be made accordingly. 

 
 

3.4 Design Parameters 
 
 

The program contains a number of parameters that will be needed to implement the design by 
the ACI code. The default values of the parameters have been selected such that they are most 
often used by numbers of conventional design requirements. These values can be changed to suit 
a particular design. Table 3.1 is a complete list of the available parameters and their default values. 

 

 
See 

Section 5.47 

 
Section 5.47.2 of this manual describes the commands necessary to define these parameters in 
the input file. For example, the distances of the faces of the supports of the end nodes of a 
beam, SFACE and EFACE (parameters that are used in the design section), have default values 
of zero, but can be modified depending on the actual situation . Similarly, the beams and 
columns are designed based on the moment analysis obtained directly without any 
magnification. MMag factor that can be used for purposes of magnification. For the beams, 
the user can generate load cases containing loads magnified by the appropriate load factors. 
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3.5 Slenderness Effects and Analysis Considerations 
 
 

The slenderness effects are extremely important in the design of compression members. The ACI-
318 code specifies two options with which the effect of slenderness can be adapted (Section 10.10 
and 10.11 ACI-318). One option is to run a precise analysis that takes into account the influence 
of axial loads and variable moment of inertia about the stiffness of the limbs and times fixed ends, 
the effect of deflections on moments and forces, and the effect of the duration load. Another 
option is to amplify approximately design times. 

 
STAAD has been drafted in such a way that allows the use of both. To perform the first type of 
analysis, use the command PDELTA ANALYSIS (PDELTA ANALYSIS) instead of the RUN 
ANALYSIS (PERFORM ANALYSIS). This method of analysis set requirements as specified in 
Section 10.10 of ACI-318 code, except for the effects of load duration. It is presumed that this 
effect can be ignored without risk since experts believe that the effects of the duration of loads 
are negligible in a normal structural configuration. If desired, Staad can also accommodate any 
arbitrary time amplification factor (second choice) as an input, in order to provide some security 
for the effects of the duration of loading. 

 

Name 
Parameter 

Default Value  Description 

FYMAIN * 60,000 psi Creep effort main reinforcing steel. 

FYSEC * 60,000 psi Creep stress secondary reinforcement steel. 

FC * 4,000 psi Compressive Strength of Concrete. 
CLT * 1.5 inch Free coating for superior reinforcement. 

CLB * 1.5 inch The free coating to the bottom gusset. 

CLS * 1.5 inch The free coating for side reinforcement. 

MinmAIN ** Rod Issue 4 Minimum size main reinforcement rod 
(No. 4-18)

MINSEC ** Rod Issue 4 Minimum size secondary reinforcement 
rod.

MAXMAIN 
** 

Rod Number 18 Maximum size of main reinforcement rod 

SFACE * 
0.0 

Supporting face at the start location of the 
beam. If specified, the cutting force at the 
beginning at a distance of d + knot SFACE 
Start member is calculated. 

EFACE * 
0.0 

Locating the support face at the end of the 
beam. (Note: SFACE & EFACE are given 
positive value) If specified, the cutting force 
is calculated at the end at a distance of d + 
EFACE knot the end of the member. 

REINF 0.0 Column with stirrups. A value of 1.0 
means spiral stirrups.

MMAG 1.0 
(For single columns)

A factor by which the moments of column 
design will be magnified.
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WIDTH * ZD Width of the concrete member. The default 

ZD according to how it is taken is provided 
in the MEMBER PROPERTIES. 

RipTH * YD Depth of concrete member. The default YD 
taken according to as provided in the 
MEMBER PROPERTIES. 

NSECTION 12 Number of equally spaced sections to be 
considered in finding the critical points for 
the design of beams.

TRACK 0.0 DESIGN OF BEAM: 
 
With TRACK 0.0, Critical Moment will not be 
printed with the report design beam. A value of 1.0 
means a print. A value of 2.0 will print the areas of 
steel required for all intermediate sections specified 
by NSECTION. 
 
COLUMN DESIGN: 
 
TRACK 0.0 the results of detailed design 
will be printed. TRACK 1.0 the result of the 
analysis of interaction in addition to the 
previous column printing (TRACK 0.0) is 
printed. TRACK 2.0 schematic diagram of 
interaction and interaction intermediate 
values is printed in addition to all the above 

*  These values should provided in the system of units that is 
you are driving. 

** When using metric units for ACI design, hold their values 
parameters in units 'mm' instead of the number of the rod. The following metric sizes rod are 
available: 6 mm, 8 mm, 10 mm, 12 mm, 16 mm, 20 mm, 25 
mm, 32 mm, 40 mm, 50 mm and 60 
mm. 

 
While ignoring the effects of the duration of charge is, in a sense, an approach to be understood 
that the approximate evaluation of effects of slenderness is an approximate method. In this 
method, when the magnification is based on an empirical formula and assuming 
contraventeado. Considering all this information, it is our opinion that an PDELTA 
ANALYSIS, as implemented by STAAD, is very suitable for the design of concrete members. 
However, it should be noted, that to take advantage of this analysis, all load combinations 
should be provided as primary load cases and load combinations not like. This is due to the 
fact that the load combinations are purely algebraic combinations of forces and moments, while 
a primary charging case is reviewed during the P-Delta analysis based on the deflection. Also, 
note that the appropriate load factors (like 1.4 for DL, etc.) must be provided by the user. 
STAAD not factored loads automatically. 
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3.6 Design of Beams (Beam Design) 
 
 

The beams are designed for bending, shear and torsion. For all these forces, all active loads on 
the beam are pre-analyzed to identify possible critical sections. The total number of sections 
considered is 12 (twelve) unless this number is redefined with NSECTION parameter. All these 
equidistant sections are analyzed to determine the time and cut envelopes. 

 

3.6.1 Design by Flex 
 

 
Reinforcements for positive and negative moments are calculated based on the properties of 
the section the user are defined. If the dimensions of the section are inadequate to withstand 
the applied load, that is, if the required reinforcement is greater than the maximum allowable 
for the section, the program reports the failure beam of reinforcement. 

 
The effective depth is chosen as the total depth - (free coating + + stirrup diameter half the 
diameter of the main reinforcement), and an assay value obtained by adopting suitable rods 
sizes of the stirrup and the main reinforcement. The relevant clauses of sections 10.2 to 10.6 
of ACI 318 is used to obtain the actual amount of steel required, as well as, allowable and 
minimum required maximum steel. These values are reported as ROW, and ROWMN 
ROWMX at the start and can be printed using the TRACK parameter 1.0 (see Table 3.1). 
Furthermore, the maximum and minimum actual spacing of the rod is also printed. 

 
It is important to note that the beams are designed only for the bending moment MZ. The 
MY time is not considered in the design of flexion. 

 

3.6.2 Design by Court 
 

 
The shear reinforcement is calculated to resist both shear forces and torsional moments. Cutting 
forces are calculated at a distance (d + SFACE) and (d + EFACE) taken from the end nodes 
of the beam. EFACE SFACE and have default values of zero, unless otherwise specified (see 
Table 3.1). Note that the value of the effective depth "d" used for this purpose, is the ultimate 
value and features for the center of gravity (cg) of the main reinforcement actual calculated 
under the design bending. The relevant provisions of ACI 318 are used to calculate the 
reinforcement for shear forces and torsional moments. Based on the total requirement of the 
reinforcement stirrup, the size of rods, the spacing, the number of rods and the distance over 
which they are defined, the calculation takes place. The stirrups are always assumed 2 branches. 

 

3.6.3 Design by Anchor 
 

 
Anchor details are provided in the flexure design output. At any particular level, the coordinates 
of the START (START) and FIN (END) of the distribution of the main reinforcement is described 
along with information on how to stitch continuous anchorage, required or not, at the point of 
START and FIN. Note that the coordinates of these points HOME and END are obtained after 
taking into consideration the requirements of the anchor. The anchor length is calculated based 
on the clauses described in Chapter 12 of ACI 318. 
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3.6.4 Description of Output for the Design of Beams 
 

Table 3.2 shows an output of a model of the real reinforcement developed by the program. 
The following notes apply to Table 3.2: 

 
1) LEVEL: The serial number of the level of the rod which may contain one or more 

rods of group 
 

 
2) HEIGHT (HT): height of the rod from the bottom of beam. 

 

3) BAR INFO: About rebar detailing the number and size of rod. 
 

4) FROM: Distance from the start of the beam at the beginning of the rebar. 
 

5) TO: Distance from the beginning of the beam at the end of the rebar. 
 

6) ANCHOR: Raises if the anchor, either a hook or (STA / END) continuum, is needed at 
the beginning (STA) or end (END). 

 

 
7) ROW: Percentage of actual bending reinforcement required (As / bd) where b = width of 

the section (ZD for rectangular and square section) and d = effective depth of section (YD 
- the distance from the extreme tension fiber to cg main reinforcement). 

 
8) ROWMN: Percentage required minimum flexural reinforcement (Amin / bd) 

 
9) ROWMX: Percentage of maximum bending reinforcement required (Amax / bd) 

 
10) SPACING: The distance between the centers of adjacent main reinforcement rods 

 
11) Vu: Cutting force factored in the section. 

 
12) Vc: nominal shear strength provided by concrete. 

 
13) Vs: nominal shear strength provided by the shear reinforcement. 

 
14) You: The factored torsional moment at section 

 
15) Tc: nominal torsional moment strength provided by concrete. 

 

16) Ts: nominal torsional moment strength provided by the reinforcement of torsion or pads 
(STIRRUP). 

HOOK ANCHOR IS IF YES STIRRUP SPACING 

 
 

HT. OF LEVEL 
OF REBAR 

 
STIRRUPS 

 
 

HT. OF LEVEL 
OF REBAR 

 

CLEAR 

SPACI

NG 

 

 
 

START 

 

 
 
 

END 
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Table 3.2 

(Real Output Design) 
 

================================================== BEAM 

================== N O. 14 D E S I G N R 

E S U L T S - Flexure 

LEN - 20.00FT. FY - 60000. FC - 4000. SIZE - 15.00 X 21.00 INCHES 
 

LEVEL  HEIGHT BAR INFO  FROM   TO  ANCHOR 
FT. IN.  FT. IN. FT. IN. STA END 

-------------------------------------------------- ------------------- 

1 0 + 2-5 / 8 3-Num.9 2 + 4 to 5/8 0-0 + 20/0 Do not YES 
| ------------------------------------------------- --------------- | 
| POS = CRITICAL MOMENT 189.77 12.00 AT KIP-FT FT, LOAD 1 | 

| REQD STEEL IN2 = 2.48, ROW = 0.0090, 0.0214 ROWMX ROWMN = 0.0033 = | 
| MAX / MIN / CURRENT BAR SPACING = 7.50 / 2.26 / 4.94 INCH | 
| BASIC / REQD. DEVELOPMENT LENGTH = 37.95 / 31.42 INCH | 
| ------------------------------------------------- --------------- | 

2 1 + 1.6 / 8 4-No.11 + 0-0 0/0 18 + 10-0 / 0 YES Do not 
| ------------------------------------------------- --------------- | 
| NEG = CRITICAL MOMENT 369.86 KIP-FT AT 0.00 FT, LOAD 1 | 

| STEEL = REQD 5.47 IN2, ROW = 0.0198, 0.0214 ROWMX ROWMN = 0.0033 = | 
| MAX / MIN / CURRENT BAR SPACING = 7.50 / 2.82 

/ 3.20 INCH | 
| BASIC / REQD. DEVELOPMENT LENGTH = 59.20 / 153.91 INCH | 
| ------------------------------------------------- --------------- | 

3 1 + 3.6 / 8 3-No.6 8-1 + 16/4 0-0 + 20/0 Do not YES 
| ------------------------------------------------- --------------- | 
| NEG = CRITICAL MOMENT 105.87 KIP-FT AT 20.00 FT, LOAD 1 | 

| STEEL = REQD 1.31 IN2, ROW = 0.0047, 0.0214 ROWMX ROWMN = 0.0033 = | 
| MAX / MIN / CURRENT BAR SPACING = 7.50 / 1.75 

/ 5.13 INCH | 
| BASIC / REQD. DEVELOPMENT LENGTH = 16.70 / 27.75 INCH | 
| ------------------------------------------------- --------------- | 

 
B E A M N O. 14 D E S I G N R E S U L T S - SHEAR 

 
START AT SUPPORT - Vu = KIP 83.90 Vc = KIP 35.10 Vs = KIP 63.61 

PROVIDE NO. 4 AT BARS 7.0 IN. C / C FOR 108 IN. 
AT END SUPPORT - Vu = KIP 57.51 Vc = KIP 35.10 Vs = KIP 32.56 

PROVIDE NO. 4 AT BARS 9.3 IN. C / C FOR  84 IN. 
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3.7 Design of Columns 
 
 

The columns are designed by the ACI code STAAD for axial forces and uniaxial and biaxial 
moments. All active loads are examined to calculate the reinforcement. The load that produces 
the maximum reinforcement is called the critical load. The column layout is made for square, 
rectangular and circular sections. 

 
For rectangular and square sections, the reinforcement provided is assumed to be evenly 
distributed with respect to each of the sides. This means that the total number of rods for these 
sections always be a multiple of four (4). If MMag parameter is specified, the column moments 
are multiplied by the value of MMag to reach the last moments in the column. Since the ACI 
code no longer requires any minimum eccentricity as a condition to be satisfied, such checks are 
not performed. 

 
Method Used: The Method Bresler load contour 

 
Known values: Pu, Very, Muz, B, D, free coating, Fc, Fy, The ultimate strain 
for concrete: 0.003 

 

The steps involved: 
 

1) Assume some reinforcement. Minimum reinforcement (1%) is a good amount to start 
with. 

 
2) Find an approximate arrangement of reinforcement rods for the course. 

 
3) Calculate PNMAX = 0.85 Po where Po is the maximum axial load capacity of the 

section. 
Ensure that the actual nominal column load does not exceed PNMAX. If PNMAX is 
less than Pu / PHI (PHI is the strength reduction factor) increased reinforcement and 
repeat steps 2 and 3 if the reinforcement exceeds 8%, the column can not be designed 
with its current dimensions. 

 
4) In the event reinforcing rod under axial load and, find capabilities upon uniaxial column 

to the Y and Z independently. These values are respectively called MYCAP and MZCAP. 
 
 

5) Solve the equation of Interaction 
 

Mny 

Myca

p 

 
 
 

Mnz 
Mzca
p 

 

 
 
 

1.0 

 

where = 1.24. If the column is subjected to a uniaxial moment is chosen as 1.0 

 
6) If the equation is satisfied Interaction, find an arrangement with the sizes of the rods 

available, find the uniaxial capacity and solve the equation of the interaction again. If the 
equation is now satisfied, reinforcement details to the output file is written. 

 

7) If the interaction equation is not satisfied, the assumption reinforcement increases 
(ensuring that it is under 8%) and repeat steps 2 to 6. 
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Interaction of the column 

 
The interaction values of the column can be obtained using the design parameter TRACK TRACK 
1.0 and 2.0 for the column member. If a value of 2.0 is used for parameter TRACK, 12 different 
Pn-Mn pairs, each representing a different point in the curve of Pn-Mn will be printed. 

 

 
Each of these points represents one of several Pn-Mn combinations of this column is able to 
carry on the given axis, to the actual reinforcement for the column is designed. In the case of 
round columns, the values are for any of the radial axes. Values printed in the output for the 
TRACK 1.0 are: 

 

P0 = Maximum capacity purely axial load bearing column (zero time). 
PNMAX = The maximum allowable axial load on the column (Section 10.3.5 of 
ACI 318). P-bal = Capacity to axial tension load balanced condition. 
M-bal = The ability to time the condition Uniaxial tension balanced. e-bal = M-bal 
/ P-bal = Eccentricity to the condition of balanced tension. 
M0 = Moment capacity with zero axial load. P-tens
 = Maximum load allowable stress on the spine. 
Des. Pn = Pu / PHI PHI where is the Strength Reduction Factor and Pu is the axial load in 

the case of critical load. 
Des. Mn = Mu * mmag / PHI PHI where is the Strength Reduction Factor and Mu is the 

bending moment for the proper axis for the case of critical load. For round columns, 
2 2 

Mor Muy Muz 

 
e / h = (Mn / Mn) / h where h is the length of the column. 

 
 
 

Output Column design 
 

 
The examples show different levels of production column design. The following output without 
any definition of TRACK (ie, using the default value TRACK 0.0) is generated: 
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TRACK 1.0 generates the following additional output over the previous output (TRACK 
0.0). 

 
 

 
 
 
 
 
 

TRACK 2.0 generates the following additional output over all 
previous outputs. 
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3.8 Design Elements, Slabs and Walls Cutters 
 
 

STAAD currently provides facilities for the design of three types of entities associated with the 
type of surface structures. 

 
a) Individual plate elements - these are designed from the viewpoint that an element is 

independent of this element. 
 

b) Walls Cortantes- structural components modeled using the SURFACE command 
INCIDENCE (incidence of the surface) can be designed as shear walls support. 

 

The design elements are made only by MX and MY time in the center of the element. The 
design will not be effected by SX, SY, SXY, SQX, SQY or MXY. Also, the design is not done 
at any other point on the surface of the element. 

 
A typical example of the output of a finite element design is shown in Table 3.4. The reinforcement 
required to resist moment Mx is denoted as longitudinal reinforcement and reinforcement 
necessary to resist My time is denoted as transverse reinforcement (Figure 3.1). The FYMAIN, 
FC and CLEAR parameters are listed in Table 3.1 are relevant in the design of a slab. Other 
parameters listed in Table 3.1 are not applicable to the design of the slab. Note that the default 
value of the coating - CLT and CLB parameters - for the elements of the plate is 0.75 inches in 
the English system and 3 cm in the international system, as shown in Table 3.1. 

 

Figure 3.2: Sign conventions for a plate‐loaded element 
 

 



TECHNICAL MANUAL STAAD.Pro 

124 

 

 

 
 
 
 

Table 3.4 Output element design plate- 
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Section 4 

Mexican Design 
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4.1 Concrete Design by NTC MEX 1987 
 

STAAD.Pro is able to perform the specific design based on the Mexican code NTC 1987 
Complementary Standards for Design and Construction of Concrete Structures. 

 

The design of the NTC members by 1987 requires selecting package STAAD "Latin American design codes" 
code. 

 
 

4.1.1 Operations Design 
 

 
STAAD has the capabilities for the design of concrete. It will calculate the reinforcement required 
for the specified section of concrete. All concrete design calculations are based on the most 
current: additional technical standards for the design and construction of structures 
Concrete - November 1987 building code for the Mexican Federal District 
‐Aug.  1993  (Building  Code  for  the  Federal 

District). 
 

4.1.2 Types sections for designing concrete 
 
 

They can define the following types of cross sections for the particular design. Columns - 

Prismatica (Rectangular, Square and Circular) 

Beams - Prismatica (Rectangular and Square), Keystone, and forms T 
Walls -Elements finite thickness with a specific 

 

 
Figure 4.1.2 ‐ Nomenclature concretely for beams and columns 
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4.1.3 Dimensions of members 
 

 
Members of concrete that will be designed by the program must have some income under 
Section Properties command MEMBER PROPERTY. The following example shows the 
required input: 

 
 

UNIT CM 
 

MEMBER PROPERTY 
 

PRISM TO 79 YD 13 40 ZD 20 IY IZ 53333 13333 
 

November 13 PR YD 20. 
 

TO PRIS YD 14 16 24 18 YB ZB ZD 48 12. 
 

PR 17 TO 19 YD 24 ZD 18 ZB 12. 
 

 
 

In the previous post, the first set of members are rectangular (40 cm deep and 20 cm wide) 
and the second set of members, not only with depth and width provided, is assumed to be 
circular 20 cm in diameter. Note that no area (AX) is provided for these members. For the 
design of concrete, should not be provided at this property. If cutting areas and moments of 
inertia are not provided, the program calculates the values of YD and ZD. Note that in the 
above example the IZ and IY values provided are actually 50% of the calculated values using 
YD and ZD. This is a conventional practice to take into account the revised parameters due 
to cracking section of the section. 

Note that the third and fourth set of members in the previous example represent a T shape 
and form KEYSTONE respectively. Depending on the properties provided (YD, ZD, YB, ZB, 
etc), the program will determine if the section is rectangular, trapezoidal or U shape and 
therefore the design of the beam is performed. 

 
 

4.1.4 Design Parameters 
 

 
The program contains a number of parameters that are necessary to realize the design by the 
Mexican code. They have been selected default parameters that are used for conventional design 
requirements numbers. These values can be changed to suit to perform the particular design. 
Table 3.1 is a complete list of the available parameters and their default values. 

 
The manual describes the commands necessary to provide these parameters in the input file. 
For example, and EFACE SFACE values (parameters used in the design of cutting), the 
distances from the face of the mounting end nodes of a beam, are assigned a default value of 
zero, but may be modified depending of the real situation. Similarly, the beams and columns 
are designed to now obtained directly 
analyzes without any increase. MMY factors and MMZ be used to increase 
column moments. For beams, the user can generate load cases containing fillers magnified by 
the appropriate load factors. 
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Note: When a parameter is specified, the value is maintained in the 
specified number until specified again. This is the way STAAD works for all 
codes. 

 
 

Table 4.1.4- concrete design parameters Mexican 
 

Parameter 
Name 

Default Value Description 

 

CODE - Must specified how come

 MEXICAN. Design code to follow. 

 
CCL 1 Class of concrete according 1.4.1d) to 

define the modulus of elasticity 
 

1. Class 1 Concrete 
 

2. Concrete class 2 

 
CFB FALSE Classification of Cold Formed bar to define 

multipliers development according to 
Table 3.1 NTC 

   FALSE ‐Cold bar unformed     

TRUE ‐Cold formed bar 
 
CLB 3 cm Lower reinforcement coating 

 
CLS 3 cm Lateral reinforcement coating 

 
CLT 3 cm Coating of top reinforcement 

 
DAG 2 cm Maximum aggregate diameter, in 

current units. 
 
DCP TRUE Loads and reactions in

 beams direct 
compression 

   FALSE - loads indirectly 
applied 
TRUE ‐Direct Compression

 
DEPTH YD Depth of the concrete member in current 

units. This default   YD under   MEMBER 

PROPERTIES. 
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DIM TRUE FALSE: No precautions - reduced from 

section to section 1.5 NTC Concrete 
 

TRUE: the precautions taken to ensure 
dimensional 

 
DSD TRUE  

Ductile frames in accordance with 
Article 5 of the code. Some design 
conditions are considered 
(excluding, for the moment, or a 
geometric confinement) 

 
FALSE - no ductile Marcos 
TRUE ‐Marcos Ductile 

 
EFACE 0  

Location facing the tail end of the 
supporting beam. If specified, the 
beginning Shear force is computed at 
a distance of EFACE + d from the 
start of the joint member. Positive 
number. 

 
EXP FALSE  

Exposure time to the ground or to set 
the coating and the steel 
reinforcement minimum 

   FALSE - Not exposed to soil or 
climate 

 

   TRUE - Exposed soil or climate 

 
FC 200 Kg / cm2 

Resistance to the compression
 concrete 

 
FYMAIN 4,200 Kg / cm2 

Yield stress for steel reinforcement 
principal 

 
FYSEC 4,200 Kg / cm2 

Yield stress for secondary steel 
reinforcement (stirrup) 
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LSS 0  

Considered part of the longitudinal 
steel to reduce shear. 0 (zero) is 
conservative. Value between 1 and 0. 

 
LTC FALSE  

Lightweight concrete development to 
define multipliers according to Table 
3.1 NTC 

     FALSE - Regular 

concrete      TRUE - 
 
MAXMAIN 12 

Size Maximum main reinforcement bar 
(Issue 2 -18) 

 
MINMAIN 2.5 

Size rebar principal minimum (Issue 2 
-18) 

 
MINSEC 2.5 

Size minimum secondary reinforcement 
bar (Number 2 -18) 

 
MMY 1.0 

Moment magnification factor for 
columns about My 

 
MMZ 1.0 Moment magnification factor for 

columns on Mz 

 

MOE 198,000 Kg / cm2 Modulus of elasticity of concrete 
 
NSECTION 12 Number of equidistant sections 

should be considered in the search 
for critical points for the design of 
the beam 

 
PHI 90 degrees Stirrups angle with the axis of 

element 
 
PSS TRUE Supported slab perimeter. To 

calculate the minimum steel to 2.1.2 

 
REINF 0 Zunchada column (spiral 

reinforcement). A value of 1 means 
spiral. 
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SFACE 0 Location faces the leading end of the 

supporting beam. If specified, the 
beginning Shear force is computed at 
a distance of SFACE + d from the 
start of the joint member. A positive 
number 

 
TEQ FALSE Beam balance required for torsional 

Cl.2.1.6a) 2nd paragraph 

     FALSE - 

No      

 
TRACK 0 

Design of Beams 
 

1. The critical moment is not printed 
with the design brief of the beam. 

 
2. Print means a critical time. 

 

 
3. It will print steel areas required 
for all intermediate sections 
specified by NSECTION. 

 
Design of columns 

 

1. It will print results of detailed 
design. 

 

 
2. It means that the interaction of the 
test results column will be printed 
with TRACK 0 output 

 
3. It will print a schematic diagram 
of the interaction and 
intermediate values in addition to 
all the above. 
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WIDTH ZD Width of the concrete member in 

current units. This defaults to ZD 
under MEMBER PROPERTIES 

 

* These values can be provided in the current unit system is used. 
 

 
Note:  When  rods  design  metrics  are  used,  provided  values  for  these 
parameters in actual units 'mm' instead of the bar number. Are available the 
following metric sizes: 4.2 mm, 6 mm, 8 mm, 10 mm, 12 mm, 16 mm, 20 mm, 
25 mm, 32 
mm, 40 mm, 50 mm and 60 
mm. 

 

 
4.1.5 Design of beams 

 

 
The beams are designed for bending, shear and torsion. For all these forces, all active loads are 
pre-scanned to identify possible critical sections. The total number of sections considered is 12 
(twelve) unless this number is redefined with NSECTION parameter. All these equidistant sections 
are analyzed to determine the envelope of the time and shear. 

 

 
 

4.1.5.1 Bending Design 
 

 
 

Reinforcement for positive and negative moments are calculated based on the section properties 
provided by the user. If the dimensions of the section are insufficient to carry the load applied, 
if the required reinforcement is greater than the maximum allowed by the cross section, the 
program reports that beam failure of reinforcement. The rectangular sections are also designed 
with compression strengthening. 

 
The effective depth is chosen as depth Total - (+ coating + stirrup diameter half the diameter 
of the main reinforcement), and a test value was obtained by adopting suitable rod sizes for 
stirrups and main reinforcements. 

 
 

The relevant clauses in sections 1.5, 1.6, 2.1.1-2-5, 3.10 and 5.2.2 NTC concrete are used to obtain 
the actual amount of the maximum and minimum steel required and necessary. These values are 
reported as ROW, and ROWMN ROWMX on output and can be printed using the TRACK 
parameter 1.0 (see Table 4.1.4). Furthermore, the maximum, minimum and actual space bar also 
printed. 

Importantly, the beams are designed for bending moment MZ only. The MY time is not 
considered in the design bending. 
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4.1.5.2 Design shear 
 

 
 

The shear reinforcement is calculated to resist shear forces and torsional moments. These forces 
at a distance (d + SFACE) and (d + EFACE) is calculated away from the end nodes of the 
beam. EFACE SFACE and have default values of zero, unless it is established under other 
parameters (see Table 4.1.4). Note that the value of the effective depth "d" used for this purpose 
is to update accounts for the actual center of gravity of the main reinforcement calculated 
under bending design. 

 
 

The concrete 2.1.5-6 and 5.2.4 NTC clauses are used to calculate the reinforcement shear forces 
and torsional moments. Based on total overall reinforcement stirrup required, the size of the 
bars, the spacing is calculated, the number of bars and the distance over which they are 
provided. The Stirrups due to geometric conditions are assumed to be 2 feet, due to design 
conditions could be 2 or 4 legs. 

 

 
 

4.1.5.3 Anchorage 
Design 

 

 
 

At the exit to design flexural strength, details of anchor are also provided. For any particular 
level, the initial end of the path of the main reinforcement coordinates and described in 
conjunction with information whether shaped anchor hook or a continuation or not the start 
and end points are required. Note that the coordinates of the start and end points are obtained 
after taking into account the anchorage requirements. 

 

 
The anchorage length is calculated based on the terms described in Section 3.1 NTC concrete. In 
case the program selects 2 different diameters or principal compression reinforcement, anchoring 
analyzed only for the larger diameter. 

 
 

4.1.5.4 Output description for the design of beams 
 
 

The following list shows which of the various parameters used in the design of concrete beams 
by the Complementary Technical Norms do not vary at all with respect to the American 
Standards ACI (See Section 3 - American Concrete Design). 

 

1) LEVEL: The serial number of the level of the rod which may contain one or more 
rods of group 

 
2) HEIGHT (HT): height of the rod from the bottom of beam. 

 

3) BAR INFO: About rebar detailing the number and size of rod. 
 

4) FROM: Distance from the start of the beam at the beginning of the rebar. 
 

5) TO: Distance from the beginning of the beam at the end of the rebar. 
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6) ANCHOR: Raises if the anchor, either a hook or (STA / END) continuum, is needed at 
the beginning (STA) or end (END). 

 

 
7) ROW: Percentage of actual bending reinforcement required (As / bd) where b = width of 

the section (ZD for rectangular and square section) and d = effective depth of section (YD 
- the distance from the extreme tension fiber to cg main reinforcement). 

 
8) ROWMN: Percentage required minimum flexural reinforcement (Amin / bd) 

 
9) ROWMX: Percentage of maximum bending reinforcement required (Amax / bd) 

 
10) SPACING: The distance between the centers of adjacent main reinforcement rods 

 
11) Vu: Cutting force factored in the section. 

 
12) Vc: nominal shear strength provided by concrete. 

 
13) Vs: nominal shear strength provided by the shear reinforcement. 

 
14) You: The factored torsional moment at section 

 
15) Tc: nominal torsional moment strength provided by concrete. 

 

16) Ts: nominal torsional moment strength provided by the reinforcement of torsion or pads 
(STIRRUP). 

 
 
 
 

Example output file of the design of a beam 
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4.1.6 Design of columns 
 
 

The design of columns in STAAD by the Mexican code is made by uniaxial axial force and biaxial 
moments like. All active fillers are made for calculating the reinforcement. The load that produces 
the greatest amount of reinforcement is called the critical load. 

 
 

The column design is performed to square, rectangular and circular sections. For rectangular 
and circular sections, the reinforcement is always assumed to be equally distributed on all sides. 
This means that the total number of bars to these sections will always be a multiple of April 
4th. If parameters are specified and MMAGx - MMAGy, column moments are multiplied by 
the corresponding value MMag to reach the last moments in the column. The conditions to 
satisfy minimum eccentricity are checked under Section 2.1.3.a of NTC. 

Method Used: The Method Bresler load contour 
 

Known Values: Pu, Muy, Muz, B, D, free coating, Fc, Fy 
 

The ultimate strain for concrete: 0.003 
 

The steps involved: 
 

1. Assume some reinforcement. Minimum reinforcement (1%) is a good amount to start 
with. 

 
2. Find an approximate arrangement of reinforcement rods for the course. 

 
3. Calculate PNMAX = Po, where Po is the maximum axial load capacity of the section. 

Ensure that the rated load in the column does not exceed PNMAX. If PNMAX is less 
than the axial force Pu / FR (FR is the force reduction factor) increases the 
reinforcement and repeat steps 2 and 3 If the reinforcement is greater than 6% (or 4% 
for the ductile design ), the column can not be designed with its current dimensions. 

 

4. For the assumed reinforcement arrangement and axial load capacities uniaxial found 
when the column to the Y and Z independently. These values are called MYCAP and 
MZCAP respectively. 

 
 

5. Solve the equation of Interaction 

Mny 

Myca

p 

 

 
Mnz 

Mzca
p 

 
 
 

1.0 

Where = 1.24. If the column is subjected to a uniaxial moment is 
chosen as 1.0 

 
6. If the interaction equation is met, a match is found with rod sizes available, is uniaxial 

to search capabilities and interaction solve equation again. If now the equation is satisfied, 
the reinforcement details are written to the output file. 

 

7. If the interaction equation is not satisfied, the assumed reinforcement increases (to ensure 
it is below 6% and 4% respectively) and repeat steps 2 to 6. 
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To check the shear and torsion in columns, sections and beams must be checked and stricter 
reinforcement adopted adopted both shear and torsion. 

 

 
 

4.1.7 Interaction column 
 

 
The interaction values of the column can be obtained using the design parameter TRACK TRACK 
1.0 and 2.0 for the column member. If a value of 2.0 is used for parameter TRACK, 12 different 
Pn-Mn pairs, each representing a different point in the curve of Pn-Mn will be printed. 

 
Each of these points represents one of several Pn-Mn combinations of this column is able to 
carry on the given axis, to the actual reinforcement for the column is designed. In the case of 
round columns, the values are for any of the radial axes. Values printed in the output for the 
TRACK 1.0 are: 

 

    P0 = the maximum capacity purely axial load bearing column (zero time). 
 

    PNMAX = Maximum permissible axial load on the column 
 

    P-bal = axial capacity at balanced strain loading condition. 
 

    M-bal = The ability to time the condition Uniaxial tension balanced.     e-bal = 

(M-bal / bal-P) = Eccentricity to the condition of balanced 

tension.     M0 = The moment capacity with zero axial 

load. 

    P-tens = maximum load allowable stress on the spine. 
 

    Des. Pn = Pu / PHI PHI where is the Strength Reduction Factor and Pu is the axial load in the 
case of critical load. 

 

    Des. Mn = Mu * mmag / PHI PHI where is the Strength Reduction Factor and Mu is the bending 
moment for the proper axis for the case of critical load. For round columns, 

 
2 2 

Mor Muy Muz 

 

   e / h = (Mn / Mn) / h where h is the length of the column. 
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4.1.8 Output column layout 
 

 
The examples show different levels of production column design. The following output without 
any definition of TRACK (ie, using the default value TRACK 0.0) is generated: 

 

 
 

 
 
 

TRACK  1.0  generates the following additional output over the previous output 
(TRACK 0.0). 
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TRACK 2.0 generates the following additional output over 
all previous outputs. 

 
 
 
 

4.1.9 Design of slabs 
 
 

The slabs are designed according to specifications of the Mexican NTC. To design a slab 
should be modeled using finite elements. 

 
The design elements are made only by MX and MY time in the center of the element. Such a 
design will not be made by FX, FY, FXY, MXY. Also, the design is not done at any other 
point on the surface of the element. The cut is checked with Q. 

 

A typical example of output element design is shown. The reinforcement required to resist 
moment Mx is denoted as longitudinal reinforcement and reinforcement necessary to resist My 
time is denoted as transverse reinforcement. Parameters 
FYMAIN, FC, CLB, CLS, CLT, DIM, and EXP listed in Table 4.1.4 are 
relevant to the design of the slab. Other mentioned parameters are 
not used in the design of the slab. 

Figure 4.1.9‐moments item: Longitudinal (L) and transverse (T) 
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ELEMENT LONG. REINF MOM-X / LOAD TRANS. REINF MOM-AND / 

  (SQ.MM/MM) (KN-MM / MM) (SQ.MM/MM) (KN-MM / 
MM)

 
 

4.1.9.1 Example of an output file of a plate-like element 
 

DESIGN ELEMENT SUMMARY 
---------------------- 

 

 
47 TOP: Longitudinal direction - Only minimum required steel. 
47 TOP: Transverse steel direction- Only minimum required. 
47 TOP: 0.205 0.00 / 0 0.205 0.00 / 0 

BOTT: 0.254 10.44 / 1 0.362 13.35 / 1 

47 SHEAR CAPACITY 57.06 KN PASS *** 3 *** FOR LOAD CASE 

Indicates EXCEEDS MAXIMUM REINFORCEMENT ***** 
*************************** END OF ELEMENT DESIGN ******************* 
******** 

 
 

 

4.2 Steel Design by NTC MEX 1987 
 

STAAD.Pro is able to perform steel design based on the Mexican code NTC 1987 
(Complementary Technical Norms for Design and Construction of Steel Structures) or Building 
Regulations for the Federal District. 

 

The NTC members by Design 1987 is required to select the package STAAD Latin American 
design codes code. 

 
 

4.2.1 General 
 
 

The design philosophy considers that the method of load cases and design strength or limit 
states design usually known as factor load and resistance design (LRFD). 

 
The structures are designed and proportionate taking into account the boundary condition 
which would become unfit for its intended use. Two major categories are recognized limit state 
- ultimate and serviceability. The main considerations in ultimate limit state design are strength 
and stability, while in service is deviation. The appropriate load factors and resistance are used 
as well, uniform for all steel structures under different load conditions while the chances of 
being overwhelmed reliability limits are acceptably remote is achieved. 

 
In implementing STAAD Mexican standards for steel structures, members are provided to 
withstand design loads without exceeding the limit states of strength and stability. Allows you 
to check the deformation to verify serviceability. 

 
Consequently, the economic section is selected based on the criteria of less weight gained by 
the designer in specifying allowable depths members, type of desired section or other such 
parameters. The check code of the program verifies that the requirements of the main code for 
each selected section are met and identifies the governing criteria. 
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The following sections describe the salient features of the Mexican specifications as 
implemented in the design of steel STAAD. A brief description of the key concepts is presented. 

 

 

4.2.2 Fundamentals of limit state design 
 
 

The primary objective of the design specification limit states is to provide a uniform basis for 
all steel structures under different loading conditions reliability. 

 
The design method used to limit state independent factors for each load and resistance. Due 
to various factors reflect the degree of uncertainty of different loads and load combinations 
and the accuracy of estimated strength, more uniform reliability is possible. 

 
The method can be summarized by the 
inequality 

AndiQi≤RnFR  

 

 
On the left side of the inequality, the required force is the sum of the various effects of load 
(Qi), multiplied by their respective load factors (Yi). The strength of the design on the right 
side is the nominal resistance and resistance (Rn), multiplied by a factor of resistance (FR). 

 
In implementing STAAD Mexican standards, assumes that you use appropriate load factors 
and load combinations creates necessary for analysis. The part of the program design should 
consider the effects of load (forces and moments) obtained from the analysis. In the calculation 
of the resistor components (beams, columns, etc.), resistance (nominal strength) and resistance 
factor automatically deemed applicable. 

 

 

4.2.3 Moments and forces members past 
 

 
The last moments and forces members in the result of members of the loads applied to the structure. 
These forces are in the local coordinate system of the members. The following figures show the final 
actions of the member with their addresses. See section 1.19 of the Technical Reference Manual for 
details. 

 

 

4.2.4 Classification section 
 

 
The specification limit state design allows inelastic deformation of section elements. Thus, the 
local buckling becomes an important criterion. The steel sections are classified as compact (type 
2), no compact (type 3) or threadlike element (type 4), depending on the characteristics sections 
of local buckling, in addition to one type of plastic sections are able design. This classification 
is a function of the geometric properties of the section. The design procedures are different 
depending on the class section. Staad is able to determine the classification of the section to 
the standard design methods accordingly. 
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4.2.5 Effort Axial members 
 

 
The criteria governing the capacity of tension members is based on two limit states. The limit 
state performance in the gross section is intended to prevent excessive limb lengthening. The 
second involves the fracture limit state in the section with the lowest effective net area. The net 
area of the section may be specified by the user by using the NSF parameter (see Table 13B.1), 
which always refers to the gross section. STAAD calculates the voltage capacity of a Member 
based on these two limit states and proceeds accordingly with the selection of members or 
verification code. 

 
 

Besides the criterion of tensile strength, the user defines whether the tension members are 
required to meet the slenderness limitations are a function of the nature of use of the member 
(main load resisting component, reinforcing members, etc.) . While the selection of member 
checking code and process it checks immediately STAAD slenderness to appropriate members 
before continuing with other procedures for determining the suitability of a particular member. 

 
 
 
 

4.2.6 Axial Compression 
 

 
Force equations take into account column inelastic deformation and other recent research 
on the behavior of the column. Two equations governing the pressure head are available, 
one for and one for inelastic buckling or elastic Euler buckling. Both equations include the 
effects of residual stresses and out-of-straightness initial. The compressive strength of a 
particular member STAAD is calculated by the method described in section 3.2 of the NTC. 
For thin elements, the procedure described in section 2.3.6 of the NTC is also used. 

 
The procedures in section 3.2 of the reviews, design aids and examples of Complementary 
Standards for Design and Construction of Steel Structures, DDF (Comment - July 1993) were 
applied to the determination of the design strength for these states limit. 

 
The effective length for calculating the compressive strength can be provided by using 
parameters KY, KZ or LY, LZ. If not provided, the entire length of the member is taken into 
consideration. 

 
Further criteria compression strength, compression members are required to satisfy the 
constraints that are a function slenderness of the nature of use of the member (main resistance 
load component, reinforcing members, etc.). While the selection of member checking code and 
process it checks immediately STAAD slenderness to appropriate members before continuing 
with other procedures for determining the suitability of a particular member. 
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4.2.7 Bending Strength Design 
 

 
In the method of limit state design, the design flexural strength of a member is determined 
primarily by the limit state of lateral torsional buckling. The inelastic bending is permitted and 
basic measure of resilience to bending is plastic moment capacity of the section. 

 
The flexural strength is a function of capacity, actual long sideways without support, limiting 
unbraced length, the time button and the coefficient of plastic bending moment. Limiting 
laterally unsupported length (Lu) and flexural strength (Mr) are functions of the geometry of 
the section and are calculated according to the procedure in Section 3.3.2 of the NTC. 

 
The purpose of bending coefficient Cb is to take into account the influence of the time gradient 
of the lateral torsional buckling. This coefficient may be specified by the user by using CBx or 
CBy parameter (see Table 11B.1) or can be calculated by the program (as LRDF USA 
specification) if CB is specified as 0.0. In the absence of CB parameter, a predetermined value 
of 1.0 is used. 

 
To specify the unbraced length, none of the parameters and UNF UNL (Table 10B.1) can be used. 
It takes into account the reduction in flexural strength due to the thin web under section 4.5.8 of 
the NTC 

 

The LRDF USA specification was used for sections where the soul and skate are thin. Areas of 
stress due to bending about the axis (MY) 

 

 
 

 
 
 
 

Note:  The  local  X  axis  goes  into  the  page;  Global  Y  axis  is  vertically 
upwards;  the  shaded  area  indicates  the  area  under  compression;  the 
shaded area indicates not energized 
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Areas of stress due to bending about the Z axis (MZ) 
 

 
 
 
 
 

4.2.8 Design shear 
 

 
The method of Item 3.3.3 Staad NTC used to design the cutting forces members. In addition 
to the combination of bending and shear are checked according to section 3.3.4 of the NTC, 
also considering the limits for stiffeners under Sections 4.5.6 / 7 NTC. The cut sections with 
wide channels skates and is resisted by the web area. 

 

 

4.2.9 Moment and axial forces combined compression 
 

 
The interaction of bending and axial forces individually and doubly symmetric shapes is 
governed by the formulas of section 3.4 of the NTC. These formulas of interaction cover the 
general case of biaxial flexural strength combined with axial. They are also valid for uniaxial 
bending and axial force. 
It is considered that the frames are part of the structures having shear walls or rigid elements 
that could be considered the lateral displacements of a flat. The program has included formulas 
that include structures with lateral displacement in the future by considering the columns B2 
individually and not full floor analysis. 

 

It takes into account whether the elements have transverse loads and if the ends are angularly 
restricted. 

 
 
 
 

4.2.10 Moment and axial forces combined tension 
 

Based on Section 3.5 4 of the NTC. 
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4.2.11 Design Parameters 
 
 

This design is sought by Mexican standards using the CODE command. Other applicable parameters 
are summarized in Table 4.2.11. These parameters communicate design decisions engineer for the 
program and thus allow the engineer to control the design process to suit the specific needs of an 
application. 

 
The parameter values were selected default numbers which are frequently used in the 
conventional design. Depending on the particular design requirements, some or all of these 
parameter values can be changed to accurately model the physical structure. 

 

The DMAX and DMIN parameters can only be used for the selection of members. 
 

When a parameter is specified, the value remains in specifying the number until specified 
again. This is the way STAAD works for all codes. 

 
 

Table 4.2.11-design parameters of steel design according to Mexican standards NTC 
 

Parameter 
name 

Default Value Description 

 

CODE - Must be specified as MEXICAN. 

Design code to follow. 

See section 5.48.1 of the Technical 
Reference Manual. 

 

BEAM 0 0: design at the ends and the locations 
specified by the command of the section. 
 
1: design at the ends and at each point 
along twelfth member 

 

CB 1  

The coefficient Cb defined under section 
NTC 3.3.2.2. 
 

If Cb is 0.0 shall be calculated by the 
program as LRFD USA (CbMex = 1 / 
CbUSA). 
 
Any other value will be used 
di tl i d i
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CMB 1 
The combined forces CMB factor when 
transverse loads on the limbs. 3.4.3.3.ii 
section NTC 
 
CMB 1.0 = The end members are 
angularly restricted. 
 
CMB = 0.85 The end members are not 
restricted angularly. 

 

DFF None (required for 
verification deflection 

TRACK 4.0) 
"Length of deflection between the maximum 
local deflection permitted. 

 

 
See Note 1 below. 

 

DJ1 Initial node member 
Number of node denoting the starting 
point for the calculation of "Deflection 
Length". 

 

 
See Note 1 below. 

 

DJ2 End node of the member  
Number of node denoting the end point 
for the calculation of "Deflection 
Length". 

 
See Note 1 below.

 

DMAX 114 cm  
Maximum allowable depth 

 

DMIN 0.0 cm  
Minimum allowable depth 

 

DSD T Contents ductile seismic design 
according to Article 11 (True or False). 

 
Main design conditions are considered 
(excluding, for the moment, geometric) 

 

FU 4,230 Kg / cm2  
Ultimate tensile steel Effort 
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Fyld 2,530 kg / cm2  
Minimum yield stress of steel 

 

IMM 0 
Primary or secondary member in order to 
check the slenderness 

 

 
1. Senior Fellow 

 
2. Secondary or contraventeos 

 

INO 0 
Definition of curve according NTC.3.2.2.1a, I 
defined for profiles or tubes 

 

 
1. n = 1.4, rolled I-profiles, tubes or 

constructed with 3 or 4 plaques 
obtained welded wider cuts 
oxygen plates. 

 

2. n = 1, I, built with tubes or 3 
or 4 plates welded 

 

IRR 0 
Variable defined for the whole structure 
indicating whether it is regular or 
irregular according to section 3.4 of the 
NTC. 
 

1. Columns that are part of 
regular structures 

 
2. Columns belonging to 

i l t t 

KX 1.0 
Effective length factor torsional bending 
buckling 

 

KY 1.0  

Effective length factor for the local Y axis 
. Generally the minor axis 

 

KZ 1.0  
Effective length factor for the local axis 
Generally the major axis Z.. 



TECHNICAL MANUAL STAAD.Pro 

148 

 

 

 

 
 

LDR T  
Defines if the structure has elements for 
wind load (shear walls, or rigid elements 
contraventeos) that restrict lateral 
movement and allow us to ignore the 
effects of slenderness. (True or False) 

 

LX Length element 
Length to determine the resistance to 
torsional bending buckling 

 

LY Length element 
Length to calculate slenderness 
ratio on the local Y axis. 

 

LZ Length element  
Length to calculate the aspect ratio 
for the local Z-axis. 

 

NSF 1 
Net area factor for tension members 

 

RATIO 1.0 
Allowable ratio of the effect of the actual 
load and design effort 

 

STIFF Length or depth of the 
longest element 

 
Spacing reinforcement beams for cutting 
design. 

 

TRACK 0  
Controls the level of detail of the output 

 
0 = Delete all design forces 

 
1 = Print all design forces 

 
2 = Print output expanded design 

 

UNB Length element Free length (L) of the lower * skate for 
calculating flexural strength. They will only 
be used if the compression is in the bottom 
flange. 

 
See note 2 below. 
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UNT Length element Free length (L) of the top * for calculating 
flexural skate. They will only be used if the 
compression is in the top flange. 

 
See note 2 below. 

4.2.11.1 For verification of deflection parameters DFF, DJ1, DJ2 table and can be used. 
All requirements remain the same. 

4.2.11.2 Top and bottom represent the positive and negative side of the local y-axis (local 
Z axis Z SET UP if used). 

 
 

4.2.12 Member Selection Options and verification codes 
 
 

Both verification code and member selection options are available in the application of Mexican 
standards STAAD. 

 
See Section 2.5 of the Technical Guide for general information about the verification code. See 
section 5.44.2 of this manual for details on specifying the verification code check command. 

 

See section 2.6 of the Technical Manual for general information on selecting members. See 
section 5.44.3 of this manual for details of the specification of the commands for selecting 
members. 

 
 

4.2.13 Results Table steel design 
 

 
The results of the verification code and member selection are presented in a tabular format. 
CRITICAL COND refers to the section governing NTC Mexican design. If TRACK is set to 
1.0, the design forces members are printed. 
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Section 5 

Commands and Input 
Instructions 
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Introduction 
 

 
 

This section of the manual describes in detail various commands and instructions related to 
STAAD. The user uses a format command language to communicate instructions to the 
program. Each of these commands provides some information either instructs the program or 
to perform some calculations using the specified data. Format command language and 
conventions in Section 5.1 is described. This is followed by a description of the available 
commands. 

 
Although the STAAD input can be created through the Modeling mode, is very important to 
understand the language of commands. With the knowledge of this language, it is easy to 
understand the problem and add or comment data when needed. The general sequence in 
which the commands must appear in an input file should ideally follow the same sequence 
presented in this section. Commands are executed in the input sequence. Obviously the data 
necessary for the proper execution of a command must precede the command (eg printing 
results after Perform Analysis). Moreover, commands can be provided in any order with the 
following exceptions. 

 

i) All data related to the design must be provided after the analysis command. 
ii) All cases of load and load combinations together, except where the CHANGE and 

RESTORE commands are used must be provided. Additional load cases may be provided 
in the last part of the inlet. 

 

All input data are provided are kept by the program. Data can be added, deleted or modified 
within existing data file. 

 

5.1 Command Language Conventions 
 

 
This section describes the language of the commands used in STAAD. First, the various 
elements of the language are discussed, then the command format is described in detail. 

 

5.1.1 Elements of Commands 
 

a) Whole Numbers: Whole numbers are numbers written without a decimal point. 
These numbers are designated as i1, i2, etc., and can not contain any point 
decimal. Signs (+ or -) are allowed in front of the numbers. If the sign is omitted, it is 
assumed to be (+). 

 
b) Floating Point Numbers: These are real numbers that can contain a 

decimal portion. These numbers are designated as f1, f2 ... etc. .. The 
values can have a decimal point and / or exponent. When specifying 
numbers with magnitude less than 1/100, you should use the format E 
to avoid errors related to the precision limit of these are 16 characters. 
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Example 
 

5055.32 0.73 -8.9 732 
5E3 -3.4E-6 
etc. 

 

 
When the sign is omitted, is assumed to be positive (+). Also note that the decimal point can 
be omitted if the decimal portion of the number is zero. 

 
c) Alphanumeric:  These  are  characters  that  are  used  to  construct  the 

names of the data, titles or commands. They alphabetic characters can 
be entered in uppercase or  lowercase. No quotation marks to frame is 
needed. 

 

Example 
 

MEMBER PROPERTIES 
TABLE 1 TO 8 ST 
W8X35 

 
 

d) Repetitive data: Repetitive numerical data can be provided using the following format: 
 

n * f 
 

Where n = the number of times the data has to be 
repeated f = numeric data, integer and floating 
point 

 
Example 

 
JOINT COORDINATES 
1 3 * 0. 

 
 

This specification of the coordinate of the board is the same as: 
 

1 0 0 0. 
 
 
 

5.1.2 Command Formats 
 

a) Free Entry Formats: All data entered STAAD are free‐form style. The 
input  data  must  be  separated  by  whitespace  other  input  data. 
Quotation marks are not required to remove any alphabetic word as 
data, commands or titles. An input limited to 16 characters. 

 
b) Comments  Entry:  To  document  a  data  file  STAAD,  the  option  to 

provide feedback is available. Comments can be included providing 
an asterisk (*) marks it as the first character in any line blank. The 
line  with  the  comment  echoes  the  output  file  but  has  not  been 
processed by the program. 
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Example 
 

JOINT LOAD 
* THE FOLLOWING IS AN EQUIPMENT FY Load 2 
March 7 35.0 
etc. 

 
 

c) Meaning of Emphasis in Manual: The exact format of the commands 
are described  in  the  last part  of  this  section. They  can  abbreviate 
many words in the commands and data. The whole word is given for 
the  purpose  of  description  of  the  command,  with  the  required 
portion (abbreviation) underlined. 

 
For example, if the word is used in a MEMBER command, only the necessary portion 
enters MEMB. Although it is more clear for others who are reading the results if the word 
is used whole, however an experienced user may wish to use the abbreviations. 

 
d) Meaning of Brackets and Parentheses: Some formats of commands, 

brackets enclose a number of options, which are placed vertically. 
They can select one and only one of the options. However, some of 
the listed options may be selected if an asterisk (*) is located outside 
the brackets. 

 

Example 
 

XY 
YZ 
XZ 

 
 

In the example above, the user must make a choice between XY or XZ or YZ. 
 

Example 
 

 

* FX 
FY 
FZ 

 
 

Here the user can choose one or all of the registration (FX, FY and FZ) in any order. The 
parentheses () indicates that the enclosed portion of the command is optional. The presence 
or absence of this portion affects the meaning of the command, as explained in the description 
of the particular command. 

 

Example 
 

PRINT (MEMBER) FORCES 
PERFORM ANALYSIS (PRINT LOAD DATA) 

 

 
In the first line, the word MEMBER can be omitted without changing the meaning of the 
command. In the second line, 
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LOAD DATA PRINT 
 

The command can also be omitted in which case the load data will not be printed. 
 

e) Multiple Data  Separator: Multiple data  can be provided on  a  single 
line, if they are separated by the semicolon (;). One restriction is that 
a semicolon can not separate the consecutive commands. They should 
appear on separate lines. 

 

Example 
 

MEMBER INCIDENCES 
1 1 2; 2 2 3; 3 3 4 
etc. 
Possible Error: 
PRINT FORCES; PRINT STRESSES 

 

 
In the above case, only the PRINT command is processed FORCES and STRESSES PRINT 
command is ignored. 

 
f) Displaying the Data: In some descriptions STAAD commands, the word 

"list" is used to identify a list of meetings, members / elements or load 
cases. The format of a list can be defined as follows: 

 
* i1, I2, I3....... 

list = i1TO i2(BY i3) 

X  or Y  or Z 
 
 

Where TO means all integers from the first (i1) to the second (i2) inclusively. BY means that 
the numbers are increased by an amount equal to the third item (i3). BY i3 If omitted, the 
increase will be considered one. Sometimes the list may be too long to fit on one line in this 
case the list can be continued on the next line by providing a hyphen preceded by a blank. Also 
note, that this applies only to continue a list and can not be used for any other data 

 
Instead of a number list, the X (or Y or Z) specification can be used. This specification will 
include all members are parallel to the specified global address. Note that this does not apply 
to joints or elements. 

 
ALL, BEAM, PLATE, SOLID. Do not use them unless the documentation for 
the command specifically mentioned as available for that command. ALL 
means all members and elements, BEAM means all members, etc. 

 
g) Continuing a command on the next line: They can only be continued 

to the next  line  lists the finishing line with a space and hyphen (see 
above)  with  the  few  exceptions:  multilinear  spring  supports,  the 
supports,  Master  /  Slave.  Others  who  have  special  types  of 
continuations. Please follow the descriptions of the command. 
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Example 
 

2 4 7 TO 13 TO 22 BY 19 February - 
31 TO 33 FX 28 10.0 
This list of items is the same as: 
2 4 7 9 11 13 19 20 21 22 28 31 32 33 FX 10.0 
Possible Error: 
3 5 TO 11 
September 15 - 
FX 10.0 

 
 

In this case, the mark below for list data is used when the list of data is not continuous. This 
will produce an error message or possibly unpredictable results. 

 
 

5.1.3 Listing of Meetings / Members / Elements by Specification Global 
Ranks 

 
This command allows the user to specify lists together / members / elements providing global 
ranges. The general format of the specification is as follows. 

 
General Format: 

 
XRANGE 
YRANGE f1, 

F2ZRANGE 
 
 
 

Where, 
Xrange, yrange, ZRANGE = address range (parallel to the global X, Y, and Z respectively) 
f1, f2 = values (in the current unit system) that defines the specified range 

 

Notes 
1. Only one address range (xrange, yrange etc.) is allowed per list. (Except: Loading Area 

/ Floor and Master / Slave). 
2. They can not be other data in the list. 
3. The values that define the range (f1, f2) must be in the current drive system 

 
 
 

Example 
 

Xrange TRUSS 
MEMBER 
CONSTANTS 20 70 
E STEEL yrange 10 55. 

 

In the above example, a XRange specified with values 20 and 70, this range will include all 
members that are completely inside parallel to the overall axis X range bounded by X = 20 
and X = 70. 
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5.2 Initiation of the Problem and Title 
 

Purpose 
 

The initial run commands in the STAAD allows the user to specify the type of structure and 
an optional title. 

 
General Format: 

 
PLANE 

SPACE 
STAAD  (Any title 

to1) TRUSS 
FLOOR 

 

Description 
 

Any input STAAD must begin with the word STAAD. The following type specifications are 
available: 

 
 

 
See Section 
1.3 

PLANE = Frame structure Plano 
SPACE = Space Frame Structure 
TRUSS = armor type Flat Structure or Space 
FLOOR Floor type = structure 

 
a1 = Any securities to the problem. This title will appear at the top of each page of results. To 
include additional information in the header of the page, use a line containing the relevant 
information as the second input line. 

 

Notes 
1) The user should be careful to choose the type of structure. The choice is dependent 

on the number of degrees of freedom that need to be considered in the analysis. The 
following figure illustrates the degrees of freedom considered in various type 
specifications. Detailed discussions are available in Section 1.3. 

 

 
STRUCTURE TYPES 

 
PLANE 

 
 
 
 
 

SPACE 

 
 
 
 

2D 3D TRUSS 
 
 

FLOOR 
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2) Optional user-supplied title is printed on the top of each page of output. The user can 
use this option to customize your results. 

 

Limits 
 

1) Number of Meetings: 1-999999 
2) Number of meetings: 100000 * 
3) Membership number / Elements: 1-999999 
4) Number of members and Elements 100000 * 
5) Load Case Number: 1-99999 
6) Number of primary cases and combinations: 1000 

 
 

STAAD * Some copies are available with much smaller limits, please verify what limits you 
have purchased. 

 

5.3 Specifying Units 
 

Purpose 
 

This command allows the user to specify or change length and force units for input and 
results. 

 
General Format: 

 
 

 
 
 

UNIT 
* force-

length-unit 

unit 

INCHES 
FEET or FT 

Cm 
length-unit = METER 

MMS 

DME 
KM 

 

 
KIP 

POUND 

KG 
force-unit = MTON 

NEWTON 

KNS 

MNS 

DNS 
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Note: DME denotes Decimeters. MNS denotes  the Mega Newtons  (1000 
Newtons)  and DNS denotes decaNewtons  (10 Newtons). MTON denotes 
Metric ton (1000 kg). All other units are self explanatory. 

 

Description 
 

The UNIT command can be specified any number of times during a run. It is assumed that 
all data is contained in the latest specification of the unit that precedes data. Also note that 
the input unit for angles is always degrees. However, the result unit for rotations of the board 
(the displacement of the joint) are radians. For all results, the units are clearly specified by the 
program. 

 

Example 
 

UNIT UNIT INCH 
KIP FT 
KNS METER UNIT 
UNIT CM MTON 

 
 
 

Notes: This command can be used as often as necessary to specify the data 
or generate the results in the desired length and / or units of force. Note 
that  the mixture  and  tie  between  systems  of  different  units  (Imperial, 
Metric, SI etc.) are allowed. 

 
This command can be anywhere as a primary command (eg, JOINT COORD, MEMBER 
INCIDENCE, etc.). Furthermore, it can also be a first level wherever load command is 

 
Exceptions: The second command level load (MEMBER LOAD, LOAD and FLOOR JOINT 
LOAD), allowed to enter the UNIT command on a separate line, not in a continuation or 
between the semicolons. 

 
 

5.4 Specifying Width Input / Output 
 

Purpose 
 

These commands can be used to specify the width (s) of lines of file (s) output. 
 

General Format: 
 

INPUT 
 
 

OUTPUT 

 
 

WIDTH i1 

 

OUTPUT WIDTH, 
i1 = 72 or 118 depending on how narrow or wide departure. 
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Description 
 

The user can specify the required width of the input / output when using this command. 
Width for INPUT is used almost always 79 The program can create outputs using two different 
widths of 72 results (the default) and 118 width of 72 characters can be used for deployment 
on most CRTs and print a "portrait" (vertical) on wide paper. The width of 118 characters can 
be used to print the "landscape" (horizontal) paper width. 

 
Note: This is a custom option that can be used to improve the quality of 
presentation of the documents of the run. 

 

5.5 September Command Specification 
 

Purpose 
 

This command allows the user to sort several general specifications for the run of the analysis 
/ design. 

 
General Format: 

 

NL i1 

DISPLACEMENT
 i2
SDAMP i3 

WARP i4 

ITERLIM i5 

PRINT i7 

SHEAR 
 

SET ON 
ECHO 

OFF 
GUI i6 

Z UP 
 
 

Where, 
i1 = The maximum number of elementary charges (NL) 
i2 = The maximum acceptable tolerance for any joint displacement in the structure. 
i3 = The ratio of buffer to be used for the calculations of all the levers of modal damping 

compound in dynamics. 

i4 = The ratio of the roll to be restricted to members used in section I 
calculating the torsional rigidity. If it is 0.0 then there will be no restriction of bank, normal 
default option ,; If it is 1.0 then the restriction of roll is complete. Cw, the constant twist 
will be calculated and used in the calculation of torsional rigidity. Values between 0.0 and 
1.0 will produce a partial warping restraint. 

i5 = The maximum number of iterations of tension / compression. 
i6 = 1 Deviation forming data and files needed for post-processing. i7 = 1, which 
prints messages Deviation Zero Stiffness. 
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Description 
 

SET NL command is used in a multiple analysis run if the user wants to add more cases of 
primary load after an analysis has been performed. Specifically, for those examples, which use 
the RESTORE or CHANGE command, if the user wants to add more cases of primary load, 
the value of NL should be the maximum number with the command SET NL. The program 
can then put the additional memory space next to the information to be added later. Note that 
this command must be given before any board member or load specifications. The value for i1 
should not be greater than the maximum number of cases of primary charging. 

 
For PDELTA ANALYSIS with option CONVERGE DISPLACEMENT SET command is used to 
specify the tolerance of convergence. If the RMS displacement of two consecutive iterations change 
less than the entered value, then that load case converges. This command must be placed before 
specification JOINT COORDINATE. 

 
For NONLINEAR ANALYSIS SET DISPLACEMENT command is used to specify a limit value 
of displacement. If any movement after any iteration exceeds the value entered here, then the 
solution is diverging and ends. This command must be placed before specification JOINT 
COORDINATE. 
The SET ECHO ON command activated and the SET ECHO OFF command will disable 
operation commands repeat (echo) input in the output file. In the absence of the SET ECHO 
command, the command repeat return input file to the output file. 

 
By definition, the Y axis is the vertical axis. However, the SET Z UP command can be used to 
model situations where the Z axis represents the vertical axis (the direction of gravity load) of 
the structure. This can be built if the geometry of the entry is created through some CAD 
software. Note that this command will affect the specification of predefined angle BETA. 
However, the BETA can be set to a certain value for all parallel to a particular global axis using 
the MEMBER X (or Y or Z) type in the list members. For additional information, see the 
specification of the constants (Section 5.26). 

 

Notes for SET Z UP 

 
The SET Z UP command directly it influences the values of the following entries: 

 
1) JOINT COORDINATE 
2) The input for the command PERFORM ROTATION 
3) BETA ANGLE 

 
The following characteristics of STAAD can not be used with the SET Z UP 
command 

 
1) Generation of Wind Loads 
2) Generation Cargo Floor 
3) Automatic Generator Mounts Springs for Slabs Foundations 
4) Loads of UBC 

 
The SET command SDAMP allow the damping spring can be considered in the calculation of the 
compound for each mode in a dynamic modal damping solution. This command is not used 
unless the proportions of CDAMP for members and elements in the command CONSTANTS 
also mess. Damping 
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compound is generally only used if there are many ways in the dynamic solution and there is 
a wide range of damping ratios for spring / members / elements. 

 
The WARP SET command will allow the member end section warping that I restricted to be 
considered when calculating the torsional rigidity stiffened Total or partial or no restrictions 
warping is not allowed. 

 
ITERLIM SET command is to increase the maximum limit of the iteration on the default of 10 
iterations in tension / compression value. Since this iterative procedure does not necessarily 
converge, this option can not help more iterations and should be used with care. 

 
After any analysis of tension / compression in the output file (. ANL) should be considered non-
convergence warnings. Do not use the results of cases not converged. 

 
The SET PRINT command 1 is to delete messages Zero Stiffness. 

 
The command SET SHEAR is to omit the additional conditions to form shear distortion rigidities 
member-beam. With this command you can match exactly the results of the theory of beams 
textbooks. 

 
 
 

Other rarely used SET command: 

 
SET DATA CHECK IGNORED
SET RUN IGNORED
SET COMPRESS FILE COMPRESSION OFF 
SUN SETUTION INCORE Use the search for determining the 

frequencies for small problems 
SUN SETShow be ignored
SET CORE be ignored (Report)
SET EXM be ignored (EXTENDED MEMORY) 
SET NJ be ignored
SET NM be ignored
SET CONNECTIVITY be ignored
MAS SETS = 1 uses the generator times like masses. 

SET MODAL be ignored
SET THISTORY = 2 Use forces exact integration over time. 

INT SETERPOLATION Lin or Log for spectra
SET DISPLACEMENT METHOD be ignored
SET BUBBLE Fns = 1 does not use bubbles in solids 
SET NOSECT no results sections will be calculated 
SET TMH be ignored
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5.6 The Command Separator 
 

Purpose 
 

This command can be used to specify the desired separator character that can be used to 
separate multiple lines of data in a single input line. 

 
General Format: 

 
 

 
See Section 
5.1.2 

 
 
 

Description 

SEPArator to1 

The semicolon (;) is the default character that serves as the separator for multiple data on a line. 
However, this can change separator character by a1 SEPARATOR command any character except 
comma or asterisk. 

 
Note:  The  Coma  (,)  or  asterisk  (*)  should  not  be  used  as  a 
separator character. 

 
 
 

 

5.7 Page New Command 
 

Purpose 
 

This command can be used to instruct the program to start a new output page. 
 

General Format: 
 

P AGE N EW 
 

Description 
 

With this command, a new page of results can begin. This command provides the flexibility, 
the user needs to design the format of the results. 

 
Note: The quality of the submission of the results can be improved 
using this command properly. 

 
 
 

 

5.8 Command Page Length / Eject 
 

Purpose 
 

These commands can be used to specify the length of the search results page and the desired 
character page eject. 
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General Format: 
 
 
 

PAGE 
LENGTH i 

 

 
SHAFTCT to1 

 
 

The length of the page in Staad result is based on a default value of 60 lines. However, the 
user can change the page length to any number i (the number of lines per page) desired 

 

Description 
 

The character expels the normal page (CNTRL L for PCs and 1 for Mini / MFRM) is included 
in the program STAAD. The PAGE EJECT command to the input of character a1 eject eject alter 
the default page in the program. A blank character deleted ejection page. 

 
 

5.9 Specifications Ignore 
 

Purpose 
 

This command allows the user to provide lists of members in a convenient manner without 
activating appropriate error messages to members nonexistent numbers. 

 
General Format: 

 
IGNORE L I ST 

 

Description 
 

LIST ignor be used if the user wants the program to ignore any absent member could be included 
in a specification list member. For example, for the sake of simplicity, a list of members can be 
specified as MEMB 3 A 40 where members 10 and 11 do not exist. An error message in this 
situation can be avoided by providing ignor anywhere LIST command at the beginning of the 
entry. A message of warning, otherwise nonexistent appear for each member. 

 
 

5.10 Design Specification No 
 

Purpose 
 

This command allows the user to declare that no design operation will be performed during 
the run. The memory reserved for the design will be released to accommodate larger work 
analysis. 

 

General Format: 
 

INPUT NODESIGN 
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Description 
 

STAAD always assumed that at some point in the input, the user may wish to make the design 
for steel or concrete members. These design processes require more computer memory. If memory 
availability is a problem, the above command can be used to remove the extra memory 
requirements. 

 
 
 

 

5.11 Specification Joint Coordinates 
 

Purpose 
 

These commands allow the user to specify and generate the coordinates of the joints of the 
structure. The JOINT COORDINATES command starts the coordinates specification. The 
REPEAT ALL and REPEAT commands allow easy generation of coordinates using repetitive 
patterns. 

 

General Format: 
 

JOINT COORDINATES (CYLINDRICAL (R EVERSE)) (NOT CHECK) 
band-spec 

 
i1, X1, And1, Z1, (I2, X2, And2, Z2, I3) 
REPEAT n, xi1, Yi1, Zi1(Xi2, Yi2, Zi2, ..., Xin, Yin, Zin) 
REPEAT ALL n, xi1, Yi1, Zi1(Xi2, Yi2, Zi2, ..., Xin, Yin, Zin) 

 

JT ORIG xOrigin yOrigin zOrigin 
band-spec = (NOREDUCE BAND) 

 
 

NOCHECK = No place check for multiple structures or orphaned seals. 
 

 
 
 
 
 
 

See Section 
1.5.1 

 

Description 
 
The JOINT COORDINATES command specifies a Cartesian coordinate system (see Figure 1.2). 
Boards and are defined using the X, Y Z Global. The CYLINDRICAL JOINT COORDINATES 
command specifies a Cylindrical Coordinate System (see Figure 
1.3). Meetings are defined using the r,   and z coordinates. The JOINT command 
CYLINDRICAL COORDINATES REVERSE specifies a system Cylindrical Coordinates 
Reverse (see Figure 1.4). Meetings are defined using the coordinates r, y. 

 
JTORIG causes the program to use a different origin (0, 0, 0) for all inputs together with this 
JOINT COORDINATES command. In JTORIG command must be entered on a separate line. 
Basically after the joint coordinates are entered or generated, then xOrigin, yOrigin and zOrigin 
values are added to the coordinates. For example a cylinder would then be generated on the Y 
axis driven by this command to its proper place. To create multiple structural parts out of the 
joints, the JOINT COORDINATES, each with a command JTORIG command goes further. 

 

Note that the concept of multiple JOINT COORDINATES command allows you to change the 
ROTATION UNIDADADES and PERFORM (PERFORM ROTATION) between them; thereby 
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these commands are applied to a selected portion of the joints. However, the PERFORM 
ROTATION command applies to all predefined together, not only those in the previous 
COORDINATE JOINT command. 
BAND NOREDUCE causes the program to run without making a reduction 
bandwidth. 

 
Example 

 
JOINT COORDINATES NOREDUCE BAND 

 
 

The REPEAT command causes the previous input line is repeated 'n' number of times with 
increases in the specified coordinates. The REPEAT ALL command functions are similar to 
the REPEAT command repeats only the most recent entries previously specified before pre 
REPEAT ALL command, or all data if no board REPEAT All previous command has been 
given. Note that using the "REPEAT ALL 0" command will start a data section to be repeated 
if necessary. (When using the REPEAT ALL and REPEAT commands, together numbering 
must be consecutive and must start with 1) 

 

    i1 = The number of the board in which the coordinates are provided. Any integer within the 

limits (see Section 5.2 for the limit) are allowed. 
 

    x1, y1 and z1 = X, Y and Z (R, and Z for cylindrical or R, Y and for cylindrical inverse) 
of the board. 

 
For analysis PLANAR z1 is an optional input data for defining the individual joints. The z1 is 
always required for the generation of the joint. The following is only used if the seals are to be 
generated. 

 

    i2 = The number of the second meeting at which the board coordinates are generated. 
 

    x2, y2, and z2 = X, Y and Z (R, and Z for cylindrical or R, Y and for reverse 
cylindrical) the coordinates of the i2 board. 

 

    i3 = number increased by the board which together generated increase. The default is 1 if 

omitted. 
 

    n = The number of times that will be carried out. Note that "n" can not exceed 989 in a single 
one of the REPEAT command. 

 

    .xik, yik and zik = X, Y and Z (R, and Z [R, Y]) increases the coordinate for the k 
th replicate. 

 
The X, Y and Z (R, and Z [R, Y]) coordinates are spaced equally between i1 and i2. 

 

* Note that the REPEAT command uses the highest number of board entered so far plus one 
for the generation of the intermediate board 
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Example 1 
 

 
 

JOINT COORDINATES 
1 10.5 2.0 8.5 
2 0.0 0.0 0.0 
3 5.25 0.0 8.5 6 50.25 0.0 8.5 

 
 

In this example, the XY coordinates of the joints and Z 1 are provided seals 6 Note that 3 to 6 
will be generated with equally spaced joints 3 to 6 Hence, the ring 4 will have coordinates 20.25 
8.5 and 0.0 will coordinate joint 5 0.0 8.5 35.25. 

 

Example 
2 

 
JOINT COORDINATES 
1 0.0 0.0 0.0 4 45 0.0 0.0 
REPEAT 4 0.0 0.0 15.0 
REPEAT ALL 10 0.0 10.0 0.0 

 
 

Here, the coordinates of 220 joints of a structure 10 levels of 3 X 4 clear generated. The REPEAT 
command repeats the first input line 4 times, while increasing each coordinate Z 15 Thus, the 
first 2 lines are enough to create a "floor" of twenty together. 

 

1 0 0 0; 2 15 0 0; 3 30 0 0; 4 45 0 0. 
5 0 0 15; 6 15 0 15; 7 30 0 15; 8 45 0 15. 
..... ..... ..... ..... 
17 0 0 60; 18 15 0 60; 19 30 0 60; 20 45 0 60. 

 
 

The REPEAT ALL command repeats all previous data (ie 20avo "floor" of the board) ten times, 
increasing the Y by 10 each time. This creates the remaining 200 seals the structure: 

 

Example 
3 

 
21 0.0 10.0 0.0 ; 22 15.0 10.0 0.0; ...; 

 

40 45.0 10.0 60.0; 41 0.0 20.0 0.0; ...; 
200 45.0 90.0 60.0; 201 0.0 100.0 0.0; ...; 
219 30.0 100.0 60.0; 220 45.0 100.0 60.0 

 
 

The following examples show various applications of the REPEAT 
command. 

 

10 5 10 5 REPEAT. 
 

 
The REPEAT above command repeats the last input line 10 times using the same type of 
increments (ie x = 5, y = 10, z = 5) 
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REPEAT 3 2 10 5 3 15 3 5 20 3. 

 

 
The REPEAT command above will repeat the last input line three times. Each use a different 
repetition rate increases. 

 

 

REPEAT 10 0 12 0 15 0 0 10 0 * 9 * 0 
 
 

The above REPEAT command repeats the last line of the input 10 times; six times using x, y 
and z increases from 0, 12 and 0, and four times using increments of 0, 10 and 0 every x, y 
and z values of 0 represents has not been changed the previous increase. To create the second 
to the sixth repeat, five sets of 0, 0 and 0 (15 * 0) are provided. The seventh repeat blocks 
increases in 0, 10 and 0 from the eighth to the tenth repeat are made with the same increases 
as the 7th, and is represented as 9 * 0 

 

Note: JOINT COORDINATE The PRINT command can be used to verify the coordinates of the board 
proportionate or can be generated by the REPEAT ALL command. Also, use the Post Processing option 
to verify geometry graphically. 

 
 
 
 
 

5.12 Specifying Member Incidences 
 

Purpose 
 

This set of commands is used to specify a member defining the connection between the boards. 
The REPEAT ALL and REPEAT commands are available to facilitate the generation of 
repetitive patterns. 

 
Incidences member / element must be defined so that the developed model represents a single 
structure, not two or more separate structures. STAAD is able to automatically detect multiple 
structures. 

 
General Format: 

 
M EMI BER NCIDENCES 
i1, I2, I3, (I4, I5, I6) 
REPEAT n, mi, 
JiREPEAT ALL n, mi, 
Ji 

 
 
 
 
 
 

 
See Section 
1.5.2 

Description 
 
The REPEAT command causes the previous input line is repeated 'n' number of times with 
increases in members and specified together. The REPEAT ALL command functions are similar 
to the REPEAT command only repeating all previously specified entries back to the most 
recent REPEAT ALL command or at the beginning of the specification if no previous REPEAT 
ALL command was issued. (When REPEAT ALL and REPEAT commands are used, members 
must be numbered consecutively). 

 

    i1 = member number to which incidents are maintained. Any whole number (up to six digits) 

are allowed. 
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i2 = number of kickoff meeting. 
i3 = number of end seal. 

 
Note: Use "REPEAT ALL 0" to begin with a set of members to be repeated if 
you do not want to repeat back the last REPEAT ALL. 

 
 

The following data are only used for the generation of membership: 
 

i4 = Second member number which members are generated. i5 = 
Increased number of member for generation. 
i6 = Increase in number of board to be added to the incidents together. (The i5 and 
i6 will default to 1 if omitted.) 
n = The number of times to repeat. 
mi = Increased number of member 
ji = The increase in the number of board 

 

Example 
 

MEMBER INCIDENCES 
1 1 2 
May 2 May 7 
7 11 13 13 2 3 

 
 

In this example, the member of the board 1 is 1 to 2 member 2 is connected between joints 5 to 
7 the number of member 3-5 is created with increased membership number 1 and a number of 
board increased by 1 (default). That is, member 3 goes from 6-8, member 4 7-9, member 5 8 10 
Similarly, in the next line, the Member 9 
will be from 14 to 16, 11 and 13 17 to 19 
20 to 22. 

 

Additional Examples 
 

MEMBER INCIDENCES 
1 January 21 20 
21 21 22 23 
REPEAT 4 3 4 
36 21 25 39 
REPEAT 3 4 4 
REPEAT ALL 20 September 51 

 
 
 

This example creates the 510 members of a structure of ten levels, with clear 3 X 4 (this is a 
continuation of the example started in Section 5.12). The first line of the input creates twenty 
columns on the first floor: 

 
January 1, 21; February 2, 22; March 3, 23; ...; 19 19 39; 20 20 40 
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The two commands (21 21 22 23 4 3 4 and REPEAT) 15 members who are creating the second 
floor, the joists run "floor", for example, in the east-west: 

 
21 21 22; 22 22 23; 23 23 24 
24 25 26; 25 26 27; 26 27 28
... ... ...    
33 37 38; 34 38 39; 35 39 40

 

The next two commands (36 21 25 39 3 4 4 and REPEAT) operate similarly to the previous two 
commands, but here creates the sixteenth floor beam "floor" running in the 
north-south direction: 

 

36 21 25; 37 22 26; 38 23 27; 39 24 28 
40 25 29; 41 26 30; 42 27 31; 43 28 32
... ... ... ...  
48 33 37; 49 34 38; 50 35 39; 51 36 40

 
 

The preceding commands have created a unit floor beams and columns, a total of 51 members. 
The REPEAT ALL this unit now repeated nine times, generating 459 new members and ends 
ten-story structure. The number of members is increased by 51 (the number of members in a 
repeating unit) and the number of the board is increased by 20 (the number of joints in a 
floor). 

 
Note: MEMBER INFO PRINT command can be used to verify the 
impact of the member provided or generated by REPEAT ALL and 
REPEAT commands. Also, use the Post Processor to verify geometry 
graphically 

 
 

5.13 Incidence Element Specification 
 

Purpose 
 

This set of commands is used to specify the ELEMENT defining connectivity between the 
boards. The REPEAT ALL and REPEAT commands are available to facilitate the generation 
of repetitive patterns. 

 
The incidences of the element must be defined so that the developed model represents only 
one structure, not two or more separate structures. STAAD is able to automatically detect 
multiple structures. 

 

Plate / Shell Element Incidences 
 

General Format 
 

ELEMENT  INCIDENCES (SHELL) 
 

i1, I2, I3, I4, (I5),  (TO i6, I7, I8) 
REPEAT  n, andi, Ji 
REPEAT  ALL  n, andi, Ji 
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See Section 
1.6 

Description 
 

SHELL ELEMENT INCIDENCES should be provided immediately after INCIDENCES MEMBER (if 
any) specified. The REPEAT command causes the previous input line is repeated 'n' number of times 
with the increments specified elements and joints. 
The REPEAT ALL command functions are similar to the REPEAT command, except that all 
the "repeats" previously specified above in the input return to more 
Recent REPEAT ALL command was issued. Use "REPEAT ALL 0 0 0" to start a game of 
repeated elements if you do not want to repeat back to last REPEAT ALL. 

 

    i1 = The item number (any number up to six digits). MEMBER INCIDENCE If provided, this 
number should not match any number of MEMBER. 

    i2, ... i5 = The numbering of nodes in the sense of clockwise or clockwise 
opposite clockwise representing connectivity element. Note that i5 is not needed for 
the triangular elements (3 knots). 

 
The following data is required if the elements will be generated: 

 
 

i6 = number of the last element to be generated. 
i7 = Increased number of element that items are generated. The default values are 1 if 
omitted. 

    i8 = Increase in number of board to be added to the incidents together. Values 
default is 1 if omitted. 

 

The following data is required if ALL REPEAT or REPEAT commands are used to generate 
elements: 

 
n = The number of times to repeat. 
ei = Increasing the number of the element. ji 
= Increased number of joint. 

 
Example 

 
ELEMENT 1 
INCIDENCE  1 2
  7  6 
2  3  4  8 
3  8  9  11  10  TO  8 
9  1  3  7  TO  14 

 
 
 

Note: The PRINT ELEMENT INFO command can be used to verify the 
impact of the item provided or generated by REPEAT ALL and REPEAT 
commands. Also, use the Post Processing facility to verify the geometry 
graphically. 

 

 
Trouble Solid Elements 
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General Format 
 

The incidences of the element for solid elements will be identified using the term to 
distinguish SOLID PLATE / SHELL elements. 

 
ELEMENT INCIDENCES SOLID 

 

i1, I2, I3, I4, I5, I6, I7, I8, I9(TO  i10, I11, I12) 
 

REPEAT n, ei, JiREPEAT
  ALL  n, andi, 
Ji 

 

Description 
 

SOLID ELEMENT INCIDENCES should be provided immediately after INCIDENCES 
MEMBER (if any) may be specified as well as following SHELL ELEMENT INCIDENCES (if 
any). 

 
 

i1 = Number of Element 
i2 ... i9 = Numbers board solid element 
i10 = Last number of the element to be generated i11 
= Increasing the number of item 
i12 = Increased number of joint 
n = The number of times the REPEAT will be carried out 
ei = Increasing the number of item 
ji = The increase in the number of board 

 
Specify the four nodes either side of the solid element in the opposite direction clockwise as 
seen from the outside of the element and then goes to the opposite side and the four nodes 
specified that face in the same direction used to specify the nodes of the first side. The opposite 
side must be behind the first side, defined by the right hand rule, ie the points of the other 
side (back) to the first (front) face of which point to the observer. 

 

Use "REPEAT ALL 0" to start a solid game that will be repeated if you do not want to 

repeat back to the last REPEAT ALL. 

Example 
 

INCIDENCE SOLID ELEMENT 
1  1  5  6  2  21  25  26  22  TO  3 
4  21  25  26  22  41  45  46  42  TO  6 

 

 

5.14 Element Mesh Generation 
 

Purpose 
 

This set of commands is used to generate the finite element mesh. The procedure involves the 
definition of super-elements are then divided into smaller elements. 
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Description 
 

This is the second method for generating the element incidents. If the user needs to divide a 
large element in several small items, you can use this option to generate the numbers and the 
coordinates of the board, the number and the impact of the element automatically. The use of 
this feature consists in two parts: 

 
1. The definition of the limit points of super-element: A super-element can be defined either 

for 4 or 8 boundary points (see Figure on next page). A boundary point is denoted by a 
single letter of the alphabet (AZ az upper or lowercase) and their corresponding coordinates. 
Hence, it can be used in any 4 or 8 to 52 characters to define the boundary of the super-
element. If 4 points are used to define the super-element, each side of the super-element is 
assumed that you have a straight edge connecting the 2 points defining that side. When 8 
dots are used, each side is a smooth curve connecting the three points that define that side. 

 

2. The generation of sub-elements: define the use of limit points of the super-element (4 or 8 
as explained above) and specifies the total number of sub-elements required. 

 
General Format: 

 

 
DEFINE  MESH  CYL 

Aixiandizi  (  (Xor, Andor, Zor)) 

. . .  RCYL 
Ajxjandjzj 

 

 
GENERATE  ELEMENT 

(QUADRILATERAL) 

TRIANGLE 

MESH  AiAjN .....1(N2) 

MESH  AmAnN .....3(N4) 
..... ..... 

(Above 20 MESH input lines) 
 

Where 

Ai, Aj = Alphabet letters A - Z or alphabets a - z. This is maximum 52. 
xi, yi, zi = The coordinates for the boundary point Ai. If RCYL CYL or defined, the above 
coordinates will in the cylindrical system of coordinates or reverse. Optional coordinates xo, 
me and zo be the Cartesian coordinates for the origin of the cylindrical coordinates. The values 
will default to 0, 0, 0, if not provided. The 3 fields (x, y, z) can be replaced by a number of 
the board whose coordinates are defined in the JOINT COORDINATE command to the input 

 
Ai JOINT jn instead of: 

 
 

Ai, Aj, Ak ... = A rectangular super-element defined by four or eight breakpoints. 
n1 = The number of elements along the side Ai Aj of the super-elements. (Do not exceed 

20). 
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n2 = number of elements along the side of Aj Ak super-elements. (Do not exceed 20). If 
n2 is omitted, provided only n1, n1 then indicate the total number of elements within 
the super-element. In this case, n1 must be the square of an integer. 

 

Limits 
 

There is a limit of 20 commands Mesh. Up to 523 boards can be generated and up to 700 
elements. The total number of joints in the model after this command is completed can not 
exceed 20,000. 

 

Notes 
 

All coordinates are in the system of the current drive. While using this option the user must 
have the following points: 

 
1) All super-elements must be 4 or 8 knots. The generated elements to 4 knots retain the 

super-elements-straight line on the sides of the super-elements, while joints were 
generated elements 8 knots be super-element in a curved path. 

F 

C 

D E 
G 

 
 

H 
D 

 
 

A 
C 

 
A B B 

 

Mesh generated for a Mesh generated for a 
super-element 4 knots super-element 8 knots 

 
2) Two super-elements, which have a common boundary must have the same number of 

elements along their common boundary. 
 

 
3) The sequence of commands MESH super-elements define the super-elements. The 

sequence of this MESH command must be such that once one is defined, the next 
super-elements must be connected to it. Therefore, for convenience, the first super-
element must be one that is connected to the largest number of super-elements. In the 
example shown here to the tank, the super-element's background is specified first. 

 
4) This command should be used after the MEMBER INCIDENCE and INCIDENCE 

ELEMENT section before MEMBER ELEMENT PROPERTIES and PROPERTIES 
section. Elements that are created internally sequentially with an increment of one that 
starts the last member / element numbered numbered. Similarly additional homegrown 
sequentially together with an increase of one who begins the latest issue of the board 
plus one numbered. It is recommended that users keep the numbering of joints and 
member / element in a sequence with an increment of one starting one. 
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5) If members surrounding a super-element being entangled, users will have to take care of 
the additions / modifications required in section MEMBER INCIDENCE as more new 
gaskets may appear in the existing common boundary as a result of the super-tangle 
element. See the following figure: 

 
A B 

 

       

       

       

       
C 

D 
 

Note: If a member exists between points A and B, you must cut it into 4 parts member. Members are 
not snared automatically. 

 
6) The sub-elements will have the same direction (in the direction of clockwise or counter 

clockwise) as the super-elements. For a super-element bounded by four points A, B, C 
and D, if ABCD, BCDA etc. is in the sense of clockwise direction, or DCBA CBad 
etc. is in reverse clockwise direction smarter. If the super-special element is denoted as 
ABCD, all the sub-elements in it have the sense of clockwise incidence element in this 
example. 

 
7) The incidences of the element of the sub-elements generated can be obtained by 

providing the 'PRINT ELEMENT INFORMATION' command after 'MESH ...' in the 
input file command. 

 

8) If the input file contains commands for STAAD JOINT COORDINATES, MEMBER 
INCIDENCES, ELEMENT MESH GENERATION INCIDENCES and should 
specified in the following order: 

 
 

 
 
 
 
 
 
 
 
 

Example 

STAAD SPACE 
UNIT. . . 
JOINT COORDINATES ... 
MEMBER INCIDENCES ... 
INCIDENCES ... DEFINE 
ELEMENT MESH ... 
GENERATE ELEMENT ... 

 

The following input section illustrates the use of the MESH GENERATION option, the user 
can compare this example with the entries in the geometry of Prob # 10 in the manual for 
examples of STAAD.: 

 

G 

 

F C 

 

B 

 

H 

 

E D 

 

A 
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STAAD SPACE STRUCTURE WITH TANK 

* MESH GENERATION 

UNIT  . . . DEFINE 

MESH 

A 0 0 0; B 0 20 0; C 20 20 0 

D 20 0 0; E 0 0 ‐20; F 0 20 ‐20 

G 20 20 ‐20; H 20 0 ‐20 GENERATE 

ELEMENT 

MESH AEHD 16 

MESH EABF 16 

ADCB MESH 16 

MESH HEFG 16 

MESH DHGC 16 
 
 
 

Typical Generation Foursquare and triangular elements: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Typical generation Typical generation 

Quad elements Triangular elements 
 
 
 

5.15 Redefinition Boards and Numbering 
Members 

 
Purpose 

 

This command can be used to redefine the numbers and BOARD MEMBER. The numbers 
in the BOARD MEMBER and the original are replaced by the new numbers. 

 
General Format: 

 
JOINT XRANGE 

YRANGE f1, F2START i 
SUBST MEMBER ZRANGE 

 

COLUMN 
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Where f1 and f2 are two values in the range of x, y, ozei is the new starting 
number. 

 

Description 
 

Numbers can be redefined board member and STAAD through the use of SUBSTITUTE command. 
After a new set of numbers are assigned, the input and output values agree with the new numbering 
scheme. The user can design numbering schemes that produce a single input specification and the 
easy interpretation of results. For example, all together on the first floor of a building can be 
renumbered as 101, 102 ...., all joints of the second floor can be renumbered as 201, 202 ..... etc. 

 

Example 
 

UNIT METER 
SUBST START JOINT YR 9.99 10.0 101 901 
START SUBST COLUMN 

 

 
The coordinates Y joints ranging from 9.99 to 10 meters will have a new start from number 101 
columns starting with the new number 901 renumbered. 

 

 
Note: The meaning of the re-specification of numbers and BOARD MEMBER can improve significantly 
the interpretation of results. 

This command can be between incidence commands: MEMBER 

INCIDENCE 
SUBSTITUTE 
ELEMENT INCIDENCE 

 

 

5.16 Displaying Boards of
 Members / Elements / Specification for GROUPS 

 

 
This command allows the user to specify a group of joints / members / elements and save the 
information using a 'group-name'. The 'group-name' can be used consecutively in the input 
file instead of a list of boards / members / elements to specify other attributes. This extremely 
useful feature prevents multiple specifications of the same list of board / member. Following 
the general format required for the command GROUP 

 

General Format: 
 

START GRODEF UPInition 
(GEOMETRY) _ (group-name) member / element / solid-list ...... 

(default) OR 
JOINT_ (group-name) joint-list ...... MEMBER_ (group-
name) member-list ...... 



TECHNICAL MANUAL STAAD.Pro 

179

 

 

 

Element_ (group-name) element-list ...... SOLID_ (group-
name) solid element-list ...... 

 
END GROUP DEFINITION 

 
Where, 
group-name = an alphanumeric name specified by the user to identify the group. The group name 

must start with the character '_' (underscore) and is limited to 16 characters. 
member-list = the list of members / elements / solids belonging to the group. TO, BY, ALL, 

BEAM, PLATE, and SOLID allowed. ALL means all members + plates + solids; 
BEAM mean all beams; PLATE all plates; SOLID and all solids. 

joint-list = List together that belong to the group. TO, BY, and ALL are allowed. 
 

Notes 
 

1) The GROUP definition must start with the START GROUP DEFINITION command 
must end with the END command. 

2) More than one GROUP name can be specified within the same definition of the 
specification. 

3) JOINT words, MEMBER, SOLID ELEMENT and may be provided if the user wishes 
to identify the name of the group and lists those specific items. However, the group 
name and the list is merely a means of grouping more than one type of structural 
component under a single title, the word GEOMETRY be provided. In the absence of 
any of those five words (GEOMETRY, JOINT, MEMBER, or SOLID ELEMENT), it is 
assumed that the list is for GEOMETRY. 

4) The same board or member number / element can be included in up to 4 groups. 
Multiple definitions are useful for output but can be ambiguous for data input as 
constants, the property of the section, relaxations, etc. 

5) If two or more groups of consecutive entries with the same name, then they 
will join. If they are not consecutive, the second entry of the same name is ignored. 

 
 
 

Example 
 

START GROUP DEFINITION 
_TRUSS 1 TO 20 25 35 
_BEAM 40 TO 50 
END 
MEMBER PROPERTIES 
_TRUSS TA LD L40304 
ST TA _BEAM W12X26 

 
 

Example 
 

START JOINT GROUP 
DEFINITION 
_TAGA 1 TO 10 
MEMBER 
_TAGB 40 TO 50 
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GEOMETRY 
_TAGC 101 TO 135 
END 

 

MEMBER PROPERTIES 
_TAGB TA LD L40304 
ST TA _TAGC W12X26 

 

 

5.17 Rotating Geometry of Structure 
 

Purpose 
 

This command can be used to rotate the coordinates of the currently defined (and members / 
elements attached) on the global axes joint. 

 
General Format: 

 
  * X d1

PERFORM ROTATION A

n

d

d2

d3

 
Where, d1, d2, d3 are the rotations (in degrees) about the global axes X, Y and Z respectively. 
This command can be entered after or between two Coordinates Joint Command or Joint 
Coordinates after all Trouble Member / Element specified. This command can be used to rotate 
the geometry of the structure (defined a priori to this command) to any desired angle for any 
global axis. The rotated configuration is used for analysis and design. While you are entering 
this command, note the direction of rotation must be under the rule of the right hand. 

 

 
 
 
 
 

Description 
 

This command can be used to rotate the geometry through any desired angle for any global 
axis. The rotated configuration can be used for analysis and design. 

 
Example 

 
ROTATION PERFORM X 20 Z -15 

 
 
 

5.18 Specifying Inactive / Delete 
 

Purpose 
 

This set of commands can be used to temporarily inactivate (inactivate) or permanently 
DELETE (DELETE) the GASKETS or specified MEMBER. 
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General Format: 
 

IN ACTIVE M EMBERS member-list 
 
 
 

THEETE 
M EMBERS JOI-member 

listNTS joint-list 

Description 
 

These commands can be used to specify that certain joints or members are disabled or 
completely nullify a structure. The INACTIVE command causes the temporarily inactive 
members; the user must re-activate them during the later part of the input for further 
processing. The DELETE command to completely void structure members; the user can not 
re-activate them. The Joint Delete command must be immediately after Joint Coordinates. 
Commands member should be provided immediately after all occurrences of the member / 
element are provided. 

 
 

Notes 

 
a) The DELETE command MEMBER void all associated together with automatically 

canceled, provided that the joints are not connected by any other member or members 
active element. 

b) The DELETE MEMBER command also void all together which is not connected to the 
first structure. For example, such boards may have been generated to facilitate the entry 
of coordinates of the board and intended to be overridden. Hence, if a DELETE MEMBER 
command is used, a JOINT DELETE command should not be used. 

c) The DELETE MEMBER command is applicable for clearing members as well as 
elements. If the list of members to be canceled extends beyond one line, should be 
continued on the next line by providing a space followed by a dash (-) at the end of the 
current line. 

 

Example 
 

INACTIVE MEMBERS July 5 TO 10 
DELETE MEMBERS 29 TO 34 43 

 
d) The INACTIVE MEMBER command can not be used in situations where one day 

inactivating member arising that are not connected together in space. 
e) The INACTIVE MEMBER command should not be used if the MEMBER TENSION / 

COMPRESSION command is used. 
f) Inactivated members can be restored for future processes (such as analysis or design for 

a 2nd set of load cases) using the CHANGE command. See Section 5.37 and Example 4 
for more information. 

g) The DELETE MEMBER command must be used to override the elements too. 
Enter the command as DELETE MEMBER j, where j is the number of the item that you 
wish to delete. In the example above, 29 to 34 and 43 are the numbers of the element. 
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h) Charges have been defined as those declared INACTIVE members will not be considered in 
the analysis. This applies to SELFWEIGHT, MEMBER LOADS, LOADS Prestress and 
POSTSTRESS, TEMPERATURE loads, etc. 

i) The JOINT DELETE command must precede commands incidence. 
 
 

5.19 Steel Specification Table User 
 

Purpose 
 

STAAD allows users to create customized tables using steel sections for specifications of property, 
check the Code and Member Selection. This set of commands can be used to create the table (s) 
and provide the necessary data. 

 

General Format: 
 

ST ART USER T ABLE 
T ABLE i1(Fn) 
section-type 
section-name 
property-spec 
END 

 

Where, 
i1 = the number of the table (1-20). During analysis, the data in the table provided for each user are 

stored in a corresponding file with an extension. U01. for example, data table 5a is stored in 
U05. The first part of the name of the input file is the same as in the STAAD input file. These 
files are located in the same active directory the input file. Hence, they can then be used as 
external user input files to other tables. 

fn = name of the external file containing the section type, name and properties 
corresponding (up to 16 characters) 

section-type = name steel sections including: WIDE FLANGE, CHANNEL, ANGLE, ANGLE 
DOUBLE, TEE, PIPE, TUBE, GENERAL, ISECTION & PRISMATIC. 

section-name = Any section name designated by the user, use 1 to 12 characters. 
The first three characters of Pipes and Tubes should be respectively PIP and TUB. Only 
alphanumeric characters and digits defining section names are allowed. (Blank spaces, 
asterisks, question marks, commas, semicolons etc. are not allowed.) 

property-spec = properties for the section. The requirements are different for each type of section 
as follows. Note that the cut areas AY and AZ should be provided to ensure proper cutting 
effort or cutting force calculations during design. They should also be provided SY, SZ, IZ 
and IY for design. 

 
Length units predefined properties are the current units. If in UNIT command is then 
caught by the User table in the file those units become input the current units. However, 
a command UNIT in an external file that only affects file and has no effect on the units 
in the subsequent command input file. The user can specify the unit of desired length 
using the UNIT command as the first command in the table (see example that follows this 
description). 
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WF

   

 
 

If the data is in the input file, then use up to 3 lines of input for each specification property 
(all done with a script, -). If the data is from the external file, then use only one line, but 
can be up to 250 characters long. 

 
Description 

 
The following section types are available under this option. 

 

Wide Flange (Skate Width) 
 

1) AX = Area of cross section 
2) D = Superelevation section 
3) TW = Web thickness 
4) WF = width skate 
5) TF = thickness Skate 
6) IZ = Moment of inertia about the local Z (usually the major axis) 
7) IY = Moment of inertia about local y-axis 
8) IX = Torsional moment of inertia 
9) AY = cutting area in the local y axis. If zero, the shear deformation is ignored in the 

analysis. 
10) AZ = Same as above except the local z axis. 

 

Channel (Canal) 
 

1) AX, 2) D 3) TW, 4) WF 5) TF 6) IZ, 7) IY, 8) IX, 9) CZ, 10) AY, 11) AZ 
And 

CZ 
 
 
 
 
 
 
 
 
 
 

Angle (Angle) 
 

1) D 2) WF, 3) TF, 4) R 5) AY, 6) AZ 
 

R = radius of gyration about the principal axis, shown as r (ZZ) in the AISC manual. There 
should be zero. 

 
Double Angl e (Double Angle) 

 
1) D 2) WF, 3) TF, 4) SP 5) IZ, 6) IY, 7) IX, 8) CY, 9) AY, 10) AZ 

 
And 

 

 
CY 

Z 
 

 
 

SP 
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T (T) 
 

1) AX, 2) D 3) WF 4) TF 5) TW, 6) IZ, 7) IY, 8) IX, 9) CY 10) AY, 11) AZ 
 

And 
CY 

 
 
 
 
 

Z 
 
 
 
 
 

Pip and 
(Tube) 

 

1) OD = Outside 
Diameter 

2) ID = Inside Diameter 
3) AY 4) AZ 5) AX, 6) D 7) WF 8) TF, 9) IZ, 10) IY, 11) IX, 12) AY, 13) 
AZ 

 

Genera
l 

 

The properties of these cross sections should be used for this type section. Note that this option 
allows the user to specify a steel section catalog or unconventional. Provide both parameters Y 
and Z to design or code checking. 

 
1) AX = Area of the cross section. 
2) D = Superelevation 

section. 
3) TD = Thickness associated with the element of the section parallel to the depth 

(usually the soul). to be used to verify the proportion cant / thickness. 
4) B = width of the 

section. 
5) TB = thickness associated with the element of section parallel to skate, to be used to 

verify the ratio of width / thickness. 
6) IZ = Moment of inertia about local z axis. 
7) IY = Moment of inertia about local y-axis. 
8) IX = Torsional moment of inertia. 
9) SZ = Section Modulus around the local z axis. 
10) SY = Section Modulus around the local y axis. 
11) AY = cutting area for cutting parallel to the local y 

axis. 
12) AZ = cutting area for cutting parallel to the local z 

axis. 
13) PZ = Plastic Module around the local z axis. 
14) P = Plastic Module around the local y axis. 
15) HSS = Torsional constant for calculation of lateral torsional buckling. 
16) DEE = The depth of the soul. For the shifts sections, the distance between the bevels 
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must be provided. 
 

Note:  Property  to  be  PZ,  PY, HSS  and DEE  defined  for  the  review  / 
selection code member by plastic theory and limit state based on codes 
(AISC  LRFD,  British,  French,  German  and  Scandinavian  codes).  For 
systems  based  on  allowable  stress  design  (ASD‐AISC,  AASHTO,  and 
NTC) codes should be zero values for these properties. 
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Profile 
I 

 
This type of section may be used to specify a general I-shaped section. The properties required 
of the cross section are listed below. Note that this option can be used to specify the variables 
forms I 

 
1) DWW = Superelevation section at node startup. 
2) TWW = Web thickness. 
3) DWW1 = Superelevation section in the final 

knot. 
4) BFF = Width of top flange. 
5) TFF = Thickness of top flange. 
6) BFF1 = Width of bottom 

flange. 
7) TFF1 = thickness of bottom 

flange. 
8) AYF = cutting area for cutting parallel to the 

Y axis 
9) AZF = cutting area for cutting parallel to the 

Z axis 
10) XIF = Torsional Constant (IX or 

J). 
 

BFF 
 

TFF 
 

 
TWW 

 
DWW 

 

TFF1 
 

 
BFF1 

 
 
 

DWW DWW1 

 
 

Notes: 
 

1) DWW should never be less than DWW1. The user must provide the incidences of the 
member accordingly. 

2) The user is allowed the following to the AYF, AZF and XIF values. 
 

a) If positive values are given, they are used directly by the program. 
b) If zero is supplied, the program calculates the properties using the following 

formula. 
AYF TWW x = D (where D = Superelevation section under 

consideration) AZF = 0.66 ((TFF BFF x) + (x BFF1 TFF1)) 

XIF = 1/3 ((BFF x TFF3) + (DEE TWW3 x) + (x TFF13 BFF1)) 
(Where the soul DEE = Superelevation section) 
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c) If negative values are given, they are applied as factors in the corresponding value (s) 
calculated by the program using the above formula. The factor is always applied provided 
the absolute value, ie if the user provides the value of XIF as -1.3, then the program 
multiplies the value of XIF, calculated by the formula above, by a factor of 1.3. 
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Prismatic 
 

Property specifications for type PRISMATIC section is as follows: 
 

1) AX = Area of cross section 
2) IZ = Moment of inertia about local z axis 
3) IY = Moment of inertia about local y axis 
4) IX = Torsional moment of inertia 
5) AY = cutting area for cutting parallel to the local y axis. 
6) AZ = cutting area for cutting parallel to the local z axis. 
7) YD = depth of section in direction of the local axis. 
8) ZD = depth of section in direction of the local z axis. 

 

Example 
 

START USER TABLE 
TABLE 1 
UNIT. . . 
WIDE FLANGE 
W14X30 
13.84 8.85 6.73 .27 .38 .385 291 19.6 0 0 
W21X50 
14.7 20.83 .38 6.53 .535 984 24.9 1.14 7.92 0 
W14X109 
14.605 32 .525 .86 14.32 7.12 7.52 447 1240 0 
TABLE 2 
UNIT. . . 
ANGLES 
L25255 
2.5 2.5 0.3125 .489 0 0 
L40404 
4. 4. .25 .795 0 0 
END 

 
 

* Note that these section names must be provided in ascending order by weight, since the 
process of selecting the member uses these tables and the iteration starts at the top. The above 
example can also be entered as follows: 

 

START USER TABLE 
TABLE 1 TFILE1 
END TABLE 2 
TFILE2 

 

 
Where are TFILE2 TFILE1 and file names to be created before the STAAD run, and where the 
TFILE1 file will contain the following: 

 

 

UNIT. . . WIDE 
FLANGE 
W14X30 
13.84 8.85 6.73 .27 .38 .385 291 19.6 0 0 
W21X50 
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14.7 20.83 .38 6.53 .535 984 24.9 1.14 7.92 0 
W14X109 
32 14.32 0.525 14.605 1240 .86 447 7.12 7.52 0 

 
 

and TFILE2 file will contain: 
 

UNIT. . . 
ANGLES 
L25255 
2.5 2.5 .3125 .489 0 0 
L40404 
4. 4. .25 .795 0 0 

 
 
 

Notes: Table (s) Steel Provided by the user can be created and maintained 
as  a  separate  file  (s).  The  same  files  can  be  used  for  all models  using 
sections  of  these  tables.  These  files must  reside  in  the  same  directory 
where the input file is located. In each file the first table must contain a 
UNITS command. 

 

 

5.20 Specifying Properties Member 
 

Purpose 
 

This set of commands can be used for specifying properties of the section frame members. 
 

General Format: 
 

AUSCAN 

TRALIANAdia

n EUROpean 

FRENCH 
MEMBER PROPerties INDIAN 

AMEBRI 

RICANTISH 

CHINA 

KORCOL 

EAD 

ALUMINUM 

DUTCH 

SPARUS 

INSIA 

GERMAN 
JAPANESE 
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TABLE spec type-table-name 

(additional-spec) 
member-list PRISMATIC property-spec 

T APERED argument-list 
UPT ABLE i1section-name 

ASSIGN profile-spec 
 
 

The AMERICAN, BRITISH, EUROPEAN options (etc.) will instruct the program to take the 
properties of the steel table appropriately. The default depends on the country of distribution. 

 

Description 
 

This command starts the specification MEMBER PROPERTY. Following are the various 
options available: 

 
a) Steel Specification user tables. (Section 5.20.1) 
b) Specification of prismatic properties. (Section 5.20.2) 
c) Specifying variable section members. (Section 5.20.3) 
d) Specification for steel user tables. (Section 5.20.4) 
e) Specification for assigning profile. (Section 5.20.5) 

 
 

Each specification is described in detail in the following sections. Examples are available in 
Section 5.20.6. 

 
MEMBER PROPERTY command can span multiple lines lines ending with a space and 
hyphen (-). 

 

5.20.1 Specifying Table Properties of Steel 
 

Purpose 
 

The following commands are used to specify the properties of the table section (s) of steel 
catalog. 

 
General Format: 

 
type-spec. table-name additional-spec. 

 

ST 

RA 

D 

LD 

SD 
type-spec = T 

C

m 

TC 

BC 

TB 
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ST section specifies simple standard catalog tables. 
RA specifies single reverse angle YZ axis (see Section 1.5.2). D
 specifies dual channel. 
LD specifies double angle long side, back to back. SD specifies 
double angle short side, back to back. T specifies tee beam section 
cut so I. 
Cm specifies the composite section beams available so I. TC
 beams with specified upper plate covers. 
BC specifies beams with bottom plate covers. 
TB beams specified upper and lower plate covers. 

 
table‐name  =  The  name  of  the  table  section  as W8X18,  C15X33  etc.  The 
documentation steel design codes  for each country  includes  information 
according to your specification steel section. For details on specific tables 
American steel sections, see Section 2.2.1 of this manual. 

 

  * SP f1

  WP f2

  TH f3

  WT f4

additional-spec =   DT f5

    OD f6

    ID f7

    CT f8

    FC f9

 
 
 
 
 

See Section 
1.7.2 

CW f10 
SP f1 = This game describes the space (f1) between angles or angles or double channels 

when channels are used. The f1 is default to 0.0 if not given. 
WP Width = f2 (f2) of the cover plate cover plate if it is used with beam 
section I. TH Thickness = f3 (f3) of rectangular plates or tubes. 
WT f4 = W (f4) of rectangular tubing, where TUBE is the name of the table. 
DT Depth = f5 (f5) of rectangular tubes. 

OD OD = f6 (f6) of tubes, wherein PIPE is the name of the table. 
ID f7 = Inside diameter (f7) tube. 
CT f8 = thickness of the concrete (f8) for composite sections. 
FC f9 = Compressive strength (f9) of concrete for composite sections. CW
 f10 = width of concrete (f10) for composite sections. 

 

Notes 
 

All F1-9 must provide values in current units. Some important points to note in the case of 
the composite section are: 

 
1) The width of the concrete slab (CW) (if not entered) is assumed to be the width of 

the top flange of the steel section + 16 times the thickness of the table. 
2) To calculate the properties of the cross-section, the ratio is calculated assuming 

modular this: 
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D 

   
YD

 
 

 
ES = modulus of elasticity of steel = 29,000 ksi. Ec 
= Modulus of elasticity of concrete = 1802.5 ksi 

 
Where FC (in ksi) defined above. 

 
 

5.20.2 Prism Specification Properties 
 

Purpose 
 

The following to specify the section properties for the prismatic cross sections are used 
commands. 

 
General Format: 

 

For PRISMATIC specification, properties are provided directly (At the end of each line with a 
hyphen "-") as follows: 

 

* AX f1 

IX f2 

IY f3 ZD ZD 

IZ f4 

property-spec = AY f5 

AZ f6 And YB 

YD f7 

ZD f8 

YB f9 ZB ZB 

ZB f10  
T-SECTION KEYSTONE SECTION 

 
 
 
 
 
 
 
 
 

See Section 
1.7.1 

 

AX f1 = Cross-sectional area of the member. 
IX f2 = Torsional moment of inertia. 

IY f3 = Moment of inertia about local y-axis. 
IZ f4 = Moment of inertia about local z axis (usually the largest). AY
 f5 = effective shear area in local y axis. 

AZ f6 = effective shear area in local z axis. 
 

If any of the above 6 parameters is omitted, it is calculated YD, ZD, YB, and / or dimensions 
of ZB. 

 

YD f7 = The depth of the member in the local address. (The diameter of the round 
section members). 

ZD f8 = The depth of the member in the local z direction. If not provided ZD and YD is 
provided, it is assumed that the section is round. 

YB f9 = The depth of the soul to Section T. 
ZB f10 = The width of the web for T section or width below for KEYSTONE section. 
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5.20.2.1 Property Specification Prismatic Tapered Tube 
 

Purpose 
 

The following commands are used to specify the properties of the section to the cross sections 
of prismatic tubes variables. For property types shown below, additional information can be 
obtained from Table 2.1 of the document ASCE 72, 2nd edition. 

 
General Format: 

 
 

 
*ROUND 

HEXDECAGONAL 
property-spec = DODECAGONAL START d1END d2THICK t 

OCTAGONAL 

HEXAGONAL 

SQUARE 
 

START d1 = Depth of section at the beginning of the 
member. END d2 = Depth of section at the end of the 
member. 
THICK t = thickness of the section (constant along the length of the member). 

 
 

ROUND 
And 

SQUARE 
And 

 
 

 
x x 

HEXDECAGONAL (16 
SIDES) Y 

HEX (6 SIDES) AND 

x x 

Dodecagonal (12 SIDES) Octagonal (8 SIDES) 

And And 

x x 
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Example 
 

 
UNIT. . . 
MEMBER PROPERTY 
1 PRIS STA 10 END ROUND 8 THI 0.375 
2 PRIS HDC STA 10 15 END THI 0.375 
3 PRIS DOD STA 12 12 END THI 0.375 

 
 
 

Tapered Prism Forms Tube 
 

 

5.20.3 Specification Tapered Member 
 

Purpose 
 

The following commands are used to specify the properties of the section for forms I variables. 
 

General Format: 
 

List-argument = f1f2f3f4f5(F6f7) 
 

 
 
 
 
 
 
 
 

See Section 
1.7.4 

Where,  
f1 = Depth of section at node startup. f2 = Web 
thickness. 
f3 = The depth of the section at the end node. 
f4 = Width of top flange. 

f5 = Thickness of top flange. 
f6 = Width of bottom flange. Defaults to f4 if it was omitted. f7 = 
Thickness of bottom flange. Defaults to f5 if omitted 

 

Example 
 

MEMBER PROPERTY 
TAPERED 1 TO 5 13.98 13.98 0.285 6.745 6.745 .455 .455 

 
 

Notes: 

 
1. All dimensions (f1, f2, f7 .....) must be in the current units. 
2. f1 (The depth of the section in the start node) must always be greater than f3 (The depth 

of the section in order knot). The user must provide the incidences of the member 
accordingly. 
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5.20.4 Specification of properties from the user steel table 
 

Purpose 
 

The following commands are used to specify the properties of the section of a steel table that 
the user previously created with USER-PROVIDED STEEL TABLE. 

 
General Format: 

 
member-list UPT ABLE I1 section-name 

 
 

UPTABLE to refer to the tables provided by the user. 
 

 
 
 
 

See Section 
1.7.3 

 

i1 = table number as previously specified (1-20) 
section-name = name of the section as specified in the table. (Refer to Section 5.19) 

 

Example 
 

See Section 5.20.6 
 
 

5.20.5 Assign Profile Specification 
 

Purpose 
 

The ASSIGN command can be used to instruct the program to assign a member of the 
framework based on the profile specification shown below a steel section convenient. 

 
General Format: 

 
 

 
 

See Section 
1.7.5 

 
 
 

profile-spec 
= 

BEAM 

COLUMN 

 
CHANnel ANGLE 

(DOUBLE) 
 

Note:  The  sections  are  always  chosen  from  the  relevant  steel  table 
catalog. To find out the details of the sections are selected, the PRINT 
MEMBER  PROPERTIES  commands  must  be  provided  after  the 
specification of all the properties of the member. 

 

5.20.6 Examples of Member Property Specification 
 

This section illustrates the various options available for specification MEMBER PROPERTY 
 

Example 
 

UNIT. . . 
MEMBER PROPERTIES 
TABLE 1 TO 5 ST W8X31 
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.

 

 
 

September 10 TABLE 0.25 SP LD L40304 
12 TO 15 PRISMATIC 10.0 IZ AX 1520.0 
ST RT 17 18 PIPE OD 2.5 ID 1.75 
20 TO 25 AT ST TUBE 8 TH DT 0.5 WT 12 
27 29 32 TO 40 42 PR 5 AX 400 IY IZ 33 - 
YD 9 IX 0.2 ZD 3. 
43 TO 47 UPT one W10X49 
UPT 2 50 51 L40404 
COLUMN ASSIGN 52 TO 55 
56 TA TC W12X26 WP 4.0 TH 0.3  
57 TA CT W14X34 CM 5.0 FC 3.0  

 
 

This example shows each input type member property. The members 1 to 5 are wide skids beams 
I selected from Tables AISC; 9 and 10 are selected double angles tables AISC; 12-15 are binoculars 
members without shear deformation; 17 and 18 are the tube sections; 20 to 25 are of rectangular 
tube sections; 27, 29, 32-40, and 42 are members binoculars shear deformation; 43 to 47 are I-
beams of a wide skids selected user table entry number one; 50 and 51 are simple angles chart 2 
that the user entered; are designated as members 52 to 55 using the ASSIGN COLUMN 
specification. I assigned program table suitable for each member a steel section. 

 

The Member # 56 is a wide-flange covers W12X26 plate with a width of 4.0 units 0.3 units 
higher thickness. The member 57 is a composite section with a concrete slab of thickness of 
5.0 units in the top of a wide-flange W14X34. The 
compressive strength of the concrete in the table is 3.0 Force / 
length2 

 

 
 

5.20.7 Specification curved Member 
 

Purpose 
 

The following commands are used to specify that a member is curved. The curve is a segment 
of a circle arc of length less than 180 degrees. Any no varying cross-section is allowed. 

 

 
 

Signs Convention curved beams 
 

T.I.P. = Tangent Intersection Point 
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General Format: 

M EMBER C 

URVE 

f1 f2 f3 
member-list CURVED ( ZMINUS ) BENDR f8   FLEX f9 

REF f4 f5 f6 
REFJT   f7 

 
 

Where, 
The parameters in parenthesis are curved member by definition parameters in the local 
coordinate system (and orientation of the curve) that are optional. Default value: The local 
coordinate system is one in which a straight member between the two boards and the curve 
are locally in the XZ + Z side. To inhibit the default local system, from 1 to 4 parameter sets: 

 

 

 
See Section 
1.7.4 

 

[The reference point along the two together define a half-plane containing the axis of 
Local and + Z plane of the 
curve.] 

 

f1 f2 f3 = x, y, z global distances from the joint output of the reference point; f4 or 
f5 f6 = x, y, z global coordinates of the reference point; or 
f7 = the number of the board whose global coordinates x, y, z are the point of reference; 
or 

 

ZM = indicates that the local system is the default but that the plane of the curve will be in 
the XZ plane of the local Z-side of a line connecting the 2 together the member. 
 
Other 
parameters: 

 

f8 = the radius of curvature of the centroidal axis of the limb (radius of curvature). See the 
figure. 
f9 = flexibility parameter for the curvatures of the pipes. See notes. 

 
FLEXIBILITY parameter. This only applies to members of curved pipes (elbows) 
and (OD and ID as entered). These members will bend over due to ovalization 
which depends on the internal pressure. The ASME‐Boiler and Pressure Vessel 
Code (Pressure Vessel Code), Section III, NB‐3687.2, 1971 The Class I components 
are used to calculate the reduction factor of flexibility. 

 

    September f9 = 0 is ignored for this calculation will occur 

flexibility increased internal pressure equal to zero. 
    September f9> 0 to specify the internal pressure for use in 

calculating this flexibility. 
The increased pressure reduces flexibility. 

    September f9 = ‐9999 ignore this additional flexibility calculation 

and use only the theory of 
beam. 

    September f9 = reduction factor flexibility (‐ FLEXF below); what 

should be a 
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FLEXIBILITY FACTORS THEORY OF ELBOW PIPE ASME [ASME 
Section NB-3687.2] 
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This section only applies if (Radius Bending / Medium Haul) 1.70 
O 
If (arc length)> (Medium 2 * Radio) 

 
 

FLEXF = (Flexibility Factor) = 

Where 

1.65 * (Mean Radius) 2 

* 
t * (Bend Radius) 1 

1 

(Pr ess) (Mean Radius) (FACT.) 

FACT. 
6 * (MR / t) 4/3 * (BR / MR)1/ 3

 

Et 
 

MR = Mean radius elbow wall BR = 
Bending Radius 
Press = Internal Pressure 
t = Wall thickness of the 
elbow E = Modulus of 
Elasticity 

 

If the calculated Flexibility Factor is less than 1.0, then use 1.0. The Flexibility Factor is multiplied 
directly or contributes more to the conditions of non-cut on the elbow flexibility matrix. 

 
Example 

 
MEMBER PROPERTY 
1 TO 5 CURVED BENDR ZM 10.0 

 

 

Notes
: 

 
1) All dimensions and pressures must be in the current units. 
2) For loads, relaxations, and outputs the local x-axis is tangent to the curve; local z axis is 

radially outside of the curve in the plane of the curve; and the local axis is perpendicular 
to the plane of the curve. 

3) This item is not complete except stiffness, relaxations and displacements. 
Truss, tension / compression, should not be specified. Loads at each end of the member 
based on the distance instead of using beam theory recessed provided. The results of 
section ignore the actual distribution of charge and should be ignored. 

 
 

5.21 Specifying Element Properties 
 

Purpose 
 

This set of commands can be used to specify properties of plate finite elements. 
Unequal members and plate elements / shell not require any property to the solid elements. 
However, as the constant modulus and the Poisson ratio are specified. 

 

General Format: 
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THE EMENT PROPERTY 
 

element-list T HICKNESS f1 (F2, F3, F4) 
 

 

f1 

 

= 
 

Thickness of the element.
f2F ...4 = Thickness of other nodes of the element, if different 

f f

 

 
See Section 
1.6 

 

Description 
 

Elements of uniform or linearly varying thickness can be modeled using this command. Note 
that the thickness value should be provided in the current units. 

 

 
 
 

Example 
 

UNIT. . . 
ELEMENT PROPERTY 
1 TO 14 August 16 TH 0.25 

 
 
 
 

 

5.22 Member / Element Releases 
 

 
STAAD relaxation allows specification of degrees of freedom in the frame members and plate 
elements. Section 5.22.1 describes the options for release of MEMBER and Section 
5.22.2 describes the options ELEMENT release. 

 

 
 
 

5.22.1 Member Specification Release 
 

Purpose 
 

This command set may be used to relax completely specific degrees of freedom for the ends 
of the frame members. Can also be used to describe a mode of attachment where the end of 
the member is connected to the board for specific degrees of freedom by means of springs. 

 

General Format: 
 

M EMBER R ELEases 
 

 
 

START 
* FX 

FY 
* KFX 

KFY 
f1
f2

member-list  
END 

  FZ 

MX 
  KFZ 

KMX

f3 
f4

      M

Y 

  KMY 

KMZ

f5 
f6
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Where to MZ and FX KFX KMZ to represent the strength-x through the degrees of freedom of 
the moment in local z-axis of the member and f1 to f6 are the spring constants for these degrees 
of freedom. If FX is used by MZ means total relaxation for that shallow, and if KFX through 
KMZ are used, means a spring attached. 

 

Example 
 

MEMBER RELEASE 
January 3 September 11 12 TO START MY MZ KFX 1000.0 
January 10, 11 13 to 18 END MZ 200.0 KMX 

 
 

In the above example, for members 1, 3-9, 11 and 12, the moments about the local axes Y and Z 
relaxing together in their home (as specified in INCIDENCES MEMBER). Later, these board 
members to its INITIAL tied along its local axis x through a spring whose stiffness is 1000.0 units 
of force / length. For members 1, 10, 11 and 13-18, the time on the local Z axis is released its final 
meeting. Also, your EXTREME board members are tied on its local axis x through a spring-time 
whose rigidity is 
Force-length / Grades 200.0 units. Note that members 1 and 11 together relaxing on both start 
and end, but not necessarily in the same degrees of freedom. 

 

 
 
 

Partial Moments mind Freed 
 

They can be partially released moments at the end of a member. This can be used to model 
partial embedment connections. The following format can be used to provide partial relaxation 
time. Note that this option is provided in the MEMBER option RELEASE and is added to the 
capabilities of existing RELEASE. 

 

General Format: 
 

M EMBER R ELEASE 
 
 
 
 

member-list 

 
 

START 
* MP f1 

END MPX  f4 
MPY  f5 
MPZ   f6 

 

See Section 
1.8 

Where f1 = relaxation factor for all 3 phases; or enter f4, f5, and / or f6 separately as relaxation 
factors for each time. The timing related to the relative stiffness coefficient is multiplied by a factor 
of (1-f1) to the specified end. 

 
Example 

 
MEMBER RELEASE 
15 25 START TO MP 0.25 
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The RELEASE command above will apply a factor of 0.75 at the time of the shear modulus 
on the START of 15 to 25 members. 

 

 
 

Notes:  It  is  important  to note  that  the  factor  f1  indicates a reduction  in 
stiffness corresponding to the rotational degrees of  freedom of MX, MY 
and MZ. In other words, you should not expect that when the member is 
reduced by a factor of f1. It may be necessary for the user to perform a test 
to  reach  the  correct  value  of  f1  to  produce  the  desired  reduction  in 
moment. 

 
Also, note that the START and END is based on the specification of MEMBER INCIDENCE. 

 

At either end of the member, for any particular a complete or partial relaxation DOF spring 
and can not be applied simultaneously. Allowed only one of the three. 

 

 
If MY (or MZ) completely relaxes at both ends, then VZ (or VY) can not be transmitted to the 
member. The final cuts in the Member shall completely due to loads applied directly to the 
member. 

 
 
 
 

5.22.2 Element Specification Release 
 

Purpose 
 

This set of commands can be used to relax specific degrees of freedom at the corners of plates 
of finite elements. 

 
General Format: 

 
THE EMENT RELEASE 

 

    * FX
J1 FY

element-list J2 FZ
  J3 MX
  J4 MY
      MZ

 

See Section 
1.8 

 
Keywords where J1, J2, J3 and J4 mean joints in the order of specifying the effect of the term. 
For example, if the impact element 76 63 and 35 42 were defined, representing 35 J1, J2 represents 
42, 76 represents J3 and J4 represents 63 Please note that relaxation of the element of the multiple 
joints can not be specified in a single line. Those must be specified separately as shown below. 

 
FX through MZ represents forces / moments to be relaxed by the local axis system. 

 

Example 
 
Proper Use Misuse 

 

10 ELEMENT TO 
RELEASE MY MX 50 
J1 

ELEMENT TO 
RELEASE 10 50 J1 J2 
MX MY 
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10 TO 50 MY MX J2 
MY 10 TO 50 J3 
MY 10 TO 50 J4 

10 TO 50 MY J3 J4 

 

Notes: 
 

 
1. All relaxations are in the local axis system. Generally, not above relaxation. The item 

must still behave like a plate after relaxations. 
2. Selfweight is applied to each of the nodes as if there were no relaxation. 
3. Thermal stresses will include pre-built strain at the end as if there was no relaxation. 
4. Can not be used with Plane Stress Element or Element Ignore inplane commands 

Rotation in the same element. 
5. Note that the usual definitions of Mx and My local is reversed here. 
6. Relaxing Fz, Mx, My relax all bendability. Relaxing Fx, Fy, Mz relax all the rigidity in 

the plane. 
 

 
 
 

5.23 Specifying Member Truss / Cable / Tension / 
Compression 

 

A member can have one of the following specifications: MEMBER 

TRUSS 
TENSION MEMBER 
COMPRESSION MEMBER 
MEMBER RELEASES 

 

If the same member multiple specifications are applied, use only the last entry (Warnings are 
printed). 

 
TRUSS MEMBER, MEMBER TENSION, COMPRESSION MEMBER and MEMBER WIRE are 
only axial rigidity. 

 

LEAD MEMBER are special members-armor type can also be specified as-voltage only. 
 

Sections 5.23.1 to 5.23.3 describe these specifications. 
 
 

5.23.1 Specifying Member Truss 
 

Purpose 
 

This command can be used to model a specified set of members as members TRUSS. 
 

Description 
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This specification can be used to specify the type members PLANE TRUSS structures, or 
FLOOR SPACE. The TRUSS members are able to withstand axial forces only. Upwind type 
Typically, members or SPACE PLANE frameworks of this nature will. 

 

General Format: 
 

M EMBER T RUSS 
 

member-list T INSION f1 
 
 

Where f1 = Optional Initial Voltage type truss members (in current units) 
 
 

 
See 
Sections 
1.9 and 
1.10 

 

Note that this command is superfluous when TRUSS structure type is already specified. 
 

Example 

 

MEMB TRUSS 
1 to 8 10 12 14 15 

 
 

Note:  TRUSS  member  has  only  one  degree  of  freedom,  the  axial 
deformation. It is equivalent to a frame member with the time relaxed 
on both ends. Also note that Member Releases not allowed. Selfweight 
and transverse loads can induce distributions cutting / time member. 

 

5.23.2 Cable Specification Member 
 

Purpose 
 

This command can be used to model a specific set of members as LEAD members. 
 

Use in all analyzes described except Nonlinear Analysis of Cable: 
The WIRE members besides the elastic axial deformation, are also capable of 
accommodate the stiffening effect of initial tension and stress due to static charge. LEAD 
members Theoretical discussions are presented in Section 1.11 of this manual. 

 
General Format: 

 
M EMBER C ABLE 

 
 

 
See 
Sections 
1.9, 1.11. 

member-list T INSION f1 

 
Where f1 = initial voltage on the wire member (in current units) 

 

Example 
 

MEMB WIRE 
TENSION 20 TO 25 15.5 
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Notes: TENSION WIRE specified in the member is applied to the structure 
as well as external load is used to modify the stiffness of the member. See 
Section 1.11 for details. If TENSION or a minimum voltage value is omitted 
it will be used. 

 

This is a truss member but not a member-only voltage unless you also include this member in 
input TENSION MEMBER. See section 5.23.3. Also note that Member Releases not allowed. 

 
The preload tension is not the last cable tension after deformation due to preload it. 

 
The description for use in the Nonlinear Analysis of Cable: 

 
The WIRE members besides the elastic axial deformation, are also able to accommodate large 
displacements. 

 
General Format: 

 
M EMBER C ABLE 

 

 
 
 

 
See 
Sections 

 

 
 
 
 
 
Where 

member-list T INSION f1 
--- OR --- 
member-list L INGTH f2 

1.9, and 
1.11. 

f1 = Initial voltage wire members (in current units) f2 = 
unstressed length of cable (in current units) 

 

Example 
 

MEMB WIRE 
TENSION 20 TO 25 15.5 

 
 

Note: TENSION WIRE specified in the member is applied to the structure 
as  an  external  load  as well  as modify  the  stiffness of  the member.  See 
Section  1.11  for details. The voltage  is used  to determine  the unstressed 
length. That length is shorter than the distance between the joints for the 
distance that the tension stress the cable. 

 
 

5.23.3 Member Specification Tension / Compression 
 
 
 
 
 
 

See Section 
1.9 

Purpose 
 

This command can be used to designate certain members as members tension-only or 
compression-only. 

 
General Format: 

 
M EMBER T INSION 
member - list 
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M EMBER COMPRESSURE 
member - list 

 
Description 

 
Members only are truss-voltage cable / members are only able to withstand tensile forces. Thus, 
they become inactive for cases automatically creating compressive load on them. 

 
LINEAR ANALYSIS TENSION  / COMPRESSION: Compression‐only members 
are truss members that are capable of supporting only compression forces. 
Thus, they become inactive for automatically loading conditions that create 
stress on them. Note that Member Releases are not allowed. The procedure 
for  the  analysis  of  tension‐only  members  or  only‐Compression  requires 
iterations for each load case and therefore are quite involved. The user may 
also  consider  using  the  INACTIVE  time  spec  if  the  solution  becomes 
unacceptably high. It is important to recognize that the input data should be 
provided so that only one instance of the primary load is maintained in each 
PERFORM ANALYSIS. The SET and CHANGE commands NL also be used  to 
carry STAAD to multiple analyzes and structural conditions are involved. 

 
NO‐LINEAR ANALYSIS LEAD: cables are automatically assumed to be only 
voltage (except only will always selfweight) without this command. They 
can only  trusses preloaded as  specified by  this  command only  tension, 
moreover these trusses can take compression too. In this type of analysis, 
trusses without bias are assumed to be linear tension members carrying 
compression regardless of this command. 

 

Example 
 

TENSION 
MEMBER TO 25 30 
35 36 

 

 
Example 

 
MEMBER COMPRESSION 
43 57 98 102 145 

 

 
Example 

 
MEMBER TO 
TENSION 
December 17 19 
37 65 
COMPRESSION MEMBER 
May 13 46 TO 53 87 

 

 
Notes LINEAR ANALYSIS TENSION / COMPRESSION: 

 
1) Loads that are defined in the declared MEMBER MEMBER TENSION COMPRESSION 

members or even be active when the member becomes INACTIVE during the analysis 
process. This applies to SELFWEIGHT, MEMBER LOADS, LOADS Prestress & 
POSTSTRESS, TEMPERATURE LOAD, etc ,. 

2) A TENSION declared as a member or member only COMPRESSION, bear only axial 
forces. It will not take moments or shear forces. In other words, it is a truss member. 
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3) They should specify the MEMBER TENSION and COMPRESSION MEMBER 
command if the command is specified INACTIVE MEMBER. The following is the 
general sequence of commands in the input file or if the MEMBER TENSION 
COMPRESSION MEMBER commands are used. This example is for the MEMBER 
TENSION command. Similar rules apply for the MEMBER COMPRESSION 
command. Dots indicate other items of input data. 

 

STAAD ... 
UNITS 
SET NL ... 
... 
JOINT COORDINATES 
... 
MEMBER 
INCIDENCES 
... 
ELEMENT INCIDENCES 
... 
CONSTANTS 
... 
MEMBER 
PROPERTY 
... 
ELEMENT PROPERTY 
SUPPORTS 
... 
... 
TENSION 
MEMBER 
LOAD 1 
... 
... 
PERFORM ANALYSIS 
CHANGE 
TENSION 
MEMBER 
LOAD 2 
... 
... 
PERFORM ANALYSIS 
CHANGE 
TENSION 
MEMBER 
LOAD 3 
... 
... 
PERFORM ANALYSIS 
CHANGE 

 

TENSION MEMBER 
LOAD 4 
... 
... 
PERFORM ANALYSIS 
CHANGE 
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TENSION MEMBER 
5 LOAD 
... 
... 
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LOAD COMBINATION 6 
... 
LOAD COMBINATION July 
... 
PERFORM ANALYSIS 
CHANGE 
LOAD LIST ALL 
PRINT ... 
PRINT 
PARAMETER ... 
... 
CODE CHECK MEMBER 
... SELECT ... FINISH 

 

 

a) See Section 5.5 for explanation of the SET NL command. The number following this 
command is the total number of primary load cases in the file. 

 

 
b) STAAD automatically above 10 iterations, stopping if converged. If not converged, a 

warning message will be output. Between SET ITERLIM i (i> 10) command before the 
first load case to increase the default number of iterations. Since the convergence may 
not be possible using this procedure, do not put the limit too high. 

 
c) The principle used in the analysis is the following. 

 

The program reads the list of members declared TENSION MEMBER and / or 
COMPRESSION. 
The analysis was performed for the whole structure and member forces are 
calculated. 
For declared MEMBER TENSION / COMPRESSION members the program checks 
the axial force and forces determine whether tension or compression. If the member 
can not take that one load, the member is "off" of the structure. 
The analysis was performed without shutdowns new members. 
Top 10 iterations of the above steps are done for each PERFORM ANALYSIS 
command. 
This method does not always converge and can be unstable. Check output for 
messages of instability. Do not use the results if it is unstable. 

 
d) In the example shown, only if specified for LOAD ANALYSIS. This is because a 

member who is under stress for a load case may be in for another compression load 
case. The stiffness matrix for analysis can answer the structural condition of one of 
these two cases of load. 

 
e) Note that the MEMBER TENSION / COMPRESSION command can be provided and 

its membership after each (except the last) of the CHANGE command. If entered, the 
new MEMBER TENSION / COMPRESSION supersedes all previous commands. This 
is because every CHANGE command means that the forelimbs in TENSION / 
COMPRESSION command is active all over again. If these commands do not come 
after a CHANGE, then the above commands will still apply. 
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f) The TENSION MEMBER command should not be used if the following load cases are 
present: load case Response Spectrum, Time History load case, load case UBC, Moving 
load case. If used, MEMBER TENSION / COMPRESSION will be ignored in all load 
cases. 

 

5.23.4 Specification Spring Tension / Compression 
 

Purpose 
 

This command can be used to designate certain media such as springs or tension springs only-
only-compression springs. 

 
General Format: 

 
SPRING T ONSION 
joint - list spring-spec 

 
SPRING COMPRESSURE 
joint - list spring-spec 

 
* KFX 

spring-spec = KFY 
KFZ 

 
Description 

 

Voltage-only springs are only able to withstand tensile forces. Thus, they become inactive for 
cases automatically creating compressive load on them. Only- Compression springs are only able 
to withstand the compression forces. Thus, they become inactive for automatically loading 
conditions that create stress on them. 

 

See Section 
1.10 

 
If no specification spring then enters all translational spring at that meeting will be only tension 
(or compression). This command does not create a spring entry only if there is a support spring 
then the board at the address specified voltage will also be only (or compression). See Section 
5.27.1 to 5.27.4 to define springs. 

 

The procedure for the analysis of tension-only springs or compression only requires iterations 
for each load case and therefore are really involved. 

 

 
It is very important to recognize that the input data must be provided so that only one case of 
primary load is maintained for each PERFORM ANALYSIS command. The SET and CHANGE 
commands NL also be used to carry STAAD to multiple analyzes and multiple structural 
conditions are grouped. 

 

Example 
 

SPRING TENSION 
December 17 19 TO 
37 65 
COMPRESSION 
SPRING May 13 46 TO 
53 87 KFY 
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Notes 
 

1. A spring-declared only TENSION-COMPRESSION or just take only axial forces. It 
will not take the time. 

2. The SPRING TENSION / COMPRESSION command should not be specified if the 
command specified INACTIVE MEMBER. 

3. The following is the general sequence of commands in the input file if 
COMPRESSION SPRING TENSION or commands are used. This example is for the 
SPRING TENSION command. Similar rules apply for the SPRING COMPRESSION 
command. Dots indicate other items of input data. 

 
 

STAAD ... 
UNITS 
SET NL 
... ... 
JOINT COORDINATES 
... 
MEMBER 
INCIDENCES 
... 
ELEMENT INCIDENCES 
... 
CONSTANTS 
... 
MEMBER 
PROPERTY 
... 
ELEMENT PROPERTY 
SUPPORTS 
... 
... 
SPRING TENSION 
LOAD 1 
... 
... 
PERFORM ANALYSIS 
CHANGE 
SPRING TENSION 
LOAD 2 
... 
... 
PERFORM ANALYSIS 
CHANGE 
SPRING TENSION 
LOAD 3 
... 
... 
PERFORM ANALYSIS 
CHANGE 
SPRING TENSION 
LOAD 4 
... 
... 
PERFORM ANALYSIS 
CHANGE 
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SPRING TENSION 
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5 LOAD 
... 
... 
LOAD COMBINATION 6 
... 
LOAD COMBINATION July 
... 
PERFORM ANALYSIS 

 

CHANGE 
LOAD LIST ALL 
PRINT ... 
PRINT ... 
PARAMETER 
... 
CODE CHECK 
MEMBER ... SELECT 
... FINISH 

 

 

a) See Section 5.5 for explanation of the SET NL command. The number following this 
command is the total number of primary load cases in the file. 

 

 
b) STAAD automatically above 10 iterations, stopping if converged. If not converged, the 

warning message will be output. Between SET ITERLIM i (i> 10) command before the 
first load case to increase the default number of iterations. Convergence may not be 
possible using this procedure, do not put the limit too high. If not converged, a message 
will be output. 

 
c) The principle used in the analysis is the following. 

 

The program reads the list of declared SPRING TENSION springs and / or 
COMPRESSION. 

 
 

The analysis is performed for the whole structure and spring forces are calculated. 
 
 

For springs declared SPRING TENSION / COMPRESSION, the program checks 
the axial force to determine whether tension or compression. Positive displacement 
is STRESS. If the spring load can not make that, the spring is "off" of the structure. 

 
 

The analysis was performed without the springs back off. 
 

Top 10 iterations of the above steps are done for each PERFORM ANALYSIS 
command. 

 
 

This method does not always converge and can be unstable. Check output for 
messages of instability. Do not use the results if it is unstable. You may need to 
include some support in each global address that is not tension (or compression) 
only to be stable in each iteration. 
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d) In the example shown, only if specified for LOAD ANALYSIS. This is because a 
tension spring that is under load to a case the compression may be another case of 
load. The stiffness matrix for analysis can answer the structural condition of only one 
of these two cases of load. 

 
e) Note that the SPRING TENSION / COMPRESSION command can be provided and 

list together after each (except the last) of the CHANGE command. If he came, new 
commands SPRING SPRING supersede all previous commands. This is because, each 
CHANGE command means that springs above a voltage / COMPRESSION back 
command are all active. If not entered after a CHANGE, then the definitions of the 
above springs are used. 

 
f) SPRING TENSION The command should not be used if the following load cases are 

present: load case Response Spectrum, Time History load case, load case UBC, Moving 
load case. If used, SPRING TENSION / COMPRESSION are ignored all load cases. 

 

 
 
 
 

5.24 Specifications Plane Stress Element Rotation 
and inplane 

 
Purpose 

 
These commands allow the user to model the following conditions in the plate elements 

 
a) Condition PLANE STRESS 
b) Rotational stiffness reformulated plane to be rigid or zero. 

 

General Format: 
 

PL AST NE RESS 
THE EMENT RIGID (IN PLANE R OTATION) 

IGNORE (IN PLANE R OTATION) 
element-list 

 
 
 

See Section 
1.6 

Description 
 

The PLANE STRESS specification allows the user to model elements selected for actions only 
in the plane [No bending stiffness or cross section]. 

 

 
The inplane RIGID ROTATION command causes the program to turn the corner on Mz "flat 
rotation" action in the other corner stiffens Mz rotations. The formulation of plate elements 
Staad normally produces a very smooth stiffness Mz involving shear deformation in the plane. 
However when Mz board is connected to a beam with bending moment as the only way of 
charging for that time, then the inplane RIGID option can be used to move the element that 
moment Mz rigidly to another ring to prevent instability end of the beam. Usually only items 
attached to beams in this way would this specification. 
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The IGNORE inplane ROTATION command causes the program to ignore the actions "of 
rotation in the plane." The formulation of the plate element STAAD normally include this 
important action automatically. However, it may be noted that some formulations ignore this 
action element default. The user can use this option to compare the results of STAAD with 
solutions of these programs. 

 

These options are unique to us and also the relaxation of the element. Not a single element 
can have more than one of these options. 

 
Example 

 

PLANE STRESS ELEMENT 
1 TO 15 October 20 25 35 
ELEMENT IGNORE 
30 50 TO 55 

 
 
 
 

 

5.25 Member Offset Specification 
 

Purpose 
 

This command can be used for a rigid frame member offset from end to model mismatch 
condition exists at the ends of the frame members. 

 
General Format: 

 
M EMBER OFFSETS 

START 
member-list  (LOCAL) f1, F2, 

F3END 
 

Description 
 

See 
Section 
1.12 

 
f1, f2, f3 and correspond to the distance measured in the global coordinate system, or Located 
board (START or END as specified) to the centroid of the start or end point of the listed 
members. The MEMBER OFFSET command can be used for any member whose start or end 
points are not coexisting with the incident given board. This command allows the user to 
answer the secondary forces which are induced due to the eccentricity of the member. Offsets 
can be specified in any of the Member 
address, including the address can match the x axis of the member. WP in the diagram 
refers to the situation of the centroid of the start point or end of the 
member. 
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7 ' 
6 ' 

 
 
 
 

9 ' 
 

 
 
 
 
 
 
 
 
 

LOCAL is an optional parameter, if not put it in the f1, f2, f3 is then assumed to be global. 
LOCAL means that the distances f1, f2, f3, are in the same coordinate system that would result 
if the member was not offset member and BETA = 0.0. 

 
 

Example 
 

MEMBER OFFSET 
1 START 7.0 
0.0 -6.0 1 END 
-6.0 -9.0 2 END 

 
 
 

Notes
: 

 
1) If a MEMBER LOAD (see specification MEMBER LOAD) is applied to an individual 

for which the MEMBER OFFSETS specified, the location of the load does not measure 
the coordinates of the kickoff meeting. Instead, it is measured from the offset location 
of the kickoff meeting. 

2) START and END is based on user specification MEMBER INCIDENCE for particular 
member. 

 
 

5.26 Specification and Mapping Constants 
 

 
 

The material constants are attributes such as modulus of elasticity and density required for 
operations like generating the stiffness matrix, compute themselves and for the design of steel 
and concrete weights. 

 
In STAAD, there are two ways in which this data can be specified: 
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a) A two step process involving: 
 

1. Creating material data by defining MATERIAL labels specified in section 
DEFINE MATERIAL (see "5.26.1 define Material") 

 
2. Assigning them to individual members, plates and solid under the title 

CONSTANTS (see "Specifying constants for the member and Elements") 
This creates commands as shown below: 

 
 

 
 

b) Assign material attributes explicitly specifying individual constants (see "Specifying 
constants for the members and elements"). 

 

 
 

 
5.26.1 Definition of Material Constants 

 
Purpose 

 
This command can be used to specify the properties of materials by the name of the material. 
Then assign members to these names and items of material in the CONSTANTS command. 

 

General Format: 
 

DEFINE MATERIAL 
 

ISOTROPIC name 
 

E 

G 
POISSON 
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DENSITY
 f1
ALPHe 
DAMPING 
CDAMP 

 
 

ISOTROPIC Repeat the name and values for many materials desired then: 
 

END MATERIAL (DEFInition) 
 
 

    Name: name of item (name up to 16 characters). 
 

    E: Young's modulus specified. 
 

    G: specifies the module Court. Only for beams between when the 
Poisson's ratio is not of 0.01 to 0.499. 

 

    POISSON Specifies the Poisson ratio. If G is not entered, then this value 
is used to calculate the Court module (G = 0.5xE / (1 + POISSON)). Must 
be from .01 to .499. 

 

    DENSITY: specifies the weight density. 
 

    ALPHA: Coefficient of thermal expansion. 
 

    DAMPING or CDAMP: damping ratio to be used in calculating modal 
damping method for damping compound. 

 

    f1: the value of the corresponding constants. For E, G, POISSON, 

DENSITY, ALPHA and damping. 
 

5.26.2 Specifying Constants 
 

Purpose 
 

This command can be used to specify the properties of materials (and Section Modulus, Poisson's 
ratio, density, linear expansion coefficient, and damping material) of the members and elements. In 
addition, this command also 
can be used to specify the orientation of the member (BETA angle or point of reference). 

 

General Format: 
 

WITHStants 
 

MATERIAL name MEMBER memb / elem-list 
(ALL ) 

 

Where name is the name of the material as specified in the DEFINE MATERIAL command (see 
section 5.26.1). 

 
No use with the previous post below. Use a separate command CONSTANTS. 
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E 

G 

   
 

MEMBER memb / elem-list

POISSON    

DENSITY 
 

BETA 
f1 BEAP

LA 

ALPIt 
has 
CDAM

  SOLID 
(ALL ) 

 

REF  f2, F3, F4 MEMBER memb / elem-list 

REFJT  f5 
 

Specification List: MEM, BEA, PLA, SOL, ALL. MEM only be followed by a list. Blanks mean 
ALL. ALL means all members and elements; BEA means all members; PLA, all plates; SOL, 
all solids. 

 

 
See 
Sections 
1.5.3 and 

1.13 

    E‐Specifies the Young's module. This value must be provided before POISSON for 
each member / element in the list of Constants. 

 

    G: specifies the module Court. Among beams only when non‐
Poisson 0.01 to 0.499. 

 

    POISSON Specifies Poisson's ratio. If G is not entered, then this value 
is used to calculate the Cutter Module (G = 0.5xE / (1 + POISSON)). 
Must be from .01 to .499. 

 

    DENSITY: specific gravity weight. 
 

    ALPHA: Coefficient of thermal expansion. 
 

    CDAMP: damping ratio to be used in calculating modal damping 
method for damping compound. 

 

    BETA: Specifies the rotation angle in degrees of the member (see 
Section 2). 

 
 
 

Note: single angle sections are oriented by default according to their 
main axes. If necessary, thereby orienting the sides are parallel to the 
overall  axis  BETA  specification  must  be  used.  STAAD  offers  the 
following additional specifications for this purpose: 

 
 

BETA BETA 
ANGLE Rangle 

 

 
The above two options will produce an orientation with sides parallel to the global axis. The 
'ANGLE' option section rotates through the angle (90 - "alpha") (where "alpha" = the angle 
between the principal axis system and the global axis system). [Please check the figures on the 
next page.] The 'Rangle' option section rotates through an angle equal to (180 - "alpha"). Both 
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choices will work the same way for the same angles. For unequal angles, the correct option 
should be used based on the required orientation. 
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Orientation of a column (vertical member) Corresponding to BETA = ANGLE 
Local and Global X Y come out of the paper (Local Global X is parallel to Y) 

 
Orientation of a column (vertical member) Corresponding to BETA = 0; 

Local and Global X Y come out of the paper (Local Global X is parallel to Y) 

 
 
 
 
 
 

 
Local Y 

 

Global X 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Local as well as Global Z Z 

 

Orientation of a column (vertical element) for BETA = 0; Local X axis and Y Global 
depart from "paper" (Local X axis is parallel to the Y axis 
Global) 

 
 
 
 
 
 
 
 
 

Global X 
 

 
 
 
 
 

Local Y 
 
 
 
 

Global Z  
Local Z 

 

Orientation of one column (Item vertical) corresponding
 BETA = ANGLE; Local X axis and Y Global depart from "paper" 
(Local X axis is 
Global parallel to the Y axis) 
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The value f1 corresponding constants. For E, G, POISSON, DENSITY, and ALFA CDAMP, 
names can be entered in the material incorporated in place of f1. The names included are STEEL, 
ALUMINUM and CONCRETE. Appropriate values are assigned automatically (in units of the 
ALPHA degrees F) for catalog names. 

 

CONSTANT FPS units
Constants Steel Concrete Aluminum Units

E (US) 29000 3150 10000 Kip / in2
 

Poisson 0.30 .17 .33
Density 000,283 .0000868 000,098 Kip / in3

 

Alpha 6.5e-6 5.5e-6 12.8E-6 L / L / deg-
CDAMP .03 .05 .03 Ratio 

E (nonus) 29732.736 Kip / in2
 

CONSTANT in MKS units
Constants Steel Concrete Aluminum Units

E (US) 199,947,960 21718455 68947573 kN / m2
 

Poisson 0.30 .17 .33
Density 76,819 541 612 23.561 26,601 820 kN / m3

 

Alpha 6.5e-6 5.5e-6 12.8E-6 L / L / deg-
CDAMP .03 .05 .03 Ratio 
E (non-US) 205,000,000 kN / m2

 
 

E (US) is used if the codes are installed US or "Member Properties American" is specified 
for analysis; otherwise E (non-US) is used. 

 

f2, f3, f4 Global coordinates X, Y and Z for the benchmark or 
f5 f5 use location point to the reference point, for which the angle BETA will be calculated by 
STAAD (see Section 1.5.3). 

 

Example 
 

DEFINE MATERIAL 
ISOTROPIC CFSTEEL 
E 28000. 
POISSON 
DENSITY 0.25 
0.3E-3 ALPHA 
DAMP 0.075 
11.7E-6 END 
MATERIAL 

 

CONSTANTS 
MATERIAL CFSTEEL MEMB 1 TO 5 

 

ALL 
CONSTANTS 
E 2.1E5 
45.0 BETA MEMB May 7 DENSITY 
TO 18 TO 29 14 STEEL MEMB 
BETA 90 X MEMB 

 
 

Note that the last command in the above example will BETA as 90 ° for all members parallel 
to the axis X. 
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Notes
: 

 
1) The value for E must always be first in the list of constants for each member / element. 
2) Should be provided all numeric values in current units. 
It is not necessary or possible to specify temperature units or ALPHA. The user must 

ensure that the value provided is consistent ALPHA thus refers to units with the value 
provided for the temperature (see Section 5.32.6). 

If POISSON RATIO is not specified, STAAD assume Poisson's ratio based on 
the elastic modulus, E. 

 

 
 
 

5.26.3 Modal Damping Information 
 

Purpose 
 

 
Define the only modal damping ratios for each mode. If all modes with the same buffer, then 
buffer between the Define Time History Load command or Dynamic Loading. 

 
The damping here can be entered explicitly for some or all modes; EVALUATE STAAD or 
specifying that each mode based on buffer mode frequency and the minimum and maximum 
damping in here. The formula used for evaluating the buffer is given below. 

 

The damping entered will be used in the time history load cases; and where Spectrum Response 
Charging using methods CQC / ASCE4 and / or spectra vs. Period curves against damping. 

 
General Syntax 

 
DEFINE DAMPING INFOrmation 

 

EVALuate dmin (dmax) 
 

 
EXPLICIT d1 (d2 d3 d4 d5 ...). 

 
END 

 
1. Between dmin and dmax and the minimum and maximum ratio of buffer to be used 

in the formula below, respectively, or 
2. Alternatively among d1, d2, d3, etc. as damping ratios for each mode. With each 

EXPLICIT option value can be preceded by a repeat factor (rf * damp) without the 
spaces. 

 
For example: EXPLICIT 7 * 0.05 0.04 0.03 <= buffer mode 1 is 0.03, modes 2-8 are 0.05, 
Mode 9 is 0.04. If there are fewer entries modes, then the damping which came last apply 
to other modes. This entry may be continued to 10 input lines with word EXPLICIT more 
only 
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line 1; end all lines but the last time with a space and a hyphen. There may be 
additional sets of lines before EXPLICIT PURPOSE. 

 

 
Damping ratios can be used in the range of 0.0 to 1.0. 

 
The formula used to EVALUATE (to evaluate the modal damping frequency) is: Damping 

for the first 2 modes is placed at the entrance to dmin. Damping modes for i = 3 
to N given dmin and the first two frequencies 1 and 2 and the nth frequency 
modal i. 

A1= Dmin / (  1+2) A0= 
A1*1*2 

D (i) = (A0 / i) + (A1 * i) buffer for modes 3 and i = N. 
 

If the resulting buffer is greater than the maximum value dmax quenching, dmax then be used. 
 

 
Example: (for dmin = 0.02, 0.12 and dmax = i given below) 

 

Mode  
i damping ratio

1 3 0.0200
2 4 0.0200
3 6 0.0228568
N 100 0.1200

 
(Calculated as 0.28605 then reset to the maximum input) 

 
 
 

5.27 Supports Specifications 
 
 

Specifications Staad support may be parallel or inclined to the global axes. The specification of 
a global axes parallel support is described in Section 5.27.1. Slants specification described in 
Section 5.27.2. 

 
 

5.27.1 Specifying Global Support 
 

Purpose 
 

This set of commands can be used to specify conditions SUPPORT for global axes parallel to 
the supports. 

 
General Format: 

 
SUPPORTS 

 
 
 

joint-
list 

PINNED 
 

 
FIXED (BUT release-spec [spring-spec.]) 
ENFORCED (BUT release-spec) 
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* FX 

FY 

FZ 
release-spec = MX 

MY 
MZ 

 

* KFX f1 

KFY f2 

KFZ f3 

spring-spec = KMX f4 

KMY f5 

KMZ f6 
 
 

 
 
 
 
 

See Section 
1.14 

Pinned and Fixed description 
 
The PINNED support is a support having translational constraint, but no rotating. In other 
words, the support does not have capacity to bear now. A FIXED support has translational 
and rotational constraints. FIXED support can relax in the global addresses as described in the 
specification-relaxation (FX to force X through Z MZ to time). Also, a recessed support may 
have spring constants as described in the specification-spring (the spring in the global 
translational axis X and through the rotary KFX spring in the global Z and KMZ). 

 
The corresponding spring constants are f1 to f6. Note that the rotational spring constants are 
always in degrees of rotation. All six relaxations can be provided as may be required to use the 
CHANGE command. If both the specifications of relaxation and spring specifications will be 
provided for the same joint support, relaxing specifications must come first. 

 

Example 
 

SUPPORTS 
1 TO 4 July PINNED 
June 5 FIXED BUT FX MZ 
September 8 FIXED BUT MZ 50.0 KFY KFX 75. 
18 21 FIXED 
27 FIXED BUT KFY 125.0 

 

 
In this example, the joints 1-4 and 7 are articulated joint. No moment is supported by those 
media. The seals 5 and 6 are fixed for the entire except DOF force in X and time 
Z. The gaskets 8 and 9 are fixed to all the DOF except when Z and has springs respectively 
in the X and Y global address with the corresponding spring constants of 50 and 75 units. 

 
The seals 18 and 21 are fixed for all translational and rotational degrees of freedom. 27 At the 
meeting, all DOF are fixed except where FY DOF has a spring with spring constant 125 units. 



TECHNICAL MANUAL STAAD.Pro 

220 

 

 

 
 

Notes
: 

 
1) Users are urged to refer to Section 5.36 for information on specifying SUPPORTS with 

specifications CHANGE command. 
2) the spring constants must be provided at existing units. 
3) All DOF springs must be entered after the last non-specified DOF spring if both are 

on the same line. 
4) If there are two entries for the same board, then ,: 

a. any direction is pinned / fixed will be fixed at that address. 
b. any relaxed in one direction and a spring on the other it uses the spring. 
c. Any direction is pinned / fixed one and a spring on the other will use the 

pinned / fixed. 
 
 
 

Enforced description 
 

Support "Enforced" defines the translational and rotational directions, at a meeting, which may 
have an offset of tax support. Movements of support are defined for each load case in section 
5.31.8. If no scrolling support is hard, then zero displacement will be imposed, as if that address 
was FIXED. The directions of movement of forces will be fixed to the dynamic load cases. 

 
If there are two entries for the same board, then any direction will be given in force at that 
address, overwriting any other specification support for that direction of the board. 

 
 

5.27.2 Specification Supports Inclined 
 

Purpose 
 

These commands can be used to specify media which are inclined with respect to the global 
axes. 

 
General Format: 

SU PPORT 

 
 

joint-list INClined 

f1 f2 f3 PINNED 
 

 
REF f4 f5 f6 FIXED (BUT release-spec [spring-spec.]) 

REFJT   f7 ENFORCED (BUT release-spec) 
 
 

Where: 
f1, f2, f3 are the global distances x, y, z from the board to the "benchmark" or 
f4, f5, f6 are the global coordinates x, y, z of the "benchmark" or 
f7 is a number whose global coordinates x, y, z are the "benchmark". 
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See 
Section 
1.14 

A vector of the joint located at the location of the reference point used to define a local coordinate 
system (same as the member with BETA = 0). Addresses are inclined support this local "Axis System 
Support Tilt" (see below). 

 
Note that the specification of relaxation and spring is the same as in the previous section (5.27.1). 
However, please note that FX to MZ and KMZ KFX to refer to the constant forces / moments and 
spring in the "Axis Tilt System Support" (see 
below)
. 

 

2 3 
 

 
 
 
 
 
 

3m 
 

 
 
 

1 
4 And 

 

 
 
 

4m 3m 

X 
Reference point (1, -1, 0) 

 

 
 
 
 

Mounting System Inclined Axes 
 
 

SUPPORT INCLINED specification is based on the "axis system Mounting Inclined". The 
local x-axis of this system is defined assuming the inclined support joint as the source and 
linking it with a "point of reference" with coordinates f1, f2 and f3 (see figure) measured from 
the inclined support joint the global coordinate system. 

 
The Y-axis and Z axis system tilt stand has the same orientation as the local Z axis and an 
imaginary member whose BETA ANGLE is zero and whose incidents are defined as inclined 
to support joint benchmark. Users can refer to section 1.5.3 of this manual for more 
information on these concepts. 

 

Example 
 

SUPPORT 
4 INCLINED 1.0 -1.0 0.0 FIXED BUT MY M FY MX Z 
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FOOting

 
f1 (f2) 

  X 
XOnly 

 

THE A joint 
li STIC

DIR And SUBgrade P f3 RINT 
  M AT YOnly  
        Z 

ZOnly 
 

 

Notes:  addresses  a  tilt  stand  is  assumed  to  be  the  same  as  global  to 
calculate some dynamic results and intermediate results by UBC (eg global 
participation factors). If the mass and / or forces in the directions of the 
inclined free carriers is a relatively small portion of the overall force, then 
the 
effect must be very small. 

 

 
 
 

5.27.3 Automatic generator type supports Spring for Foundations 
 

STAAD has the option for automatic generation of media springs to model foundations and slab 
foundations. This command is specified under the SUPPORT command. 

 
General Format: 

SU PPORT 

 
 
 
 
 
 
 

 
Where 

 
f1, f2 = length and width of the foundation. If f2 is not given, the foundation is assumed as a 

square with sides f1 
f3 = Modulus of sub-grade soil in units of force / area / length X, Y, Z 
= Global Direction in which the soil springs are to be generated 

 
Do not use this commando with Z SET 
UP. 

 

The choice of ELASTIC FOUNDATION: If you want to specify the area of 
influence of a board and has STAAD simply multiply the area you specified 
by the modulus of sub‐grade, use the FOOTING option. Situations where 
this may be appropriate are as scattered when a foundation is located on a 
board where you want to specify a spring support. Please note that  it  is 
absolutely essential  that you provide  the  f1  (and  f2  if  it  is a non‐square 
foundation) if you choose the option FOOTING. 

 
The choice of ELASTIC BED: If you want to make STAAD calculate the area 
of influence for the board (instead of specifying an area) and use the area 
along  with  the  module  sub‐degree  to  determine  the  value  of  spring 
stiffness, use the MAT option. Situations where this may be appropriate 
are as when a slab is on the earth and carries the weight of the structure 
above. You may have shaped the entire slab with finite elements and want 
to generate props springs at the nodes of the elements. 

 
The choice of Address: The DIR keyword is followed by one of the letters 
of the alphabet X, Y or Z (or XONLY, YONLY or ZONLY) which indicates the 
direction of resistance of spring supports. If X or Y or Z  is then select a 
spring  support  is  generated  at  that  address  plus  3  other  addresses 
receiving a fixed support, eg. If Y is selected, then FY is supported by a 
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spring; FX and FZ and MY are the fixed support; and MX and MZ are free. If XONLY, YONLY 
or ZONLY are selected then only one spring support at that address is generated. 

 
Subgrade option: A keyword followed by the subgrade reaction value of the 
subgrade. Please note  that  the value should be provided  in  the current 
drive system meaning  the most  recent previous statement  to SUPPORT 
UNIT command. 

 
The PRINT option: Print the area of influence of each joint. 

 

Example 
 

SUPPORTS 
1 TO 126 ADDRESS AND ELASTIC MAT 200 subg. 

 
 

The above command tells STAAD supports generating internally to all nodes from 1 to 126 
with elastic springs. STAAD calculates perpendicular first area of influence the overall axis of 
each joint and then multiplies the area of influence for the respective sub-module 200.0 soil 
degree calculated spring constant to be applied to the knot. 

 

Notes
: 

 
 

A closed surface is generated based on the list of the board that accompanies the 
ELASTIC MAT command program. The area within this closed surface is determined 
and the portion of this area for each node in the list is then calculated. 

 
 

Hence, while you are specifying the list of boards, one must ensure that these together 
constitute a closed surface. Without proper closed surface, the calculated area for the 
region may be indeterminate and values of spring constants may be erroneous. Therefore, 
the list should have at least 3 knots ,. 

 
 

The interior angle formed by two adjacent segments connecting 3 consecutive nodes 
in the list must be less than 180 degrees. In other words, the region will have the form 
of a convex polygon. The example below explains the method can be used to reach a 
situation where a convex polygon is unavailable. 

 
 

For model comprised of plate elements 100 to 102 in the figure below, one may want to generate 
spring supports 1 to 8 knots with one ELASTIC MAT command will not be enough, because 
the angle between the inner 1-8 and 8-7 edges to node 8 are 270 degrees that violate the 
requirements of a convex polygon. So, one should interrupt it in 2 commands: 

 
 

January 2nd August 3 ELASTIC MAT 200 DIREC And subg. 
3 4 5 6 7 8 ADDRESS AND ELASTIC MAT 200 subg. 
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7 6 
 
 
 
 

102 
 
 
 

8 
1 5 

 
 
 

 
100 

 

101 

 
 
 

2 4 
3 

 
Boards 3 and 8 will reach here to contribute to both commands above. The command only 
works when the plane of the closed region is parallel to one of the global planes XY, XZ or 
YZ. For regions that are inclined to one of the global planes, the spring constant must be 
evaluated by hand and using the specified type of support FIXED BUT spring. 

 
 
 
 

5.27.4 Specification Support Multi-Linear Type Spring 
 

 
When the soil is modeled as spring supports, can be modeled variable resistance offered by 
external loads using this option, much as when its behavior is tension or compression. 

 

General Format: MULSPR 

TILINEARINGS 

joint SPRINGS d-list1s1d2s2D ......nsn 

 
Where (di si) pairs represent displacement and spring constant of the pairs (Yup is zero or 
positive). The first pair defines the large spring constant negative displacement offset above the 
second pair. The last pair defines the spring constant for displacements greater than the shift in 
the last couple. 

 

Example 
 

UNIT. . . 
SUPPORT 
1 PINNED; February 4 FIXED BUT SPRINGS KFY 40.0 
multilinear 
April 2 SPRINGS -0.51 40.0 -0.50 50.0 0.5 65.0 
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The load-displacement characteristics of the ground can be represented by a multi-linear curve. 
The amplitude of this curve represent the soil spring characteristics to different displacement 
values. A typical floor spring characteristic curve can be represented as step as shown in Figure 
below. In the above example 
the command specifies multi-linear spring spring soil on boards 2 and 4 [Note that 
the amplitude of the pitch curve does not change after the first point.] 

 
Each load case in a multi-linear analysis should be separated by a CHANGE command and 
should have its own PERFORM ANALYSIS command. There can be no PDELTA, NONLIN, 
dynamic, or analysis of TENSION / COMPRESSION included. The command of multi-linear 
spring start an iterative cycle analysis and convergence check. The cycles continue until the 
RMS or effective proportions of used springs remain virtually the same for two consecutive 
cycles. 

 
You must have entered previously SUPPORT springs during each spring in here. During the 
first cycle, the value used is the value of the spring in the spring (non zero displacement here). 
Use a realistic and stable value. All values in a spring board will support multi-linear curve with 
this one. 

 
Note: This command may be continued up to 11 lines running all but the last 
with a hyphen. Dots and commas and xrange, yrange, ZRANGE listed items 
may not be used. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

F = Force Units 
L = Length Units 
The spring constant is always positive or zero. 
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5.28 Specification Master / Slave 
 

Purpose 
 

 
This command set may be used to model the special joints (displacement ligation, the rigid 
links) through joints specification MASTER and SLAVE. Please read the release notes for 
restrictions. 

 
 

General Format: 
 
 

  * XY 

YZ 

 

SLAVE   ZX 

RIGID 
MASTER j JOINT joint-spec

    FX 

FY 
   

    FZ 

MX 
   

    M

Y 

   

 

joint-list 
 

 

joint-spec = *XRANGE YRANGE

 f1, 

F2ZRANGE 
 

 
 

Description 
 

 
The choice of master / slave provided in STAAD allows the user to model the special junctions 
(linkage of displacement, rigid links) in the system. For example, SLAVE FY ... connecting the two 
together so that the displacement of the slave will be Y 
And sum of displacements of the master over the rigid rotation R SIN. 

 
Note that instead of maintaining a list of boards worked like a slave, a range of values of the 
coordinate (in the global system) can be used. It is assumed that all joints whose coordinates 
are within the range will be worked as slaves together. For convenience, the range of the 
specified coordinate for the joints worked as slaves on that entry may include the board of the 
master. However, master and slave boards of other inputs should not be included in the range 
of the coordinate. All 2 or 3 ranges can be entered into a "tube" or "box" for selected region 
on the tube or box joints. 

 

Fx, Fy etc. are the addresses which are slaves (any combination can be input). 
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If two or more entries have the same master, the slave list will be mixed. It is also OK to have 
different specified addresses. 

 
Specifiers direction (XY, YZ, ZX) are combinations of the basic directions, XY is equal to log FX, 
FY, MZ ,; etc. Any combination of address specifiers can be entered. An example of using this format 
is a floor rigid diaphragm which still retains the flexibility of the entry ... ZX SLA flexion. 

 
If RIGID or if all addresses are provided, the boards are supposed to be rigidly connected. 

 
Restrictions 

 

Solid elements can not be connected together slaves. Together 
Teachers can not be slaves in another entry. 
Boards Slaves can not be master or slave in another post. 
Directions Slaves in the joints can not be addresses media or have imposed 
displacements. 
Together Teachers and / or slaves may not be inclined supports. 
The master / slave specification is only for linear static and dynamic analysis. 

 
 

Example Fully Rigid and Rigid Floor diaphragm Day 

 
RIGID JOINT MASTER SLAVE 22 10 TO 45 
RIGID JOINT MASTER SLAVE 70 YR 25.5 27.5 
SLA  ZX  MAS  80  JOINT  YR  34.5  35.5 

 
 
 

5.29 Switching frequency vibration modes 
 

Purpose 
 

These commands are used in conjunction with dynamic analysis. They can be used to specify 
the highest frequency or the number of mode shapes need be considered. 

 
General Format: 

 
 

See 
Section 
1.18.3 

FREQuency
 f1CUT  (OFF)

 MODE SHAPE i1 

TIME t1 
 
 

Where, 
f1 = the highest frequency (cycle / s) to be considered for dynamic analysis. 
i1 = The number of mode shapes to be considered for the dynamic analysis. If the command 

is not cut off frequency provides the cut off frequency will default to 108 cps. If the cut 
off form so no command is given, the first six modes were calculated. These commands 
must be provided above the specifications of loads. 
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t1 = Ending time for analysis over time. If zero (the default), the time history will end 
when the last show of force over. 

 

Note that maximum i1 mode shapes is calculated despite f1. If during the test of convergence of 
0 to f1 f1 frequencies converge, the modal calculation will be completed before the mode shapes 
of i1 is calculated. 

 

5.30 Definition charging systems 
 

Purpose 
 

This section describes the specifications necessary to define the various charging systems for 
automatic generation of Mobile Uploads, UBC Seismic loads and wind loads. In addition, this 
section also describes the specification of load time history for time history analysis. 

 

Description 
 

STAAD has incorporated algorithms to generate moving loads, the lateral seismic loads (the 
Code Uniform Building Code) and wind loads on a structure. The use of load generation option 
consists of two parts: 

 

 
 
 
 

See 
Section 1.17 

 

1) System definition (s) of cargo. 
2) Case generation system using primary load (s) as defined above load. 

 
The definition of the system (s) loading must be provided before any primary load case 
specified. This section describes the system specification (s) of cargo. Information on how to 
generate primary load cases using the system (s) defined load is available in Section 5.32.12. 

 

UBC loads do not consider the effects of forces entirely inclined support addresses or addresses 
of the slave board. The forces applied to these situations can introduce errors which are 
generally small. 

 

 

5.30.1 Definition of cargo moving system 
 

Purpose 
 

This set of commands can be used to define the charging system in motion. 
 

General Format: 
 

DEFINE M OVING AS AD (FILE file-name) 
 
 
 

TYPE j 
LOAD f1, F2, .fn(DISTANCE d1, D2, .. Dn-1  (WIDTH w)) 

 

 
load-name (F) 

 

(DISTANCE d1, D2, .. Dn-1   (WIDTH w)) 
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See Section 
31.5.12 

Note that LOAD MOVING system can be defined in two ways directly into the input file or 
an external file. 

 
The FILE option should be used only in the second case when the data will be read from an 
external file. The file name should be limited to 16 characters. 

 

 
Mobile charges may be generated for frame members only. They can not be generated for 
finite element. Note: All loads and distances are in units of the current system. 

 

Define Loads moved tr or give them the input file 
 
Use the first specification TYPE. The input data must be all on one line (as shown above) or 
two sets of lines. If two games, then the second game should start with DIS as shown below. 
If two games, then the Load and Dis lines can end each line but the last of each game with a 
script (see example). 

 

T YPE j LO AD f1, F2, F ...n (Set 

1) DISTANCE d1, D2, ... D(N-1)   (WIDTH w)

 (Set 2) 
 
 

Where, 
j = Number of mobile charging system (integer limit of 100 
types) n = number of loads (eg axles), 2-50. 

fi = value. ith load conc. 
di = the distance between the (i + 1) th and the ith charging load in the direction of 
movement 
w = space between loads perpendicular to the direction of motion. If omitted, a 

dimensional load is assumed. (For example the width of the vehicle). Note that this 
parameter will double the total load as the fi is applied to each wheel. 

 

Definition of Mobile Charging using an external file 
 

 
 

Use the second specification TYPE. 
 

T YPLoad-name E j (f) 
 
 

Where, 
Load = name The name of the mobile charging system (maximum 12 characters). 
and f = Optional Factor multiplied to scale up or down the value of loads. (Default = 
1.0) 

 
The following is a typical file containing the data. 

 

CS200 ----- Name system load (load-name must begin in column 1) 
----- 50 80 90 100 loads (79 characters in the input line) 
7 7 9. ----- Distance between charges (one line) 
6.5 ----- Wide 
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50 80
 90 

 

100 

 
 
 
 
 
 
 
 

 

6.5 
 

 

7.0 7.1 9.0 

 

 

Note that some charging systems can be repeated within the same file. The 
mobile generator charges STAAD involves: 

 
1) All loads are acting on the overall direction vertical (Y or Z) negative. The user is 

advised to fix the structural model accordingly. 
2) The resultant in the direction of movement is determined by the increments of 

movements of X, Y and Z as they were provided by the user. 
 

Loads of rock 
references to 

 
First concentrated load specified in mobile charging system as the reference load is designated. 
While primary load subsequent instances are generated, the initial position of the charging system 
and the movement direction is defined with respect to the reference load condition. Also note 
that selecting the load situation with a positive reference value specified width, then the following 
two views define the reference load situation. 

 

reference point 

x x 

d1 

W 

 
 
 

d2 

d1 d2 

z 
reference point 
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z W 

 

Movement parallel to the overall axis X Movement parallel to the global Z 
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Note that in the left view, the point of reference is in the wheel track of the positive side of 
Z; while in the right view, the point of reference is the smallest positive footprint X side of 
the wheel. 

 
Specifying standard AASHTO loads 

 

General Format: 
 
 

 
See Section 
1.17.1 

 
 
 
 
 
 
where, 

HS20 
TYPE i HS15 (F) (V) 

H20 
H15 

 
 
 
 
 

Example 

i = Mobile Charging System type number. (Integer). 
f = Optional multiplication factor (default = 1.0) 
vs = spacing of the variable as defined by AASHTO, stop HS series trucks (default = 14 

ft.) 

 

DEFINE  MOVING  LOAD 
TYPE  1  LOAD  10.0  20.0  ‐ 
15.0  10.0 
DISTANCE  5.0  7.5  ‐ 
6.5  WIDTH  6.0 
TYPE  2  HS20  0.80  22.0 

 

 
Example: 

 
When the data is provided through an external file called MOVLOAD 

 

Data in input file 
 

UNIT  . . . 
DEFINE MOVING LOAD FILE TYPE 1 
MOVLOAD AXLTYP1 
TYPE 2 AXLTYP2 1.25 

Data in external file MOVLOAD 

AXLTYP1 
10 20 15 
5.0 7.5 
6.0 
AXLTYP2 
20 20 
10 
7.5 
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5.30.2 Definitions for Static Force Procedure for Seismic Analysis 
 

 
STAAD provides the means to determine the lateral loads acting on structures due to seismic 
forces, using rules codes available in several national publications and widely accepted. The codes 
allow publications to use what is called static force equivalent methods instead of more complex 
methods such as response spectrum analysis and history through time. Among the many such 
codes is supported by STAAD UBC, IBC, IS 1893, AIJ, etc. 

 

Once the lateral loads are generated, the program can then analyze the structure for those 
loads using the rules explained in the code documents. 

 
 

 
5.30.2.1 UBC load definition 1997 

 
Purpose 

 

This feature allows you to generate seismic loads by 97 UBC specifications using a static 
approximation equivalent. 

 
Description 

 
The seismic load generator may be used only to generate the lateral loads in the X and Z 
directions and is the direction of gravity loads. This option has not been developed for cases 
where the Z axis is positioned to be the vertical direction using the "SET Z UP" command. 

 
 
 

Methodolog
y 

 

The design base shear is calculated in accordance with the code section UBC 1630.2.1 The 
primary equation 1997 called, 30-4, is checked as shown below. 

 
 

V 
CvI W 
RT 

 
...................... UBC Ecuación30‐4 1997 

 
 

In addition, the following additional equations are checked: Equation 

30-5 - The overall design of the base shear should not exceed: 

V 
2.5CtoR 

W R 
 
 

Equation 30-6 - The overall design of the base shear should be no less than: 
 

V 0.11CtoIW 
 
 

Equation 30-7 - In addition, for Seismic Zone 4, the total base shear shall not be less than: 
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V 
0.8ZNvR 

W R 
 

For an explanation of the terms used in the above equations, please refer to the 1997 UBC code. 
 

There are 2 phases of specification command to generate lateral loads. This is the first phase 
and is activated through the DEFINE UBC LOAD command. 

 
General Format 

 
DEFINE UBC (ACCIDENTAL) LOAD 

ZONE f1 ubc‐spec 
SELFWEIGHT 
JOIWEI NTGHT 
Joint‐list WEIGHT w 
MEMBER WEIGHT 
Mem‐list (UNI ....) 

 

ubc‐spec = {I f2, f3 RWX, RWZ f4, f5 STYP, NA f6, f7 NV (CT f8), (PX f9), (PZ f10)} 
 
 

Where: 
 

Seismic coefficient f1 = f2 = area 
Importance Factor 
f3 = Numerical coefficient R for lateral loads in the X direction 
f4 = Numerical coefficient R for lateral loads in the Z direction 
f5 = Type of Soil Profile 
Nearby f6 = source factor Na = 
f7 source factor Nv Near 
Optional f8 = CT value for calculating the period of time based on Method A 
f9 = Optional period structure (in sec) in the X direction to be used in Method B 

    f10 = Optional period structure (in sec) in the Z direction to be used in the 
Method B 

 
 

The type parameter STYP soil profile can take values from 1 to 5 These are related to the 
values shown in Table 16-J of the 1997 UBC code as follows: 

 
Value STAAD Code 1997 value UBC

1 SA

2 SB

3 SC

4 SD

5 SE
 
 

Soil type SF profile is not supported. 



TECHNICAL MANUAL STAAD.Pro 

235

 

 

 
 

The seismic zone factor (ZONE) along with the type of soil profile (STYP) factor of the near 
source (Na), and the Middle power factor (Nv), are used to determine the values of seismic 
coefficients Ca Cv and Tables 16-Q and 16-R of the 1997 UBC code. 

 

Examples 
 

DEFINE UBC LOAD 
0.38 ZONE  I  1.0  STYP  2 RWX RWZ 5.6 5.6 NA 1.3 1.6 CT NV 0.037 

JOINT 
SELFWEIGHT
  WEIGHT 
WEIGHT 51 56 93 100 1440 
WEIGHT 101 106 143 150 1000 
151 156 193 200 720 WEIGHT 

 
 
 

The steps for calculating the basal cutting are: 
 

1. The time period of the structure is calculated based on the clause 1630.2.2.1 (Method A) 
and 1630.2.2.2 (Method B). 

2. The user can overwrite the program period calculated using the B method specifying 
a value for PX or PZ (the f9 and f10 items) depending on the direction of the burden 
of UBC. The specified value will be used instead of the calculated using Method B. 

3. The Time Period ruler of the structure is then chosen between the two periods 
mentioned above-on the basis of the guidance provided in clause 1630.2.2.2. 

4. The coefficients Ca and Cv are calculated in Table 16-Q and 16-R. 
5. The Basal Shear Design is calculated based on the clause 1630.2.1 and distributed on 

each floor using the rules of clause 1630.5. 
6. ACCIDENTAL If the option is specified, the program calculates the time of additional 

torque. The lever arm to calculate the torque is obtained as 5% of the dimension of the 
building at every floor level perpendicular to the direction of loading of UBC (clause 
1630.6). Each board where a weight is located, the lateral seismic force acting on that 
board it is multiplied by the lever arm for the torque of that meeting. 

 
 

The following example shows the commands required to enable the program to generate lateral 
loads. Users can refer to the section LOAD GENERATION Reference Manual for this 
information. 

 

 
LOAD 1 (SEISMIC LOAD IN X DIRECTION) 
UBC LOAD X 0.75 
LOAD 2 (LOAD IN SEISMIC Z 
DIRECTION) UBC LOAD  Z 0.75 

 
 

UBC / IBC input can be provided in two or more lines using the following symbol (hyphen) 
as shown in the following example: 

 

ACCIDENTAL DEFINE UBC LOAD 
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ZONE 3000 ‐ 
I RWX 1.00 1.100 ‐ 
RWZ 1.40 NA 5.000 1.200 NV STYP 1.50 CT ‐ 
PZ PX 1,300 2,100 2.20 

 

 
 

5.30.3 Defining Loads Of Wind 
 

Objective 
 

This group of commands is used to define the parameters for the automatic generation 
of wind loads on the structure. 

 
General Format 

 
DEFINE WIND LOAD 

 

TYPE j 
 

INTEnsity p1 p2 p3 ... pn HEIGHT h2 h3 h1 ... hn 

EXP{E1 OSURE JOINT joint‐list | YRANGE f1 f2 | ZRANGE f1 f2} 
 

 
 

Where:   
J: number system load due to wind (integer) 
p1, p2, p3, ... pn wind intensity (pressure) force over area. 
h1, h2, h3, ... hn Elevations (on the absolute coordinate) to which the above 
intensities occur 

e1, e2, e3, ... in Exposure Factors. The default is 1.0, which means that 
due to wind force is applied to the entire area of influence associated with the node or 
nodes 
joint‐list: List of nodes associated with the exposure factor 
f1 and f2 values of the (global) vertical coordinates that specify the vertical range of 
exposure. 

 
 

If you do not specify the EXPOSURE command, the selected exposure factor is 1.0. 
 

 
Description 

 
All loads and elevations are defined in the system of units in use. In the list of the intensities, 
the first intensity value acts from the ground level to the first elevation. The second intensity 
(P2) acts on the absolute direction, between the two first heights (h1 and h2) and so on. The 
program assumes that the level of the floor has the lowest coordinate of axis Y. 

 
 

The exposure factor (e) is the fraction of the area of influence associated with the nodes or on 
which the load acts. The total load acting on a particular node is calculated as follows: 
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Load at node = (exposure factor) X (area of influence) X (wind strength). 
 

The exposure factor can be specified by a list of nodes, or giving a range for Y, within which 
all nodes have the same exposure. When the exposure factor is not specified, the default value 
is 1.0, in which case will be considered complete influence area associated with the nodes. 

 
For plane frames, the area of influence for each of the nodes is calculated considering the 
perpendicular to the plane of the structure unit width. Note that you can tailor the actual width, 
when incorporated into the exposure factor as follows: 

 

 
Exposure Factor (Spec. By User) = (fraction of the area of influence) X (width of influence for node) 

 
 

Note: All currents, heights and ranges must be defined  in the system of 
units in use. 

 
 

Example:	
 
 

UNIT FEET 
DEFINE WIND LOAD TYPE 1 
INTENSITY 0.1 0.15 HEIGHT 
December 24 
EXPOSURE 0.90 yrange November 13 
EXPOSURE JOITN 0.85 17 20 22 
WIND LOAD 1 LOAD IN X‐DIRECTION 
WIND LOAD TYPE 1 X 1.2 

 

 
 

5.30.4 Definition of analysis "over time" (land consolidation) 
 

Objectiv
e 

 

This group of commands is used to define the parameters for the step load of the 
structure analysis. 

 
 

General Format 
 

 
 

Repeat the TYPE command and places Amplitude vs Time until all commands are entered, then: 
 

 
ARRIVAL T I ME 
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to1to2to3To .......n 
 

(D AMPING d | CDAMP | MDAMP) 
 

 
The time history (time history) can be explicitly defined using pairs of time and acceleration 
values, force or moment, where: 

 
    Acceleration indicates the type of load time variation is an earthwork. 

    Strength indicates a forcing function 

    Time indicates a forcing function of time 
 

Variable or 

Command 

Default Value  Description 

x - Solving time step used in the step of 
integration coupled equations. Values 
smaller than 0.00001 is placed at DT 
default 0.0013888 seconds. 

i - Type varying number of load versus 
time (integer). They can provide up 
to six different types. 

Scale f7 1.0 The choice of the scale factor multiplies 
all were, accelerations and amplitudes 
entered, read or generated within this 
type. Used primarily to convert 
acceleration 
g's to current units (9.80665, 
386.08858, etc) 

Save - The save option is to create a file 
(input file with TIM extension) that 
contains the history of the 
displacement of each node of the 
structure at each time step. Syntax: 
TYPE 1 FORCE SAVE 

t1, P1; t2, P2 - Values of time (sec) and corresponding 
force or acceleration dependent on 
whether the load variation with time is 
a forcing function or ground movement. 
They can provide up to 499 pairs for 
each type, values 
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    ascending time. It may use more than 

one line if required. 

to1to2to3... An - Values of the different possible arrival 
times (seconds) for the various types of 
dynamic loads. The arrival time is the 
time when a guy starts acting load on a 
node (forcing function) or at the base of 
the structure (ground motion). The 
same type of load may have different 
arrival times for different nodes, where 
these values should be specified here. 
Arrival times and the couple force - time 
to load types are used to create the 
necessary load vector for each time step 
of the analysis. See 
5.32.10.2 for specifying information 
input in the application of loads or 
loads force functions ground motion. 
You can specify up to September 99 
arrival times. 

d 0.05 Modal damping ratio. Can only use a 
damping ratio for the entire structure. 

 

 

Note that the option "function-spec" is used to specify harmonic loads. You can specify 
harmonic sine and cosine functions. The program will automatically calculate the 
harmonic load history based on the following specifications. 

 
For the amplitude function and 
option: 

 
 

Where: 
 

 
 
f1 - Range of motion in units in use. 
 

f2 - If FREQUENCY then circular frequency (cycles / sec) If RPM, then rpm. 
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    f3 - Phase angle in degrees, or default. 
 
 

f4 - No. of load cycles. 
f5 - Time load step, default = one tenth of the circular frequency. 

Example: 

UNIT FT 
DEFINE TIME HISTORY 
TYPE 1 FORCE 
0.0 1.0 1.0 1.2 2.0 1.8 3.0 2.2 
4.0 2.6 5.0 2.8 
TYPE 2 ACCELERATION 
0.0 2.5 0.5 2.7 1.0 3.2 1.5 3.8 
2.0 4.2 2.5 4.5 3.0 4.5 3.5 2.8 
ARRIVAL TIME 
0.0 1.0 1.8 2.2 3.5 4.4 
DAMPING 0.075 

 
 
 

Note: The 'READ THFILE' command will be provided only if the history of 
load variation with respect to time is read from an external file. THFILE 
Where is the file name. The data in the external file must have in each line 
of the torque ‐ time as shown in the following example. 

 

Data in the input file UNIT KIP 

FEET 
DEFINE TIME HISTORY 
TYPE 1 FORCE 
READ THFILE 
ARRIVAL TIME 
DAMPING 0.0 0.075 

 

Data in the external file "THFILE" 0.0 

1.0 
1.0 1.2 
2.0 1.8 
3.0 2.2 
4.0 2.6 
5.0 2.8 
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Example of generation of harmonic loads 
 

UNIT KIP 

DEFINE TIME HISTORY TYPE 1 FORCE 

* Following lines for Harmonic Generator Loading SINE 

FUNCTION 

60 AMPLITUDE FREQUENCY CYCLES 100 6.2831 0.02 ARRIVAL 

TIME STEP 

0.0 

DAMPING 0.075 
 
 
 
 

Note:  The  response  (. Displacements,  forces  etc.)  contain  only  the 

contribution of those modes whose frequency is less than or equal to 

60 cps. The contribution of modes with frequency greater than 60 cps 

is not considered. For more information about the physical behavior 

of the soil from which the values entered in this section 
see the book of Soil Mechanics Volume I of Juárez-Badillo (Chapter 10: The phenomenon of 

one‐dimensional consolidation of soil) 
 
 
 

5.30.5 Defining snow loads 
 

This set of commands can be used to define some of the parameters for the generation of snow loads 
in the structure. See 5/31/13 snow loads Generation section for the definition of additional parameters 
and surfaces that will be charged. 

 
General Format 

 
DEFINE SNOW LOAD 

 
TYPE f1 PG f2 CE f3 CT f4 IM f5 

 
 

Where:   
 
f1: Type number (limit 100). The "type number" is an integrated value (1, 2, 3, etc.) denoting 
a number by which the type of snow load will be identified. Multiple types of snow load 
can be created in the same model. 
 

  : Snow load on the ground (default = 0.0). The pressure or weight per unit area, 2 
is used to calculate the design snow load. Use a negative value to indicate that the 
load is acting above the roof (down). 
 
f3: exposure factor (default = 1.0). Depends on the type of exposure the roof (fully 
exposed / exposed partially / fully refugee) and category of land. 
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    f: thermal factor (default = 1.0). Depends on the thermal condition. 
4 

 
    f: importance factor (default = 1.0). This value depends on the category in which five 

the structure belongs. 
 

Example 
 
 

FLOOR START GROUP 

DEFINITION 

_ROOFSNOW TO 102 TO 153 159 160 170 179 195 TO 197 
 

DEFINITION GROUP END 

UNIT DEFINE POUND 

FEET SNOW LOAD 

TYPE 1 PG 50 EC CT 0.7 1.1 1.1 IM 
 

 
 

5.30.6 Definition of types of reference loads 
 

 
Larger models can include multiple load cases that require analysis in their own right and are 
simply the building blocks for inclusion in the main load cases. Thus reference loads may be 
defined for this purpose. This is similar to 
REPEAT LOAD command (see Section 5.31.11), but has the advantage of not being resolute in 
his 
own right. 

 
This is a real case of the burden becomes something similar to a load case definition. A 
reference load case is solved only when later he is called in a load case. The advantage is that 
you can define as many load cases as you like, but tell the program that actually solves only a 
limited number of cases of "real" charge number, which limits the number of results should 
be examined. 

 
See "Load Cases Reference - Application" on page 272 for a description of the procedure to 
specify the information of the reference load in cases of active load. 

 
General Format 

 
REFERENCE DEFINE LOADS 

 
LOAD R (i) LOADTYPE (type) TITLE load_title 

 
(Load items) 

 
.
.
. 

 
REFERENCE END DEFINE LOADS 
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Example 
 

 
REFERENCE DEFINE LOADS 

 

LOAD R1 LOADTYPE SELFWEIGHT DEAD DEAD 

AND TITLE REF ‐1 

JOINT LOAD 
 

FY 4071 4083 4245 4257 ‐4.04 
 

4090  FY  ‐

0.64 ELEMENT LOAD 

378 TO 379 406 TO 410 422 TO 426 PR GY ‐1.44 

MEMBER LOAD 

5006 TO 5229 UNI GY ‐0.64 PMEMBER 
 

LOAD 
 

1 TRAP GY ‐0,347 ‐0,254 35.5 42 LIVE 

LOAD R2 LOADTYPE JOINT TITLE LIVE 

LOAD REF 

FY 4209 ‐6.63 
 

FY 4071 4083 4245 4257 ‐1.71 
 

SNOW LOAD R3 LOADTYPE JOINT TITLE SNOW 

LOAD REF 

FY 4109 ‐8.69 
 

FY 4071 4083 4245 4257 ‐3.29 
 

LOAD REF R4 LOADTYPE SOIL SOIL ELEMENT TITLE TO 

LOAD 1367 1394 1396 1398 1522 1539 TO 1574 ‐ 

TRAP 1575 JT ‐0.78 ‐0.78 ‐0.719167 ‐0.719167 
 

R4 LOADTYPE LOAD MODEL MASS MASS TITLE 

SELFWEIGHT X1 

SELFWEIGHT Y 1 
 

SELFWEIGHT Z1 

JOINT LOAD 

FY 17 TO 48 ‐2.5 
 

FY 49 TO 64 ‐1.25 
 

REFERENCE END DEFINE LOADS 
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5.30.7 Definition of direct analysis of members 
 

This set of commands can be used to define which members the bending stiffness and the axial 
stiffness are considered to contribute to the lateral stability of the structure. Also �b the initial value 
for each member can be placed here. See paragraph 7 of ANSI / AISC 360-05. 

 
Members listed with FLEX have their EI to 0.80 times the factored �b while the overall solution 
is made. The final member forces and with verification code will be 100% of the bending stiffness. 
Members listed with SMD have their EA factored to 
1.80 while the overall solution is made. The final member forces and code 
100% verification will the axial stiffness. The value Fyld only be used for the calculation of �b. 

 
General Format 

 

 
 

Where: 
F1: τb value. Default = 1.0. See Appendix 7 of ANSI / AISC 360‐05 
F2: yield stress in the current units. 
F3: nodal load factor. The default is 0.002. itself is entered a value of 0.003 or higher, then �b be equal 
to 1.0 and no iterations are performed. 
F4, F5: upper and lower range values, respectively, used when a range is specified by FLEX or 
Fyld. 

 
To specify nominal loads, please see Section 31.5.14. Nominal loads and factor used is entirely 
specified load data. 

 
Notes
: 

 

 
a) the notional LOAD FACTOR f3 command instructs the program not create nodal 

loads. Instead, it is a parametric control using only to make the following decision: 
 

    Yes f3 is 0.002, the calc programula τb iteration on a base. 
 

    Yes f3 is greater than 0.00299, the program sets the limit to one iteration and does not 
perform an additional iteration. 

 

b) Τb is the value entered by the FLEX command. Τb omitted to 1.0 itself is not entered. 
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5.31 Loads Specification 
 

 
Objective 

 

This section describes the different options available load in STAAD. The following 
commands can be used to start a new load case. 

 
 

General format: 
 

LOAI DING1(Any load title) 
 
 

Where:  
 
 
i1 = any integer (up to five digits) that identifies the case load. This number need 
not be sequential with respect to numbers of previous load. 

 

 
 

The LOADING command starts a new load case. Under this heading, you can give all the 
different charges related to this charge number. These different types of loads are described 
below. 

 
 

5.31.1 Specification of nodal loads 
 

 
Objectiv
e 

 
This group of commands is used to specify the loads of nodes in the structure. 

 

General Format: 
 

JOINT LOAD 
 

joint‐list * {FX f7 | FY f8 | FZ f9 | MX f10 | MY f 

 
 
 
| MZ f  } 

12 
 

 
 

Where: 
 

 
 
FX, FY and FZ: specify an absolute force in the appropriate direction. MX, 

MY and MZ: specify a time corresponding absolute address f1, f2, ... f6: load 

values 
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Example 
 
 

JOINT LOAD  

3  TO  7  9  11  FY  ‐17.2  MZ  180.0

5  8  FX  15.1 

12  MX  180.0  FZ  6.3 
 
 
 
 

Note: The numbers of nodes can be repeated, in the place where loads 
are to be added to the node. 

 
 
 
 

5.31.2 Specification of cargo in the Member 
 

Objective 
 

This group of commands is used to specify the loads on frame members. 
 

General Format: 
 

MEMBER LOAD 
 

member‐list {{UNI | UMOM} dir‐spec f1 f2 f3 f4 | {WITH | CMOM} 

dir‐spec f4 f5 f6 | LIN dir‐f7 f8 f9 spec | f spec dir TRAP 
f11

 

f12 f13}
 

 
 

Where: 
 

dir‐spec = {X | Y | Z | GX | GY | GZ | PX | PY | PZ} 
 
 

    X, Y, and Z specifies the address of the load in the x, y, and z local (member).     

GX, GY and GZ specifies the address of the load in the X, 

Y, and Z Global. 

    PX, PY, PZ can be used and the burden is projected along the length of the member in the 
corresponding global address. 

 

    UNI or UMOM Specifies a uniformly distributed load or a moment with a value of f1, f2 at a 
distance from the start of the member at the beginning of the load; f3 and distance from the start 
of membership at the end of the load. The load is assumed to cover the entire length of the 
member when f2 and f3 are omitted. 
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    WITH or CMOM Specifies a concentrated force or moment worth f5 f6 applied to a distance 
from the start of the member. f6 have as default, half the length of the member. 

 

    f4 perpendicular distance from the shear center to the loading member. The value is positive in 

the general direction of the parallel (or nearly parallel) local axis 
 

 
 

    LIN specifies an increase or decrease linear or a triangular load. If the load increases or decreases 
linearly, then f7 is the value at the beginning of the member and f8 is the value at the end. If the 
load is triangular, then f7 and f8 are given as f9 is zero and the value of half the loading member. 

 

    Specifies a trapezoidal load TRAP linear variation, which can act on the partial or total length 
of a member and a local, absolute address or projected. The load value at the start is given by 
f10 and the load value at the tail end by f11. The location of the load is given by f12, the start 
point of the load, and f13, the endpoint. Both are measured from the start of the member. When 
n is not specified, f12 and f13, the load is assumed to cover the entire length of the member. 

 
Note: The specification of the global axes is not permissible for linear 
loads  (LIN  option).  If  the  member  is  loaded  lag  distance  (see  the 
specification  of MEMBER  OFFSET),  the  location  of  the  load  is  not 
measured  from  the  coordinates  of  the  start  node  but  the  displaced 
distance. 
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5.31.3 Specifying load on an element 
 

Objective 
 

This group of commands is used to define the different types of loads on plate 
elements. 

 
General Format 

 
ELEMENT LOAD 

 

PRESSURE element‐list {{GX | GY | GZ} p1 (x1 y1 x2 y2}} 

 
element‐list TRAP {GX | GY | GZ | LX | LY} {X | Y} f1 f2 

 
 

The PRESSURE option should be used when you need to specify a pressure UNIFORM. The 
uniform pressure can be set on the entire item, or a specific portion (defined by x1, y1 and 
x2, y2. See description below). If you do not provide x1, y1 and x2, y2, pressure is applied 
to the entire item. If only provided x1, y1, assume that the load is concentrated load applied 
to the specified point. 

 
 

Note that the pressure can be defined either in the global addresses (GX, GY, GZ) or 
(normal to the element) Local Z direction. If the global address is omitted, the applied 
load is assumed at the local address is Z. 

 
Where: 

 

    GX, GY, GZ: denotes overall direction for the pressure in the X, Y and Z respectively 
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1  7   TO  10  PR  2.5   

11   12  PR  2.5  1.5  2.5  5.5  4.5

15   TO  25  TRAP  X  1.5  4.5   
34   PR  5.0  2.5  2.5   
35   TO  45  PR  ‐2.5   

 

    f1: Pressure element (force / square length) or concentrated load (force). 
Note that f1 is considered as a concentrated load when x2 and y2 are omitted 

 
    x1, y1 & x2, y2: coordinate points in the local coordinate system (the central node is the source) 

defining a rectangular area on which the pressure is applied. 
 

    The TRAP option should be used when needed to define a linearly varying pressure. The 
variation must be defined on the whole element. 

 
 

    X or Y address of variation pressure 
element. The TRAP option X / 
Y indicates that the variation of 
the trapezoid is the Local 
direction X or Local direction Y. 
The load always acts in the 
local Z axis 

 

    f2: pressure intensity first part 
 

    F3: Intensity of pressure at the end 

of 
 

Note: 
 

1. The start and end defined in the previous part is based on the positive directions 
of the local axes X or Y. 

2. While X or Y direction indicates the variation of the V, the load acting on the local 
direction Z. 

 
 
 

Example 
 
 

4 ELEMENT 

LOAD LOAD 
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5.31.4 Specifying load floor and surface charge 
 

 
Objectiv
e 

 

These commands are used to specify Area Loads Loads condo or a structure. The surface 
charge is used to model a distribution in one direction and the load distribution to model 
a floor in two directions. 

 
General format for LOAD AREA: 

 
AREA LOAD 

 

memb‐list ALOAD f1 {GX | GY | GZ } 

 
    f1 = value of load acting on an area (unit weight of unit length squared). This load is always 

acting along the Y-axis positive local members for analysis FLAT, this direction coincides with 
the axis in the absolute majority of cases. (For a detailed description refer to Section 2). 

 

Example 
 
 

AREA LOAD 

February 4 TO 8 ALOAD ‐0.250 

December 16 ALOAD ‐0.500 
 
 
 

Note: The loading area should not be specified as members declares two 
MEMBER CABLE, TRUSS MEMBER or MEMBER TENSION. 

 
 

General Format for FLOOR LOAD: 
 

FLOOR  LOAD 
 

YRANGE  f1  f2  FLOF3 {AD XRANGE f4 f5 ZRANGE f6 f7} 
 
 
 

Where: 
 

 
 
 
f1 f2 values in global vertical coordinates, to specify the vertical range. The floor load 
will be calculated for all members who are included in the global horizontal plane 
vertically within the specified range overall. 
 

The value of f3 floor loading (weight per unit length of the square). This load 
always acts parallel to the vertical axis absolute. A positive value means 
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the load is acting in the overall positive direction Y. A negative value 
indicates an overall negative charge in the direction Y. 

 
    f4-f7 absolute values of xyz coordinates that define the corner points of the area over which the 

load specified da floor (f3) act. If not specified, the load floor will be calculated for all members 
on all floors within the overall vertical range. 

 
 

Notes: 
 

1. The structure must be shaped such that the vertical axis remains perpendicular to 
the overall plane of the floor. 

 
2. Specifying Load Floor considered for load distribution in two directions, The 

specification of the surface charge considered an action in one direction. 
 

 
3. The load floor slab is distributed on four sides as trapezoidal or triangular loads 

depending on the length of the sides as shown in the diagram. Internally, these 
charges are converted to multiple loads. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. The total charge applies only to quadrilateral and triangular slabs or panels. The 
load per unit area can not be varied for a particular panel and then be assumed to 
be continuous without holes. 

 
5. The FLOOR LOAD option is not available if the SET Z UP command is used (See 

Section 5.5.) 
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Example 
 

 
The input LOAD FLOOR explained through an example. Consider the 

following home plan at y = 12 '. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If the floor has a full load of 0.25 (force / unit area), then the entry would be as follows: 
 

. . . 
LOAD 2 
FLOOR LOAD 
YR 12.0 12.0 0.250 FLOAD 
. . . 

 

 
If in the above example, panel A has a charge of 0.25 and panel B and C have a charge of 0.5, 
then the entry will be as follows: Note the format of the xrange and yrange specifications. 

 

 
. . . 
LOAD 2 
FLOOR LOAD 
YR XR 12.0 0.0 12.0 11.0 0.250 FLOAD ZR 0.0 16.0 
YR XR 12.0 12.0 11.0 21.0 0.5 FLOAD ZR 0.0 16.0 
LOAD 3 
. . . 

 

 
 

The program identifies internally panels (shown as A, B and C in the figure above). The floor 
loads are distributed as trapezoidal and triangular loads as shown by the dotted lines in Fig. 
The negative sign to the charge means is applied downward on the global address Y. 
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5.31.5 Prestressing load specification 
 

 
Objective 

 

This command is used to define prestressing loads acting on the structure members. 
 

 
General Format 

 
MEMBER {PRESTRESS | POSTSTRESS} (LOAD) 

 

memb‐list FORCE f 
1 

 

* {ES f2 
 

| EM f 
3 

 

| EE f4} 

 

 
 

Where:   
 

f1 = prestressing force. This value is positive according to the direction of the local 
axis x 
 

 
ES = Specifies eccentricity prestressing force member to start a centroid distance 
f2 

 
EM = Specifies eccentricity prestressing force to the member to a half of the 
distance from the centroid f3 

 
EE = Specifies eccentricity prestressing force at the end of the member at a 
distance from the centroid f4 

 
 

Description 
 

The first option, LOAD memeber Prestress, considers the effect of prestressing force during 
application. Thus, the transverse shear generated at the ends of the member subject to pre-
stressing forces is transferred to the adjacent members. 

 

 
The second option (POSTSTRESS MEMBER LOAD) considers the effect of existing 
prestressing load after prestressing operation. Thus the cross-cutting at the ends of the member 
subject to pre-stressing force is not transferred to adjacent members. 

 

Example 
 
 

Prestress 2 MEMBER 
TO FORCE July 11 
50.0 

 
MEMBER POSTSTRESS 

 

8 FORCE IS 30.0 -6.0 3.0 EM EE 3.0 
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In the first instance, a force of pre-stress of 50 kips is applied through the centroid (i.e., no 
eccentricity) of the members 2 to 7 and 11 In the second example, a force of post - stress of 
30 kips is applied with an eccentricity of 3 inches in the initial part, -6.0 half inches and 3 
inches at the end of the end 8. 

 
One of the limitations in the use of this command is that under any load case, any member 
can only apply a load of prestressing and post - effort only once. If the member has given 
multiple prestressing cables or have a condition of prestressing or post load - effort, this 
situation will have to be specified through multiple load cases for that member. See the example 
below. 

 
 

Incorrect Entry 
 
 

LOAD 1 

Prestress MEMBER 

July 6 FORCE 100 GB 2 ‐3 EM EE 2 
6 FORCE EM 150 GB 3 3 ‐6 EE PERFORM 
ANALYSIS 

 

 
 
 
 

Examples of Modeling Techniques 

 
The following examples describe the partial data entry for member profiles and cables 
shown below. 

 

 
Example 1 

 

JOINT COORD 

1 0 0; 2 10 0 

INCI MEMB 

1 1 2 

... 

UNIT 

LOAD 1 

... 

POSTSTRESS LOAD 

1 FORCE EM 100 GB 3 3 ‐3 EE 

PERFORM ANALYSIS 
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Example 2 

 
JOINT COORD 

1 0 0; February 20 0 

INCI MEMB 

1 1 2 

... 

Prestress INCH 

UNIT LOAD 1 

LOAD 

1 FORCE MS 100 EN ‐3 ‐3 ‐3 EE 

PERFORM ANALYSIS 
 

 
 

 
Example 3 

 
JOINT COORD 

1 0 0; 2 5 0; 3 15 0 0; April 20 0 

INCI MEMB 

1 1 2; 2 2 3; 3 3 4 

... 

1 INCH UNIT 

LOAD 

Prestress LOAD 

1 FORCE MS 100 EN 3 0 ‐3 EE 
2 FORCE MS 100 EN ‐3 ‐3 ‐3 EE 
3 FORCE MS 100 EN ‐3 0 3 EE 
PERFORM ANALYSIS 

Example 4 
 

 



TECHNICAL MANUAL STAAD.Pro 

256 

 

 

 
 
 
 

JOINT COORD 

1 0 0; 2 10 0; March 20 0 0 

INCI MEMB 1 1 2; 2 2 3 

... 

Prestress INCH UNIT 

LOAD 1 LOAD 

1 FORCE MS 100 EN 3 0 ‐3 EE 
2 FORCE MS 100 EN ‐3 0 3 EE 

PERFORM ANALYSIS 
 
 
 

 
 

 
Example 5 

 

 
JOINT COORD 
1 0 0; 2 10 0; March 20 0 0 
INCI MEMB 
1 1 2; 2 2 3 
... 
1 INCH UNIT 
LOAD 
Prestress LOAD 
1 FORCE MS 100 EN 3 3 ‐3 EE 
2 FORCE MS 100 EN 3 ‐3 3 EE 
PERFORM ANALYSIS 
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5.31.6 Load Specification Due to Temperature 
 

 
Objective 

 

This command is used to specify the loads due to temperature or strain loads on the members 
and elements. 

 
General Format 

 
 

memb / elem‐list {TEMP f1f2f4| STRAIN f3| STRAINRATE f5} 

 
 

Where:  
 
 
f1 = The temperature change that produces axial expansion in Member or uniform 
volumetric expansion elements. The unit of temperature is the same as that selected for 
the thermal expansion coefficient ALPHA under command CONSTANT 
 
f2= Temperature difference from top to the bottom element of a member or part. (T 
upper surface -T lower surface). The bending will not be considered when f is omitted2 

 

f3 = initial axial elongation (+) / contraction (-) in members due to misalignment, 
etc. in the unit length 

 
 
 

Example 

 
TEMP LOAD 

1 TO 15 September 17 TEMP 70.0 

TEMP TO 23 90.0 18 66.0 

8 TO 13 0.45E‐4 STRAIN 
 

 
 

Note: It is not necessary or possible to specify the units of temperature 
or ALPHA. The user must ensure that the value provided to ALPHA is 
consistent  in  terms of units provided  for charging  temperature.  (See 
Section 5.26) 

 
 

5.31.7 Specifying Load On A Far Recessed 
 

 
Objectiv
e 

 

This command is used to define the loads acting on a flush-end framing members. 
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General Format 
 

FIXED (END )  LOAD 
 

member‐list f1, F2, ..... F12 
 

Where: 
 
 
 

f1 ... f6 = Force x, shear and z shear, torsion, time and time z (all in local 
coordinates) at the start of the member. 
 

 
f7 ... f12 = Same as above except that the final end of the member 

 

5.31.8 Specifying Load Shift Support 
 

 
Objective 

 
This command is used to specify the load displacement of supports of the structure. 

 

General Format 
 

SUPPORT DISPlacment 
 

joint‐support‐list {FX | FY | FZ | MX | MY | MZ F1} 
 
 

Where:  
 
 
f1 = value of the corresponding displacement. For translational displacement, the units 
are specified das according to the unit of length in use, while for rotational 
displacement units will always be degrees. 
 
FX, FY, and FZ specifies n translational displacements in the global addresses X, 
Y and Z, respectively. MX, MY and MZ n specified rotational displacement absolute 
addresses X, Y and Z. 

 
 

With this command, the shift in support is provided as a burden. Note that the offset 
can not be specified in a direction in which the support is free. 

 
Exampl
e 

 

 
 

SUPPORT UNIT 
INCHES displ 
5 TH November 13 FY ‐0.25 
19 21 TO 25 MX 15.0 
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In this example, the nodes in the first list of supports will be displaced 0.25 inches in 
overall negative direction, while supporting the second list will be rotated by 15 degrees 
around the axis X. Overall 

 
 

Notes: The offsets can be applied only in 4 load cases. Displacing support 
should not be applied in a finite structure containing elements. 

 

 
 
 
 

5.31.9 Specifying Load Due To Dead Weight 
 

 
Objectiv
e 

 

This command is used to calculate and apply the weight of the structure in the analysis. 
 

General Format 
 

SELFWEIGHT ({X | Y | Z} f1) (LIST member‐list | ALL | _group name) 
 
 

Where: 
 

 
 
f1 = factor used to multiply the weight of the structure 
 
X, Y and Z represents the overall direction in which acts the weight of the structure. 

 
 

This command is used when you are going to consider the weight of the structure. The weight 
of each active member is calculated and applied as a uniformly distributed load member. 

 
This command can also be used without specifying factor and address. So, if specified as 
"SELFWEIGHT" loads will be applied in the negative absolute direction with a unit factor. 

 
 

Notes:  The  density  shall  be  indicated  for  calculating  the weight  of  the 
structure. The own weight of  finite elements  is  converted  to  charge on 
nodes connected nodes and not used as a load element pressure. 

 
 

5.31.10 Dynamic Load Specification 
 

 
Objectiv
e 

 

Specifying command that is needed to perform the spectrum analysis and step is explained in 
the following sections. 
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5.31.10.1 Specifying the Response Spectrum 
 

Objectiv
e 

 

This command is used by the user to specify and implement a response spectrum in the 
dynamic load analysis. 

 
General Format 

 
SPECTRUM {SRSS | ABS | CQC | ASCE | TEN | CSM | GRP * {X} 
f1 | Y f2 | Z f3 {ACC} | DIS } (SCALE f4) 

 

{DAMP f5 | CDAMP | MDAMP} ({LIN | LOG}) (MIS f6) (ZPA f7) (FF1 

f8) (FF2 f9) ({DOMInant f10 | SIGN}) (SAVE) (IMR f11) (STARTCASE 

f12) 
 

 
Where: 

 

   = f1 ... f3 are the factors for the input spectrum, which will be applied in the X, Y, and Z. You 
can specify some or all of the addresses. When an address is provided its default value is zero. 

 

   f4 = Scale factor for which the response spectrum is modified. If not specified, the default value 

is 1.0. 
 

   f5 = Damping factor. The default value is 0.05 (5% damping). This value is required only for the 

CQC method. 
 

   ACC or DIS = na is referred acceleration or displacement. 
 

    P1, V1, P2, V2, ...; Pn, Vn = Default periods (seconds) and the corresponding acceleration (unit 
length / sec 2) or displacement (using length in use) as the case requires. More than one line may 
be used if necessary. The use of the hyphen (-) at the end of line is not allowed to continue on 
the next line data. Pairs of spectra must be provided in ascending period value with a maximum 
of 99 pairs of spectrum. 

 
Description 

 
Note that if the SPECTRUM SRSS, manners used combinations are made according to 
the method of SRSS (square root of the sum of the squares). Otherwise, the CQC (full 
quadratic combination) method is used. 

 
 

This command must appear as part of a load specification. If the first, you must be 
accompanied by the load value that will be used to calculate the frequency and vibration 
modes. The Additional instructions do not require additional information. The 
maximum response spectrum load cases allowed execution is 4. 
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The results of calculations of frequency and vibration modes can vary significantly 
depending on the mass modeling. All active mass must be modeled as loads. All masses 
which are capable of movement, should be modeled as loads applied in all directions of 
movement. 

 

In response spectrum analysis all bodies that are able to move in the direction of the 
spectrum should be provided as loads acting in that direction. 

 
Example
: 

 
 
 

2 LOAD SPECTRUM IN X-DIRECTION 
SELFWEIGHT X 1.0 
SELFWEIGHT Y 1.0 Z 1.0 JOINT 
LOAD SELFWEIGHT FX 10 17.5 
FY 10 17.5 
FZ 10 17.5 
SPECTRUM SCALE ACC SRSS 1.0 X 32.2 
0.20 0.2; 0.40 0.25; 0.60 0.35; 0.80 0.43; 1.0 0.47 
1.2 0.5; 1.4 0.65; 1.6 0.67; 1.8 0.55; 2.0 0.43 

 
 
 

Multiple Response Spectra 
 
 

When defined in the input file more than one response spectrum, the load data must 
accompany only the first group of spectral data. Where subsequent load, only the spectrum 
must be defined. See the example below. 

 
1 LOAD SPECTRUM IN X‐DIRECTION 
SELFWEIGHT X 1.0 
SELFWEIGHT Y 1.0 
SELFWEIGHT Z 1.0 
JOINT LOAD 
10 FX 17.5 
FY 10 17.5 
FZ 10 17.5 
SPECTRUM SCALE ACC SRSS 1.0 X 32.2 
0.20 0.2; 0.40 0.25; 0.60 0.35; 0.80 0.43; 1.0 0.47 
1.2 0.5; 1.4 0.65; 1.6 0.67; 1.8 0.55; 2.0 0.43 
* 
2 LOAD SPECTRUM IN Y‐DIRECTION 
SRSS 1.0 ACC SPECTRUM AND SCALE 32.2 
0.20, 0.1; 0.40 0.15; 0.60 0.33; 0.80 0.45; 1.00 0.48 
1.20 0.51; 1.4 0.63; 1.6 0.67; 1.8 0.54; 2.0 0.42 
* 
3 LOAD SPECTRUM IN Z‐DIRECTION 
SPECTRUM Z SRSS 1.0 SCALE 32.2 ACC 
0.20, 0.2; 0.40 0.25; 0.60 0.35; 0.80 0.43; 1.00 0.47 
0.5 1.20; 1.4 0.65; 1.6 0.67; 1.8 0.55; 2.0 0.43 
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5.31.10.2 Applying Loads for Variable Time History Response 
Analysis 

 
Objectiv
e 

 
This command set is used to model the registration period the load on the structure for analysis 
step. Note that registration can provide both nodal and period ground motion. 

 

General Format 
 
 
 
 
 
 

 
Where: 

TIME LOAD 
 

joint‐list * {FX | FY | FZ | MX | MY | MZ } ItItof2GROUND 

MOTION {ABS | (REL)} {X | Y | Z} ItItof2 

 
 

It = type number for the load varying over time (see Section 5.30.4) Ia = number of time of 
arrival (Section 5.30.4) (integer). 
This is the sequential number of response time in the list provided in section 6.31.4. 
Thus, the number of arrival time of a3 is 3 and is of an n. 

 
 

Note that whether or GROUND MOTION TIME LOAD, or both may be specified under a load case. 
It's not allowed for a load case for the "over time" analysis. 

 

 
Example 

 

LOAD 1 
SELFWEIGHT X 1.0 
SELFWEIGHT Y 1.0 
1.0 MEMBER LOADS 
SELFWEIGHT Z 
5 WITH GX 7.5 10.0 
5 CON GY 7.5 10.0 
GZ 5 WITH 7.5 10.0 
LOAD TIME 
2  3  FX  1  3
5  7  FX  1  6
GROUND MOTION 
X  2  1 

 

 
In the above example, permanent masses in the structure are specified in the form of das own 
weight and charges for membership mode vibration and frequency. The rest of the data is 
input to the application of loads that vary with time in the structure. A force function type 
1 is applied to the nodes 1 and 3 beginning with the time of arrival number 3 (the number 
3 is the time of arrival of 1.8 seconds in the example presented in Section 6.31.4). Similarly, 
the forcing function of type 1 is applied to the nodes 5 and 7 starting with the 



TECHNICAL MANUAL STAAD.Pro 

263

 

 

 

number six arrival time (4.4 seconds). Ground movement (type 2) acts on the structure in the x 
direction beginning with the arrival time number 1 
(0.0 seconds). 

 
 

5.31.11 Repetitive Loads Specification 
 

 
Objectiv
e 

 

This command is used to create a case of primary load cases using the combination of 
predefined primary charge. 

 
General Format 

 
REPEAT  LOAD 

 
i1, F1, I2, F2I ...n, Fn 

 
Where: 

 

  i1, i2, ... in = number of cases of primary charge     

f1, f2, ... fn = corresponding factors 

 
Description 

 

 
This command can be used to create a primary load case combinations using predefined 
load cases. The repeated load command differs from the load merge command (see 
Section 5.34) in two ways: 

 
1. a repetition of charge is treated as a new primary charge. Therefore, P-Delta 

analysis, reflecting the correct side effects. (The combinations of load, on the 
other hand, the effects of combined algebraically predefined primary loads, 
independently assessed). 

2. In addition to primary loads previously defined, the user can add new load conditions. 
3. The REPEAT LOAD option is available with load cases with JOINT LOADS and 

LOADS MEMBER containing specifications UNI and CON UMOM only. It is not 
available to MEMBER LOADS LIN specifications and TRAP. It can be used to 
load cargo cases ELEMENT PRESSURE (without the TRAP specification). These 
charges should not be used in repetitive loads (REPEAT LOAD): scrolling support 
load (LOAD SUPPORT DISPLACEMENTS) load temperature (TEMPERATURE 
LOAD) members or elements, load response spectrum (RESPONSE SPECTRUM 
LOAD) and TIME HISTORY LOAD. It is also available for the generated charges 
using the build options of the program and UBC generator loads, wind loads 
generator, generator charges in motion. 
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Example 
 

LOAD 1 DL + LL 

SELFWEIGHT ‐1.4 

MEMBER AND LOAD 

UNIFORM AND 1 TO 7 ‐3.5 

LOAD 2 DL + LL + WL 

REPEAT LOAD 

1 1.10 

JOINT LOAD 
 
 
 
 

5.31.12 Generating Loads 
 

 
Objectiv
e 

 

This command is used to generate moving charges, UBC seismic loads and wind loads 
using the definitions previously defined load. 

 
 

The primary load cases can be generated using predefined charging systems. The 
following sections describe the generation of moving charges, UBC seismic loads and 
wind loads. 

 
 
 

5.31.12.1 Moving charges 
 

 
The types of charging systems on predefined motion can be used to generate the desired 
number of primary load cases, each representing a particular position to the cargo moving 
on the structure. This procedure simulates the movement of a component in a specific 
direction on a specific plane of the structure. 

 
 

General Format 
 

LOAGEN DEration n (ADD LOAD i) 
 

TYPJ E {x1 y1 z1 * XINC f1 | YINC f2 | ZINC f3} ({YRANGE | ZRANGE} r) 
 
 

Where:  
 
 
n = total number of cases of primary charge to be generated 
 

i = number of load case, in the case of predefined load, to be added to the generated 
charges. 
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    j = number of type system previously defined load. 
 

    x1, y1, z1 = coordinates X, Y and Z (global) the starting point of the reference load. 
 

    f1, f3 = f2 increments X, Y and Z (overall) of the position of the loading system to be used to 

load subsequent instances. 
 

    r = (optional) defines the section of the structure along the vertical axis Y. This absolute value 
of r is added to the reference vertical coordinate (y1 or z1) in the positive direction Y. The overall 
vertically moving charge externally will be distributed among all members thus generated 
between the vertical range. r should always be a positive number. In other words, the program 
seeks members who are in range Y1 and Y1 + ABS (r) or Z1 and Z1 + ABS (r). 

 
 
 

The ADD LOAD specification can be used to add a load case previously defined for all 
load cases generated by the LOAD command GENERATION. In the example below, do 
the weight specified in the load case 1 is added to all load cases generated. 

 
Sequential Numbers load cases will be assigned to case series generated primary load. The 
numbering will begin with the case number above prior load. They are allowed to specify the 
load cases after generation of load case. 

 
 

Note: The primary  load cases can be generated  from the system moving 
charges only for members of frames. 

 
 
 
 
 

Exampl
e 

 

 
LOAD ONLY 1 DL 

SELFWEIGHT 

LOAD LOAD GENERATION 20 ADD 1 

TYPE  1 0.  May. In October.  XI  In October. 

TYPE  2  0.  In October.   In 

October. ZI    15 LOAD  22 LIVE

  LOAD  ON PAVEMENT MEMB LOAD 

10  TO  20  30  TO  40  UNI  GY  ‐5.0 

LOAD  COMBINATION  31 

10  0.75  22  0.75 

PERFORM ANALYSIS 
 

 
5.31.12.1.1 UBC seismic loads 

 
Algorithms included automatically distribute the base shear between the appropriate levels and 
ceiling according to the specifications of UBC (Universal Building Code). The 
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following format shall be used to generate a load of UBC type on a particular direction. 
 

General Format 
 

LOAD i 
 

Code LOAD {X | Y | Z} (f1) (DEC f) (ACC f) 

Code = {UBC | IBC | 1893 | JIA | COL | CFE | NTC | RPA} 
 
 

Where:  
 
 
i = number of load case 
 
f1 = factor used to load the UBC, the default value is 1.0 
 
f2 = multiplier Natural torsion, which occurs due to static eccentricity is the difference 
between the center of mass and center of stiffness of a diaphragm rigid floor, to be 
used to multiply the UBC, IBC, 1893, charging Horizontal torsion etc. (Default = 0.0). 
Must be a positive or zero. 
 
f3 = Accidental torque multiplier should be used to multiply the UBC, IBC, 1893, 
accidental torsion loading etc. (Default = 1.0). May be negative (otherwise default 
signal MY is based on the direction of the lateral forces generated) 

 
 

Example 

 
DEFINE UBC LOAD 

K ZONE 0.2 0.5 1.0 I 1.5 TS 

SELFWEIGHT 

JOINT WEIGHT 

1 TO 100 WEIGHT 5.0 

WEIGHT TO 200 101 7.5 1 

LOAD IN X‐DIRECTION UBC 

UBC LOAD X 

JOINT LOAD 

May 25, 30 FY ‐17.5 

2 LOAD IN Z‐DIRECTION UBC 

UBC LOAD Z 

DEAD LOAD LOAD 3 

SELFWEIGHT 

LOAD COMBINATION 4 

1  0.75  2  0.75  3  1.0 

 
In the above example, note that the first two load cases belong to UBC type, and which 
are defined before any other load case. 
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Notes: 

 
1. UBC load cases must be defined as the first set of loading cases. 

No primary load cases specified UBC before a load case UBC are not accepted. 
Additional loads as members MEMBER LOADS and LOADS loads JOINT nodes can 
be specified by the UBC load under the same load case. 

 

Misuse 
 
 

LOAD 1 LOAD 

2 ‐1 

SELFWEIGHT 

AND JOINT 

LOAD 3 FX 

45 

LOAD 3 

UBC JOINT LOAD 

LOAD X 1.2 

3 FY ‐4.5 

LOAD 4 

UBC LOAD LOAD 3 

Z 1.2 MEMBER 

UNI GY ‐4.5 

PERFORM ANALYSIS 
 

 
 

2. All load cases involving UBC load generation must be given before the ANALYSIS 
specification. In other words, the multiple analysis in which UBC load generation is 
performed in the separate analysis gives not allowed. 

 

Misuse 
 
 

LOAD 1 

UBC LOAD X 1.2 

SELFWEIGHT ‐1 JOINT 

AND LOAD 

3 FY ‐4.5 

PDELTA LOAD 

ANALYSIS 2 

UBC LOAD Z 1.2 

SELFWEIGHT ‐1 JOINT 

AND LOAD 

3 FY ‐4.5 

ANALYSIS PDELTA 
 

 
 

3. The REPEAT LOAD specification can not be used for load cases involving charge 
generation UBC. For example 
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Misuse 
 
 

LOAD 1 

UBC LOAD 2 LOAD X 

1.0 

SELFWEIGHT Y ‐1 

LOAD 3 

REPEAT LOAD 1 

1.4 2 1.2 

ANALYSIS PDELTA 
 

 
 

4. If UBC load generation is performed given for X and Z directions, the command for 
the X direction must precede the command to the Z direction 

 

 
Misuse 

 
 

LOAD 1 

UBC LOAD Y Z 

SELFWEIGHT 1.2 ‐ 

1 LOAD 2 

UBC LOAD X 1.2 

‐1 ANALYSIS AND 

PDELTA SELFWEIGHT 
 
 
 
 
 

5.31.12.2 Wind Loads 
 

The option to generate wind load can be used to calculate wind loads based on the parameters 
defined in Section 5.30.3. The following general format shall be used for the generation of 
wind load. 

 
General Format 

 
LOAD i 

 

 

WINLOA DD (‐) {X | Y | Z} (f) TYPE j (OPEN) {XR f1f2| YR 

f1f2| ZR f1f2| LIST memb‐list | ALL} 

Where: 
 

    i = Number of load case 
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 X, X or Z, Z = Wind direction with respect to the global axes system     j = 

number of type system previously defined 

    f = factor that will be used to multiply the wind load. The negative sign is used to indicate the 
opposite direction of the wind (the default is 1.0) 

 

    f1, f2 = global coordinate values to specify the range of X or Y or Z to select members. 
 

    OPEN = option word to be used if the load will be generated in such open structures. If this is 
not specified, load will be generated assuming that the panels are "closed". 

 
 

Using X, X, Z or Z and f factor. To the axis, the negative sign indicates that suction occurs 
on the other side of the selected structure. If all members are selected and X (or Z) is used 
and the factor is positive, then the surfaces exposed to 

within the leadership - x (or - z) will be charged to the positive x (oz) direction (normal to the 
wind 
positive) direction. See the diagrams below. If you use a negative factor X and then exposed 
surfaces facing in the + x direction will be charged on the negative x direction (normal wind 
in negative direction). [If introduced - X and a negative factor, 
then exposed surfaces in the x - direction will be charged to the negative x direction (suction). 
If - X is introduced and a positive factor, then the exposed surfaces facing in the + x direction 
will be charged in the positive x direction (suction)]. 

 

 
 

Figure 5.31.12.2 (a): Conventions signs for internal and external pressures 
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A membership list or a range of values of coordinates (global system) can be used. All members 
who have both end coordinates within the range are assumed to be candidates (for closed-type 
structures) to define a surface that can be charged if the surface is exposed to the wind. The 
charge will be in the form of common charges (no load on the member). Ranks 1, 2 or 3 can 
be introduced to form a "layer", "tube" or "box" for the selection of members in the combined 
ranges. Using ranges to accelerate calculations of the larger models. 

Exampl
e 

 

 
DEFINE WIND LOAD TYPE 1 

INTENSITY 0.1  0.12 HEIGHT 100  200 

EXP  0.6  JOI  1  TO  25  BY  7  29  TO  37  BY  4  22  23 

TYPE  2 

INT  0.1  0.12 HEIGHT 100  900 

0.3 YR EXP 0 TO 500 

LOAD 1 

SELF AND ‐1.0 

LOAD 2 

WIND LOAD TYPE 2 Z 1.2 

LOAD 3 

WIND LOAD TYPE 1 X 
 
 

To open structures 
 
 

WIND LOAD 1 LOAD IN Z DIRECTION 

WIND LOAD TYPE 1 2 ‐1.2 OPEN 
 

 
 

Notes
: 

 
 

1. For closed-type structures, panels or closed surfaces are generated based on the members 
of the specified ranges and end joints program. The area within each closed surface is 
determined and then the area ratio (area of influence) for each node in the list is 
calculated. The individual must be bounded areas will not be charged flat surfaces, a 
tight tolerance, or. Therefore, one must ensure that members / joints that are exposed 
to wind form a closed surface (soil may form a closed surface edge). Without proper 
closed surface, the calculated area for the region may be indeterminate and joint force 
values may be erroneous. Consequently, the number of exposed joints should be at least 
three. 

 
2. Plaques and solids are not considered for the generation of wind load. In such 

institutions, the wind must be applied using pressure load commands for plates and 
solid. 
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Figure 5.32.12.2 (b): Load diagrams for wind open structures. 
 
 
 

 
Tip: To learn more about the behavior of structures due to the effects of 
natural  phenomena  (wind)  and  the  grounds  or  theories  in  which  the 
program is built to perform the necessary analysis, see "Effects of Wind" in 
the 
book " Di Stru cture l lis " Meli Piralla 2da. Editing Editorial Limusa. 

 

 
 
 

5.31.13 Generating snow loads 
 

This command is used to generate snow loads using definitions previously specified snow 
load. This entry must be part of a load case. 

 

 
General Format 

 

SNOW LOAD 
 

_flr_group TYPE j CS f1 {BALA | UNBA } {OBST | ONEB} 

{MONO | HIP | GABLE} 
 
 

Where:   
 
_flr_group = members that form the roof and must be loaded by snow load must 

be included in a group of soil (see Section 5.16). 
 
j = load type system previously defined snow. 
 

f1 = roof slope factor (CS). Default = 0.0. For sloping roofs, the roof slope factor described 
in Section 7.4 of SEI / ASCE-7-2. A value of 0 indicates that the roof is horizontal. 
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   BALA or UNBA = Snow load balanced or unbalanced. Default is balanced (BALA). These 
terms are described in Section 7.6 and Figures 7.3 and 7.5 of ASCE 7-02. 

    OBST or UNOB = obstructed or unobstructed. By default it is not clogged.     
MONO or HIP GABLE = type or ceiling. Default value 
is MONO. 

 

 
 

Use as many groups and floor types as needed for each load case. 
 

 
 

5.31.14 Nominal charges 
 

 
A nominal load is a load side (horizontal load) that is derived from an existing vertical load 
case. This type of charging is introduced to accommodate a requirement in design codes. AISC 
360-05 specifications define nominal loads such as lateral loads are applied at each level of 
structure and specified in terms of gravity loads. 

 

 
Description 

 

 
The cases of both major burden for reference can be selected and moved within the definition of 
nominal load factor can be specified where required and address. Rated loads are calculated and 
applied as loads on nodes. 

 
 

Note: the actual values of the applied load in the user interface until after 
the analysis is done are not displayed. 

 
 

 
General Format   

 
Nload LOADTYPE type LOAD TITLE title 
... 
Load items 
... 
Notional LOAD 

n {X | Z} (f1) 
 

Where:   
 
n = number if the primary load case or load case reference that contains the elements 
of vertical load the load. 
 

 
f1 = factor by which the content of CO is increased. Typically, codes recommend 0.2 to 0.3% (0002-0003). The 
default value is 0.002 and the factor specified in the definition block DIRECT ANALYSIS (scans). 
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You can specify multiple elements under any notional LOAD load (nominal load) and may have 
one or more blocks of the command of the rated load at any load case. 

 
 

 
Example 1 

 
LOAD  1  :  DEAD  JOINT 

LOAD 

13 TO 16 29 TO 32 45 TO 48 61 TO 64 FY ‐100 LOAD 2: DEAD LOAD 

notional 

Notional LOAD  1  X 

0.002 

... 
 

LOAD 10: Imposed JOINT 

LOAD 

13 TO 16 29 TO 32 45 TO 48 61 TO FY 64 ‐50 LOAD 
 

11: Imposed Notional 

Notional LOAD LOAD 10 x 

0.002 

 
 
 

Example 2 
 

Yes we combine loading assumptions in the example shown above, the correct syntax would be 
 
 
 
 

LOAD 3: LOAD LOAD 1 + 2 + Notional REPEAT LOADS LOAD 

1 1.0 2 1.0 

Notional LOAD 
 

1 X 2 X 0002 0002 
 
 
 

The following syntax does not include the contributions of nominal load cases for each 
component as nominal charges will not be repeated. 

 

 
LOAD 3: LOAD LOAD 1 + 2 + Notional REPEAT 

LOADS LOAD 

1 1.0 2 1.0 
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Example 3 

 
Similarly 

 

LOAD TEST TITLE 1 LOADTYPE SELFWEIGHT NONE Y ‐ 

1.15 

MEMBER LOAD 
 

CON GY 143 145 ‐16 
 

CON GY 502 515 ‐95 
 

LOAD LOADTYPE NONE TITLE 2‐Notional Notional LOAD 

TEST 1 X 1.0 

LOAD TEST 3 LOADTYPE NONE‐COMBO TITLE 

REPEAT LOAD 

2 1.0 
 

 
The Load Case 3 in the above example would produce loads. 

 

 
Example 4 

 
 

Using nominal loads with reference loads 
 

REFERENCE DEFINE LOADS 
 

LOAD R1 LOADTYPE DEAD DEAD LOAD REF TITLE AND SELFWEIGHT 
 

LIST 1 ‐1 120 FLOOR 

TO LOAD 

Yrange FLOAD ‐0.05 19 21 GY 
 

Yrange FLOAD ‐0.05 39 41 GY 
 

LIVE LOAD R2 LOADTYPE TITLE FLOOR LOAD LIVE LOAD REF 

yrange FLOAD ‐0.03 19 21 GY 

Yrange FLOAD ‐0.03 39 41 GY

  REF

ERENCE END DEFINE LOADS 

********************************************** 
 

* LOAD COMBINATIONS INCLUDING LOADS * notional 
 

********************************************** 
 

* 
 

* DEAD + LIVE LOAD +/‐ notional 
 

* 
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LOAD  1  REFERENCE 
 

LOAD  R1 R2 1.2 1.6 

Notional LOAD 

R1 R2 X 0.0024 X 0.0032 
 

LOAD  2  REFERENCE 
 

LOAD  R1 R2 1.2 1.6 

Notional LOAD 

R1 R2 X X ‐0.0024 ‐0.0032 
 

LOAD  3  REFERENCE 
 

LOAD  R1 R2 1.2 1.6 

Notional LOAD 

Z Z R1 R2 0.0024 0.0032 
 

LOAD  4  REFERENCE 
 

LOAD  R1 R2 1.2 1.6 

Notional LOAD 

R1 R2 Z Z ‐0.0024 ‐0.0032 
 

 
 

If a PRINT or PRINT CHECK STATIC LOAD DATA with any analysis specification command input 
file is added, the theoretical loads generated would be printed as follows: 
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5.32 Load cases reference- Application 
 
 

Describe how you can call the data specified under those types in cases of actual load. Reference 
load types are described in Section 5.30.6 of this manual. 

 

General Format 
 

The format of a reference to a reference of the load in a case of the primary load (j) looks 
like this: 

 
 
 
 
 
 
 

Example 

LOAD LOADTYPE j (type) load_title 
 

REFERENCE LOAD 

R (i) 1.0 

 

LOAD  1  LOADTYPE  NONE  TITLE  D + 

L REFERENCE LOAD 

R1 R2 1.0 1.0 
 

LOAD 2 LOADTYPE NONE TITLE REFERENCE 

DEAD SNOW LOAD + 

R3 R1 1.0 1.0 
 

LOAD 3 LOADTYPE NONE TITLE 

REFERENCE LOAD D + H 

R1 R4 1.0 1.0 LOAD ELEMENT 
 

TRAP GY JT 1212 1267 ‐0.54 ‐0.44 ‐0.44 ‐0.54. 
 

 
 
 
 

5.33 Specification of Frequency Natural 
 

 
 

Objectiv
e 

 
This command is used to calculate the natural frequency of the structure corresponding to the 
general direction of the deflection caused by the load case preceding this command vibration. 
So then, this command is typically used after a load case. 

 
General format: 

 

 
CALCulate  NATURAL  (FREQUENCY) 



TECHNICAL MANUAL STAAD.Pro 

277

 

 

 

Description 

 
This command is specified after all other load specifications of any primary load case for 
which the natural frequency is calculated. This natural frequency calculation is based on 
Rayleigh iteration method. If a full scale Eigen solution is required, the MODAL 
CALCULATION command (see next section) may be used. Note that a solution Eigen 
runs automatically if a response spectrum specified for a load case. 

 
 

Example 
 
 

1 DEAD AND LOADING AREA LOAD 
LIVE LOAD 
1 TO CALCULATE 23 ALOAD -200.0 
NATURAL WIND LOAD FREQ 2 
LOADING 

 

 
 

In this example, the natural frequency for load case 1 will produce the output value of the 
natural frequency in cycles per second (cps), the maximum deflection together with the 
absolute address and the node number where this occurs is calculated. 

 
Note:  This  command  is  based  on  the  Rayleigh  iteration method.  The 
frequency  estimates  calculated  frequency  for  vibration  mode 
corresponding  to  the deflected  shape generated  static  loads within  the 
load case. 

 
 
 

Calculating modal command 5.33.1 
 

 
Objectiv
e 

 

This command is used to obtain a full scale Eigen solution for the calculation of the 
relevant frequencies and vibration modes. 

 
General format: 

 
MODAL (CALCULATION REQUESTED) 

 
 
 

This command is typically used in a load case after all specified load cases do have. The charges 
will be handled as masses for Eigen solutions. The static displacements and forces calculated 
for the load case in particular. 

 

This command may be used only for a load case, and may NOT be used in conjunction 
with a response spectrum analysis. 

 
Note:  Eigen  solution  initiated  by  this  command  will  cause  the  loads 
specified  load  cases are  treated as masses. Users are advised  to  specify 
loads keeping this in mind. 
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5.34 Specification of Loads Combined 
 

 
Objectiv
e 

 
This command is used to combine the results of the analysis. The combination may be algebraic 
square root of the sum of squares (SRSS) or by combination of both. 

 

General format: 

 
LOAD COMBination (SRSS) i to1 

 

i1, F1, I2, F2... (FSRSS) 
 
 

Where:   
 
i = Number of combined load (any less than 100,000 different integer but any 
number previously defined for cases of primary load). 
 

 
a1 = Any title for the combined load. 
 
1i, i2, ... = Represents the load case numbers which are to be combined. 
 
f1, f2, ... = represent the relevant factors to be applied to the loads. 
 

fsrss = optional Factor to be applied as a multiplier on the combined results of the 
load combination SRSS. 

 
 
 

If the minus sign precedes any loading case number in the LOAD COMBINATION SRSS 
option, then that load case will be combined algebraically with the SRSS combination of the rest. 
The total number of cases of combination of charge can not exceed 150. 

 
 

Description 
 
 

Test results may be combined using either algebraically or SRSS method (square root of the 
sum of the squares). The combination scheme can be mixed when required. For example, if 
the same combination of load, the results of the load conditions can be combined as SRSS and 
then algebraically combined with other load cases. The following example illustrates this. 

 

Example 

 
Different examples of combination are provided to illustrate the possible combination schemes. 
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Simple algebraic combinations and the SRSS method 
 

 
 

LOAD COMBINATION 7 DL + LL + 
WL 1 0.75 2 0.75 3 1.33 
LOAD COMBINATION SRSS 8 SEISMIC DL 
+ 1 1.0 2 0.4 3 0.4 

 

 
 

The first line above (LOAD COMBINATION 7) illustrates a simple algebraic combination. The 
second line (LOAD COMBINATION 8) illustrates a combination of pure SRSS load a default 
factor of 1 for SRSS combination The following diagram will be used. 

 
v = 1.0 1 x L12 + L22 + 0.4 x 0.4 x L32 

 

 
Where: 

    v = combined value and l1 - l3 = values of load cases 1, 2 and 3. 
 

 
Note that because a factor of SRSS, the default value used by the program is 1 is indicated. 

 
Algebraic and SRSS combination within the same load case combination of Example 1 

 
LOAD COMBINATION SRSS 9 
‐1 0.75 2 1.0 3 1.0 0.75 

 
 

 
The combination formula is as follows 

 
v = 0.75 + 0.75 x L1 1.0 x 1.0 x L22 + L32 

 

 
Where: 

 

    v = combined value 
 

    L2 and L3 = values of load cases 2 and 3 
 

 
In the above specification, note that the case load has a minus sign at the beginning. As 
the load 1 is algebraically combined with the results obtained from the combination of 
load cases 2 and 3 of SRSS. Note that a factor of 0.75 for the SRSS combination for 2 and 
3 applies. 
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Example 2 
 
 

LOAD COMBINATION SRSS 10 

‐1 0.75 ‐2 0.75 3 1.0 4 1.0 0.75 
 
 

Here, both the load cases 1 and 2 are combined algebraically with the SRSS combination of load 
cases 3 and 4 Observe the SRSS factor of 0.75. The combination formula is 

 
v = 0.75 x 0.75 x L1 + L2 + 0.75 1.0 x 1.0 x L12 + L22 

 

 
Notes 

 

1. This option combines the results of the analysis in the manner specified. No 
analyzes the structure for the combined load 

 

 
2. If the side effects of the combination of load cases will be obtained through a PDELTA 

analysis, COMBINATION LOAD command is inappropriate for this purpose. See for 
details the REPEAT LOAD (section 6.32.11) command. 

 

3. In a combination of load specification, a value of 0 (zero) as a load factor is not 
allowed. In other words, a specification as follows: 

 

 
 
 

LOAD COMB 7 
1  1.35  2  0.0  3  1.2  4  0.0  5  1.7 

 
 
 
 

It is not allowed. What happens is that because of the way the program processes data as 
soon as it encounters a 0.0, it stops at 0.0 and not read further. Because of this, in the case 
of previous load results only consist n forces due to load 1 multiplied by a factor of 1.35. 
The contribution of 1.2 * 1.7 * Load 3 and Load 5 is not worth because the program simply 
does not read the data. 

 
4. All cases of combination of loads must be provided immediately after the last case of 

primary charge. 
 
 
 
 
 

5.35 Specification Analysis 
 

 
Objectiv
e 

 
The analysis option STAAD.Pro includes linear static analysis, P-Delta (or second-order 
analysis), analyzes and various linear dynamic analysis. 
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This command is used to define the type of analysis required. Additionally, this command is 
used to obtain various types of data related to the analysis, such as load information, static 
verification, vibration modes, etc. 

 

General Format 
 

LOAD DATA 
PERFORM STATICS CHECK 
PDELTA (n) ANAPRI LYSISNT STATICS 
LOADNONLINEAR (n)  MODE SHAPES 

BOTHAL
L 

 
 

Where: 
 

 
 
n = number of desired iterations (the default is n = 1). 

 
 
 

This command instructs the program execution analysis, which includes: 
 

a) Check that all relevant information has been provided for the analysis 
 

b) Generate the stiffness matrix of the nodes 
 

c) Check the stability of the structure 
 

d) Solving simultaneous equations, and 
 

e) Calculate the member forces and displacements 
 

f) If the P-Delta analysis, the forces and displacements are specific recalculated, taking 
into account the effect P-Delta 

 
g) Nonlinear analysis will take into account the nonlinearity and P-Deltas effects. (Refer 

to Section 2.17.2.2). 
 

h) When a response spectrum within a specified load case, or MODAL 
CALCULATION command, the program will perform a dynamic analysis is used. 

 

 
i) For each of the n iterations of the P-Delta analysis, the load vector will be modified to 

include the side effects generated by the displacement caused by the previous analysis. 
 

With the lack of any of these commands, the analysis will not be executed. These commands 
can be repeated when analyzing several analyzes may be required in different phases. 

 

 
Note that a P-Delta correct analysis reflects the side effects of the combination of load cases, only 
when they are defined by the REPEAT LOAD (Section 5.31.11) specification. The side effects will 
not be evaluated correctly for LOAD COMBINATIONS. 
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If the LOAD DATA command PRINT is specified, the program will print an interpretation of 
all data load. 

 
    Statics PRINT CHECK, provide a summary of the applied loads and support reactions, as well 

as a summary of the moments of the loads and reactions taken around the origin. 
 

    Statics LOAD PRINT prints the same as PRINT CHECK statics, but also prints a summary of 
all internal and external forces at each node, generating large outputs. 

 

    MODE SHAPES PRINT prints the vibrational modes in the nodes for all modes of vibration 
calculated. 

 

    PRINT BOTH, is equivalent to more PRINT PRINT LOAD DATA CHECK statics. 
 

    PRINT ALL is equivalent to more PRINT PRINT LOAD DATA LOAD statics. 
 
 

Notes 
 

STAAD.Pro allows multiple analysis within a single execution, which could be used for the 
following purposes: 

 

 
1. Subsequent analysis and design cycles within a single execution result in a

 optimized design. The active database of STAAD.Pro sizes automatically updated 
cross-sections of the members, so that the whole process is automated. 

 
2. The multiple analysis can be used to load dependent structures. For example, structures 

with bracing members are tested at various stages. Bracing members are considered 
which can only withstand tensile load. As will require activation and deactivation 
depending on the load laterally. 

 
3. The entire process can be modeled within a single program execution through several 

PERFORM ANALYSIS command. The STAAD.Pro database automatically stores the 
results for different runs and is capable of generating a layout based on the load 
combinations defined. 

 

4. Also can be used to model multiple analysis changes for other features such as 
SUPPORTS, RELEASES, etc. SECTION PROPERTIES 

 
5. The use of multiple analysis may require the use of other commands such as SET and 

CHANGE NL. 
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5.36 Specification Change 
 

 
Objective 

 
This command is used to reset the stiffness matrix. This command is generally used when it is 
required to perform multiple analyzes within the same run. 

 
General format: 

 
CHANGE 

 
 

This command indicates that expected by those input data that will change the stiffness matrix. 
This command should be used only when an analysis has already been executed. The CHANGE 
command does the following: 

 
a) Place the stiffness matrix to zero, 

 

b) Transforms active members, when these are placed as inactive INACTIVE by a 
previous command, and 

 

 
c) Allows specification of the supports again another SUPPORT command, which causes 

the former supports are ignored. The SUPPORT specification must be such that the 
number of relaxations before CHANGE must be greater or equal to the number of 
relaxations after CHANGE. Also, the supports must be specified in the same order before 
and after the CHANGE command. 

 

Example 
 

 
Before CH ANGE 

 

1 PINNED 
2 FIXED BUT MY MZ FX 

3 FIXED BUT FX MX MY MZ 
 
 
 
 
 

After CH ANGE 
 
 

1 PINNED 
2 FIXED 

3 FIXED BUT FX MZ 
 

 
 

The CHANGE command is not necessary when we review only the member properties for 
further analysis. This is the typical case in which the user has asked for a selection of member 
and then use the PERFORM ANALYSIS command to analyze again based on the new member 
properties structure. 



TECHNICAL MANUAL STAAD.Pro 

284 

 

 

 
 

Notes 
 

 
1. If new load cases are specified two after the CHANGE command as in the case of a 

structure where the INACTIVE MEMBER command is used, the user needs to define 
the total number of primary load cases using the SET NL option. 

 
2. Multiple Analysis using the CHANGE command should not be performed if the input 

file contains load cases involving UBC Analysis, Analysis and Response Spectrum 
Analysis HISTORY TIME. 

 
 
 

 

5.37 Specification of loading lists 
 

 
Objectiv
e 

 
This command allows you to define a group of cases of active loads. All load cases defined as 
active using this command will remain so until a new list of charges specified. 

 
General Format 

 
LOAD LIST {load‐list | ALL } 

 
 

Description 
 

 
This command is used to activate the cases listed in the command load and, to some extent, 
disables all other load cases that are not listed in this command. In other words, the loads listed 
are used for printing and design for the implementation of specific calculations. Note that when 
the PERFORM ANALYSIS command is used, the program uses internally all load cases, 
regardless of the LOAD LIST command, except after a RESTORE or CHANGE command. In 
these two cases, the LOAD LIST command causes the program to run the analysis on only those 
charges that are in the list. If the LOAD LIST command is never used, the program will assume 
that all load cases are active. 

 

Example 
 
 

LOAD LIST ALL 

PRINT LOAD FORCES MEMBER LIST March 1 

PRINT CHECK CODE ALL SUPPORT 

REACTIONS 
 
 
 

In this example, the forces in the members will be printed for all load cases, while loads 1 and 
3 will be used to print the support reactions and review in accordance with codes of all 
members. 
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Note:  The  LOAD  LIST  command  can  be  used  in  situations  where 
multiple analysis required to execute a set of load cases only. Note that 
all load cases are automatically activated before a RESTORE or CHANGE 
command is used. 

 
 
 
 
 

5.38 Grouping Loads 
 

 
"Load Envelopes" are a means of grouping a set of  load cases under one name 
(number). If one or more tasks have to be performed by a set of load cases, such 
as: Service test on steel design for a set of load cases, design verification efforts 
steel under another set of cases, etc. This feature is desirable. 

 
It is an alternative to the LOAD LIST command described in section 5.37. 

 

The pool can be labeled with optional keywords to specify the qualitative nature of the load 
or combination cases included in the definition of the load. 

 
Example 

 
In the following example, the keyword associated with serviceability envelope 2. 
Keywords can be any word (with or without spaces) of your choice. 

 
 
 

DEFINE ENVELOPE 
 

1 TO 8 1 ENVELOPE TYPE CONNECTION 
 

September 15 ENVELOPE TO TYPE 2 Serviceability 
 

April 16 ENVELOPE TO 28 END 

DEFINE TYPE ENVELOPE STRESS 

 
The first line in the DEFINE command ENVELOPE loading cases numbered 1 to 8 make up one 
group of type CONNECTION loads. Load cases 9-15 also defines the grouping of two kinds 
serviceability loads. 

 
To print the reactions corresponding to the grouping of load 1 support, the following commands 
should be entered in the input file 

 
 
 

LOAD LIST ENV 1 
 

PRINT SUPPORT REACTIONS 
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5.39 Specification Sections 
 

 
Objective 

 
This command is used to specify the areas along the members of a frame-like structure for the 
forces and moments are required. 

 
General Format 

 

 
SECTION f1(F2) (F3) ... (F5) {MEMBER memb‐list | (ALL)} 

 
 

Description 
 

This command specifies the sections in terms of fractional lengths of the members, in which 
the forces and moments are considered for further processing. 

 
    f1, f2, ..., f5 = Section provided for members (in terms of the fraction of the length of the 

member). The maximum number of sections is 5, including those taken at the beginning and end 
of the member. In other words, more than three intermediate sections for the SECTION 
command is not allowed. 

 
This command is used to rotate to any desired geometry around any global axis angle. May 
be used in the analysis and design rotated pattern. 

 
Example 

 
 

SECTION  0.0  0.5  1.0  MEMB  1  2 

SECTION  0.25  0.75  MEMB  3  TO  7 
SECTION  0.6  MEMB  8 

 

 
 

In this example, the values of the first section of the members 1 and 2 and 0.0, 0.5 are placed, 
and 1.0, ie, at the beginning, in the middle and at the end. The members 3 and 7 are defined in 
the next SECTION command, where the sections are set as 0.25 and 0.75. 

 
In the next SECTION command, member 8 has a specified section 0.6. The rest of the members 
will not have intermediate sections for them. If the value of the section to a member is not 
specified, the default values are 0.0 1.0 (ie, the beginning and end). For example, if the section 
is not defined, the initial and final forces members will be used in the design. As mentioned 
above, no more than three intermediate sections allowed for the SECTION command. 
However, if more than three intermediate sections are involved, they may be checked by 
repeating the SECTION command after completing the required calculations. The following 
example will help clarify this. 
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Example 
 
 

SECTION   0.2  0.4  0.5

  PRINT ALL  SECTION

    SECTION FORCES 

  0.6  0.75  0.9 

  PRINT ALL  SECTION

    FORCES 
 

 
In this example, first intermediated forces in three sections (that is, 0.2, 0.4 and 0.5) are printed 
and then three additional forces into sections (that is, 0.6, 0.75 and 0.9) are printed. This 
provides the user forces over three intermediate sections. 

 
 

Notes
: 

 
1. The SECTION command specifies only the sections. SECTION FORCES Use the 

PRINT command after this command to print the forces and moments of the specified 
sections. 

 
2. This is a secondary analysis command. Note that the analysis must be run before using 

this command. 
 
 
 
 
 
 

5.40 Print Specification 
 

 
Objectiv
e 

 

 
This command is used to tell the program to print various test results and information 
modeling. STAAD.Pro offers a number of versatile printing commands used to format the 
output. 

 
General Format 

 
To print command data: 

 

PRIJOI NT {NT COORDINATES | MEMBER PROPerties | ELEMENT 

INFOrmation (SOLID) | MEMBER PROPerties | SUPPORT 
INFOrmation | ALL} {(ALL) | LIST item / joint / Member‐
list} 

 
 

To print CG location 

PRINT CG (_group_name) 
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To print the test results 
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PRI{NT (JOINT) DISPLACEMENTS | MEMBER FORCES (GLOBAL) | 
ANALYSIS  RESUTLS |  MEMBER  SECTION  FORCES  |  MEMBER 
STRESSES  |  ELEMENT   (JOINT)  STRESSES  (AT  f1  f2)  | 

ELEMENT FORCES | ELEMENT (JOINT) STRESSES SOLID | MODE 

SHAPES spec‐list} 
 

List‐spec  =  {(ALL)  |  LIST  joint  /  member  /  elements‐
list} 

 
 
 

For printing the support reactions 
 

PRISUP NTPORT REACtions 
 

For offset printing or stiffness 
 

PRINT STORY DRIFT (f3PRINT STORY STIFFNESS 
 

Print the location of the center of rigidity at each floor 
 

PRINT DAYPHRAGM CR 
 

 

Description 
 

Note that the list of terms is not applicable for RESULTS ANALYSIS PRINT, PRINT and PRINT 
MODE SUPPORT REACTIONS SHAPES commands. 

 
The PRINT JOINT COORDINATES, command prints all the coordinates of the nodes 
interpreted. 

 
The PRINT MEMBER INFORMATION, command prints all the information of the members, 
including limb length, incidence of members, beta angles, if a member is not armor or conditions of 
release and the Member at the beginning and end (1 = free, 0 
= Not 
free). 

 
The PRINT command prints INFORMATION ELEMENT all incidents nodes, thicknesses of 
the elements and Poisson modules for flat / crack ng elements. The PRINT command prints 
INFORMATION ELEMENT similar information for solids. 

 
The PRINT MEMBER PROPERTIES command prints all properties including cross-sectional 
area, moments of inertia, and section modulus members on both axes. The units for the 
properties are always inches or centimeters INCH CM (depending on the system or METRIC 
units FPS) without considering the drive specified in the UNIT command. 

 

The following designation is used for property names of members:     AX 

- Cross Section Area 

    AY - Area used to calculate the shear deformation at the local Y axis 
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    AZ - Area used to calculate the shear deformation in the local Z axis     

IZ - Moment of Inertia about the local Z axis 

    IY - Moment of inertia about local y axis     

IX - Torsional Constant 

    SY - Smaller section modulus about the local Y axis     

SZ - Smaller section modulus about the local Z 

MATERIAL PROPERTIES The PRINT command prints all the properties of the materials to 
members, including E (elastic modulus), G (shear modulus), specific gravity and thermal 
expansion coefficient (alpha) for frame members. This command is available for members only. 

 

SUPPORT INFORMATION The PRINT command prints all the information regarding your 
support stability, freedom and spring constant, if any. 

 
The PRINT ALL command is equivalent to the combination of the last five commands. This 
command prints the coordinates of the nodes, the information of members, member properties, 
properties of materials and information support in that order. 

 
CG The PRINT command prints the coordinates of the center of gravity of the structure. Only 
the weight of the structure is used to calculate the center of gravity. The charges in the nodes 
and the user-defined members are not considered in calculating the center of gravity. 

 

 
The PRINT (JOINT) command prints DISPLACEMENTS displacements at the nodes in a 
tabulated form. Offsets for all six directions be printed for all cases of load specified. The unit 
of length is inch for travel INCH or CM centimeter (depending on the type of system or 
METRIC units FPS) without considering the drive specified in the UNIT command. 

 
The PRINT command (MEMBER) FORCES prints the member forces (ie, the axial force, 
shear at the local Y and Z, Torsional Moment, moments about the Y and Z) in a tabular form 
per member for all specified loading cases. 

 

ANALYSIS RESULTS The PRINT command is equivalent to the last three combined 
commands. With this command, the movement of the nodes, the support reactions and 
member forces will be printed in that order. 

 
(MEMBER) SECTION FORCES forces printed in the middle sections give the PRINT 
command specifies a prior SECTION command. Printing is done in a tabular form per member 
for all load cases specifies two. 

 

 
The PRINT (MEMBER) command STRESSES efforts tabula members at the initial node, the 
end node and all intermediated sections specified days. These efforts include the axial (ie, the 
axial force on the area), the bending-and (that is, the time-and 
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on the section modulus in the local axis), the bending-z (i.e., the time-z on the section modulus 
in the local Z), the shear stress for local addresses and z, and combined efforts (combination 
absolute axial, bending and flexion-y-z). 

 
For prismatic sections, if not provided AY and / or AZ, the area of the entire section (AX) will 
be considered in the calculation of shear. 

 
For sections with variable banking, values of AY and AZ are those for the location where stress 
is printed. So if the effort is printed in place 0.0, the AY in AZ are based on the size of the 
member in the initial node. 

 

 
Cant AY = Total * Thickness of the Soul. 

AZ = 2/3 area both skates together 

The PRINT ELEMENT STRESSES command must be used to print efforts (FX, FY, FXY, QX, 
QY), moments per unit width (MX, MY, MXY) and principal stresses (SMAX, SMIN, TMAX) 
plans for items / shells . Typically, the forces and moments per unit width at the centroid will 
be printed. Efforts are also printed Von Mises (VONT, VONB) as the angle (ANGLE) defining 
the orientation of the principal planes. 

 

The variables that appear in the output are as follows. See Fig. 2.13 in section 2 of this reference 
manual for more information on these variables. 

 
    QX = Shear stress in local face X in the Z direction     

QY = Shear stress in local face And in the Z 

direction     MX = moment per unit width 

about local face X     MY = moment per unit 

width about local face And 

    MXY = Torsional moment per unit width in local XY plane     FX = 

Axial Stress at the local address X 

    FY = Axial Stress at the local Y direction 
 

    FXY = Shear XY locally 
 

    Von Mises VONT = Effort in the upper surface of     Effort 

VONB = Von Mises on the lower surface of the 

element 

    SMAX = Principal stress maximum flat SMIN = Main Effort minimum flat TMAX = maximum 
in-plane shear stress 
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    ANGLE = Angle determines the direction of maximum principal stress with respect to the local 
axis X. 

 

If the JOINT option is used, the forces and moments at the nodal points are also printed in 
addition to the centroid of the element. 

 

 
The AT option can be used to print forces in the elements at any specific point of the element. 
The AT option must be accompanied by f1 and f2. Note that f1 and f2 are the local coordinates 
X and Y (in units in use) the point where the time and effort are required. Refer to section 
2.6 of this manual for details of the local coordinate system of the elements. 

 

The PRINT ELEMENT (JOINT) SOLID STRESS command allows you to print to the center 
of effort SOLID elements. The variables that appear in the output are: 

 
    Standard Efforts: SXX, SYY and SZZ     

Efforts Cutters: SXY, SYZ and SZX 

    Major efforts: S1, S2 and S3. 

    Von Mises Stress: SE 
 

    Cosines Directors 6 are direction cosines DC printed following expression 
corresponding to the first two directions of effort. 

 
The print option JOINT efforts nodes of solid elements. 

 

The MODE SHAPES PRINT command prints the displacements of the nodes for all the 
calculated modes. 

 

 
The PRINT command prints SUPPORT REACTIONS reactions props in tabular form, for 
support, for all load cases. The LIST option is not available for this command. 

 
The PRINT ENTIRE TABLE command can be used to obtain a print catalog content steel 
which member properties are being read. This command should be provided following the 
specification of the Member properties. 

 
Examples 

 
 

PERFORM ANALYSIS 

PRINT ELEMENT JOINT FORCES 

PRINT ELEMENT FORCES 0.5 0.5 LIST AT 1 TO 10 

PRINT SUPPORT REACTIONS 

PRINT JOINT TO LIST 1 DISPLACEMENTS 50 

PRINT FORCES MEMBER LIST 101 TO 124 
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Notes 

 
1. The output generated by these commands are based on the unit system in use. 

The user may want to verify the unit system in use and replace if necessary. 
 

2. The results can be printed for all nodes / members / elements or based on a specific 
list. 

 

 
 
 
 
 

5.41 Printing sections displacements 
 

 
 

Objective 
 

This command is used to calculate and print displacement sections (intermediate point) of 
frame members, providing deflection data between nodes. 

 

 
General Format 

 
PRINT SECTION (MAX) DISPLACEMENTS (NSECT i) (SAVE a) { 
NOPRINT | ALL | LIST memb‐list} 

 
 

Where:   
 

i = number of sections to be taken. 12 NSECT default if you do not use and also if 
SAVE (max. = 24, min = 2) is used. 
 

 
a = filename where offset values can be stored and used by the graphics program 
STAADPL. NOPRINT If the command is used in conjunction with the SAVE 
command, the program writes the data to file 
only and does not print them out. 

 
Description 

 

This command prints the displacements at intermediate points between two nodes of a member. 
These displacements are in the directions of the global coordinates (see figure). If the MAX 
command is used, the program will print only the maximum local travel between all load cases. 

 
Example 

 
 

PRINT PRINT SAVE SECTION 
SECTION displ MAX DISP 
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Original 
Position 

 
 
 
 
 
 
 
 
 

Displacement 
Y 

 

Displacement in X 
 
 
 

 
Position 

Moved 
 
 
 
 
 
 
 
 
 

The movements of the sections are measured in global coordinates. The values are measured 
from the original position (not deflected) to the deflected position. See previous figure. 

 

 
Also printed is the maximum local displacement. First, the location is determined and then 
the value is measured from this location, a line connecting the start and end nodes of the 
deflected member. 

 

 
 
 

Notes 

 
1. The offset values are available in Global section coordinates. 

The undeflected position is used as a baseline for calculating deflections. 
 

2. This command is for secondary analysis. It should run a scan before this command 
can be used. 
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5.42 Specifying printing of the grouping of forces 
 

 
Objective 

 
This command is used to calculate and print the envelope of force / moment for members of 
the frame. This command is not available for finite elements. 

 

 
General Format 

 

 
 

PRINT {FORCE | MAXFORCE ENV}ELOPE (NSECTION i) list‐ 
spec 

 

spec = {list‐LISMemb‐list T | (ALL)} 
 

 
 

Where:  
 
 
i is the number of equally spaced sections to be considered in the printing of the 
envelopes of maximum and minimum forces. If NSECTION i command, the default 
value for i will 12. MAXFORCE command produces only the values of maximum / 
minimum force all sections is omitted while the FORCE command prints the values 
of maximum strength / minimum each section as well as the strength values of max / 
min of all sections. The components include forces FY, MZ, FZ and MY. Note that 
the SECTION (as described in Section 5.40) command does not define the number of 
sections for groups of forces. 
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Example 
 
 

PRINT  FORCE  ENV  PRINT 

MaxF ENV NS 15 

DK 4 ENV PRINT FORCE TO LIST March 15 
 
 

 
Note: This is a secondary analysis of command and should be used after 
the analysis specification. 

 
 
 

 

5.43 Specification Size 
 

 
 

Objectiv
e 

 

 
This command provides an estimate of the required section properties for members of the 
framework, based on certain results of the analysis and the requirements you define. 

 
 

General Format 
 

SIZE * {WIDTH f1| DEFLECTION f2| LENGTH f3| BSTRESS f4| 

SSTRESS f5MEMBER memb} {‐list | ALL } 

 

 
 

Where:  
 
 
f1 = maximum allowable width 
 
f2 = maximum allowable ratio (length / maximum local deflection) 
 

f3 = length to calculate the above ratio. The actual length of the member shall be 
taken by default 
 

 
f4 = maximum allowable bending stress 

f5 = Maximum Allowable shear stress 

Note that the values should be provided in the system of units being used. 
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Description 
 
 

This command is used to calculate the required properties of a section of an individual, based 
on the analysis results and the criteria the user specifies two. The criteria specified by the 
user, may include the width of the member, allowable ratio (length / maximum deflection), 
maximum allowable bending stress and maximum stress allowable cut. Any number of these 
criteria may be used simultaneously. The output includes: the required section modulus (about 
the major axis), the required cutting area (cutting parallel to the minor axis), maximum 
moment capacity (about the major axis), maximum cutting capacity (to cut parallel to minor) 
axis and the maximum rate (local maximum length deflection). 

 

 
Example 

 
WID SIZE 12 DEFL 300 LEN 240 BSTR 36 ALL 

BSTR DEFL SIZE 450 42 16 TO 25 MEMB 
 
 
 

Note: the sizing is based solely on the criteria specified by the user in 
the SIZE command. 

 

 
For example, in the above example, the sizing member is specified based on a user do with a 
width of 12, a ratio of length / deflection 300 (where length = 240) and a maximum allowable 
bending stress of 36. 

 
In the second example, the dimensioning will be based on a ratio of length / flex 450 (where 
the length is equal to the actual length of the limb) and a maximum allowable bending stress 
of 42. 

 
 

Note: This is an option for post ‐ analysis. So this command will have to be 
used after the analysis specification. 

 
 

 

5.44 Design Specification for Steel 
 

 
 

In this section, all necessary for structural steel design specifications are described. 
 

 
Section 5.44.1 discusses all the specifications that can be used to control the layout. Sections 
5.44.2 and 5.44.3 describe the options and MEMBER SELECTION CODE CHECKING 
respectively. The selection of members for optimization is discussed in section 5.44.4. 
STAAD.Pro also provides options for the design of welds which are described in section 5.44.5. 
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5.44.1 Specifying Parameters 
 

Objective 
 

This group of commands is used to define the parameters required for the design of steel. 
General Format 

 
PARAMETER 

 

Design‐code CODE 
 

F1 {parameter‐name | PROFILE a1 (a2 a3)} {MEMBER memb‐list | ALL| 
member‐group‐name | deck‐name} 

 
design‐code = {AAShto, AISC, AUSTRALIAN, BRITISH, CANadian, FRENCH, GERMAN, 

INDIAN, JAPAN LRFD, MEXICAN ...} 
Description 

 
Parameter‐name  ‐ refers to the name of the parameter  listed  in the parameter table 
contained in section steel design. 

 
For AISC allowable stress design, see Table 2.1. For a list of design parameters for AISC LRFD 
load resistance, see Table 2.2. For design of steel to other codes, refer to the relevant sections. f1 
= Parameter value. The user can control the layout by specifying the appropriate parameters. 

 
The PROFILE parameter is available for code AISC ASD (allowable stress design) only. The user 
can specify up to three sections (a1, a2 and a3). The profile, as described in Table 3.1, consists of 
the first three letters of a name in the catalog of AISC steel, for example, W8X, W12, C10, L20, 
etc. PROFILE Name parameter is used only for the selection of members to these profile names. 
Also specified under section PROFILE must be the same as specified initially given under 
MEMBER PROPERTIES. Note that the PROFILE command, you can only use for the catalog of 
American steel. The CODE parameter selects the type of code will be verified steel do in design. 
The default code for steel depends on the country of distribution. 

 

Example 
 
 

PARAMETERS 

CODE AISC 

KY 1.5 MEMB March 7 TO 11 

NSF 0.75 ALL 

W14 W12 PROFILE MEMB February 1 23 

ALL RATIO 0.9 
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Notes 

 
1. All values of the units must be in the system of units in use. 

 

2. For the default values of the parameters, see the appropriate table settings. 
 

3. The PROFILE command is available with the American code AISC ASD only. Not 
available with AASHTO LRFD or codes. 

 
 
 
 

5.44.2 Specification review under codes 
 

 
Objectiv
e 

 
This command is used to execute the code under verification. 

 

General Format 

 
CHECK CODE {MEMBER memb‐list | ALL | Group‐name member‐ 
| Deck‐name | PMEMB pmember‐list} 

 

 
Description 

 
This command checks the members specified against the specifications of the desired code. 
For detailed information, refer to Section 2 of this Manual. 

 
Note: The output of  this  command  can be  controlled using  the TRACK 
parameter. Three levels of information are available. See the appropriate 
section of steel design for more information about the TRACK parameter. 

 
 
 
 
 

5.44.3 Member Selection Specification 
 
 

Objectiv
e 

 
This command is used to execute the MEMBER SELECTION. 

 

General Format 

 
SELECT {MEMBER memb‐list | ALL | Member‐group‐name | 
deck‐ name | PMEMB pmember‐list} 
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Description 
 

 
Using this command, the program selects specific members, based on the constraints on the 
values of the parameters and the specific code. The selection is made using the latest results 
and analysis sections iterating until the size of less weight is chosen. See Section 3 of this 
manual for details. 

 
 

Notes: The output of this command can be controlled using the TRACK 
parameter.  Three  levels  of  detail  are  available.  See  the  appropriate 
section Steel Design  for more  information on  the TRACK parameter. 
Member selection can be made after an analysis has been performed 
do. Consequently,  the  command  for  the  analysis has  to be  specified 
before the MEMBER SELECT command may be specified. 

 
 
 
 
 
 

5.44.4 Selecting Members for Optimization 
 

Objectiv
e 

 
This command executes the member selection optimized using a technique based on multiple 
iterations of design and analysis. 

 
General Format 

 
SELECT OPTIMIZED 

 

Description 
 

 
Through this command, the program selects all based on a sophisticated optimization technique 
members. This method requires multiple analysis of the stiffness matrix, as well as the iteration 
of sizes until the minimum weight of the whole structure is obtained. This command should be 
used with caution, since it requires more processing time to solve a structure. 

 
 

Notes 
 

 
1. The output of this command can be controlled via the TRACK parameter. Three levels 

of information are available. See appropriate steel design for more information about 
the TRACK parameter. 

 

2. This command may involve multiple cycles of analysis and design iterations so that 
could be a very slow process. 
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5.44.5 Welding Specification Selection 
 

Objective 

 
This command performs the selection of sizes for specified Welding members. 

 
 

General Format 

 
SELECT WELD (TRUSS) {MEMBER memb‐list | ALL } 

 

Description 
 

 
Through this command, the program selects weld sizes at the beginning and end of the 
specified members. The selections are tabulated with all necessary information. TRUSS If the 
command is used, the program designed for angle welds or double members 
angle connected to one another to strengthen the splice plates with welding along the length 
of the member. 

 
 

 
Note: The calculation of weld size can also be controlled parametrically. 
For more information on the available parameters, see the appropriate 
section in Steel Design. 

 
 

 

5.45 Group specifications 
 

 
Objectiv
e 

 
This command is used for grouping members within the analysis and design of steel. 

 

General Format 

 
(FIXED GROUP) 

 

GROUP MEMBER memb prop‐spec‐list (SAME AS i1) 
 

prop‐spec = {AX | SY | SZ } 
 

Description 
 

 
This command allows the program to group specific members for analysis according to their most 
important properties. If the member number in the SAME AS i1 command, the program provides 
members grouped according to i1. This command is typically used after the selection of members, 
and where the members can be grouped for further process. 
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If FIXED GROUP option is used, the specified group will be retained in memory for the program 
and will be used in selecting operations and subsequent members of the cluster results will not 
be seen unless a MEMBER SELECT operation is performed. 

 

 
 
 

Example 
1 

 
 

SZ MEMB GROUP TO 1 3 7 15 December 
MEMB GROUP 17 TO 23 27 SAME AS 30 

 

 
 
 

In this example, members 1, 3, 7 to 12 and 15 are assigned with the same properties according 
to which these members have the largest section modulus. 

 
Members from 17 to 23 and 27 are assigned with the same properties as the member 30, regardless 
of whether the member 30 has area smaller or larger section. AX is the default property on which 
grouping is based. 

 

 
 
 

Example 
2 

 
 

FIXED GROUP GROUP 

1 TO 5 MEMB 

SELECT OPTIMIZED 
 
 

In the above example, using the GROUP command FIXED illustrated. OPTIMIZED SELECT 
command involves the following three processes, 

 

 
1. Member Selection 

 
2. Grouping members (1-5) 

 
3. Analysis 

 
Until after several iterations convergence properties of members in consecutive cycles is 
obtained. FIXED GROUP command is necessary for the execution of step 2 in the cycle. 

 
 

Note: This command is typically used after the selection of members for 
further analysis and design. This option can be effectively used to develop 
a design‐oriented, where various members need to be the same size. 
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5.46 Specification of Steel Estimating 
 

 
Objectiv
e 

 
This command is used to obtain a summary of all the steel sections used along with their 
lengths and weights. 

 
General format: 

 
STEEL (MEMBER) TAKE (OFF) 

 
Description 

 

 
This command provides a complete list of all the different sections of the tables used in the 
steel structure. The tabulated list include the total length of each section name and its total 
weight. This can be useful in estimating quantities of steel. The MEMBER option lists the 
length and weight of each member by number, the type of profile, weight and length. 

 
Note: This option can be effectively used to obtain a quick estimate of the 
amount of steel in the structure. 

 

 
 
 
 
 

5.47 Concrete Design Specification 
 

 
 

This command describes the specifications for the particular design. The design procedure 
implemented STAAD.Pro specifically consists of the following steps. 

 
1. Home Design 

 
2. Specifying parameters 

 
3. Specifying design requirements 

 
4. Requisition estimate 

 
5. Conclusion Design 

 
The design section 5.47.1 describes the design start command. About 5.47.2 section relation to 
specifying parameters. The specifications of design requirements are described in Sections 
5.47.3. The particular estimation command described in section 
5.47.4 and finally, the command completion design is described in section 5.47.5. 
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5.47.1 Home design specifically 
 

Objective 

 
This command is used to start the particular design. 

 

General format: 
 

START  CONCRETE  DESIGN 
 

Description 
 

 
This command starts the particular design specifications. With this, the design parameters are 
automatically placed in their corresponding default values (as shown in Table 3.1). Without 
this command, any of the following commands concrete design will be recognized. 

 
 

Note:  This  command must  be  included  before  any  other  command 
particular design. 

 
 
 

5.47.2 Concrete Design Parameters 
 

Objectiv
e 

 
This group of commands are used to specify the parameters that control the particular design. 
General Format 

 
Design‐code CODE 

 

parameter‐name f1{MEMBER member‐list | ALL } 
 

Description 
 

 
Parameter-name refers to particular parameters described in Table 3.1. f1 is the value of the 
parameter. Note that this value is always given in the units in use. The UNIT command is also 
accepted during any phase of the particular design. 

 
 

Note: All values should be provided according to the system of units in 
use. For the default values of the parameters, refer to Section 3. 

 
 

5.47.3 Command Concrete Design 
 

Objectiv
e 

 
This command is used to specify the type of design required. Members can be designed as 
beams, columns or elements. 
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General Format 

 
DESIGN {BEAM | COLUMN | ELEMENT memb‐list} {| (ALL)} 

 

Description 

 
Members will be designed must be specified as BEAM, COLUMN or ELEMENT. Note that 
members, once they have been designed as beams, can not be redesigned again as columns, or 
vice versa. 

 

 
Note:  Only  the  plates  can  be  designed  as 
elements. 

 
 

 
5.47.4 Estimation of Concrete 

 

 
Objectiv
e 

 
This command is used to obtain an estimate of the total volume of concrete and rebar that 
will be used and their respective weights. 

 

 
General format: 

 
WITHCRETE T AKE OFF 

 

Description 

 
This command can be used to print the total volume of concrete and the number of rods and 
their respective weights designed for members. 

 
Sample output: 

 

 
 

TAKE OFF CONCRETE ************** ************** 
(DESIGNED FOR BEAMS AND COLUMNS 

ABOVE) 
 
 

TOTAL VOLUME OF CONCRETE BAR SIZE = 

87.50 CU.FT WEIGHT 

NUMBER (In lbs) 
-------- -------- 

4 805.03 

6 91.60 
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8 1137.60 
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9 653.84 

11 818.67 

------------ 

TOTAL *** = 3506.74 
 

 
 
 

Note: This command is used effectively to quickly estimate quantities. 
 
 
 
 
 

5.47.5 Completion of Concrete Design 
 

Objective 

 
This command should be used to finalize the design in particular. 

 
 

General format: 

 
END WITHCRETE D ESIGN 

 

 
 
 
 

Description 

 
This command specifically design concludes after which normal STAAD.Pro commands 
continue. 

 
Example 

 
 

START  CONCRETE  DESIGN 

CODE ACI 

40.0 FYMAIN ALL 

FC 3.0 ALL 

DESIGN TO BEAM 1 July 4 

COLUMN DESIGN TO 16 September 12 

DESIGN ELEMENT 20 TO 30 END 
 
 

Note: Without this command, subsequent commands will not be 
recognized STAAD.Pro. 
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5.48 Foundations Design Specification 
 

 
In previous versions of the program STAAD.Pro (For example: STAAD-III). The foundation 
design specifications was together with the complete package in a single program, such as 
performing other types of design that just discussed (Design of Steel and Concrete). 

 
The foundation design can be performed using the program separately from STAAD.foundation 
through user interface design similar to that of STAAD.Pro foundations. 

 

 

5.49 Design Specification Walls Cutters 
 
 

STAAD performs the design of reinforced concrete shear walls by the following codes: ACI 318-
02 (American), BS 8110 (UK) and is 456: 2000 (Hindi). To design a shear wall, you must first 
be modeled using the surface element. 

The Scope of the design depends on whether the definition of the panel, as explained in 
Section 5.49.1, precedes the input block design shear walls as explained in Section 5.49.2. 

 
a. No definition of Panel 

Design is made to the specified horizontally full section, located at a distance c from the 
origin of the local coordinate system. 

 

 
b. The panels are defined. 

Design is made for all panels of the cross section located at a distance c from the 
commencement of the panel. 

 
The design of shear walls is not available for dynamic load cases. 

 

5.49.1 Wall Settings Panel for Walls Design Cutters 
 

 
Due to the presence of openings may be defined three types of structural elements within the 
limits of a shear wall: wall, column and beam. For each of these entities, a different set of design 
and details of the rules applies. Types of panels 
‐ Functionally different parts of  the  shear wall  ‐ are assigned manually. 

Allocation 
is based on the geometry of the panel, the overall position and configuration of wall. Wall, 
column and beam panels are then designed according to the relevant provisions of the Code. 

 
 

General Format 
 

 

START PANTHE DEFInition 
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SURI PAN FACETHE j x1 y1 z1 x2 ptype z2 y2 ... xn yn 

zn PAN ENDTHE DEFInition 
 

Where: 
 

 
 
 
i: Number of ordinary surface j: 

regular Number of panel 

ptype: panel type. For the ACI code, the available types are Wall, column and beam (for 
ACI 318 and 456). For the British code, only the type of wall is available. 
 
x1 y1 z1 (...): coordinates of the corners of 
the panel 

 
 

5.49.2 Walls Home Design Cutters 
 

 
It is used to initiate a design cutting concrete wall. 

 
General Format 

 
SHEARWALL START DESIGN 
CODE {ACI | BRITISH | INDIAN} 
parameter_name f1 
DESIGN SHEARWALL (f2 AT) LIST wall_list 
TRACK CREINF 
i1 i2 
SHEARWALL END DESIGN 

 

Options are ACI code (ACI 318) or British (BS 8110). Where: 
 

    parameter‐name = refers to the parameter name (s) listed  in tabular form 
(Table  3.4)  in  section  3.8  of  this manual  for  the ACI  code  and manual of 
international codes 456 and BS 8110: 2000. 
f1 = Parameter value. Not all parameters required values. f2 = optional 

location in which the design is to make 
 

 
Note: If the AT command is omitted, the design is appropriate for all cross 
wall panels or  sections,  as  appropriate,  as defined by  the  input  values 
SURFACE SURFACE DIVISION DIVISION X or Y. 
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  i1 = Parameter column reinforcement. Distribution reinforcing panels within the column is controlled by 

the CREINF parameter, which can have one of three possible values: 
 

1. number of bars on all four sides of the column (the default), 
 

2. equal number of bars perpendicular to the plane of the wall, two sides 
 

3. equal numbers of two parallel rods on the wall plane faces. 
 
 
 

i2 = TRACK output parameter specifies how detailed should be the output of the 

design: 
1. indicates a core set of outcome data (default) 
2. Full design output is generated. 

 

 
 
 

5.50 Various Special Commands 
 

 
The following are two special commands, which can be used to control the precision 
characteristics of the elements of the stiffness matrix and the memory requirements for a 
particular problem. 

 
 
 

5.50.1 Commando Precision 
 

Objectiv
e 
This command is used to control the characteristics of accuracy in verifying the stiffness matrix 
of the structure. 

 

General Format 

 
PRECision  f1 

 
 

Where:   
 
f1 = number against which the stiffness coefficients be checked (the default is 0.01) 

 
 

Note: This command must be provided before  JOINT COORDINATES 
specifications. 

 
 

Description 
 

 
The global stiffness matrix of a patterned structure right mind is always a symmetric matrix 
with positive elements on the main diagonal. Negative or positive, but very small components 
are usually a result of incorrect modeling in a matrix 
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poorly conditioned stiffness. In STAAD.Pro, all numerically lower stiffness coefficients of 0.01 
are identified as potential sources of instability and in such cases warning messages are sent to 
the user. In certain special situations, these stiffness coefficients may represent correct numbers. 
So to eliminate the error message in these circumstances, use the PRECISION command re-
specifying the value against which the coefficients are double checked. This command should 
be included at the beginning of the input file. 

 
 

5.50.2 Command Memory Entry 
 
 
 

Objectiv
e 

 
This command is used to control the memory requirements in the event that there is an 
overflow problem. 

 
General Format 

 

 
 
 

INPUT M EMORY f1 
 

 
 

Where:  
 
 
f1 = memory capacity (the default for the PC version is 16000) 

 

Description 
 

 
This command can be used in a state of overflow, to reduce the memory requested by the 
problem. A default value of 16000 is preset in the program. A low number that it can reduce 
the memory requirements. Problems that require more memory, can be solved using this 
command. Using this command will result in slower execution. So, we must be cautious with 
the use of this command. If you have the resources, increasing the number will result in faster 
execution. This command should be included at the beginning of the input file. 

 
 

Notes 

 
1. This command must be provided before specifying CCORDINATES JOINT. 

 

 
2. The value of f1 do can be specified as zero, in which case the command INPUT 

MEMORY result in a minimum demand for central memory problem. However, the 
user is warned of its use, since it will reduce the speed of execution. Thus, one should 
consider the use of this command only when a message has appeared OVERFLOW 
CORE and all other means of reducing the demand for the main memory have been 
extensively analyzed. 
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5.51 Specifying Saving Files 
 

 
Objective 

 
This command can be used to store execution data and analytical results for later execution of 
the program. 

 
General Format 

 
SAVE (a1To2) 

 

 
 
 
 

Description 

 
    a1 = name of the file in which the analytical results and data will be saved. 

Any name up to 12 characters, beginning with alphabetic characters, will be accepted. 
 

    a2 = name of a second file in which the load data will be saved. 
Any name different from the first and up to 12 characters, beginning with an alphabetic 
character, will be accepted 

 

 
 
 

Note: If the file names are not provided, the data will be saved in files 
named TEM1 and TEM2 respectively. 

 
 
 

 

5.52 Specifying File Restoration 
 
 
 

Objective 
 

This command can be used to restore data from a saved by the SAVE command execution. 
 

General Format 

 
RESTORE (a1To2) 
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Description 
 

 
a1 and a2 are the same as on file names are specified in the SAVE command. This command is 
used to restore a previous run of STAAD.Pro that has been saved with the SAVE command. If 
a1 and a2 names are omitted, the program will take names as TEM1 and TEM2 respectively. 
Thus, an updated, without defining any execution file name may be restored in the same way, ie, 
not specifying the names of the files in the RESTORE command. 

 
Exampl
e 

 
 

STAAD SPACE RESTORE 
TITLE FILE1 FILE2 

 
 
 

Note: This command will recognize the names of the files and TEM2 TEM1 
default. Operations involving Finite Element can not be performed with 
the restored file. 

 

 

5.53 Specifying the Implementation Completion 
 
 

Objectiv
e 

 
This command must be used to complete the execution of STAAD.Pro 

 

General format: 

 
EndISH 

 

Description 

 
This command must be provided as the last input command. With what is left terminating a 
running STAAD.Pro 



 

 




